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Revision History

Rev. 1.0: Initial release. The description for the software functionality is based on VAST rev.
1.13.1.10.

/\ WARNING:

1. Do not format or initialize the Disk 0: drive on your NVR. The Disk 0: drive contains the
operating system. Doing so will disable the system.

2. No storage system is completely fail-safe. Damage to data might occur due to file system
corruption, operating system malfunction, virus infection, HDD component failures, and so on.
Therefore, it is highly recommended to regularly back up your data, and VIVOTEK disclaims
responsibilities of data loss or recovery.

3. Always power off the system using the power down button on system desktop. Do not
disconnect the power cord while the system is still operating. Doing so will result in data
inconsistencies. The normal power-off procedure allows cached data to be written to disks.

Technology License Notice

iz HEW’ \dvance

\-'c u
"B (Covered by Patents at patentlisthevcadvance.com

Notices from HEVC Advance:

THIS PRODUCT IS SOLD WITH A LIMITED LICENSE AND IS AUTHORIZED TO BE USED ONLY
IN CONNECTION WITH HEVC CONTENT THAT MEETS EACH OF THE THREE FOLLOWING
QUALIFICATIONS: (1) HEVC CONTENT ONLY FOR PERSONAL USE; (2) HEVC CONTENT THAT
IS NOT OFFERED FOR SALE; AND (3) HEVC CONTENT THAT IS CREATED BY THE OWNER OF
THE PRODUCT. THIS PRODUCT MAY NOT BE USED IN CONNECTION WITH HEVC ENCODED
CONTENT CREATED BY A THIRD PARTY, WHICH THE USER HAS ORDERED OR PURCHASED
FROM A THIRD PARTY, UNLESS THE USER IS SEPARATELY GRANTED RIGHTS TO USE THE
PRODUCT WITH SUCH CONTENT BY A LICENSED SELLER OF THE CONTENT. YOUR USE OF
THIS PRODUCT IN CONNECTION WITH HEVC ENCODED CONTENT IS DEEMED ACCEPTANCE
OF THE LIMITED AUTHORITY TO USE AS NOTED ABOVE.
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Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera
is not only a high-performance web-ready camera but can also be part of a flexible surveillance
system. It is the user’s responsibility to ensure that the operation of such devices is legal before
installing this unit for its intended use.

It is important to first verify that all contents received are complete according to the Package
Contents listed below. Take note of the warnings in the Quick Installation Guide before the
Network Camera is installed; then carefully read and follow the instructions in the Installation
chapter to avoid damage due to faulty assembly and installation. This also ensures the product is
used properly as intended.

The Network Camera is a network device and its use should be straightforward for those who
have basic networking knowledge. It is designed for various applications including video sharing,
general security/surveillance, etc. The Configuration chapter suggests ways to best utilize the
Network Camera and ensure proper operations. For creative and professional developers, the
URL Commands of the Network Camera section serves as a helpful reference to customizing
existing homepages or integrating with the current web server.

ﬁ NOTE:

The operating system and management software are installed on a flash memory mounted on
the main board. Except for the plug-ins for onscreen display, there is no need to install software.

Package Contents

m NR9682 or NR9782

m Power cords

m Software CD

m Warranty Card

m Mouse

m Quick Installation Guide
m Screws and slide rails

Symbols and Statements in this Document

INFORMATION: provides important messages or advices that might help prevent inconvenient
1 or problem situations.

? NOTE: Notices provide guidance or advices that are related to the functional integrity of the
machine.

v~ Tips: Tips are useful information that helps enhance or facilitae an installation, function, or
process.

WARNING! or IMPORTANT: These statements indicate situations that can be dangerous or
hazardous to the machine or you.

Electrical Hazard: This statement appears when high voltage electrical hazards might occur
to an operator.

>5



Chapter One Hardware Installation and Initial
Configuration

Introduction

NR9682/NR9782 is the latest 64-/128-channel H.265, RAID-protected NVR from VIVOTEK,
bringing stable and efficient system operation under a wide range of recording/network man-
agement/system settings. The unit supports all VIVOTEK camera models, including the latest
5-Megapixel and fisheye cameras. The support for RAID 1/5/6/10 provides data security in the
event of disk drive failure.

The unit is equipped with two gigabit Ethernet RJ45 ports which provide network failover func-
tionality to avoid the risk of recording loss. When one network line is disconnected, the system
will shift to the other network automatically, providing continuous access for video data. Up to
16 HDDs can be installed in the NR9782 for a total storage capacity of up to 96TB (6TB max.
each). The hot-swappable HDD trays are available in the front of the unit, with hot-swap func-
tionality for easy replacement.

A VAST CMS server runs on the machine that manages surveillance recording and playback.
The compatibility with the iViewer application allows for remote access to the NR9682/NR9782
on handheld devices. By integrating all of the components together using VIVOTEK’s NR9682/
NR9782, network cameras, VAST, and iViewer software, users can realize a fully-featured and
robust next-generation surveillance system. This ingenious NVR also features the remote man-
agement capability with a full range of server/client structures and thus is capable for robust and
diverse applications.

Special Features

e Runs on embedded Windows

e 3U Rack Mount Design

e RAID 0, 1, 5, 6, 10, 50, 60 in virtual drive storage configurations

e 16 x HDD Tray, for a max. capacity of 96TB

e 2 x Gigabit RJ45 Ethernet ports

e 8 (QG2,WG2: 6 x USB 3.0, 2 x USB 2.0; L: 4 x USB3.0, 4 x USB2.0)
e Size: (WxHxD)435x132x 540 mm (17.13" x 5.2” x 21.26”)

e 128-CH Live View & 16-CH Synchronous Playback

e H.265/H.264/ MPEG-4

e PTZ Support

e Snapshot / Export Media

e PiP Video Control

e Bookmark Design

e Fast Configuration Backup / Restore

e Pre-installed VIVOTEK VAST Central Management Software*
e Full Integration with VIVOTEK Network Cameras

e VIVOTEK iViewer Support (i0S/Android)



Safety

1. Read these safety instructions carefully.

2. Keep this User Manual for later reference.

3. Disconnect this equipment from any AC outlet before cleaning. Use a damp cloth. Do not use
liquid or spray detergents for cleaning.

4. For plug-in equipment, the power outlet socket must be located near the equip-ment and
must be easily accessible.

5. Keep this equipment away from humidity.

6. Put this equipment on a reliable surface during installation. Dropping it or letting it fall may
cause damage.

7. For rack-mount equipment, please firmly install the device with pallets or sliding rails in the
rack.

8. Do not leave this equipment in an environment unconditioned where the storage temperature
under 0° C (32° F) or above 40° C (104° F), it may damage the equipment.

9. The openings on the enclosure are for air convection. Protect the equipment from overheat-
ing. DO NOT COVER THE OPENINGS.

10. Make sure the voltage of the power source is correct before connecting the equipment to the
power outlet.

11. Position the power cord so that people cannot step on it. Do not place anything over the
power cord.

12. All cautions and warnings on the equipment should be noted.

13. If the equipment is not used for a long time, disconnect it from the power source to avoid
damage by transient overvoltage.

14. Never pour any liquid into an opening. This may cause fire or electrical shock.

15. Never open the equipment. For safety reasons, the equipment should be opened only by
qualified service personnel.

16. If one of the following situations arises, get the equipment checked by service personnel:

B The power cord or plug is damaged.

W Liquid has penetrated into the equipment.

B The equipment has been exposed to moisture.

W The equipment does not work well, or you cannot get it to work according to the user's
manual.

B The equipment has been dropped and damaged.

W The equipment has obvious signs of breakage.

17. CAUTION: The computer is provided with a battery-powered real-time clock circuit. There is
a danger of explosion if battery is incorrectly replaced. Replace only with same or equivalent
type recommended by the manufacture. Discard used batteries according to the manufac-
turer’s instructions.

18. This device complies with Part 15 of the FCC rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interferencethat may cause undesired operation.



19. CAUTION: Always completely disconnect the power cord from your chassis whenever you
work with the hardware. Do not make connections while the power is on. Sensitive electronic
components can be damaged by sudden power surges.

20. CAUTION: Always ground yourself to remove any static charge before touching the
motherboard, backplane, or add-on cards. Modern electronic devices are very sensitive to
static electric charges. As a safety precaution, use a grounding wrist strap at all times. Place
all electronic components on a static-dissipative surface or in a static-shielded bag when
they are not in the chassis.

21. CAUTION: Any unverified component could cause unexpected damage. To ensure the
correct installation, please always use the components (e.g., screws) provided with the
accessory box.

Installation Instructions

Warning:
Read the installation instructions before connecting the system to the power source.

Warning:
This product relies on the building’s installation for short-circuit (overcurrent) protection.
Ensure that the protective device is rated not greater than: 250V, 20 A.

Warning:

The system must be disconnected from all sources of power and the power cord.re-
moved from the power supply module(s) before accessing the chassis interior to install or
remove system components.

Warning:
Only trained and qualifiedpersonnel should be allowed to install, replace, or service this
equipment.

Warning:

This unit is intended for installation in restricted access areas. A restricted access area
can be accessed only through the use of a special tool, lock and key, or other means of
security. (This warning does not apply to workstations).

Warning:

There is the danger of explosion if the battery is replaced incorrectly. Replace the bat-
tery only with the same or equivalent type recommended by the manufacturer. Dispose of
used batteries according to the manufacturer’s instructions.

Warning:
This unit might have more than one power supply connection. All connections must be re-
moved to de-energize the unit.



Warning:

Hazardous voltage or energy is present on the backplane when the system is operating.
Use caution when servicing.

Warning:

Installation of the equipment must comply with local and national electrical codes.

Warning:
Ultimate disposal of this product should be handled according to all national laws and
regulations.

Warning:
The fans might still be turning when you remove the fan assembly from the chassis. Keep

fingers,screwdrivers, and other objects away from the openings in the fan assembly’s
housing.

Warning:

When installing the product, use the provided or designated connection cables, power
cables and AC adaptors. Using any other cables and adaptors could cause a malfunction
or a fire.Electrical Appliance and Material Safety Law prohibits the use of UL or CSA -cer-
tified cables (that have UL/CSA shown on the code) for any other electrical devices than
products designated by the manufacturer only.

Power Supply

Watt 550W max. (80+ Gold, PFC) (1+1 Redundant 2U)
Input rating 100 ~ 240 Vac ~6.9A-2.8A, 50-60Hz

Output voltage +5VSB @ 2.5A, +12V @ 45A

Minimum load +12V @ 0.5A

Safety UL/TUV/CCC

Environmental Specifications

Environment Operating Non-operating

Temperature 5~35°C (32 ~ 104°F) --40 ~ 70°C (-40 ~ 158°F)

Humidity 10 ~ 95% @ 40°C, non-condensing 10 ~ 95% @ 60°C, non-condensing
Vibration 0.5 G rms 2G

Shock 10 G with 11 ms duration, half sine wave

Safety CE compliant
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Grounding Requirements

1. The enclosure is designed to be rack-mounted, in an equipment room which has limited hu-
man access.

2. In addition to the grounding via the power cords, make sure your equipment rack is properly
grounded. If the equipment rack is not properly grounded, connect the ground wire to a go-
runding bus bar, which is then connected to an earth ground.

3. Use a ground wire of a copper cross section at least 16AWG.

o0

Main grounding bus
bar

o =S m—el

S=——

Ground screw

Rack ground bar [

i

— Mesh common bonding

Earth
ground
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Physical Description
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Warning:

Knowing the correction positions of hard drives is very important. For example, if a hard

drive fails in a RAID5 Virtual Drive, you can initialize a rebuild by locating and replacing
the failed drive. If you replace the wrong drive, it means that you have 1 failed drive and
another mistakenly failed drive. Having 2 failed drives in a RAIDS configuration renders
all data inaccessible. All data in the RAIDS Virtual Drive will be lost.



Control Panel buttons and LEDs

Power switch Press this switch to turn the system power on or off. Please use
system shutdown or press this switch for few seconds to turn
off the system ATX power.

The main power switch is used to apply or remove power from
the power supplies to the server. Turning off system power
using this button removes the main power but keeps standby
power supplied to the system. You must unplug the system
before servicing components inside the chassis.

Reset button Press this button to reboot the system.
@ Power LED Blue Red
= ON: Normal N/A
LAN status LED ON: Normal N/A
Blinking: transmitting data. N/A
@ HDD LED* Blinking: data access. N/A
OFF: idle N/A
Information: PEF occurred |N/A ON: System abnormal.
by motherboard's BMC

* The HDD LED here only displays the status for those attached to the motherboard.

Front Hot-swappable Drive Tray LEDs

SCF Activity LED: Green G\ Status LED:
Drive not present OFF OFF
Drive present, no activity ON OFF
Drive present, activity 4Hz blinking OFF
Locate (Identify) OFF 4Hz
Fail OFF
Rebuild OFFF 1Hz

Activity

@ e i
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e =
C 3 =
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Status



O Rear View

Ground screw

Mute button
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Display

Interface Resolution

HDMI Supports max resolution HDMI 1.2 1920 x 1200 @ 60 Hz (Colay HDMI 2.0,4096 x 2160 @
60 Hz, optional)

DVI-D Supports max. resolution 1920 x 1200 @ 60 Hz

Display port Supports max resolution 4096 x 2304 @ 60 Hz

eDP Internal pin header, supports max. resolution 3840 x 2160 @ 60 Hz (on board)

VGA Max resolution 1920 x 1200 @ 60 Hz (on board) (optional)

Triple display eDP/ VGA + DP++ + HDMI, eDP/ VGA + HDMI + DVI-D, DP++ + eDP/ VGA + DVI-D,
DVI-D + DP++ + HDMI

Dual display DP++ + HDMI, DP++ + DVI-D, DP++ + eDP/ VGA, HDMI + DVI-D, HDMI + eDP/ VGA,

eDP, VGA + DVI-D

/\ IMPORTANT:

It is important to leave a clearance of 76cm to the rear side of the chassis. The clearance is re-
quired to ensure an adequate airflow through the chassis to ventilate heat. A 64cm clearance is
also required on the front of the chassis.

To ensure normal operation, maintain ambient airflow. Do not block the airflow around chassis
such as placing the system in a closed cabinet.
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Chassis Dimensions
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Rack-mounting

A IMPORTANT:

If you have either a round-holed or square-holed rack, install cage nuts or clip nuts to the
desired positions on the rack posts.

The instructions below are based on the installation to a 4-post equipment rack.

1. There is a pair of ears and handles in the accessory box. If you need to install them, please
refer to the drawing below to fasten them to the front-right and front-left mounting ears using
the provided screws.
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2. Remove the inner rail from the slide rail assembly.
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3. Secure the inner rails to the sides of the chassis using the included screws.

*Push the safety lock forward to secure

*Release safety lock
before mounting

a..”.........“ =

5 (P T 7

Push the safety lock forward to secure the bracket. .

4. Insert the stag into the upper and lower square holes on the EIA rail from the back of the rail.
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It is important to check if the safety lock is in the unlocked position before mounting the brackets.
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5. Lift and insert the chassis into the rack cabinet as shown below. It is important to check if the
ball bearing retainer is in the fully open position before installing the chassis or it might cause
catastrophic damage to the chassis if the ball bearing retainer is not in the fully open position
while mounting the chassis. While you are pushing the chassis into the cabinet, you will need
to release the slide from the locking position by pressing the trigger down.

* VERY IMPORTANT — IT REQUIRES AT LEAST 2 PEOPLE TO INSTALL
THE CHASSIS FOR SAFETY PUROPOSE.

*Press trigger down to release
the slides from locking
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Installing Hard Disk Drives

/N IMPORTANT:
* Refer to VIVOTEK's website for the hard disk compatibility information.

* Avoid touching the hard drive's circuit board or connector pins. Doing so can damage the
hard drive by electro-static discharge.

1. Remove drive trays from the chassis. Push the bezel lock to the left, and then press the
release tab. The tray lever will pop out.

It is recommended to wear an anti-static
E wrist strap when handling hard drives.

A I T 5™




into the chassis.

I
5]
S
£
S

S

®
|
o)
(%2}

&)

1
©

(9V]

3. Install hard drives by driving screws from the sides. When done, gently install the drive trays
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2. Pull the lever to remove drive trays.




Connecting Interfaces

Refer to page 18 for the interface connections.

1. Make sure all cameras have been properly installed, either they are powered by 12V
power lines or using one or several PoE switches or mid-spans. Refer to the cameras'
documentation for details.

2. Connect all other interfaces to USB mouse/keyboard, one or two monitors, and audio input/
output devices.

3. Make sure you connect both power supplies to power mains.

Initial Configuration

1. Power up the system by pressing the power on button.
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2. Skip the BIOS screens and select Enter NVR at the selection screen. The system will start.
Wait for the start-up process to complete.

i

0 Enter NVR

1 Restore to default

2 Reboot
3 Shutdown




RAID5/6/10 Virtual Drive

Drive Group

Our default recommendation is to combine 4 hard drives into 1 drive group. The capacities of
these drives will be utilized to form 1 Virtual Drive. If all 16 drive bays are populated, you can
create 4 Virtual Drives. A 4-member Virtual Drive can receive the video feeds from 32 cameras.
You can also create two 8-member Virtual Drives to receive the video feeds from 64 cameras (CH,
or channels.)

Recording will not take place unless you create a Virtual Drive first. Select RAIDS as the RAID
level during the configuration process.

each LUN

. LUN - Volume

Virtual Drive

Drive Group
x2
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The default configuration for a configuration of 128 cameras should look like the following:

Physical & Logical Configuration

components

Hard drive 16

Virtual Drive 4, each has 4 members. Configured in RAIDS.
If using 6TB drives, the available capacity in each Virtual Drive will be,
4 x 6TB-1 x 6TB(parity drive)= 18TB.

Volume 4, each created from 1 Virtual Drive.

The camera configuration should look like this,

Physical & Logical
components

Configuration

Cameras

128

Recording Group

4, each responds to 32 cameras, and each Recording Group is associated with 1 Virtual
Drive volume.

Volume

4, each created from 1 Virtual Drive, and associated with 1 Recording Group. .

A Virtual Drive appears to the host system (Windows) as a logical disk partition. The logical
parition, when formatted, becomes a disk volume.

LUN - Volume
x4
Virtual Drive
x4
Drive Group 4 members (RAID5)

x4
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1. The system will boot up to the system main screen. Double-click on the RAID Config shortcut
to start the MegaRAID storage configuration utility.

tm Control Cantar Diske: Sram Harwans Seaie fyrnn thars

¢ © & m

Trgort | Fxges RNy

= 8 =9
X2
L=t ME RATD Lonily

2. Select the default server, namely, the Windows 7 server running on this machine. Click Login
to begin your configuration.

3. Enter vivotek/vivotek as the User Name and Password. Click Login to proceed.

e

- A
Server : 127.0.0.1
|| - .
and password to login the
User Name: vivotek |

Default:
Password: |v-i votek | V'! votek

vivotek
Login Mode: Full Access -

| Loon & _/EE
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4. A Dashboard view will appear. Click the Logical tab.

‘Mamaga Go e Log Fosis bl
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5. Left-click to select the AVAGO MegaRAID controller, and then right-click to display a

command menu.

ﬂ‘_lmﬁ“&mlﬂ e
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6. Click on Create Virtual Drive.

N\

/
Unconfgpaed Il Vbl fies . .
SO S " "=="C_Create Virtual Drive

| B : HPCAEES [0, Slience Aarrm '
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St Patrol Resed Propesties
Dicabis 550 Guard

T
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R
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7. The Create Virtual Drive wizard will start. Click to select the Advanced mode. Then click the
Next button to proceed.

B cone Voo
AvaGo

This wizard will help you quickly create virtual drives.

Choose how to create the virtual drive:

Wﬁmmﬂhﬂwhs@hﬁﬁ&mfmm.Tl'isislheaas'stwaylncraalza
wir

@ Advanced
Choose additional settings and customize virtual drive creation. This option provides greater flexibility when creating
virtual drives for your spedfic requirements,
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8. Select a RAID level, and then select multiple disk drives as the members of your drive group.
Left-click to select a disk drive, and click Add to add it to group. You do not need to select the
Data protection option.

7 - 3
a Create Drive Group - Drive Group Settings @

Create the drive group by specifying the RAID | ecurity method.
RAID level:

. RAID 5 This RAID level is suitable for multi-user environments{database

IRA].D 5 - or file system) with large IO size and high proportion of read activity.

Celect Drive security method:

RAID O Select Drive sgcurity wi.II make ﬂ1e virtual drive secure by applying encryption logic to

underlying data in the drive.

RAID 1

|~ protectn:

RAD & Disable Data Protection is a guard thgldetects corruption of data on media; thereby preventing|

system errors caused ta corruption (SDC).

R.AID 00 - Spanned Drive Group
RAID 10 - Spanned Drive Group

rive groups:
Controllerd: AVAGO 3108 MegaRAID(Bus 2, De

- @ ETETE

L2 Enclosure : HPC8316 (0), Slot: 0: SATA

Select unconfigured drives:

Drive Type
< Enclosure : HPC8316 (0... |SATA
2 Enclosure : HPC8316 (0... SATA 1.819TH
2 Endosure : HPC8316 (0... SATA 2.723TB

4| i b

Refer to the next section: RAID Basics on page 46, for details about RAID levels.

9. Click on the Drive Group 0 entry you have just configured. The Create Drive Group button
will become available. Click Next to proceed.

g Create Drive Group - Drive Group Settings

Create the drive group by spedfying the RAID level and Drive security method.
RAID level:

RAID 5 This RAID level is suitable for mul
or file system) with large IO size a

Drive security method:

Select Drive security will make the virtual dri

underlying data in the drive.

Data protection:

Dieable Data Protection is a guard that detects corrupti ‘enting
system errors caused by silent data corruption (5D

Select unconfigured drives: Drive groups:

@ Controllero: ava¥o 3108 MegaRAID(Bus 2,1 «
Add == Bw L
= Endosure : HPC3316 (0), Slot: 0: 54 =

ST R 7 Enclosure ; 316 (), Slot: 1: 58—
- = Remov + Endo & (), Slot: 2: 58 ~
4 | T , << Remove e ,

Drive Type Capa...
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9. Select the following key parameters:
Initialization State: Fast Initialization, Strip size: 64KB, RAID policy: No Read Ahead,
Write policy: Always Write Back.

These are important parameters to the disk array performance, and have to be correctly
configured. Click Create Virtual Drive.

No Read Ahead
Always Write Back

10. Click Yes to leave the Write Back concern message.

g Always Write Back mode provides optimal performance, but data loss will
occur if there is a power failure and no cache battery installed or the battery
is failed or discharged.

Are you sure you want to select Always Write Back mode?

Yes | No

A
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11. The wizard may prompt for another virtual drive. Multiple virtual drives can be created from
a physical drive group. Repeat the process to create more 4-member Virtual Drives. When
done, click to select the Virtual Drive 0,VD_0, and then click Next to proceed.

Spwecily par ameters for e nes viriual drive.
Vel drive name: (VD0

[ psdote VensdDve | | oo it [ Remove Whsaloe |

12. The Virtual Drive is instantly created. Click OK, and then click Finish to close the wizard.
You can then terminate the MegaRAID utility.

Pevir P sy dref e sk f prured b e corections. dervla]
ST

Orive group oEmel Orive Geeuapd
RAID Lavel: RAID &
Mombse f GCLlVRES Uiedi i

Orive securicy mechod: Bo Teczyptiom
Daza Frotactian: fimaBied

Her Space L]

Total capacatyr 145,554 &N

Wistual drive I name: a_a
CREATISY 145,354 &0

o TR —
W Creste Vil Derve - Summany ]

= Lvaco

Raview the summary anad n'nhd:i"ml:-.d-* covectans, The virkusl drive(s) wil be ceated when you dick Sinh,
T

Ceive greup mame: DOeive C=eapd
BRID Level: . I

Namber of drives af
brive aecurity scuf
Data Protecticn:
Hot Spare
Toal capacity:

Virtual Srive 1 nags
Capasityi
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13. Double-click on the Disk Management shortcut on the desktop to open the utility.

“m Control Canter Disk: Stofu Netuntirk Smnes Gyatem St

¢ € =k =

@ kL = ©
X2 o
® E E

14. The virtual drive you created should appear as a new disk partition. You need to initialize
and format the partition before using the disk capacity. Left-click to select and then right-click

to display the command menu. Click Initialize Disk to proceed.

B Dizsk Mansgement ‘ e B H |
cFile Reioe Mvow::Help - ¥
o | 1| Rl

mumnumuﬂmwmﬂn
Sefect delcy:

rm

Lise the Tollowing partiion stvle Tor the selocted disky:
| MBS (Master Boct Record]
% GPT (LMD Partison Table)

Neote: The GGPT panion ey is not meagrized by o wersona of
Windews. It is recommendesd fior dieks laoger than T, or dsh used on

tmnumbased computens.
| [ox ][ Coce | ﬂ

S N T [ 7S T (o |
Ha

mpis i AT Heakny (b 059 GE EIDGE
mple L N1 enkey (5 BLET OB o BN L %
Tnple B FAT Heakisy P LITGE El3ME 43N L] %

B G FATR 'ﬂb} Gl NTFE
Haakiny {hctive, Pristasy Pustiticn) |wwmwnmw

Initialize Disk

Offline
Detach VHD




15. Select GPT (GUID Partition Table), and then click OK to proceed. This window may
automatically pop up when Disk Management is started.

Initialize Disk ==

You must intialize a disk before Logical Disk Manager can access it.
Select disks:
[+ Disk 2

Ilze t \ng partition style for the selected disks:

%er Boot Record)
@ GPT (GUID Parttion Tahle}< G PT

Mote: The GFT partition style is not recognized by all previous vergjons of
Windows. It is recommended for disks larger than 2TE. or dj an
tanium-+based computers.

| oK | Cancel |

16. Once initialized, you can create a new volume. Right-click to display the New Simple
Volume command. Click to proceed.

4 Disk 0 e

Basic )
59.63 GB 10,00 GB FAT32 49,562 GB NTFS
Online Healthy {Active, Primary Partition) Healthy (System, Boot, Primary Partition)

== Disk 1 |

Removable (D:)

1.87 GB 1.87 GB FAT

Online Healthy (Primary Partition)
4 Disk 2

Basic

5588.00 GB 204800 GB

Online Unallocated

Mew Simple Volume...
Mew Spanned Volume...
Mew Striped Volume...
MNew Mirrored Volume...

MNew RAID-5 Volume...
Properties

Help

B Unallocated [l Primary partition



17. The New Simple Volume Wizard will prompt. Click Next to proceed.

Mew Simple Volurme Wizard @

Welcome to the New Simple
Volume Wizard

Thig wizard helps you create a simple volume on a disk.

A zimple volume can only be on a single disk.

To continue, click Nexd.

< Back [ Mext > [ Cancel ]

18. Leave the volume size unchanged. Click Next to proceed.

Mew Simple Volume Wizard IEI

Specify Volume Size
Choose a volume size that is between the maxdimum and minimum sizes.

Maximum disk space in MB: 5721982
Minimum disk space in MB: 8
Simple volume size in MB: 57215828

cBack | New? Cancel
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19. When prompted to assign a drive letter, click Next to proceed.

Mew Simple Volume
| J—
||  Assign Drive Letter or Path
L For easier access, you can assign a drive letter or drive path to your partition.
@ Assign the follawing drive letter:
(7 Mount in the following empty NTFS folder: ]

| ==

() Do not assign a drive letter or drive path

| <Back [ Net> | [ Cancel |

20. On the Format Partition page, select the Allocation unit size as 64KB. When done, click
Next to proceed.

Format Partition
To store data on this partition, you must format it first.

Choose whether you want to format this volume, and if so, what settings you want to use.

() Do not format this volume
(@ Format this volume with the following settings:

[¥] Perform a quick format
[] Enable file and folder
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21. Click Finish to end the wizard.

New Simple Volume Wizard @

Completing the New Simple
Volume Wizard

You have successfully completed the New Simple YVolume
Wizard.

You selected the following settings:

Volume type: Simple Volume -
Disk selected: Disk 2
Volume size: 5721982 MB
Drive letter or path: E:

File system: NTFS
Allocation unit size: Default
Wolume label: New Volume
Cnirk frimat- Yes

m

To close this wizard, click Finish.

<Back || Finish Cancel

22. The formatting process will run in the background. When done, the new volume shall be
indicated as a healthy new volume. Close the Disk Management window.

R ELLLAR 3B ik | 32 B0 LaH NIES
Online Healthry [Active, Primary Partition) Heralthy [Systern, Bont, Primany Partitior
ekl
Hermavable ([ 1]
157 &b LET GEFAT
Unline Heslthy (Primary Parttion]
Ak 2
Rasic
5587.88 GR 555787 GB
Omline Furmating
=Disk 1
Remaovable (D:)
1.8]". GB 1.87 GB FAT
Online Healthy (Primary Partition)
i Disk 2
Basic New Volume (E:)
5587.88 GB 5587.87 GB NTFS

Online Healthy (Primary Partition)




23. Start VIVOTEK LiveClient utility by double-clicking its shortbut. Enter admin and admin as
the User Name and default Password. You can change the password later in the utility. Click

Log in to proceed.

Yvivorex

X2

g

Layalhent Plangfusck
F 4 o
&

Shepherd e Manager
——
=
¥ x
- 418 =

Ok Management

]

-

Servoe

K
&%

Import, § Export Uity

T 'U VAST LiveClient |
—' [¥]Log in local station
Kieybo

Address: 127.0.0.1
: Authentication: |Basic Account -_]
E‘__ IUser Mame: admin ad m ! n
RAID © d

Password: LITTT] a m I n

Log in ] [ Cancel ] [ Mare >>= ]
R ®

Servies =peet | Expent LRy

® | =
] "'no'l:z\:.;cl Kyboan LiFapagg
® E E
.-'..- e Lk F_.p-wn-lu.u'. =.#!_-:‘{-.--ru
Top row Control Center: the default desktop.
Disk Status: Displays the current storage volume status (system drive and RAID volumes).
Network Status: Displays the information for the current network connections.
System Status: Displays the current system status, license information, and VAST service.
Desktop Shortcuts
LiveClient Starts the VAST LiveClient utility.
Playback Starts the VAST Playback utility.
Service Enables you to start, stop, or restart the VAST server instance.
Import/Export|Allows you to import or export VAST configurations.
Shepherd Use the Shepherd utility to locate cameras within your network.
File Manager |Provides access to the files in system disk drive volumes.
Keyboard Toggles the virtual keyboard in case you do not have a physical keyboard.
Language Changes the Ul language. .
Control Opens the operating system's control panel.
Disk Starts the Disk Management utility in Windows.
Managment
RAID Config. [Starts the RAID card storage configuration utility.
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24. Click Configuration > Station Settings > Recording Storage Settings.

System | Edit | View | Configuration | Layout | Help

Camera Management 4
Statiocn Management...
Logical Tree View Management...

I/O Box Management 3 3
. Camera User Management... qf 6 11:359
... (M B93814 o lﬁfﬂUGQllﬂﬂﬁ“ﬂ S
o ' Mega P Association Management... , -
2 B Recording Stor Alarm Management... ’ ’ 4
: Virtual Matrix Mai t
= - Defaults irtual rix na?ernen - y
o [N B Search ViveCam Switches... / .

o (G Me | Station Settings General Settings
-------- - Layout Client Settings 3 Metwork Settings
Recerding Sterage Settings
Recording Schedule Settings
Scheduled Backup Settings
Server Settings 4
Relay Settings

Video Enhancement 3

25. Click on the Add Local Path button. Select the new local path displayed as D:/ or E:/ drive
(your new volume). Click OK to proceed.

Since you cannot record video to the root directory, click Add to create a new folder, e.g., D:\
Recording.

=

Bath: B
Tyme: @ Sirage Path () Recovery Path

Tols: SEETET  GBrles Fres: SEREL Eyien
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26. Enter a name for the new folder, e.g., Recording.

r
&4 Select Local Path

- YMS_Station
-- C:\
=-D:\
. [H-VAST_log
G- Wiy

%4 Add New Folder

Folder Name:

|recording|

Path: D:\

Type: (@ Storage Path () Recovery Path

Storage Information
Total: 445,47 GEytes Free: 445.38 GBytes
Reserved: 44 GBytes

27. Select the new folder you just created and click OK button.

[ ad.. J[ peete ] Rename.. |

Path: D:Yrecording

Type: (@ Storage Path (7) Recovery Path
Storage Information
Total: 445,47 GBytes
Reserved: 44 GBytes
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28. The selected Storage path will appear on the list along with its total, reserved, and Free
storage spaces information. Click Apply.

29. Open the Camera Management > Insert Camera or Batch Insert Cameras window.
Use the Search button to locate cameras in your local area network. Select and click Insert.
Select and insert all cameras of your choice in your deployment, and then close the Camera
Management window.

System | Edit | View | Configuration | Layout | Help

Insert Camera...
Update Camera...
Delete Cameras...
Batch Insert Cameras...

Camera Management »

Station Management...

Logical Tree View Management...

/0 Box Management 3
User Management...

Association Management...

Camera Configuration...

H Alarm Ma nt...
— - 1j0 Box m nageme

Virtual Matrix Management 4
Search VivoCam Switches...
Station Settings 2
Client Settings 4

[t B ]
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30. You will return to the Live View window. By default, once cameras have been inserted and
the storage path is ready, the NVR starts recording the video streams. Note the red light icons
on the view cells. If red icons appear on the view cells, recording is taking place.

o LrwCleemt

[ System Edit | View . Gonfguraton | Layoul | Heip.

O]l Gl [ox[B]] « @5 [ Hhea{EBIET| 5]

Virtual Drive

31. You are done with the initial configuration. Refer to the rest of the manual for the configurable
options in the VAST management software.

% NOTE:

1. Cameras and the NVR must reside in the same subnet. Otherwise, the NVR will not be able
to recruit them into a recording configuration.

2. Itis recommended all network cameras use static IPs. If you let a DHCP server assign IPs to
these cameras, IPs may be changed later and the NVR may not recognize them.



RAID Basics

& IMPORTANT:

For a RAID volume configuration, it is recommended you use hard drives of the same model
featuring the same capacity and rotation speed. It is also preferred that these drives are running
the same version of firmware.

A Redundant Array of Independent Disks is an array, or group, of multiple independent physical
drives that provide high performance and fault tolerance. A RAID drive group improves 1/O
performance and reliability. The RAID drive group appears to the host computer as a single
storage volume or as multiple virtual units. An I/O transaction is expedited because several
drives can be accessed simultaneously.

A RAID drive group improves data storage reliability and fault tolerance compared to single drive
storage. Data loss resulting from a drive failure can be prevented by reconstructing missing data
from the remaining drives. The benefits of RAID come from the improvement of I/O performance
and the increased reliability.

What are the Virtual drives?
Virtual drives are drive groups that are available to the operating systems. The storage space in
a virrtual drive comes from all the members in the drive group.

The RAID functions available for virtual drives include:
Hot spare drives.

Drive group and virtual drive configurations.

Initializing one or more virtual drives.

Individual access to controllers, virtual drives, and disk drives.

Failed drive rebuild.

Verification of redundancy data in virtual drives using RAID levels 1, 5, 6, 10, 50, and 60.
Reconstructing virtual drives after the RAID levels or adding a drive to a drive group.
Indepently selecting a host controller to work for.

RAID configuration components
B Drive group: a group of physical drives. These drives will be managed in partitions known as
virtual drives.
W Virtual drive: a partition in a drive group made of continguous data segments from the
individual disk drives. A virtual drive can consist of the following components:
B An entire drive group.
B More than one entire drive group.
B A part of drive group.
B Parts of more than one drive group.
B A combination of any two of the conditions above.



RAID Fault Tolerance

RAID Level Number of Tolerable Drive Failures
0 No fault tolerance
1 1, each drive group
5 1
6 2
10 multiple, as long as each failure is in a separate drive group
50 1 in each drive group
60 2 in each drive group

For example, if disk failure occurs in different drive groups, a RAID10 configuration can
tolerate multiple drive failures. In each RAID1 drive group, data is mirrored to a counterpart
disk drive. Data remains intact if one disk drive should fail in each drive group.

RAID10

RAIDO

N\
RAID1 RAID1 RAID1 RAID1 RAID1 RAID1

Consistency Check

The consistency check operation verifies the correctness of the data in virtual drives that use
RAID levels 1, 5, 6, 10, 50, and 60. RAIDO does not provide data redundancy. In a system with
parity, check consistency means calculating the data on one drive and comparing the results to

the contents of the parity drive.



Background Initialization

Background initialization is a check for media errors on the drives when you create a virtual
drive. It is an automatic operation that starts five minutes after you create a virtual drive. This
check ensures that striped data segments are the same on all of the drives in the drive group.

Background initialization is similar to a consistency check. The difference between the two is
that a background initialization is forced on new virtual drives and a consistency check is not.

New RAID 5 virtual drives and new RAID 6 virtual drives require a minimum number of drives
for a background initialization to start. If fewer drives exist, the background initialization does not
start. The background initialization needs to be started manually. The following number of drives
are required:

B New RAID 5 virtual drives must have at least five drives for background initialization to start.
B New RAID 6 virtual drives must have at least seven drives for background initialization to
start.

The default and recommended background initialization rate is 30 percent. Before you change
the rebuild rate, you must stop the background initialization or the rate change will not affect the
background initialization rate. After you stop background initialization and change the rebuild
rate, the rate change takes effect when you restart background initialization.2.1.7Patrol Read

Disk Striping

Disk striping lets you write data across multiple drives instead of just one drive. Disk striping
involves partitioning each drive storage space into stripes that can vary in size from a minimum
of 64 KB to 1 MB for MegaRAID controllers and 64 KB for Integrated MegaRAID controllers. The
LSISAS2108 controller allows stripe size from 8 KB to 1 MB. These stripes are interleaved in

a repeated sequential manner. The combined storage space is composed of stripes from each
drive. It is recommended that you keep stripe sizes the same across RAID drive groups.

For example, in a four-disk system using only disk striping (used in RAID level 0), segment 1 is
written to disk 1, segment 2 is written to disk 2, and so on. Disk striping enhances performance
because multiple drives are accessed simultaneously, but disk striping does not provide data
redundancy.

Segment 1 Segment 2 Segment 3 Segment 4
Segment 5 Segment 6 Segment 7 Segment 8
Segment 9 Segment 10 Segment 11 Segment 12



Stripe Width
Stripe width is the number of drives involved in a drive group where striping is implemented. For
example, a four-disk drive group with disk striping has a stripe width of four.

Stripe Size

The stripe size is the length of the interleaved data segments that the RAID controller writes
across multiple drives, not including parity drives. For example, consider a stripe that contains

1 MB of drive space and has 64 KB of data residing on each drive in the stripe. In this case, the
stripe size is 1 MB and the strip size is 64 KB.

Strip Size
The strip size is the portion of a stripe that resides on a single drive.

Disk Mirroring

With disk mirroring (used in RAID 1 and RAID 10), data written to one drive is simultaneously
written to another drive. The primary advantage of disk mirroring is that it provides 100 percent
data redundancy. Because the contents of the disk are completely written to a second disk, data
is not lost if one disk fails. In addition, both drives contain the same data at all times, so either
disk can act as the operational disk. If one disk fails, the contents of the other disk can run the
system and reconstruct the failed disk.

Disk mirroring provides 100 percent redundancy, but it is expensive because each drive in the
system must be duplicated. The following figure shows an example of disk mirroring.

Segment 1 Segment 1 Duplicated
Segment 2 Segment 2 Duplicated
Segment 3 Segment 3 Duplicated
Segment 4 Segment 4 Duplicated

3_01080-00

Parity

Parity generates a set of redundancy data from two or more parent data sets. The redundancy
data can be used to reconstruct one of the parent data sets in the event of a drive failure. Parity
data does not fully duplicate the parent data sets, but parity generation can slow the write
process. In a RAID drive group, this method is applied to entire drives or stripes across all of the
drives in a drive group. The types of parity are described in the following table.



Parity Type Description

Dedicated The parity data on two or more drives is stored on an additional disk.

Distributed The parity data is distributed across more than one drive in the system.

A RAID 5 drive group combines distributed parity with disk striping. If a single drive fails, it can
be rebuilt from the parity and the data on the remaining drives. An example of a RAID 5 drive
group is shown in the following figure. A RAID 5 drive group uses parity to provide redundancy
for one drive failure without duplicating the contents of entire drives. A RAID 6 drive group also
uses distributed parity and disk striping, but adds a second set of parity data so that it can
survive up to two drive failures.

Segment 1 Segment 2 Segment 3 Segment 4 Segment 5 Parity (1 to 5)
Segment 7 Segment 8 Segment 9 Segment 10 Parity (6 to 10) Segment 6
Segment 13 Segment 14 Segment 15 Parity (11 to 15) Segment 11 Segment 12
Segment 19 Segment 20 Parity (16 to 20) Segment 16 Segment 17 Segment 18
Segment 25 Parity (21 to 25) Segment 21 Segment 22 Segment 23 Segment 24
Parity (26 to 30) Segment 26 Segment 27 Segment 28 Segment 29 Segment 30

Disk Spanning

Disk spanning allows multiple drives to function like one big drive. Spanning overcomes lack
of disk space and simplifies storage management by combining existing resources or adding
relatively inexpensive resources. For example, four 20-GB drives can be combined to appear
to the operating system as a single 80-GB drive.Spanning alone does not provide reliability or
performance enhancements. Spanned virtual drives must have the same stripe size and must
be contiguous. In the following figure, RAID 1 drive groups are turned into a RAID 10 drive

group.

Can Be Accessed As
One 120-GB Drive

Can Be Accessed As
One 120-GB Drive

o ———— = ——
o ———— = ——

N N

Spanning two contiguous RAID 0 virtual drives does not produce a new RAID level or add
fault tolerance. It does increase the capacity of the virtual drive and improves performance by
doubling the number of spindles.

Spanning for RAID 00, RAID 10, RAID 50, and RAID 60 Drive Groups

The following table describes how to configure RAID 00, RAID 10, RAID 50, and RAID 60
drive groups by spanning. The virtual drives must have the same stripe size and the maximum
number of spans is 8. The full drive capacity is used when you span virtual drives; you cannot
specify a smaller drive capacity.



Level Description

00 Configure a RAID 00 by spanning two or more contiguous RAID 0 virtual drives, up to the
maximum number of supported devices for the controller.
10 Configure RAID 10 by spanning two or more contiguous RAID 1 virtual drives, up to

the maximum number of supported devices for the controller. A RAID 10 drive group
supports a maximum of 8 spans. You must use an even number of drives in each RAID
virtual drive in the span. The RAID 1 virtual drives must have the same stripe size.

50 Configure a RAID 50 drive group by spanning two or more contiguous RAID 5 virtual
drives. The RAID 5 virtual drives must have the same stripe size.
60 Configure a RAID 60 drive group by spanning two or more contiguous RAID 6 virtual

drives. The RAID 6 virtual drives must have the same stripe size.

Hot Spares

A hot spare is an extra, unused drive that is part of the disk subsystem. It is usually in Standby
mode, ready for service if a drive fails. Hot spares let you replace failed drives without system
shutdown or user intervention. The MegaRAID SAS RAID controllers can implement automatic
and transparent rebuilds of failed drives using hot spare drives, which provide a high degree of
fault tolerance and zero downtime.

The RAID management software lets you specify drives as hot spares. When a hot spare is
needed, the RAID controller assigns the hot spare that has a capacity closest to and at least as
great as that of the failed drive to take the place of the failed drive. The failed drive is removed
from the virtual drive and marked ready awaiting removal after the rebuild to a hot spare begins.
You can make hot spares of the drives that are not in a RAID virtual drive.

You can use the RAID management software to designate the hot spare to have enclosure
affinity, which means that if drive failures are present on a split backplane configuration, the hot
spare will be used first on the backplane side in which it resides.If the hot spare is designated as
having enclosure affinity, it tries to rebuild any failed drives on the backplane in which it resides
before rebuilding any other drives on other backplanes.

The hot spare can be of two types:
* Global hot spare
* Dedicated hot spare

Global Hot Spare

Use a global hot spare drive to replace any failed drive in a redundant drive group as long as
its capacity is equal to or larger than the coerced capacity of the failed drive. A global hot spare
defined on any channel should be available to replace a failed drive on both channels.

Dedicated Hot Spare

Use a dedicated hot spare to replace a failed drive only in a selected drive group. One or more
drives can be designated as a member of a spare drive pool. The most suitable drive from the
pool is selected for failover. A dedicated hot spare is used before one from the global hot spare
pool.



Hot spare drives can be located on any RAID channel. Standby hot spares (not being used in
RAID drive group) are polled every 60 seconds at a minimum, and their status made available
in the drive group management software. RAID controllers offer the ability to rebuild with a disk
that is in a system but not initially set to be a hot spare.

Observe the following parameters when using hot spares:

* Hot spares are used only in drive groups with redundancy: RAID levels 1, 5, 6, 10, 50, and
60.

* Ahot spare connected to a specific RAID controller can be used to rebuild a drive that is
connected only to the same controller.

* You must assign the hot spare to one or more drives through the controller BIOS or use drive
group management software to place it in the hot spare pool.

* Ahot spare must have free space equal to or greater than the drive it replaces. For example,
to replace a 500-GB drive, the hot spare must be 500-GB or larger.

Disk Rebuilds

When a drive in a RAID drive group fails, you can rebuild the drive by re-creating the data that
was stored on the drive before it failed. The RAID controller re-creates the data using the data
stored on the other drives in the drive group. Rebuilding can be performed only in drive groups
with data redundancy, which includes RAID 1, 5, 6, 10, 50, and 60 drive groups.

The RAID controller uses hot spares to rebuild failed drives automatically and transparently,

at user-defined rebuild rates. If a hot spare is available, the Rebuild operation can start
automatically when a drive fails. If a hot spare is not available, the failed drive must be replaced
with a new drive so that the data on the failed drive can be rebuilt.

The failed drive is removed from the virtual drive and marked ready awaiting removal when the
Rebuild operation to a hot spare begins. If the system goes down during a Rebuild operation,
the RAID controller automatically resumes the rebuild after the system reboots.

ﬁ NOTE:
When the Rebuild operation to a hot spare begins, the failed drive is often removed from

the virtual drive before management applications detect the failed drive. When this removal
occurs, the event logs show the drive rebuilding to the hot spare without showing the failed
drive. The formerly failed drive will be marked as ready after a Rebuild operation begins to a
hot spare. If a source drive fails during a rebuild to a hot spare, the Rebuild operation fails,
and the failed source drive is marked as offline. In addition, the rebuilding hot spare drive

is changed back to a hot spare. After a Rebuild operation fails because of a source drive
failure, the dedicated hot spare is still dedicated and assigned to the correct drive group, and
the global hot spare is still global.

An automatic drive Rebuild operation will not start if you replace a drive during a RAID-level
migration. The Rebuild operation must be started manually after the expansion or migration
procedure is complete. (RAID-level migration changes a virtual drive from one RAID level to
another.)



Hot Swap

A hot swap is the manual replacement of a defective drive unit while the computer is still
running. When a new drive has been installed, a Rebuild operation occurs automatically if these
situation occurs:

+ The newly inserted drive is the same capacity as or larger than the failed drive.

» The newly inserted drive is placed in the same drive bay as the failed drive it is replacing.

The RAID controller can be configured to detect the new drives and rebuild the contents of the
drive automatically.

Drive States

A drive state is a property indicating the status of the drive. The drive states are described in the
following table.

Parity Type Description

Online A drive that can be accessed by the RAID controller and is part of the virtual drive.

Unconfigured Good A drive that is functioning normally but is not configured as a part of a virtual drive or as a
hot spare.

Hot Spare A drive that is powered up and ready for use as a spare in case an online drive fails.

Failed A drive that was originally configured as Online or Hot Spare, but on which the firmware
detects an unrecoverable error.

Rebuild A drive to which data is being written to restore full redundancy for a virtual drive.

Unconfigured Bad A drive on which the firmware detects an unrecoverable error; the drive was Unconfigured
Good or the drive could not be initialized.

Missing A drive that was Online but which has been removed from its location.

Offline A drive that is part of a virtual drive but which has invalid data as far as the RAID
configuration is concerned.

Shield State An interim state of physical drive for diagnostic operations.

Copyback A drive that has replaced the failed drive in the RAID configuration.




Virtual Drive States
The virtual drive states are described in the following table.

Parity Type Description
Online The virtual drive operating condition is good. All configured drives are online.
Degraded The virtual drive operating condition is not optimal. One of the configured drives has

failed or is offline.
The operating condition in a RAID 6 virtual drive is not optimal. One of the configured

drives has failed or is offline. A RAID 6 drive group can tolerate up to two drive failures.

Partial Degraded

Failed The virtual drive has failed.
Offline The virtual drive is not available to the RAID controller.
Beep Codes

An alarm sounds on the MegaRAID controller when a virtual drive changes from an optimal
state to another state, when a hot spare rebuilds, and for test purposes.

drives

Parity Type Virtual Drive State Beep Code

RAID 0 virtual drive loses a virtual drive |Offline 3 seconds on and 1 second off
RAID 1 virtual drive loses a mirror drive |Degraded 1 second on and 1 second off
RAID 1 virtual drive loses both drives Offline 3 seconds on and 1 second off
RAID 5 virtual drive loses one drive Degraded 1 second on and 1 second off
RAID 5 virtual drive loses two or more  |Offline 3 seconds on and 1 second off

RAID 6 virtual drive loses one drive

Partially degraded

1 second on and 1 second off

RAID 6 virtual drive loses two drives Degraded 1 second on and 1 second off
RAID 6 virtual drive loses more than two |Offline 3 seconds on and 1 second off
drives

A hot spare completes the Rebuild B/A 1 second on and 3 seconds off
process and is brought into a drive group

A copy back occurs after a Rebuild Optimal 1 second on and 3 seconds off

operation completes

RAID Levels

The RAID controller supports RAID levels 0, 00, 1, 5, 6, 10, 50, and 60. The supported RAID
levels are summarized in the following section.

In addition, the RAID controller supports independent drives (configured as RAID 0 and RAID 00
drive groups) The following sections describe the RAID levels in detail.

Summary of RAID Levels

A RAID 0 drive group uses striping to provide high data throughput, especially for large files in
an environment that does not require fault tolerance.

A RAID 1 drive group uses mirroring so that data written to one drive is simultaneously written
to another drive. The RAID 1 drive group is good for small databases or other applications that
require small capacity but complete data redundancy.



A RAID 5 drive group uses disk striping and parity data across all drives (distributed parity) to
provide high data throughput, especially for small random access.A RAID 6 drive group uses
distributed parity, with two independent parity blocks per stripe, and disk striping.

A RAID 6 virtual drive can survive the loss of any two drives without losing data. A RAID 6 drive
group, which requires a minimum of three drives, is similar to a RAID 5 drive group. Blocks of
data and parity information are written across all drives. The parity information is used to recover
the data if one or two drives fail in the drive group.

A RAID 00 drive group is a spanned drive group that creates a striped set from a series of
RAID 0 drive groups.A RAID 10 drive group, a combination of RAID 0 and RAID 1 drive groups,
consists of striped data across mirrored spans.

A RAID 10 drive group is a spanned drive group that creates a striped set from a series of
mirrored drives. A RAID 10 drive group allows a maximum of 8 spans. You must use an even
number of drives in each RAID virtual drive in the span. The RAID 1 virtual drives must have
the same stripe size. A RAID 10 drive group provides high data throughput and complete data
redundancy but uses a larger number of spans.

A RAID 50 drive group, a combination of RAID 0 and RAID 5 drive groups, uses distributed
parity and disk striping. A RAID 50 drive group is a spanned drive group in which data is striped
across multiple RAID 5 drive groups. A RAID 50 drive group works best with data that requires
high reliability, high request rates, high data transfers, and medium-to-large capacity.

% NOTE

Having virtual drives of different RAID levels, such as RAID Level0 and RAID Level5, in the
same drive group is not allowed. For example, if an existing RAIDS5 virtual drive is created out
of partial space in an array, the next virtual drive in the array has to be RAID Level 5 only.

A RAID 60 drive group, a combination of RAID level 0 and RAID Level 6, uses distributed parity,
with two independent parity blocks per stripe in each RAID set, and disk striping. A RAID 60
virtual drive can survive the loss of two drives in each of the RAID 6 sets without losing data. A
RAID 60 drive group works best with data that requires high reliability, high request rates, high
data transfers, and medium-to-large capacity.

% NOTE

The MegaSR controller supports the standard RAID levels — RAIDO, RAID1, RAID5, and
RAID10. The MegaSR controller comes in two variants, SCU and AHCI, both supporting a
maximum of eight physical drives. A maximum of eight virtual drives can be created (using
RAIDO, RAID 1, RAID5, and RAID10 only) and controlled by the MegaSR controller. One
virtual drive can be created on an array (a maximum of eight if no other virtual drives are
already created on the MegaSR controller), or you can create eight arrays with one virtual
drive each. However, on a RAID10 drive group, you can create only one virtual drive on a
particular array.



RAID 0 Drive Groups

A RAID 0 drive group provides disk striping across all drives in the RAID drive group. A RAIDO
drive group does not provide any data redundancy, but the RAID 0 drive group offers the best
performance of any RAID level. The RAID 0 drive group breaks up data into smaller segments,
and then stripes the data segments across each drive in the drive group. The size of each data
segment is determined by the stripe size. A RAID 0 drive group offers high bandwidth.

By breaking up a large file into smaller segments, the RAID controller can use both SAS

drives and SATA drives to read or write the file faster. A RAID 0 drive group involves no parity
calculations to complicate the write operation. This situation makes the RAID 0 drive group ideal
for applications that require high bandwidth but do not require fault tolerance. The following
table provides an overview of the RAID 0 drive group. The following figure provides a graphic
example of a RAID 0 drive group.

% NOTE

RAID level 0 is not fault tolerant. If a drive in a RAID 0 drive group fails, the entire virtual drive (all drives
associated with the virtual drive) fails.

Uses Provides high data throughput, especially for large files.Any environment that does not
require fault tolerance.
Strong points Provides increased data throughput for large files.
No capacity loss penalty for parity.
Weak points Does not provide fault tolerance or high bandwidth.All data is lost if any drive fails.
Drives 1to 32

Segment 1 Segment 2
Segment 3 Segment 4
Segment 5 Segment 6

Segment 7 Segment 8




RAID 1 Drive Groups

In RAID 1 drive groups, the RAID controller duplicates all data from one drive to a second drive
in the drive group. A RAID 1 drive group supports an even number of drives from 2 through 32

in a single span. The

RAID1 drive group provides complete data redundancy, but at the cost

of doubling the required data storage capacity. The following table provides an overview of a
RAID1 drive group. The following figure provides a graphic example of a RAID1 drive group.

Uses

Use RAID 1 drive groups for small databases or any other environment that requires fault
tolerance but small capacity.

Strong points

Provides complete data redundancy.A RAID 1 drive group is ideal for any application that
requires fault tolerance and minimal capacity.

Weak points Requires twice as many drives.
Performance is impaired during drive rebuilds.
Drives 2 through 32 (must be an even number of drives)
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RAID 5 Drive Groups

A RAID 5 drive group
property of being odd

includes disk striping at the block level and parity. Parity is the data’s
or even, and parity checking is used to detect errors in the data. In RAID5S

drive groups, the parity information is written to all drives. A RAIDS drive group is best suited for
networks that perform a lot of small input/output (I/0O) transactions simultaneously.The following
table provides an overview of a RAIDS drive group. The following figure provides a graphic
example of a RAIDS drive group.

Uses

Provides high data throughput, especially for large files.

Use RAID 5 drive groups for transaction processing applications because each drive can
read and write independently.

If a drive fails, the RAID controller uses the parity drive to re-create all missing
information.Use also for online customer service that requires fault tolerance.Use for any
application that has high read request rates but random write request rates.

Strong points

Provides data redundancy, high read rates, and good performance in most environments.
Provides redundancy with lowest loss of capacity.

Weak points

Not well suited to tasks requiring lots of small writes or small block write operations.
Suffers more impact if no cache is used.

Drive performance is reduced if a drive is being rebuilt.

Environments with few processes do not perform as well because the RAID drive group
overhead is not offset by the performance gains in handling simultaneous processes.

Drives

3 through 32




Segment 1 Segment 2 Segment 3 Segment 4 Segment 5 Parity (1 to 5)

Segment 7 Segment 8 Segment 9 Segment 10 Parity (6 to 10) Segment 6

Segment 13 Segment 14 Segment 15 Parity (11 to 15) Segment 11 Segment 12
Segment 19 Segment 20 Parity (16 to 20) Segment 16 Segment 17 Segment 18
Segment 25 Parity (21 to 25) Segment 21 Segment 22 Segment 23 Segment 24
Parity (26 to 30) Segment 26 Segment 27 Segment 28 Segment 29 Segment 30

RAID 6 Drive Groups

A RAIDG drive group is similar to a RAID5 drive group (disk striping and parity), except that
instead of one parity block per stripe, there are two. With two independent parity blocks, A
RAIDG drive group can survive the loss of any two drives in a virtual drive without losing data.
A RAIDG drive group provides a high level of data protection through the use of a second
parity block in each stripe. Use a RAID6 drive group for data that requires a very high level of
protection from loss.

In the case of a failure of one drive or two drives in a virtual drive, the RAID controller uses the
parity blocks to re-create all of the missing information. If two drives in a RAIDG6 virtual drive fail,
two drive rebuilds are required, one for each drive. These rebuilds do not occur at the same
time. The controller rebuilds one failed drive, and then the other failed drive.The following table
provides an overview of a RAID6 drive group.

Uses Use for any application that has high read request rates but low random or small block
write rates.
Strong points Provides data redundancy, high read rates, and good performance in most environments.

Can survive the loss of two drives or the loss of a drive while another drive is being
rebuilt.Provides the highest level of protection against drive failures of all of the RAID
levels.Performance is similar to that of a RAID5 drive group.

Weak points Not well-suited to tasks requiring a lot of small and/or random write operations.A RAID 6
virtual drive must generate two sets of parity data for each write operation, which results
in a significant decrease in performance during write operations.

Drive performance is reduced during a drive Rebuild operation.Environments with
few processes do not perform as well because the RAID overhead is not offset by the
performance gains in handling simultaneous processes.

A RAIDG6 drive group costs more because of the extra capacity required by using two
parity blocks per stripe.

Drives 3 through 32

The following figure shows a RAIDG6 drive group data layout. The second set of parity drives is
denoted by Q. The P drives follow the RAIDS drive group parity scheme.

Segment 1 Segment 2 Segment 3 Segment 4 Parity (P1-P4) Parity (Q1-Q4)
Segment 6 Segment 7 Segment 8 Parity (P5-P8) Parity (Q5-Q8) Segment 5
Segment 11 Segment 12 Parity (P9-P12) Parity (Q9-Q12) Segment 9 Segment 10
Segment 16 Parity (P13-P16)  Parity (Q13—-Q16) Segment 13 Segment 14 Segment 15
Parity (P17-P20)  Parity (Q17-Q20) Segment 17 Segment 18 Segment 19 Segment 20

Note: Parity is distributed across all drives in the drive group.



RAID 00 Drive Groups

A RAID 00 drive group is a spanned drive group that creates a striped set from a series of
RAIDO drive groups. A RAIDOO drive group does not provide any data redundancy, but, along
with the RAIDO drive group, does offer the best performance of any RAID level. A RAIDOO drive
group breaks up data into smaller segments and then stripes the data segments across each
drive in the drive groups. The size of each data segment is determined by the stripe size. A
RAIDOQO drive group offers high bandwidth.

% NOTE

RAID level 00 is not fault tolerant. If a drive in a RAID 0 drive group fails, the entire virtual drive (all drives
associated with the virtual drive) fails.

By breaking up a large file into smaller segments, the controller can use both SAS drives and
SATA drives to read or write the file faster. A RAIDOO drive group involves no parity calculations
to complicate the write operation. This situation makes the RAIDOO drive group ideal for
applications that require high bandwidth but do not require fault tolerance. The following table
provides an overview of the RAIDOO drive group. The following figure provides a graphic
example of a RAID 00 drive group.

Uses Provides high data throughput, especially for large files.Any environment that does not
require fault tolerance.
Strong points Provides increased data throughput for large files.

No capacity loss penalty for parity.

Weak points Does not provide fault tolerance or high bandwidth.

All data lost if any drive fails.

Drives 2 through 256
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RAID 10

A RAID10 drive group is a combination of RAID level 0 and RAID level 1, and it consists of
stripes across mirrored drives. A RAID10 drive group breaks up data into smaller blocks and
then mirrors the blocks of data to each RAID1 drive group. The first RAID1 drive in each drive
group then duplicates its data to the second drive. The size of each block is determined by the
stripe size parameter, which is set during the creation of the RAID set. The RAID 1 virtual drives
must have the same stripe size.

Spanning is used because one virtual drive is defined across more than one drive group. Virtual
drives defined across multiple RAIDIevel 1 drive groups are referred to as RAID level 10, (1+0).

Data is striped across drive groups to increase performance by enabling access to multiple drive
groups simultaneously.

Each spanned RAID 10 virtual drive can tolerate multiple drive failures, as long as each failure
is in a separate drive group. If drive failures occur, less than total drive capacity is available.
Configure RAID 10 drive groups by spanning two contiguous RAID1 virtual drives, up to the
maximum number of supported devices for the controller. A RAID10 drive group supports a
maximum of 8spans, with a maximum of 32drives per span. You must use an even number of
drives in each RAID10 virtual drive in the span.

% NOTE

Other factors, such as the type of controller, can restrict the number of drives supported by RAID 10 virtual drives.

The following table provides an overview of a RAID10 drive group.

Uses Appropriate when used with data storage that needs 100 percent redundancy of mirrored
drive groups and that also needs the enhanced I/0O performance of RAID 0 (striped drive

groups.)

A RAID10 drive group works well for medium-sized databases or any environment that
requires a higher degree of fault tolerance and moderate-to-medium capacity.

Strong points Provides both high data transfer rates and complete data redundancy.
Weak points Requires twice as many drives as all other RAID levels except in RAID 1 drive groups.
Drives 4 to 32 in multiples of 4 — The maximum number of drives supported by the controller

(using an even number of drives in each RAID 10 virtual drive in the span).

In the following figure, virtual drive 0 is created by distributing data across four drive groups (drive groups 0
through3).
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RAID 50

A RAID50 drive group provides the features of both RAIDO and RAIDS drive groups. A RAID50
drive group includes both distributed parity and drive striping across multiple drive groups. A
RAIDS0 drive group is best implemented on two RAIDS drive groups with data striped across
both drive groups.

A RAID50 drive group breaks up data into smaller blocks and then stripes the blocks of data to
each RAIDS disk set. A RAIDS drive group breaks up data into smaller blocks, calculates parity
by performing an exclusive OR operation on the blocks, and then performs write operations

to the blocks of data and parity to each drive in the drive group. The size of each block is
determined by the stripe size parameter, which is set during the creation of the RAID set.

A RAID level 50 drive group can support up to eight spans and tolerate up to eight drive failures,
though less than total drive capacity is available. Though multiple drive failures can be tolerated,
only one drive failure can be tolerated in each RAID 5 level drive group.

The following table provides an overview of a RAID50 drive group.

Uses Appropriate when used with data that requires high reliability, high request rates, high
data transfer, and medium-to-large capacity.

Also used when a virtual drive of greater than 32 drives is needed.

Strong points Provides high data throughput, data redundancy, and very good performance.
Weak points Requires two times to eight times as many parity drives as a RAID 5 drive group.
Drives Eight spans of RAID 5 drive groups that contain 3 to 32 drives each (limited by the

maximum number of devices supported by the controller)
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RAID 60

A RAID 60 drive group provides the features of both RAID 0 and RAID 6 drive groups, and
includes both parity and disk striping across multiple drive groups. A RAIDG6 drive group supports
two independent parity blocks per stripe. A RAID 60 virtual drive can survive the loss of two
drives in each of the RAIDG6 drive group sets without losing data. A RAIDG0 drive group is best
implemented on two RAIDG6 drive groups with data striped across both drive groups.

A RAIDG60 drive group breaks up data into smaller blocks and then stripes the blocks of data to
each RAIDG6 disk set. A RAID6 drive group breaks up data into smaller blocks, calculates parity
by performing an exclusive-OR operation on the blocks, and then performs write operations to
the blocks of data and writes the parity to each drive in the drive group. The size of each block is
determined by the stripe size parameter, which is set during the creation of the RAID set.

A RAIDG0 drive group can support up to 8spans and tolerate up to 16 drive failures, though less
than total drive capacity is available. Two drive failures can be tolerated in each RAID 6 level
drive group.

Uses Provides a high level of data protection through the use of a second parity block in each
stripe. Use a RAID60 drive group for data that requires a very high level of protection
from loss.

In the case of a failure of one drive or two drives in a RAID set in a virtual drive, the RAID
controller uses the parity blocks to re-create all of the missing information. If two drives in
a RAID 6 set in a RAID60 virtual drive fail, two drive Rebuild operations are required, one
for each drive. These Rebuild operations can occur at the same time.

Use for online customer service that requires fault tolerance. Use for any application that
has high read request rates but low write request rates. Also used when a virtual drive of
greater than 32 drives is needed.

Strong points Provides data redundancy, high read rates, and good performance in most environments.
Each RAID6 set can survive the loss of two drives or the loss of a drive while another
drive is being rebuilt.Provides the highest level of protection against drive failures of all of
the RAID levels.

Weak points Not well-suited for small block write or random write operations. A RAID 60 virtual

drive must generate two sets of parity data for each write operation, which results in

a significant decrease in performance during write operations.Drive performance is
reduced during a drive Rebuild operation. Environments with few processes do not
perform as well because the RAID overhead is not offset by the performance gains in
handling simultaneous processes.

A RAIDG6 drive group costs more because of the extra capacity required by using two
parity blocks per stripe.

Drives A minimum of 6.
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VIVOTEK - A Leading Provider of Multimedia Communication Solutions

Technical Specifications

Hardware Informat

Model

0os

CPU

Flash

RAM

Watchdog

Power Restoration

HDD Devices
HDD Max. Capacity
Disk Management

Video Output
Resolution

Graphics Decoder

Decoding Capacity

Camera Position

USB Interface

Audio

NR9681

Embedded Windows

Intel Core i5

64G SATA DOM

8GB

Hardware + Software

System Restart Automatically after Power Recovery

Hot-Swappable Tray x8

6TB x8

Create, Format and Remove Disk
RAIDO, 1,5, 6,10

HDMI x1, Display Port x1, VGA x1, DVI x1
HDMI: 4096x2304

DP: 3200x2000

VGA/DVI: 1920x1200

Hardware decoding

H.265/H.264:

2560x1920 @ 30 fps (2-CH)

1920x1080 @ 120 fps (8-CH)

1280x720 @ 240 fps (16-CH)

1280x720 @ 480 fps (32-CH)

1280x720 @ 480 fps (64-CH)

Change the viewcell position on the Live View screens

USB 2.0 x4

USB 3.0 x2

Microphone audio jack Input x1
3.5 Line input audio jack x1

3.5 Line output audio jack x1

Software Informatio

Maximum Channel
Record Throughput (MB)
Network Throughput (MB)
Audio Format

Video Format

Video Resolution

Recording Time (sec.)
Recording Stream
Recording Mode

Recording Setting
Recording Path
Record Video Format

64

512 Mbps

400 Mbps

G.711, G.726, AMR, AAC

MJPEG, MPEG4, H.264 AVC, H.264 SVC, H.265
VGA, TMP, 2MP, 3MP, 5MP & 9MP Camera
Pre-Record: 3 ~ 15

Post-Record: 10 ~ 60

Single

Continuous, Schedule, Manual, Event, Activity Adaptive
Streaming

Recycle (unit: Size or Day)

Local Path or Network Path

3GP

Stream Application

LiveView Display

Monitor Enhancement

PTZ Control

PTZ Operation

Stream Selection & Auto Stream Size

64-Channel (with Dual Monitors)

Multi Layout Display: 1x1, 2x2, 145, 3x3, 1412, 4x4, 5x5, 1431,
1P+2, 1P+6, 1P+8, 2V, 3V, 4V, 2V+3

Single Layout Display, Full Screen Display, Sequential Display
Drag & Drop, Remote I/0 Control, PiP (Digital Zoom), Instant
Replay, De-interlace, Video Display Mode (Aspect Ratio, Hide
Borders, Keep Top/Down Borders), Fisheye Dewarp (Regular: 10,
1P, 1R, 103R, 4R; Wall Mount: 1P2R, 1P3R; Ceiling/Floor Mount:
2P, 4R Pro, 108R), Video (Basic Mode:

Contrast, Saturation, Hue; Intelligent Mode: Defog, Rain, Snow,
Fire / Smoke)

Panel Control & Mouse Click Control

Direction Control, Home, Zoom, Focus, Iris, Preset, Patrol
(Group), Pan, Stop, Speed

Playback Display

Playback Control

Video Search

Monitor Enhancement

Snapshot
Video Clip Export

16 Channels

Multi Layout Display: Multi Layout Display: 1x1, 2x2, 145, 3x3,
1412, 4x4, 2V, 3V, 4V, 2V4+3

Single Layout Display, Full Screen Display, Sequential Display
Play, Rewind, Pause, Stop, Next/Previous Video Start, Next/
Previous Frame, 1/8X ~ 64X Speed Control, Bookmark
Browsing, Date & Time (Fast), Event, Bookmark, Alarm, Log,
Timeline, Timeline Scale

Drag & Drop, PiP (Digital Zoom), De-interlace, Video Display
Mode (Aspect Ratio, Hide Borders, Keep Top/Down Borders),
Fisheye Dewarp (Regular: 10, 1P, 1R, 103R, 4R; Wall Mount:
1P2R, 1P3R; Ceiling/Floor Mount: 2P, 4R Pro, 108R), Video
Enhancement (Basic Mode: Brightness, Contrast, Saturation,
Hue; Intelligent Mode: Defog, Rain, Snow, Fire/Smoke)

JPEG & BMP

AVI, 3GP & EXE

LiveView Display

Monitor Enhancement
PTZ Control

PTZ Operation
Snapshot

32 Channels

Multi Layout display: 11, 2x2, 3x3, 4x4, 5x5, 145, 1412, 1431
Drag & Drop, Image Freeze, Audio Control, Remote /0 Control,
Event Notification, Bookmark, Fisheye Dewarp (10, 1P, 1R)

Panel Control
Direction Control, Home, Zoom, Preset
JPEG

Playback Display
Playback Control

Monitor Enhancement

Snapshot

1 Channel
Multi Layout display: 1x1
Regular (Play, Pause, Stop), Speed Control, Timeline, Timeline

Drag & Drop, Audio Control, PiP Control, Fisheye Dewarp (10,
1P, TR)
JPEG

Schedule Type

VIVOTEK INC.

Continuous, Schedule, Manual

Network Interface

Protocols

Power Input
Power Consumption

LED Indicator

Form Factor

Operation Buttons
Dimensions

Weight

Operating Temperature
Humidity

Safety Certifications
Warranty

Operating System

CPU

Memory

Ethenet

Display Resolution
Web Browser
Software AP
Mobile/Tablet App

Others

Camera Event
Camera Status
Substation
Storage Status
Station Status
Action

Recording Time (sec.)

Manual

User Management

Log

Date&Time

Firmware

Restore Default
Backup/Restore (Configuration)

Language

Insert Camera

Video (Media) Setting
Audio Setting

PTZ Control

PTZ Operation

Motion Detection
ONVIF Core Spec
ONVIF Stream
ONVIF Recording
ONVIF Control

ONVIF Discover

UpPs
Joystick

1/0 Box
Switch

10/100/1000Mbps Ethernet (RI-45) x2
IPv4,TCP/IP, HTTP, HTTPS, UPnP, RTSP/RTP/RTCP, SMTP, FTP,
DHCP, NTP, DNS, DDNS, IP Filter

Redundant Power 100~220V AC
Max. 740 W

Power, HDD, Net1, Net2, Overheat, Power fail

2U Rackmount

Power, Reset

89 (H) x 437 (W) x 648 (D) mm
27 kg (without HDD)
5°C~35C@A1'F~95F)

0 ~95%

CE, LVD, FCC, VCCl, C-Tick, UL
36 months

Microsoft Windows 8, 7, Vista, XP

Microsoft Windows Server 2012, 2008, 2003, 2000
Intel Celeron or above

2 GB or above

10/100Mbps

1024x768 pixels or above

Internet Explorer 11/10/9 (32 bit)

Installation Wizard 2, Shepherd, VAST

iViewer (i0S/Android)

Power Cord, Quick Installation Guide, 8x H.D.D. Tray, 1x USB
Mouse

Motion, DI/O, Video Lost/Restore, PIR, Tampering, Temperature,
IR, Line Crossing Detection, Loitering Detection, Field Detection
Connection Status, Recording Status, Recording Error
Substation Connection Status

Storage Connection Status, Storage Capacity Status

License Status, Network Status, Virtual Memory Status

Email, Start Recording, Set DO, GSM Short Message, HTTP &
Client Notification

Max. 30

USB Dongle (FAT Format)
NAS (SMB & CIFS)

Authentication: Basic Account / Windows AD Account

User Account: 1024

User Account Time Limit: No limitation

User Level: Administrator / Power User / User / Operation /
Guest

Operation, System and Event Log
Sync Server

Manual update

Supported

Supported

Czech, English, French, German, Italian, Japanese, Persian,
Portuguese, Russian, Spanish, Simplified Chinese, Traditional
Chinese

Manual, Search

Compression, Resolution, FPS, Video Quality

Codec, Bitrate

Panel Control & Mouse Click Control

Direction Control, Home, Zoom, Focus, Iris, Preset, Patrol
(Group), Pan, Stop, Speed

Supported

Version 2.2 or above (By Project)

Video (H.264, MPEG4 & MJPEG) & Audio (G.711, One Way)
Continuous, Schedule, Manual

PTZ Control (Up, Down, Left, Right & Zoom In/Out)

Discover the other brand camera through
“Insert Camera & Batch Insert"

Windows UPS Compatible

VIVOTEK USB Joystick
All Windows® Compatible USB Joystick

Advantech ADAM-6000
VIVOTEK VivoCam PoE Switch (AW-GEV Series)

648 mm

ww /gy
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VAST Server and Client Components

There are four components in VAST: one server component--VAST Server, three client
components--VAST LiveClient, VAST Playback, and VAST Matrix.

VAST Server provides a centralized management site for video recording. VAST LiveClient
is a client program for the user to login and modify the server's configuration, edit the server's
recording storage, schedules and many other functions on the server; VAST Playback is
another client program for the user to log in and browse the recorded video database and video
clips related to specific events on the server.

Usage Scenario

The powerful management scalability of VAST makes it suitable for managing small- to large-
scale structures.

For users that manage only a few cameras, we recommend installing the client and server
components on the same computer. A host with all of the three components installed is recognized
as a stand-alone site. All the functions can be simultaneously performed on one single site.

Local Server Structure

Stand-alone site
VAST Server
VAST LiveClient
VAST Playback

]

I [
Network Cameras
P P O B @’

For users who manage large-scale surveillance deployments, please plan the hierarchical
structure first. Then you can start to add cameras to each station and connect these sub-stations
to the root station. The whole hierarchical management system is thus constructed.

Remote Server Structure
Client

T & T & T % Please refer to page 268 for
- ‘ : Logical Tree configuration, which

VAST LiveClient VAST Playback Wéb Console ;
allows for a flexible and use-

N\ oo S oriented privilege control.
Login | VAST CMS Server
‘ (Root station)




Technical Specifications

Version 1.13
General

Max. Number of o
Cameras* Unlimited
Max. Number of Servers*  Unlimited
Max. Number of Clients Unlimited

Windows 10, 8, 7, Vista, XP

Support O3 Windows Server 2012, 2008, 2003, 2000

Support Web Browser Internet Explorer 11/10/9

Mobile Support iViewer (i0S/Android)
Virtual Matrix Support* VAST Matrix
Devices Pack .vdp File Update

*Please refer to System Requirements Page
(http://www.vivotek.com/vast/#system)

LiveView (Local Display)

Max. Channel 128-Channel (with Dual Monitors)
Multi Layout Display: 1x1, 2x2, 1+5, 3x3,
1412, 4x4, 5x5, 1+31, 8x8, 1P+2, 1P+6,
Layout 1P+8, 2V, 3V, 4V, 2V+3

Single Layout Display, Full Screen Display,
Sequential Display, Layout Rotate
Stream Application Stream Selection & Auto Stream Size
Drag & Drop
Remote 1/0 Control
PiP (Digital Zoom)
Instant Replay
De-interlace
Video Display Mode (Aspect Ratio, Hide
Borders, Keep Top/Down Borders)

View Application

Fisheye Display Mode:

Regular: 10, 1P, 1R, TO3R, 4R

Wall Mount: 1P2R, 1P3R

Ceiling/Floor Mount: 2P, 4R Pro, 108R

Fisheye Dewarp Mode

Playback

Max. Channel 16 Channels
Multi Layout Display: 1x1, 2x2, 1+5, 3x3,
1412, 4x4, 2V, 3V, 4V, 2V+3

Layout

Single Layout Display, Full Screen Display,
Sequential Display

Playback Mode Asynchronous & Synchronous

Play, Rewind, Pause, Stop, Next/Previous
Video Start, Next/Previous Frame, 1/8X ~
64X Speed Control, Bookmark

Playback Control

Browsing, Date & Time (Fast), Event,
Bookmark, Alarm, Log, Timeline, Timeline
Scale

Search Mode

Video

Video Format m_]gg?, MPEG4, H.264 AVC, H.264 SVC,

Video Resolution Up to 9 Megapixels

Basic Mode: Brightness, Contrast,
Saturation, Hue

Intelligent Mode: Defog, Rain, Snow, Fire/
Smoke

Video Enhancement

Audio
Audio Format G.711, G.726, AMR, AAC

Audio Capability Two-way Audio

Audio Control

Record

Recording Time (sec.)
Recording Stream Type

Recording Stream
Recording Mode

Recording Setting
Recording File Format

External Storage
Recording

Alarm Management
Alarm Period (sec.)

Alarm Filter

Alarm Setting

Schedule Type

Camera Event

Camera Status

Substation

Storage Status

Station Status

External Devices Event
Action

Alarm State for
Management

Alarm Result Export

eMap

Source

Device

Marked

Event Notification

PTZ

PTZ/ePTZ Control

PTZ/ePTZ Operation

Mute, Broadcasting & Sound Play

Pre-Record: 3-15, Post-Record: 10-60
Unicast
Single/Multiple

Continuous, Schedule, Manual, Event,
Activity Adaptive Streaming

Recycle (Unit: Size or Day)

3GP

NAS (SMB & CIFS)

Max. 30
Name, Time, Source, Event Type, State

LiveView Alarm Notification: Fixed &
Popup
Alert Sound

Continuous, Schedule, Manual

Motion, DI/O, Video Lost/Restore, PIR,
Tampering, Temperature, IR, PPTZ, Line
Crossing Detection, Loitering Detection,
Field Detection, Audio detection, SD

Card life Expectancy Detection, Shock
Detection, ONVIF Motion Event, ONVIF DI/
O, ONVIF Video Lost/Restore

Connection Status, Recording Status,
Recording Error

Substation Connection Status, Substation
DI/DO Trigger*
* Support for VIVOTEK's ND Series NVR

Storage Connection Status, Storage
Capacity Status

License Status, Network Status, Virtual
Memory Status

DI/O (With I/0 Box)

Email, Start Recording, Move to preset
location, Set DO, GSM Short Message,
HTTP & Client notification

New, Assigned, In Progress, Resolved,
Closed, Later, Reject, Ignore

.csv File

Import Picture

Camera, External DI/O, Substation
camera, Substation DI/DO*
* Support for VIVOTEK's ND Series NVR

Add, Remove, Direction Control, PTZ
Control & Indicator LiveView

Event Icon Light Flash, Show Live
Streaming on E-map

Panel Control & Mouse Click Control

Direction Control, Home, Zoom, Focus,
Iris, Preset, Patrol (Group), Pan, Stop,
Speed



Technical Specifications

PTZ Operation Mode
Export

Print

Snapshot

Export File

Backup

Schedule

User Management

Authentication

User Level

User Control

User Login Time
Limitation

User Login Schedule
System

Date & Time
Network

Multicast

Language

Device Integration

Joystick

Switch

1/0 Box

Camera Integration

Camera Insert

Video Source

%/VIV@'EK

Click to Move & Continuous Move

Selection Windows & All Windows
BMP & JPEG

AVI, 3GP & EXE

NAS (SMB & CIFS)

Basic Account/Windows AD Account

Administrator, Power User, User, Operator
& Guest

Permission, Accessible Cameras &
Substations

By Time & By Day

Weekly Setting

Sync PC

DDNS, SMTP, UPnP, Proxy, HTTPS

Matrix Only

Czech, English, Finnish, French, German,
Italian, Japanese, Persian, Polish,

Portuguese, Russian, Spanish, Simplified
Chinese, Traditional Chinese

VIVOTEK USB Joystick
All Windows® Compatible USB Joystick

VIVOTEK AW-GEV Series (VivoCam PoE
Switch)

Advantech ADAM-6000 Series
CHIYU CYT-133SC

Manual & Search

VIVOTEK Cameras, ONVIF Cameras, RTSP
URL

Basic Setting

Connection Setting

Video Setting

Audio Setting

Remote Focus

NTP Setting

ONVIF Core Spec

ONVIF Stream

ONVIF Control

ONVIF Event

ONVIF Discovery

VCA Solution
VCA for Surveillance

VCA for Business
Intelligence

VCA Event

User Name, Password & Camera Model
Detection

Configuration Protocol: HTTP, HTTPS
Streaming Protocol: TCP, UDP, HTTP,
HTTPS

Video Stream, Compression, Resolution,
FPS, Video Quality

Compression & Bitrate

Manual Focus Adjustment & Full Range
Scan

IP Address (NTP Server or VAST Server) &
Updating Interval

Version 2.2 or above (by Project)

Video (H.264, MPEG4 & MJPEC) & Audio
(G.711, One Way)

PTZ Control (Up, Down, Left, Right &
Zoom In/Out)

Motion Event, DI/DO, Video Lost/Restore

Discover the other brand camera through

Insert Camera & Batch Insert

Motion Detection, Line Crossing

People Counting

Line Crossing Detection, Loitering
Detection, Field Detection

*Only Support VIVOTEK Cameras.

Advanced Features

VIVOTEK Exclusives

Failover Redundancy

Virtual Machine Support

Panoramic PTZ

Seamless Recording

Standard VCA Integration (Line Crossing &
Loitering & Field Detection)

VCA Counting Solution

Support N x M Structure*
* Only Support VAST Server

VMware, Parallel, Virtual Box,
Hyper-V (by Project)
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VAST Server Functionality

Centralized management site for all the logged in clients
Maintain the configuration of the hierarchical management list
Hundreds of video recording channels

Store recorded data onto multiple networked or local hard disks
Live video for the local/remote LiveClient users

Retrieval of recorded video for the local/remote Playback users
Zero latency database recovery

Multiple stream recording

LiveClient is the management interface to your VAST server. The server-related settings are
made via the VAST LiveClient utility. The convenient and intuitive user interface on VAST
LiveClient provides access to camera, live monitoring, and recording configurations.



VAST LiveClient Functionality

e

Server function control

B Hierarchical station management

User account management

Recording storage management

Recording schedule management

Recorded data backup

Event trigger management

Flexible video live view layout

B Dual screens for a maximum of 64 or more channels for simultaneous monitoring

B 1x1, 2V, 1P+2, 3V, 2x2, 4V, 2V+3, 1+5, 1P+6, 3x3, 1P+8, 1+12, 4x4, 5x5, 8x8, 1+31 moni-
toring layouts (V stands for vertical layout)

m 1P+2, 1P+6, and 1P+8 Panoramic PTZ layouts
B Multiple video viewing pages

Virtual Matrix for video wall display

Intelligent PiP function

E-map for overall management

Network storage for recorded video

Convenient switching among multiple monitors
PTZ / E-PTZ operation panel for camera control
Supports two way audio

Instant playback for event recording

Instant replay for immediate playback

Supports joystick control

Remote configuration for network cameras
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VAST Playback Functionality

B Browse the database of recorded video from the server
B Flexible video playback layout
B Maximum 16 channels with simultaneous playback
B 1x1, 2V, 3V, 2x2, 4V, 2V+3, 1+5, 3x3, 1+12, 4x4 video playback layouts
B Supports powerful playback functions
B 1/8x, 1/4x, 1/2x slow-down playback
B 2x, 4x, 8x, 16X, 32x, 64x video playback speed
B Intelligent PiP function
B Supports convenient evidence and data exporting
B Export media files of recorded video
B Supports snapshot and print out
B Supports convenient switch among multiple monitors
B Search engine:
B Time search
B Event search
B Bookmark search
B Alarm and Log search B Alarm search result export
B Playback while recording
B Support synchronous/ asynchronous playback

e ————— - — Ml
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Minimum System Requirements

Before installing the VAST software, please make sure your system meets the following
recommended minimum system requirements.
If you would like to install ST7501 Server only, please follow the requirements as below:

Server

: Windows Server 2000, 2003, 2008, 2012 / Windows XP Professional, Windows
Operating System .

7, Windows 8
Recording Channels

(4Mbps per CH) up to 64 CH (256Mbps throughput) Up to 128CH (512Mbps throughput)

CPU 3rd Generation Intel® Core™ i5 3rd Generation Intel® Core™ 7
Processors or above Processors or above

RAM 4GB or above - 64CH; 8GB or above - 128CH

Network Interface Card Ethernet, 1 Gbit recommended

Graphics Adapter DirectX 9 compatible 1GB graphics card

Single recording group w/ one HDD Two recording group w/ two HDDs*

Hard Disk T
e DI e SATA, SCSI, SAS (7200 rpm or faster) in NTFS format

* Each recording group can receive recordings for 60 channels.

If you would like to install both the server and client programs, please follow the requirements as
below:

LiveClient and Playback

Windows Server 2000, 2003, 2008, 2012 / Windows XP Professional, Windows

ClpErEilng SsET Vista, Windows 7, Windows 8

Clients Aze
(Display Logg;;f"\"bps' 4CH 10CH 18 CH
Channels) .
1080P,4Mbps,
H 265 2CH 5CH 9CH
CPU 3rd Generation Intel® 3rd Generation Intel® 3rd Generation Intel® Core™
Core™ i3 Processors Core™ i5 Processors i7 Processors
RAM 2 GB or above 4GB or above 4GB or above
Network Interface Card Ethernet, 1Gbit recommended
Graphics Adapter DirectX 9 compatible 1GB graphics card

* Display requirements of the 3MP fisheye camera is equal to a 720P camera.
** Display requirements of the 5MP fisheye camera is equal to a 1080P camera.

If installing Server and Client on the same PC, the overall loading on the PC is to be evaluated.



VIVOTEK - A Leading Provider of Multimedia Communication Solutions

&
® Only users with Administrator privileges can install or use VAST on a Windows Vista system.
® The required hard disk space will depend on the video settings, the number of network cameras and recording
group settings. Please add more hard disks if you want to extend the system.
Below are approximate numbers for a week-long recording. The actual storage space required also depends on
imaging parameters, e.qg., a complex retail environment that involves many moving objects requires more pixel
dala to be transmitted over network than a simple environment such as a parking lot.
32-CH, VGA, about 1 week recording: 750 GB
64-CH, VGA, about 1 week recording: 1TB x 2
32-CH, 2-megapixel, about 1 week recording: 2TB x 2
64-CH, 2-megapixel, about 1 week recording: 2TB x 4
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VAST Software License

To activate the software, refer to the flow chart below:

Scenario Need

Action

Dongle license users Need more CHs

1. Help > License > export license.

2. Send license file to VIVOTEK to
purchase more dongle license.

Need more than
32 CHs.

New users preferring
more than 32 CHs

1. Install the 256 CH trial VAST.

2. Help > License > Generate license
update request.

3. Send request file to VIVOTEK to
purchase software license.

Fine with less than
32 CHs.

New users fine with
32 CHs

1. Install the 32 CH free VAST.

The VAST software provides 32 free channels. Since revision 1.11, the VAST software is
activated using a software license instead of the original hardware dongle.

For users running the previous dongle version, there is no need to upgrade their original license.
If they need the license for more channels, They can export their license file, and purchase more

dongle licenses.

For users who require more than 32 channels, they can install the 256 channel trial version first,
and go to Help > License page, and click on Generate License Update Request. Send the
request back to VIVOTEK to purchase more channel licenses.

£ iy
p
Swale | Loeal
Purdhaced VIVOTE: Usad ety e Lhad Wi Eed
Syalemn 2 O {Froay: 1T7EE) 1 313
| e 55
Fuschased NTWOTEE Linad Criter fwand ke e
® WWTE_Stabond 2 O {Fro: 422 [x] &1
WVTE 300 O {Fress: 1RG0} 1 e
Irmgueek Licengs Gererate Licenss Lipdate Recuest [a' Y

When you purchased and received the
official software license, use the Import
License function to activate the official
license.

| When importing purchased licenses, you

can manally select which station/license
file to update, or click the Auto Dispatch
button and let system decide the
distribution of license updates especially
when there are substations under a
managing VAST server.

Before the Auto Dispatch function is
available, license has to be individually
updated on every substations.



Reminders for VAST Software License

H Limitations:

1. The Batch import/export function applies when a managing VAST server needs to collect and
update the licensing information from subordinate VAST substations and itself. An enterprise
may have a central management server and several VAST instances running in branch offic-
es. In that case, the substations will be listed on the device list, and may not be displayed on a
hierarchical structure.

The Batch import/export function is accessed through the Help > License menu on LiveCli-
ent.

e ——

2.The batch download/import function only takes effect on a VAST instance running on server,
not on the Linux-based NVR.

3.The trial channels on VAST substations will not be available for use on a managing VAST
server (one that manages multiple substations).

4.1f you access a VAST deployment via a web console, the license related information will not

be available.

5.In this revision, an identical software license applies to both VIVOTEK and other-brand cam-
eras (ONVIF). You do not need to activate two different kinds of software licenses.

6. The Batch export update of the current license profile is supported.

7.The licensing mechanism does not apply to machines running Virtualized OSes (VMWare,
VirtualBox, Hyper-V, Parallels), either through an upgrade or generating software license on
a new installation.

8.1f VAST is removed and then re-installed, the number of licensed channels remains intact.

9.If users plan to integrate the software licenses from previous dongle licenses, problems may
occur if users changed the exported license file name.



10. The VAST rev. 1.11 supports 32 free channels, and trial licenses for up to 256 channels.
Note that the unused trial licenses in a VAST substation will not be available for a managing
VAST server. The 32 free licenses will be available for a stand-alone VAST server only.

11. The software license verifies its availability on a machine by checking the computer’s main
components, e.g., GPU or memory. If a VAST server has several of its main components re-
placed, the software license may become invalid. Note that users can only change 2 compo-
nents on a substation (server components - CPU/Memory/Graphics card/Network card/Main
board).

12.For an older VAST installation containing a VAST substation licensed through the dongle, the
32 free channels will be automatically added to the total number of licensed channels. One
substation comes with 32 free channels. The added number of licensed channels will be-
come available for the managing VAST server.



VAST Installation

Installing the VAST Software (This is in case you need to re-install
the software)

1. Run VAST_Setup.exe on your computer. Select the displayed language. Click | ACCEPT the License
Agreement and specify a location to install the program.

Installer Language . & VIVOTEK VAST Setup: License Agreement | = S|

ST
Please select the language of the installer w Plzase read this license agreement carsfully before installing.

End-User License Agreement

|English - PLEASE READ CAREFULLY: This EndUser License Agresment

("EULA"™) is a legal agreement between VIVOTEK Inc. ("VIVOTEE")

[ P ] | cancel | as licensotr, and you, as licensee, for the VIVOTEK software that
accompanies this EULA, which includes the wideo management

software VAST W1 and other applicable software (the “3oftware™).

TOU AGREE TO BE BEOUND EY THE TERMSE OF THIZ EULA BY

INZTALLING, COPYING, OR OTHERWISE USING THE S0FTWARE

OF CLICKING THE BUTTON MARKED “I AGREE™ OR “YES™ -

& VIVOTEK WAST Setup: Installation Folder | 1 &]

4 Setup will install YIVOTEK WAST in the fallowing Folder, To inskallin a
\H different folder, click Browse and select another folder, Click Mext to
cankinue,

Destination Folder

VIVOTEK IncivasT Browse. ..

Space required; 525,3ME
Space available: 560.8GE

Cancel | < Back | | Mext = |

2. Select the items you want to install, then click Next to continue.

m |f you want to install both VAST Server component and Client components, please follow the steps
below to install the database.

&4 VIVOTEK VAST Setup: Installation Options | = ihI

4 Check the components you want to install and uncheck the components
gl vou don't want to install, Click Mext to continue.

-

Select components to install: WAST LiveClient Server Component
YAST Playback — .
vasT server Client components

Space reguired: 523, 3ME

Zancel < Back. | | Mesxt =




3. You can install the free 32 CH version, or, select the Trial 256 CH version, then click Next to continue.

® The trial version will expire after 60 days. You can then contact VIVOTEK's sales representatives to
purchase the official software license to continue using the software.

&4 VIVOTEK WAST Setup : Server Configuration | = —ZhJ
@) Free version: 32 channels (WIWOTEK only)
Trial version: 256 channels (60 days)
| Cancel | | < Back | [ Mext = ]

In the LiveClient window, you can go to Help
> License, and click on Generate License
Update Request. You can send the request file to
VIVOTEK's sales representatives to facilitate the
purchase process.

4. Assign a username and password for the VAST Server and click Next to continue. A strong password
is recommended using a minimum of 8 characters, in upper/lower case, and special characters.
Resetting passwords regularly is also recommended.

& VIVOTEK VAST Setup : Server Configuration | =1 Jh]
WAST Server User Mame: adrin
YAST Server Password: LLILE LT
Corfirm Password: LTTTLTTY |
| Cancel < Back | [ Mext =

ge

Please record the user name and password for login later.

é&

Once you have created a user account for a VAST station, you can login fo VAST Server from any computer over

the network through the LiveClient and Playback utilities.



5. An SQL Lite database is automatically installed on your server. In order to avoid conflicts among
different databases, we suggest you remove the original database from your computer.

Usually, you do not need to change the Station Listen Port and RTSP port for streaming video. If
necessary, e.g., when the port has been occupied by other applications, change the port number.

Specify a file recording path on your server. Multiple recording groups can be created, and if you have
more than 32 channels, it is recommended to assign a recording path on a different hard drive or RAID
volume disk other than your system drive. Click Install to continue the process.

&4 VIVOTEK VAST Setup : Server Canfiguration = 2
Station Mame: "F"‘."TK_Statil:lnl
Station Lisken Park: 3454
RTSP Port: 4543
Default Recording Path: E:\recording |:|
| Cancel | | < Back | | Install |

The installation process should be completed within several minutes. Shortcuts will be created on your
desktop. Double-click on the shortcut to start using the software.

&4 VIVOTEK WAST Setup: Installing | =u| J

& Installing the Wa3T Server. ..

>

W




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

If you installed the trial version, you will be prompted to activate the trial license. Click Yes to start
using the trial version.

&4 Information

o The software is running trial mode. Would vou like to activate the software?

Loes J[ m |

.
&4 Information ﬁ

0 The software is activated.

Lo |
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VAST Server

Activating the VAST Server

VAST Server is a service program that will run automatically when your VAST station starts.
Users can also deselect the Auto launch option at windows startup on the VAST Service Control
program tray. The program tray icon can be located on Windows tool bar.

How to Configure the Server

Please follow the steps below to configure the VAST Server:

1. Find a local/remote computer that has installed VAST LiveClient.
2. Activate VAST LiveClient and login to the target VAST Server.
3. Configure the server using the VAST LiveClient user interface.

How to Stop/Reboot the Server

Please follow the steps below to stop/reboot the server:
1. Click on the VAST Service Control program tray icon in the toolbar.

WAST Servic |
= } ) 10:44 AM

» g 1 (4

2. There are 3 options: Start Service, Stop Service, and Restart Service. It's selectable by a right-click on
the Service Control program tray icon.

Open VAST Service Control

Start Service

Stop Service

Restart Service

Exit




VAST LiveClient Configuration

Activating the VAST LiveClient and Logging in to a VAST Server

VAST LiveClient allows you to monitor live video from cameras managed by the VAST Server; it
is also the main user interface for server function control.

After installing the VAST LiveClient program, please follow the steps below to activate VAST
LiveClient:

1. Run the VAST LiveClient program.
2. A Login window will pop up. Enter the information as shown below:

m |f you want to login to a remote VAST Server, enter the IP Address, User Name, Password and the
Communication Port of the target server correctly. Click Login to log in to the target server.

m |f you want to login to a local host that is running VAST Server, check the Login local station check-
box, then the local IP Address will be displayed automatically. Enter the User Name, Password,
and Communication Port of the local server for login. Click Login to login to the target server.

"\d VAST LiveClient == 4 VAST LiveClient (=25l
Log in local station V| Log in Jocal station m Please refer to page 154 for
how to enable and configure
Qe 1521686117 M| S Windows AD accounts
Authentication: |Basic Account - Authentication: |Basic Account - |
User Mame: admin User Name: admin
Password: sssss Password: sesee
Port: 3443 + [luse ssL Port: 3443 - [¥luse ssL
| Proxy Setfings | | Proxy Setfings |
[ Log in ] | Cancel | | Hide =< | [ Log in ] | Cancel | | Hide << |

3. The VAST LiveClient monitoring window will prompt.

ge

m /f your network environment needs to set up proxy, click More >> to extend the login window, then click Proxy
Settings to open the dialog. Then enter related information to link to your proxy server.

&4 VAST LiveClient g 4 Proxy Settings i, e
Log in local station
Enable Proxy
Address: 192.168.6.117 -
Address;
Authentication: |Basic Account -
- Port: 20
User Mame: admin
Lser Mame:
Password: .
Port: 3443 =| [ @luse S5L Passweord:
| | Proxy Settings | 0y ] | Cancel
| | Log in | | Cancel | | Hide << | ’

m Available functions of the VAST LiveClient program will be enabled according to the role of your login account.
For more details about the privileges of the user account, please refer to How to Manage User Accounts on
page 151.



If you use LiveClient to access a remote VAST server, you can use the SSL login for secure

connection.

To prevent network layer attack, the management session between a VAST LiveClient and
server can be encrypted using the HTTPS connection. HTTPS (Hypertext Transfer Protocol over

Secure Socket Layer) encrypts the traffic between web browsers and servers.

When starting the LiveClient, click the More button, and select the Use SSL checkbox.

%d WAST LiveClient
Log in local station

Address: 192.168.6.117

==

Authentication: |Basic Account

User Name: admin
Password: .
Log in ] | Cancel | [ Maore ==

% VAST LiveClient
Log in local station

Address: 192.168.06.117

23

Authentication: |Basic Account

IUser Name: admin
Password: .
Port: 3443 = [¥]use s5L

Proxy Settings

| Log in || Cancel ||Hide-::-::




VAST LiveClient User Interface

B
H
A. Menu bar B. Quick access bar C. Hierarchical management tree
D. Camera control panel (PTZ / Two way audio / Instant Playback control panel)
E. Live view window F. Matrix view window  G. Status panel H. Alarm window
Menu Bar

(System | Edit | View | Configuration | Layout | Helpj

Menu ltem

System
Edit

View

Configuration

Layout
Help

Drop-down Options

Lock / Enable Click On Image (Disable Click On Image) / Language / Second View / E-map /
Launch Playback / Logout / Exit

Manually Begin Recording (Stop Manual Recording) / Snapshot / Print / Record to EXE (3GP,
AVI) / Snapshot Zoomed Image / Print Zoomed Image / Find

Logical Tree view/ Device Tree view/ PTZ Panel / Two Way Audio Panel / Instant Playback
Panel / Alarm Window / Full Screen / Minimize / Matrix View

Camera Management (Insert Camera / Update Camera / Delete Cameras / Batch Insert
Cameras / Camera Configuration) / Station Management / Logical Tree View management
/ 10 Box Management / User Management / Association Management / Alarm Management
/ Virtual Matrix Management (Matrix Management / Matrix View Settings) / Station Settings
(General Settings / Network Settings / Recording Storage Settings / Recording Schedule
Settings / Scheduled Backup Settings / Server Settings / Relay Settings) / Client Settings
(Snapshot Settings / Recording Settings / View Settings / General Settings / Joystick Settings /
Proxy Settings / PiP Settings) / Video Enhancement (Basic Image Adjustment / Defog)

Start Rotating (Stop Rotating) / Save to / Delete / Choose
About / License




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

Status Panel

User Name

Station Name (IP Address)

Login Time (yyyy-mm-dd hh:mm:ss)
Current Time (yyyy-mm-dd hh:mm:ss)
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Help Panel

The Help panel provides software revision information and the access to the associated iViewer
software in either the iOS or Android version. You can also click on the License button to review
the number of cameras and manageable substations.

If necessary, you may also use the Import License button to activate the functionality you
separately purchased or generate a license request.

\d About VAST Livem ot
" N Leense tniomation -—i— = l:"
- VAST LiveClient 1.9.0.2 ——— - ————

w | Trial vawson (Remareg e 50 days) |
Al vights reserved. Copyright @ 2009-2014 VIVOTEK IMNC, Nara Vs Cscriphon |
btk fwarne vivotel.com Carmeea namber 256 M rmber of the total camerns channets,
A Othee brand camera rumber 10 Muasimim rrmber of the other brand cameea,
Device Pack Yersion: 2,01 | Update... Sybstation rumber i ML number of substations foe this koerse

WIVOTEK iWiewer

Please click QR code to purchase it,

Product Information

1

k=

Available on the
D App Store

Device Pack Update

A Device Pack consists of information of new VIVOTEK cameras or the updated information
for previous models, such as various configurations including resolutions, FPS, DI/DO, etc. For
example, some panels, such as the PTZ panel, may not be available for a new PTZ camera.
Your VAST server might not recognize the features of the latest VIVOTEK cameras. With the
Device Pack, you can configure and implement the latest VIVOTEK models without the need
to upgrade the entire VAST software to acquire the associated information. Please visit: http://
www.vivotek.com/web/product/productdetail.aspx?Model=VAST. For configurations not specified
in the device pack, you can still open a web console with individual cameras to change their
configuration.

You can consult VIVOTEK's technical support for the latest Device Pack [CSV files (*.csv)],
and use the Update... button in the Help window to replenish camera information. The update
information will be displayed, and the update process is completed almost immediately.

Device Pack Update
Old version: 1.0.2
New version: 1.0.3

Ready for update.

_ Update | [ Cancel ]



http://www.vivotek.com/web/product/productdetail.aspx?Model=VAST
http://www.vivotek.com/web/product/productdetail.aspx?Model=VAST

Quick Access Bar

[olela]]al]. (@[] FkaE >[5

Icon Function

Exit

Logout

Lock

Volume
Snapshot

Print

Record to Media
Alert Sound
Switch Screen
Adjust SVC Level
Remove All Connections
Layout

Full Screen

Page Up

Page Down

Start / Stop Rotating

Description
Exit the system
Log out from the current station

Click to Lock the system for security concerns (@ Unlock the system)

Adjust the audio volume of the current video (@ Mute)

Capture pictures from the focus live video cell

Print out the pictures of focus live view window or all live video cells
Record media in EXE/3GP/AVI format (E Recording Media)
Play sound when an event triggers

Switch the current window to another screen

Dynamically adjust the SVC control over frame rates

Remove all live videos from the live view window

Change the layout of the live view window

Maximize the live video cell

Switch to the previous live view page

Switch to the next live view page

Start or stop live view layout rotating

N ERLEEREECRERERRE

Some buttons will be disabled if the selected devices do not support the corresponding functions.

Live Video Monitoring Window

The "VIVOTEK" logo is displayed where no camera has been assigned to a video cell.
The red frame ( |:| ) represents the current selection.

Video Cell




Hierarchical Management Tree

=B BT Station1(127.0.0.1) Root Station Name (IP address)
= P& Camera
= EN 1_IP7139(192 162.5.120) | Connected devices listed under the root station
i DI-1 Camera name (IP Address)
W Do-1 S
= P&y Recording Storage
< E DefaultGroup __ Connected devices that have been assigned to
the default recording storage
Bk 1 P7170
P Layout Layout list
- WWTK_Station2(172.16.4.23) ——— Sub-station Name (IP address)
# [ camera

#- [ Recording Group

gg

By default, the I/O device connection status display is disabled. You can turn up the display by visiting
Configuration > Client settings > General settings > Keep detecting camera DI/DO status.

Icon Description
_i -.'_—-_ A station (The host that’s installed with VAST Server)
A station (The host that’s installed with ST7501 Server)
VIVOTEK fixed network camera (or ONVIF cameras)
E/ En Red dot signifies that the camera is recording.
& /3 VIVOTEK PTZ network camera
Red dot signifies that the camera is recording.
;Q / @ VIVOTEK dome network camera
Red dot signifies that the camera is recording.
@ / @ VIVOTEK fisheye network camera
Red dot indicates that the camera is recording.
— VIVOTEK video server
. / E Red dot signifies that the video server is recording.

i / ﬂ Digital input on / off

-/ @ Digital output on / off

A layout of the live monitoring window

i ] A station that’s not able to be connected currently.

== A device that's not able to be connected currently.




Camera Control Panel

Pan/Tilt/Zoom (PTZ) Control Panel
Up

Digital -
Cllck to move hd

A

Activated mode: [

PTZ operation mode:

Top left

Top right

et — GHOD |

Return to home position
Right

Bottom left

NGy

Bottom right
Down

L‘.J.

Zoom out ————— &Ellemns
Focus near Di

- Auto focus
—— Zoom in

—— Focus far

I — (=
Close —c_:{—z:

Open

Patral '.'

Start to auto pan ————~ P

Auto iris

Stop auto pan/ ser )

Auto Tracking
Start to auto patrol

patrol ¥ opesd

Pan speed:
Tilt speed:
Zoor speed:
Focus speed: ]

Panaoramic speed: 1

Rotate speed: 1

Preset Location:

E - ]

Speed control

— Drop-down list of preset positions

gg

m There are two types of PTZ control: Digital (E-PTZ for megapixel cameras) and Mechanical (PTZ cameras or
fixed cameras with camera control via RS-485). If the connected cameras support PTZ/E-PTZ function, the
PTZ option(s) will appear on the drop-down list. For detailed camera control settings, please refer to the user's

manual that came with VIVOTEK network camera .

m Click System > Enable Click On Image fo use the mouse for the control of the PTZ and E-PTZ functions in the
video cells for linked cameras. An icon will appear in the video cell as shown below.

1_FD&161

_ System | Edit | View | C

Lock Crl+L
Enable Click On [mage

Langnage

E-Map
Lanmnch Plavhack

Logont
Exit

2010408/03 AM 11:25:23

®m You can control the PTZ function through joystick as well. For more information regarding to the joystick

configuration, please refer to instructions on page 246.



VIVOTEK's latest SD8xxx speed dome series supports the Continuous Move control. The
"Click to move" enables one movement by every mouse click on the PTZ buttons.

When Continuous Move is enabled from the PTZ panel, you can click and hold down the
mouse button on an arrow key to command the camera to continue moving to that direction.
The move will stop when you release the mouse button. Also, if the pan/tilt/zoom/focus speed
is configurable for a PTZ camera, you can use the Speed button to display the speed options:
pan, tilt, zoom, focus, panoramic, and rotate speeds.

For fisheye cameras, two more options will be available: Panoramic speed and Rotate speed.
These two options apply to the onscreen control for the Panoramic and Regional views.

ge

In addition to the PTZ panel, the following hot key combinations are also available:

Ctrl + NumPad (PTZ control)

Up Ctrl + 8

Left Ctrl +4

Home Ctrl + 5

Right Ctrl + 6

Down Ctrl + 2

Focus (Far - Near) Ctrl+1 [Ctrl +3
Zoom (Qut - In) Ctrl+7 [Ctrl+9
Pan Ctrl +/

Stop Ctrl +*

Patrol Ctrl + -

Preset locations (pre- Ctrl + 0~9 (number keys above the alphabetic keys)
configured by users)

Full screen Ctrl + F

Single view Ctrl +V

Previous layout page Alt + PageUP
Next layout page Alt + PageDown
First layout page Alt + Home

Last layout page Alt + End
Snapshot Ctrl + S

Stop alarm Ctrl + A

Mute audio from current (Ctrl + M

stream

Start/ Stop rotation Ctrl + O




Two Way Audio Control Panel

The two way audio function allows the user to remotely communicate with people nearby the

network camera. :
PTZ | Two Way Audio | Instant Playback

Talk Panel
= Selected device that
1 PZT131 can use the two way

audio function

Click to play sound from the camera
Remove all cameras

Click to talk ———= ) from the Talk Panel

[ Talk ) Play Sound ) ClearAll

Client Settings
Select sound from the

Sound File : file list

C:\Program Files'Vivotek Inc\S1 @@7 Click to play the selected

sound on the client's side

Volume : [ | ]

g, Click to adjust volume

® For detailed information about How to Use the Talk Panel, please refer to page 217.
®m Only cameras that come with the two way audio function can be added to the Talk Panel.

Language Selection

VAST currently supports multi-lingual user interfaces including: English, Cesky, Deutsch, Espa-
fiol, Farsi, Francais, Italiano, H#4<3E, Portugués, Pycckuin, fiifAHSC, %487 < | If you want to select
another language for the interface, please click System > Language on the menu bar to select
the desired language. Please note that if you want to change the language option, a message
will prompt to remind you to restart the system.

ol Lyl
System | Cod | View Conliguration | Layoe Haip éi
.:L-::a.:-'f’.a:a.—q. o |L . !;’5_:. HIIKS-
angoage G ol If you want to use "User Defined" language, please prepare images and
i ol language strings, and upload the files to the following folders:
EEERMCA Gopor) s ...\VASTI\Client|LiveClientllanguagelzz_UD (language string)

oo ...\VASTIClient|LiveClientlimage (images)

Pomugi

Proooss

| 4.1 04

W Cefired



Alarm Window

ée

* Only the alarm-related messages will be displayed in this window. An Alarm is a configuration
consisting of triggers and reactions set to activate during a specific period of time. The
Alarm-related settings is configured in Configuration > Alarm management. See page 162
for more information.

« For the event messages of the overall system operation, please refer to the Playback > Log
viewer.

« If a VAST server is reset, the Alarms will disappear from the Alarm window. You can go to the
Playback utility and use the Alarm search function to retrieve the past events.

Click View > Alarm Window to open a window showing the real-time information for event
triggers. If you want to hide this window, deselect this option on the menu bar.

—_—_ e e
View IIC(:Infjguraliorl | Layout |f iererscsmss  tas T Lamemgitin sarcs T e Iypm W L . T Srie
Panel L ¥F] NI TEEE . ot StegRery M Pl HaEverrs Caven & PMOCr - Wrkw 3 = M-S P N P
ity i SOy P 4l btk Corara 1% 201008 R TF T
v TwoWayAudio Panel L¥] PETSSHE 0. OO DRt Mo heteors Lamars PRI - W = AT LA A T
Instant Playback Panel s sl SDWMETSE T3 o i MRS 134132578 Mew
ATAEINT [ ADAM 053 0. 1 ol Trigger 203000 35 1320 118 Hew
Full Sereen Ctrl+F
Minimize
v Matrix View .
ol THTe |:l1=:_|
|
Event Window s General Setings =
. . . W&uiigs
The default Alarm window is set to be fixed on the AutaTaREaly 1 n 3t KSDang h £ operErg SRR
bottom of the LiveClient. If you want to change sutomaticaly daplay el sersen ator g
the Alarm window as a popup page, please open 41 it 384 niwnseted G to weo cel
the Configuration > Client Settings > General Retres RTSP siears on soeched port: | 4542
Settings window to switch the display modes. | Eannact substation streaming v relay
Keep detecting D00 Satus
Camers Maragament ¥ 1 5ot raman by pama
Station Management.. -
Lagieal Tres View BAARsgrment | & Al Sattings
Lﬂ.‘*.llaﬁ‘n-.lhhn:q-e:nl ? . E}@]J:'El@' | < Enabla bee slerm notfcaton
User Manngemes o Wi | Enabla alart sunsis)

¢ Enable F-Map popup window
|[ Al window mide: & Fred

Agsaciaticn Management

Alan Managemer

ZaASIRE - LANGEEL T

Wirtaal Matrix Mansgement " Pooun

Falover Maragement ¥

Sedrch VivaCam Switches.. Hrantion Setre
Enabie rotation after ign
Lianon Setmngy ¥ AT P N e s v 15 5 ikl (000
==
Videp Enhancement " Recording Settings Dimplay Selliogs

Mzermum number of view rals (64 =

4

#| Enable auto stream soe: | Qualty first -

IWE*WJFQ!I Enablé de-mitirbce funchon

5 7

st ek o o Engble Jtant Replay of vdeo el
PP Settings

Default repay ngth: |30 sacteds =

Local ftreyrng boffer tma: 0 Y milsscond(s) (0= 10000}

(a3 Fancal




m The Event Type field in the Alarm window shows the event category and another field Value displays
the percentage of motion in the detection window. You can go to the Configuration setting page of the

connected device to set the percentage.

Enable motion detection

Video(TCP-AV)

Alarm Filter

Window Mame
[t
Sensitivity
— }— 8%
Percentage

o e——— 1L

[REWY |

On the Alarm panel, a list of alarms will be displayed. Click on the attributes with a funnel icon.

Instant Playback  Marne

w SD Ol
w S0 DI
w 50D DI

Event Type W Walue

DI Trigger
DI Trigger
DI Trigger

Time T

2015-07-31 11:50:36.426
2015-07-31 11.50:24,722
2015-07-31 11:50:13.750

State W
WY
e

[WEWY

The Alarm Filter window will prompt. Use the Name, Time selector, and the State checkboxes in
the Source and Event Type panes to specify what kinds of alarms will be displayed.

&4 Alarm Filter
General
Harme:
State
[CIMew [ Assigried
[T1n Progress [T Resalved
[ Closed [Later
[CIReject [Cignaore
Time
[Clstart Time:
2015f 731 10:56:32
[C1End Tirme:
2015f 731 11:56:32

Event Type

=7 Category
-7 Camera Events
-7 Camera Status

(-7 Storage Status
- [ Station Status
[#- [ External Device Events

] [ Cancel

Apply




For example, you can set up a filter to display the alarms with a name associated with a specific
camera, such as "bullet on the corridor." The name of the alarm is configured in Configuration
> Alarm management on page 162.

General .

1 J|Enable this

| Enable live notification

Mame:

Description:

Trigger Period

o |

Detail

Schedule ..,

Trigger .. Action .

alarm

g 5 (sec) 0O I_J 30

Back | et | Firish | Canicel |

Use the Filter tab at the bottom of the Alarm window to display a different sorted result.

w
w

Real Time  Filter

Alarm State

motion detection
dddddd

IP2135HP mo...
IPE152Y-3

Left-click to select an alarm, and then right-click to display the Update Alarm button.

SoEcE T

SCE1nd D=2 1]}

SERUBLOGE O

Laiel -2 &l]

EvetType T

Wals Tims T Stara T

Lipelats Alatm

You can change the alarm state from the pull-down menu. For example, if someone has already
been sent to check out the situation, for example, an intruder broke in through a window, you
can select the Assigned status. A 1024 bytes decription can be added into the alarm Note for

S Lipcate Alarm
| Al Indorsiation

Farmar:
=80

Dseriphors

ST
" SOE1EL D2

| Event Tend

& T
* T ricagr
Tirw
= AE0T-31

= n -

Al Haclineg

SEbEc | M -
Fitrw

Lol e |
I Frogress
vt
Ciosed
Lt
gt
Ignarg

L1 40

b S

s

future reference.

If an alarm is proved as a
false alarm, the alarm can
be designated as Ignore or
Resolved, and so on.

The different alarm states can
also be used as the filtering
conditions in the Alarm filter.
Single or multiple states can
be selected in the filter. For
example, to display the Resolved
alarms only, use the Resolved
state as the filter.



Instant Playback

Check View > Instant Playback to open the window on the panel. The entries listed in the
Event panel are the short recordings made from triggered events.

Wiew ihgurabion,  Layoul | H
Banal

| b | Deselect this item if you want to hide this window.

¥ Alam Window

Full Soreen cilaE

T Lwscrgiten sarce T - T
M P vk Cifrend Fi F MRS U e
Piess i btink Cirma 0200035 D0 TT T
IPYTSEHE L. OO0 DeRChon Mo heteor Laera MO - AW =N S ) A
AT el AL ETSE T3 o Triagar 010925 13:41:32. 178
e ol ADUM 053 0.1 ol Trigger 00T B39, 118

FEIT78

;
o [l eI .
e LnJini[m] Ry Ty

Instant Playback Window with a slide bar, play, pause, and stop function

The recorded media that was triggered by an event will be indicated with a playable W icon.

You can double-click an event on the list to playback the recorded video. Each event contains
a video clip of 20 seconds in length. (The default recording data of an event is 20 seconds. For
more information about event recording, please refer to page 188.)



Instant Replay

n If a camera is currently recording to the VAST server, then a Replay button will be
available at the lower left corner of its view cell. This allows you to immediately retrieve the video
recording in the past few seconds or minutes.

The Instant Replay function enables you to quickly retrieve videos of what has just happened (20
seconds to 15 minutes ago), without the need to open the Playback utility for the past videos.

Prerequisites for Instant Replay:

1. The function is enabled by default, only available on a LiveClient installed on a PC.

2. There must be recorded videos of the immediate past. If the video streams from a camera
were not recorded, you can not retrieve videos using the Instant Replay function.

J NOTE:

1. When using the Instant Replay function and you change the stream number on a video cell,
the Instant Replay will be interrupted.

2. The Instant Replay will also be interrupted when the time comes for a rotation of Live View
pages. For example, if you have multiple Live View pages and you set up a rotation of these
pages by every 10 seconds, page swap (rotation) still has a higher priority even if you are
viewing the Instant Replay.

How to Use:

1. On a selected view cell, mouse over to the lower left corner. A Replay icon H will appear.
2. Click on it to display the Replay control bar. Click on the play button.

M 10:19:30

2013-07-04

3. The default queue length is 30 seconds. You can click on the number on the right to change
the queue length.

The Playback option allows you to directly open the Playback utility. A

maximized single view window will open. In this single view, previous

recording will be played, but, unlike the smaller Instant playback pane, the
S playback will continue until manually stopped.

1 minute

S minutes This playback mode is not memorized as the norm the next time you use

15 minutes the Instant Replay function.

The queue length configuration stays with the view cell, and it will not go unless you remove
and insert the camera again.



4. To stop the Replay and return to the Live View, click on the Return to Live button. n

5. On a Replay view cell, you can apply the same Snapshot, Print, Single view and Full screen
control as those on a normal view cell. You can also right-click to display the Display Mode
and Video Enhancement functions.

Click and drag the playhead to skip or move to a different point in time on the playback.

An active Replay view cell is indicated by the Replay text |nd|cator and the time of occurrence
of the current playback. | e

To change the default Replay settings, open the Configuration > Client Settings > General
Settings menu.

I Display Settings I

Maximum number of view cels |64 =

[¥| Enable auto stream size: | Quality first v|

[[Enable de-interlace function

[¥] Enable Instant Replay on video cell

Default replay length: |30 seconds | ~

Local streaming buffer time: 0 = milisecond(s) (0 ~ 10000)

| K || Cancel |

Audio Control

(O] & |00 & « |@E): EJ€)>]=

The audio function will be enabled if the device is equipped with an internal or external
microphone. For detailed audio control settings, please refer to page 138.




How to Manage Devices

Please follow the steps below to open the Camera Management window:
a. Select the station from the hierarchical management tree.

b. Click Configuration > Camera Management on the menu bar (or right-click the station, then select
Camera Management).

c. Then you can choose to insert, update, delete, or batch insert cameras.

System  Cdid | Ve | Conliguration Layrul Fielp
e tET T Camen Meagemen
| A ||"- =
{ O J{ )| b e
eorral Troe Ware Mansgeros
rage

B v _stamoniis
a =

Insert Cameras

Please follow the steps below to add devices to a station:

a. Click Configuration > Camera Management > Insert Camera on the menu bar (or right-click the
device/station, then select Camera Management > Insert Camera).

b. The Camera Management - Insert window will pop up. The device tree managed by the station will
be displayed in the left Camera List window.

c. Enter the Camera Name, IP address (or you can enter an IP address and check Auto to get a
camera name automatically) and configure the Connection Settings.

m |f the camera is on the LAN, you can click Search Camera to detect all VIVOTEK network
cameras on the LAN. A Camera List window will pop up and show a list of detected cameras on
the LAN. On the top of Camera List window, you can select "List the cameras which are not
inserted" or "List all cameras". The items listed below will then change accordingly. You can click
Mac, IP Address, Model, HTTP port to sort the items. Then select a camera from the list to insert
to the station.

®m The streaming protocol determines how the live video stream is sent from the camera to the local
computer. Please refer to the note on the next page for a detailed description of each transmission
protocol. Specify the recommended live monitoring stream for the device. If you want to change the
live viewing stream, please refer to the next page to update the camera settings. Or you can right-
click the desired cell, then select a desired stream. Please refer to Dual / Multiple Streams on page
124 for a detailed illustration.

m Click Detect Model to detect the device. The Model Name and MAC Address of the device will
automatically be displayed in the respective fields if the connection is successful.

d. If you want to make sure you are connected to the target device, click Connection Test to preview the
live video from the device.
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@ Camera Management for VVTK_Stationl - Inﬂ
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Camera List p—
% YV TK_Station1(127.0.0.1) Brand: vivoTek ] l 02:42;4@ |

Module: - - -
@ Carnera Mame: VAuto | e

sy

Address: 102.166.6175 (][] |9

Model Mame:  |IPS162

MAC Address:  |000201157840

Connection Test ‘I‘ @]

Connection Settings |Recarding Settings | |

User Mame: Passwoard:
Configuration Protocol:  [HTTP - Configuration Port: 80 =
Streaming Protocal: TCP - Channel: 1

Iriitial @ Stream: 1 =

| Insert || Close

V| automatically add camera into recording storage | DefaultGroup IZ| H

) e . W ==

List the cameras which are not inserted

@ List all cameras | Refresh |
Camera List
A Address Mode! HTTF Paort

00-02-D1-15-7B-40 192.168.6.175 IPE162 a0

ﬁi 00-02-01-81-73-02 192,168.6.101 FE=2173 20

m /f you want to use "HTTPS Port", please enable the HTTPs settings on the configuration page of the Network
Camera first.
m The characteristics of each protocol are shown in the following table:

Protocol Description

UDP uses a simple transmission model without implicit hand-shaking dialogues for guaranteeing
reliability, ordering, or data integrity. Thus, UDP provides an unreliable service and data grams may
arrive out of order, appear duplicated, or go missing without notice. This protocol allows for almost
real-time audio and video streams. However, network packets may be lost due to network burst
traffic and images may be obscured. Activate UDP connection when occasions require time-sensitive
responses and video quality is less important.

UDP

TCP provides the service of exchanging data reliably directly between two network hosts, whereas IP
handles addressing and routing message across one or more networks. In particular, TCP provides
reliable, ordered delivery of a stream of bytes from a program on one computer to another program
on another computer. This protocol guarantees the delivery of streaming data and thus provides
better video quality. The downside with this protocol is that the real-time effect is worse than that with
UDP for a narrower bandwidth.

TCP

HTTP is a networking protocol for distributed, collaborative, hypermedia information systems. It’'s the
foundation of data communication for the World Wide Web. This protocol allows for the same quality
as TCP and the users need not open a specific port for streaming under some network environment.
Users inside a firewall can utilize this protocol to allow streaming data through.

HTTP

This protocol enables authentication and encrypted communication over SSL (Secure Socket Layer),

HTTPS which protects streaming data transmission over the Internet on higer security level.



e. Configure Recording Settings:

Connection Settings | Recording Settings

Basic Settings

Recarding Stream: 1 Enable seamless recording

Pre-event Time: 10 > seconds(3-15)
Post-event Time: 10 = seconds(10-60)

Activity Adaptive Stream
Active

m Recording Stream: By default, the stream source of the recording stream is stream 1, if you want to
change it later on, please refer to the previous page to update the camera settings (Update Camera).

m Pre-event time: Enter a number to decide how much time to record before an event is triggered.
m Post-event time: Enter a number to decide the duration of recording after an event is triggered.

Connection Setting | Recording Settings @
Basic Settings | Pre-event time l/‘ Post-event time \I
Recording Strearn: 1 = pre- post-
10 sec. 10 sec.
Pre-event Time: i = seconds(3-15) Trigger Activation
Post-event Time: 10 > seconds(10-60)

Activity Adaptive Stream

Active

For example: If both the Pre-event time and Post-event time are set to 10 seconds, a total of 20

seconds of video will be recorded if an event is triggered. This function is supported by the buffer area
P %

4]

on a VAST server.
(2]
e R Fe

Note the following with the associated configuration:
| frame ---> Full frame rate ---> |frame

o
m The Pre-/Post-event time configuration only applies to %-
event recording. =
m The Activity Adaptive Stream (a.k.a., AAS) only applies to l—z
the Continuous Recording.

Bandwidth

N

m Activity Adaptive Stream (active if possible): Check this for Dynamic Frame Rate Control

item to enable activity adaptive stream recording. For

cameras that come with multiple streams features, users

can make use of activity adaptive streaming for dynamic
frame control.

If you check Activate Activity Adaptive Stream, the VAST Continuous recording Time
server will record full-frame-rate video only when an

event is triggered on the camera; otherwise, it will only

request the | frame data during normal monitoring, thus

effectively save lots of bandwidths and storage.

Vv
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Camera List

Brand:

o (B Tk _Station1(127.0.0.1)

i

Module:

Camera Mame:

9

WTWOTEK

Address: 192.168.6.175
Model Mame: | [PE162
MAC Address: 000201157840

)
102:42:55 |

Connection Test

Connection Settings | Recording Settings |

Llser Mame:
Configuration Protocal;
Streaming Protocol:

Initial Wiewing Strear:

HTTP -

e

TCR

1

Password:
Configuration Part: 80 =
- Channel: 1

ﬁ, [¥] Automatically add camera into recording storage

DefaultGroup

[m | Insert ] [

f. The device will automatically be assigned to the default recording group. Deselect the item if you want

to cancel this setting.

g. You can deselect the "Auto" checkbox behind the Camera Name entry, and manually enter a name
of your choice, such as "East alley bullet." This name will be used as the folder name for the recorded
video files. An index number will still be appended to the folder name. Note that if this name is changed
when the recording is taking place, the configuration change will not take effect until the next day.

h. When all settings are completed, click Insert to add the device to the station. The device will be

displayed under the Camera List on the left.

i. To insert additional devices to the station, repeat the above steps.
j. When completed, click Close to exit the camera management window.

k. Back to the main window, you will find the newly-inserted devices displayed under the station and the

live video in the video cell.

= WY TK_Station1(127.0.0.1)
= P Camera
=Rl FOR161(192,163.5.132)
- [ Recording Storage

B Lavout

D Live View ﬁ Matrix View

1_FD&161

2010408/03 AM 11:25:23




Seamless Recording

Seamless Recording safeguards critical videos in the occurences of network disconnection.
In the event of temporary disconnection, video is stored in individual cameras' SD/SDHC/
SDXC card; and once the connection is restored, a VAST server can automatically resumes the
recording. More remarkable is that, a VAST server can simultaneously retrieve the time-tagged
videos that were temporarily stored on SD/SDHC/SDXC cards. For information about the latest

firmware/software revisions that support this feature, please contact your sales representatives
or technical support.

Seamless Recording
Disconnect Restored
14:30 14:50

2

VAST
Server Station

VAST
Server Station

|

Normal recording SD/SDHC/SDXC
—

Retrieval

The video data retrieved from SD/SDHC/SDXC card also include event-triggered recordings
such as pre- or post-event footages, if events were detected during the network outage.

The Seamless Recording feature is enabled when inserting, updating, or batch inserting
cameras in the Camera Management window. The firmware/hadware compatibility of this
feature is automatically detected, i.e., this feature is not available when a non-compliant camera
is attached. If a compatible camera is attached, a checkbox will be available as shown below.

[“IEnable seamiess recording :@: Tips:

:\.l"l:t-tll Munsprment for VVTE _Stahonl - Tnsent h’:‘.‘j Try Out the Detect model
Cammera List Al T
o B wissmetizoony | g ==8 button on the Insert Camera

ackess ol | page if the Seamless
Mods! Harre Recording checkbox does not
ML Addness

appear.

Brand: VIVOTEK [+
[ congecton Tes | Camera Mame: JlAuto
Corvesction Setirgs | Recordng Settrgs FRHNEN
C o LA L La*: = Address: 192.168.6.207 |\{Sb| 3 |
it Seltings T

Recondeg Streare |1

l: Enaie: shircion "':"'*'a Model Mame: | MSEEI1EY

MAC Address:  000253591C319

Pro-wvort Tima 1 = socondsd3-1%)
Peat-dvert Time 10 = secord] 10-50)
Acthity Adapthee Streasm

| B tred i Pl

[#] Automaticaly add camera nto recording storage | DefaitGroug -

froet | Cose
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When the SD/SDHC/SDXC card storage space is full, cameras will stop recording. When
the network conneciton between VAST server and cameras is restored, videos in the SD
card will be transmitted back to the VAST server. Note that the videos that were not recorded
during the time when the network was disconnected will not be transmitted.

If the videos on the cameras belong to those that are about to be erased within 24 hours (e.g.,
for the lack of storage space on a VAST server), those videos will not be retrieved.

Limitations:

Retrieving video fragments from a camera can momentarily double the throughput of normal
video streaming.

Video streams recorded using the MJPEG codec is not supported by Seamless recording.
Seamless recording can only take place from a camera with 1 video stream recorded to a
maximum of 3 VAST servers. .

Onscreen Elements for Seamless Recording:

The associated icons will appear in the Liveview, popup window on e-Map, and the Matrix
view. The status icon appears on the upper right of the view cell.

Below is the description of the Seamless recording statuses and the indicative icons.
Normally the video fragments will be retrieved first, and then the event log:

@ Currently not recording video from camera, but is retrieving data from camera due to
previous disconnection.

o Currently not recording video from camera, but is retrieving event log.

@ Currently recording video to system as well as retrieving data.

Q Currently recording video to system as well as retrieving event log.

After a period of time, the gaps of recording (those blue lines or blocks representing network
interruptions during the recording) should be gradually stitched up. It is, however, system
integrators' responsibility to build a reliable network. Additional bandwidth should also be
available for retrieving fragmented recordings from the camera side.

The VAST checks for the need for retrieving fragmented videos by every one minute. If the
retrieval failed due to some network faults, the server will re-try the retrieval tasks later on.

I o

U 2014-04-25
18:00:00
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In the Playback utility, you can select the tabbed window on top of the device tree to select
"Seamless Recording Status." If, after a cable disconnection, you can select to check if the
Seamless recording has duly performed a recovery.
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Note that when a cable is disconnected, the Seamless Recording Status may not immediately
display a disconnection event. The timeout for a disconnection is 1 minute, and the VAST server
and camera will take some time handling the disconnection and re-connection. Even you notice
the disconnection on live view, the Seamless Recording Status may take longer than 1 minute
to display the current status.

Status Description

Camera is Disconnected|The connection between server and camera has not been restored.
Standby Standing by for recovery.

Recovering Recovering recording data from camera.

Revover failed

Recovery errors occurred, and recovery failed.

Recover successfully

Recovery success.

No Need to Recover

No Need to Recover.

Ul Elements

ltem Description

Start time Beginning of a disconnection.

End time The end of a disconnection.

Time Zone Time zone of the disconnection event.
Description Length of the disconnection.

Status The handling status for the disconnection event.

Frequency of Recovery

The attempts made to recover data.

Last Recovery

The time the last attempt was made to recover.




Enable SVC

If the camera to-be-added supports the latest SVC (Scalable Video Coding) feature, select the
SVC checkbox to enable the related control. The SVC feature enables streaming of videos for
multiple clients from one single set of layered IP packets. Designed for saving bandwidth and
CPU load on client stations, the frame rate of a video stream appearing through a view cell
can be individually adjusted. This feature applies when an administrator experiences unstable
video streaming due to the lack of network bandwidth, less-than-ideal hardware, or during an

occurence of network problems. _
[ &f 30fps
’ — | Client PC

VAST Server

25fps
Notebook

-

Network Camera
5fps

3G Cell Phone

60fps
NVR Storage

The VAST server (rev. 1.6.1 and later) automatically negotiates with a camera and determines
whether a network camera comes with the SVC feature.

To configure the SVC-related feature:
1. When inserting a new camera into your configuration, select the streaming option, usually the

stream #1.
Camera List .
Video |AudiD |Rethe Focus |NTF‘ Settings |F‘anoramic F‘TZ|
...... = i
- VVTK—StatIDhluz?'D' O [Fishe\,re mode (MaX 15fps) v]
= Mega-Pixel Netwe
= Mega-Pixel Netwe
Yideo stream: -
= Mega-Pixel Metw [Stream 1 ]
I 25% Zoom Speed | | | Codec type: (H.264 ~|
e (D Metwork Carnerai : [MPEG-4
b 2D Maga-Pixel Metw Frame size: H.Z54
Maxirnurn frarne rate: IPEG
L ' J
Wideo quality: [Cunstant hit rate v] l4 Mbps v]

Copy settings to |E| [ Save ] [ Close




2. Right-click on the view cell of an SVC-enabled camera. Select SVC fps adjust bar.

Mega-Pixel Network Camera 2011j07427 111707

Remove

v Single View Ctrl+v
Full Screen Ctrl+F
Others 3
Fisheye Settings »

SVC fps adjust bar

3. A slide bar will appear above the view cell. Click and drag the slide bar. A numeric indicator
will display the current selection. See below for the frame rates represented by the numeric
indicator.

Indicator Frames per second (fps)
Maximum 30

7 26

6 22

5 18

4 12

3 8

2 4

1 1
Minimum 1/4

ﬁ NOTE:

The SVC feature only applies to H.264 and MJPEG streams. It is not applicable to MPEG-4 streams.
Please refer to Configuration -> Media -> Video for individaul stream settings.



If you have multiple SVC-enabled cameras, you can enable a collective setting via the Adjust
SVC level button on the tool bar. The frame rate selected here will then apply to all view cells on

the VAST LiveClient console.

[:System | Edit | View | Configuration | Layout | Help)

ogla]w]af&]« O [aEE < >

- Bl Eric_YVTK_Station(192.168.4.104)
- S Camera Maximum
: : . reomrer Camera

------ @& Mega-Pixel Network Camera(192.

Please note that the SVC related setting can not take effect while the LiveClient station is
running the Layout Rotation. Stop the layout rotation before configuring the SVC function.

g;

While you save your bandwidth for live viewing, you can still record full-frame-rate video by changing the
recording setting. For example, you can enable resource-saving SVC on stream #1 and configure stream
#2 to be recorded with full details, in terms of frame size, frame rate, and video quality.

———— - B

Camera List
_ Camera Name: [¥] Auto
------ EricVAST_Station1(192.168.4.
Address: 192.168.4.134
Model Mame: 1P8352
MAC Address: | 0002D1117A3D

Connection Test
Connection Settings| Recording Settings
Basic Settings
I Recording Stream: 2 ;‘ I
Pre-avent Time: 10 = seconds(3-15)
Post-event Time: 10 = seconds(10-60)
Activity Adaptive Stream
[T Active if possible 3
[¥] Automatically add camera into recording storage | DefaultGroup IZ|

J il | Insert ][ Close ]




Streaming URL

You can enter a camera's IP address to add a camera's RTSP streaming for live view and
recording, and playback.

To insert a camera using the URL-like command,
1. Select the camera Brand as "URL."

[ Comiaen Mamagemant o VS _Station - et
Camera List

o B s smmeet1ar.0.04)

e UL

Camena Hame: ¥t
Addrea 19206340

Hooa Harme:

MAC Address (00207 J006E2

URL s

Cornemon Ted

ot RGN | Ritonding Settngi

| atperaticaly add CIrTan Fon Mcoreeg Rorege | Defellios

2. Enter the camera's IP address.

3. Enter the camera's MAC address as printed on the camera label, or one found by the
Shepherd utility.

4. Enter "554" in the Configuration port.

5. Enter "live.sdp" in the URL field, as this is part of the original RTSP streaming command:
"rtsp://172.18.204.58:554/live.sdp". If streaming stream #2, enter live2.sdp.

Note that the free 32 channel licenses does not apply when inserting a camera using the
URL command. Only the live view, recording, and playback functions are supported if thus
connected. All other functions are not supported, such as auto streaming size or changing to
another video stream. Camera DI/DO is also not supported.



Insert NVR (Network Video Recorder)

1. Before you can include an NVR system into your current configuration, you should enable
the corresponding configuration on a web management console with the NVR system. In
Configuration > System > VAST, click on the Enabled checkbox and enter a password for
authentication.

HITP Part ]
HETPS Poit a3
EBTSP port o
WS B Viewee

u Alory acoe

D) s panwornd b5 oy for CMS conmectan, Wiewer Login scount i
thet SemiE 5% MWVR

For: 3454
CM5 passwond:

Confirm passweord:

2. Return to your VAST management screen. Left-click to select your VAST station on the navigation
panel, and then right-click to display and select "Station Management..."

(System | Edit | View | Configuration | Layout | Help)

|

Camera Management »

F:J ------ = Camem
5

@M Network Camera ( Station Management... )

& Mega-Pixel Netw
- @MW Network Camera
- BB Video Server(192
& Mega-Pixel Netw
- @M Network Camera
------ EN Network Camera
G- [ Recording Storage
- [ Layout

(= NWVR({60.251.25.60)

E Camera

P Recording Storag

User Management...
Association Management...
Event Management...

Virtual Matrix Management
Station Settings

Find...
Output Streaming URL
Get PublicIP

- —




3. The Station Management window will prompt. Enter the Address, Password, and check if the

Communication Port match that you set for the NVR. Click on the List Sub-Station Hierarchy
button.

i 1
A4 Station Wanagemen 5

Station Tree for VVTK_Stationl

Address:

( 60.251.25.60

B Tk station1(192.168.4.105)

Con

Password:

( 3454

Communication Port:

-

-

)
)
)
)

List Sub-Station Hierarchy ’ Insert H Search...
Hierarchical ma nt tree

Update

After a brief delay, the NVR server will be listed in the column. You may also use the Search
button to locate similar devices if they are reacheable in your local area network.

4. You can then click the Insert button to add the NVR server to your configuration. When
done, click the Close button.

A4

r——
tation Management for VWTE_Station! LJ
Station Tree for VVTK_Stationl . 60.251.25.60
v B WYTK_Station1(192.168.4.105)
Password: eee
Communication Port: 3454 =
| [ Insert ] D Search...
nt tree
Insert Station ul 60)

Elzpsed time: 0:00:02

Update

Coo= |



VIVOTEK - A Leading Provider of Multimedia Communication Solutions

5. The NVR will appear in the navigation panel along with its subordinate cameras.

System | Edit | View | Configuration |

- B vyTK_Station1(192.168.4.105)
= camera

- M Network Camera(192.168.4.133
& Mega-Pixel Network Camera(192

EM Network Camera(192.168.4.104
- (i) Video Server(192.168.4.115)
= S Recording Storage

- [ DefaultGroup
........ - Laq,!out

PBM Rrecording Storage

To enable the detection of NVR DI/DO signales,
1. Enter Configuration > Client Settings > General Settings. Select "Keep detecting DI/DO status."

Note that you should restart the VAST console for the configuration to take effect.

System Settings
Dwmﬂﬂmhwmm

¥} Autnmaricaly deplay i ful scraan aftar login

1 Autn add nevh-nserad cemess oo vdeo cel
iRetrve RYSP stream on soechied port: 4541 |-
[ Cornisce sehstation strearmg va ridy

[ Kep detectng DYDO status

[71 Sort camera: by name

Alarm Setings
[#] Enable b atum natfication

1“1 Enable alert saund(s)
] Enable £-Hap popup windew
Al windaw mode: @ Feed
) Popun
Rotation Settings
[l erabie rotaton after gn
Ratate the page every 10 B secondls) (3~ 599)

Display Settings
Missimum rurmber of vew cels (64 x|

¥ Enable auto stream sce: [Quaity it |
[7] Enable de-nteriace function
[ Enatie Instank Reoley on video cel
Defaut repay engin: (30 seconds <]
Local streamng buffer tme: 0 5] milsecondls) (0 ~ 10000)
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VIVOTEK - A Leading Provider of Multimedia Communication Solutions

The NVR's DIs and DOs will be listed on the device tree. Note that the DI/DO status is not supported by
NVRs running an embedded VAST software.

System | Edit | View | Configuration | L

VMS_Station(127.0.0.1)
- Camera
P Recording Storage
B Yo Box
A Layout

=

Insert a Video Server

1. Left-click on your VAST station, and then right-click to display the Camera Management
command. Let your cursor stay on the command for a second and then move to the Insert
Camera command. Click on the command to open its configuration window.

SES LR Ed B

Camera Management ) (> Insert Camera...
Station Management... Update Camera...
Logical Tree View Management... Delete Cameras...

/O Box Management 3 Batch Insert Cameras...

User Management... Camera Configuration...

Association Management...

Alarm Management...

Virtual Matrix Management 2
Search VivoCam Switches...

Station Settings 3
Find...

Output Streaming URL

Output Camera List

Get PublicIP

110 - User's Manual




2. See below for the steps to insert a Video Server along with its subordinate cameras.

- -
%4 Camera Management for WWTK Stat ‘ﬁi 0 g

| Camera List

Camera Name: [¥] Auto

4

= B VVTK_Station1(192.168.4.105

Y - Y= —=]=-—

@M network Camera(192.16§  Address: 192.168.4.115
@ Mega-Pixel Metwork Came
o (@M Metwork Camera(192.16¢

Model Name: V58401

MAC Address: | 00ABCDABCDEF

I_I -
Connection Test
Connection 5ettings | Recording Settings

User Name: root Password: ssssssf

Configuration Protocol: |[HTTP - Configuration Port: 80 =

Streaming Protocol: TCP - Channel: 1

Initial Viewing Stream: 1

(5)

[¥] Autormatically add camera into recording storage | DefaultGroup E

2-5.

2-6.

. You can deselect the Auto checkbox to enter a name for the Video Server. If set to Auto and your

video server already has a name, that name will be displayed in your device list.

. Enter the Address of the video server - or - use the Search | .| button to open a Search window.

. If you enter its address and it is found after you click on the Detect Model [<%/|button, its Model
Name and MAC Address will be listed.

. Before you click the Detect button, you should enter the User Name and Password for access

to the video server. You should also confirm the Configuration Protocol, Configuration Port,

Streaming Protocol, and the rest of the networking parameters.

You may select or deselect the checkbox in front of the recording storage option - or - use the pull-

down menu to select the default group or a pre-configured storage group.

You might use the Connection Test button to verify if the stream comes from the device you prefer.

Click Insert to include the video server to your configuration.

The Video Server should now be listed on the Camera List.
You can also use the Search button to poll the local area network for VIVOTEK's devices. You can
select to list all cameras or list those that have not been included in your current configuration.
Click on a device, and its detailed information will immediately appear in the Camera Management
window on the left. For recording settings, please refer to page 98 as previously described.

LET the cameras which ane not indarted

] Lt al camems Fiafrash
Cammera List
MAL Address Hodel HTTR Part

S
152 168.4.122




Update Devices

Please follow the steps below to update a device via Camera Management window:

a. Click Configuration > Camera Management > Update Camera on the menu bar (or right-click the
device/station, then select Camera Management > Update Camera).

b. The Camera Management - Update window will pop up. The device tree managed by the station will
be displayed in the left Camera List window.

c. Select a device from the list you want to update. Its related information will automatically be displayed
in the corresponding fields in the Camera Management window. Then you can modify Connection
Settings and Recording Settings of the device.

d. After modifying the settings, you can click Connection Test to preview the live video from the device.
e. When all settings are completed, click Update to enable the settings.

Delete - e
Refresh l
Camera Settings

Camera Management » Insert Camera...

Cutput Streaming URL Lt

Send to Talk Panel

" Camera Configuration...

Uelete Lameras...

% Camera Management for VWTK Stationl - U

Camera List
Brand: WIWIDTER

& YW TK Station1(127.0.0.1) |
L @ 20x Zoom Mega-Pixel SpE| Module: -

@ - SV Mega-Prel Network Came
o M Mega-Pixel Network Carne

Camera Mame:  20x Zoom Mega-f

Addrass: 102.168.6.143

Model Marme:  |SDE363E

MAC Address:  |000Z012150FE

peed dome

Connection Test
Connection Settings | Recarding Settings

Lzer Mame: Pazsword:

Configuration Protocal: Configuration Port: 20 =
Streaming Protocol: oP - Channel: 1

Initial Wiewing Strearm: 1 =

[ Lpdate ] [ Close




Delete Devices from the VAST Server

m Delete a device:

Right-click the device on the device tree, then select Delete. A dialog box will pop up. Click Yes to
delete the device along with the recorded data; click No to delete the device but retain the recorded
data; click Cancel to cancel the delete action.

El ------ h Carmera
B & 20: zoom Mo gfolonondy :’ j
ﬂ DI-1 | Delete v Are you sure you want to delete this camera along with recorded data?
@ oz | Hetresh -
- o3 I Carnera Settings - fes | [ Mo ] [ Cancel
N ﬂ D4 | Camera Management 3
- g DO-1 %
@& D02 Qutput Streaming URL
- C3D Mega-Pixel NE. Send to Talk Panel

= Delete more than one device at a time:

a. Click Configuration > Camera Management > Delete Cameras on the menu bar (or right-click the
device/station, then select Camera Management > Delete Cameras).

b. The Delete Cameras window will pop up.
c. Select the devices you want to delete from the list, then click Delete.

d. A dialog box will pop up. Click Yes to delete the device along with the recorded data; click No to delete
the device but retain the recorded data; click Cancel to cancel the delete action.

e. When completed, click Close to exit the Delete Cameras window and return to the main window. The
deleted device will disappear from the station.

B v stationa(az7.0.0.1)

B=r camera
PEE o : iy
@ d fefresh "

ﬂ I Camerna Setfings
ﬂ I Carmera Managermenl k lrerl Carmera..,
- H Clutpart Strearsing LIRL Spdure Camern_

) ™ |: S s Tolk Bl Deletes Cameras

o TP Megs EEmm— Lamera Lonhguratson.
[ T -

Address Part Mached Marme
192.168.6.143 a0 SDE363E 20 Zoom Mega-Pixel ...

________ 2 Mega-Pixel Network Ca...
192.168.6.219 20 1PE332 Mega-Pixel Network Ca...

#
1
3

S
AR

G €]
LDSeIect all I Delete l Close ]

] T ———

"
{'r_ ;\: A yOul SUNG piLl want B0 dolete s camera along with reconded data?
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Batch Insert Devices

Batch insert is a very useful function that allows user to search, filter, and import a row of
devices that are in the same LAN to a VAST station. The basic settings can also be applied to

those inserted devices simultaneously, e.g., a common user name and password.

Please follow the steps below to batch insert devices to a station:

a. Click Configuration > Camera Management > Batch Insert Cameras on the menu bar (or right-

click the station, then select Camera Management > Batch Insert Camera).

b. The Batch Insert Cameras window will pop up. Then click Search to open the Search Camera

window.

c. On top of the Camera List window, you can select "List the cameras which are not inserted" or "List
all cameras". The items listed below will then change accordingly. You may select ONVIF-compliant

cameras as well using the Brand selector.
d. Use the 4 Filters to narrow down the range of the wanted cameras from the list.

® |P Range: Type in a range of IP address to narrow down the list; the filter automatically applies after

you fill in a correct IP range.

x Batch Insert Cameras

(=T E)

Instruction
Search button Edit Connection Settings
Specify Address button ->  Import into List ->  Edit Recording Settings - Insert button
Irnport From File button Edit Video Settings b
# Marne Address Part Model  MAC Status Search...

I

Specify Address...

[

Irnport From File, ..

4 Search Cameras

Brand: |WIWVOTEK -

@ List the cameras which are not inserted

_ List all carmneras

Camera Mame:

Connection Setting [ address Range:

User Mame: .
[ address with prefix:

Configuration Prot .
Model with prefix:

Streaming Protocd )
MAC with prefis

Initial Wiewing Strd

v 53]

|

id
Set following filters to narrow down the range of searched cameras.

# Address Part Brand Mods!
1 192,168.6,143 20 SDe363E 00-02-D1-21-530-FB
r oz 192.168.6.101 20 FES173 00-02-01-81-73-03
3 192,168.6,219 20 IPa3z2 00-02-D1-19-2D-02
Select Al (a4 ] [ Cancel

Recording Storage

&dd the cameras to the recording
storage:

DefaultGroup (3/256 CH) -

I Insert ‘I Close

|




m |P with prefix: Type in the prefix of the IP address to narrow down the list.

% Search Cameras EJ

O List the cameras which are not inserted
() List all cameras
Filters

Set folowing filters to narrow down the range of searched cameras,

[[] address Range: ~

[] Address with prefie |192.168.5,132]

[(Iraodel with prefix:

[CIMac with prefie

# Addrass Port Model A

r 1 192,168.5,132 20 FD2161 00-02-D1-FD-21-15

= Model with prefix: The user can type in the prefix of the model name or the complete model name of
the cameras to narrow down the list.

¥ Search Cameras E]

O List the cameras which are nat inserted
(@ List all cameras
Filters

Set following filters to narrow down the range of searched cameras,

[ address Range: s

[ address with prefix:

Maodel with prefix: Foe161|

[CIMAC with prefic

# Address Port todel A

1 192,168.5,132 a0 FD2151 00-02-D1-FD-81-15

= MAC with prefix: You can type in the prefix of the MAC address of the cameras to narrow down the
list.

¥ Search Cameras E]

O List the cameras which are not inserted

@ List all carneras

Filters
Set following filkers to narrow down the range of searched carmeras.
[ address Range: ~
[ address with prefis:
[CIradel with prefic
[IMAC with prefis: 00-02-D1-FD
# Address Part Model MAC

M1 192.168.5.132 a0 FDE161 00-02-D1-FD-831-15
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e. When the list is filtered, you can select the cameras one by one or check Select All to add them to the
batch insert list. Then click OK to finish searching.

Lt the carmeras which are not insgrted
2Lkt l camerss
Fiters
50t folowing flters. to narmow down the range of searched cameras,
[Flnddns fapgo: 1920685 | o (1920685 |
Claddoss wihi profic | I
[Mogel with pred; | |
Ot withprefts. | 1
P 1 192.158.5.131 ] o133 D002 085530
F 2 192,168 5,152 g Fo1a1 00201 P08 15
F 3 192 168.5.119 & FELE 00201320353
TGkt & () B==0

. The selected cameras will be shown on the batch insert camera list with the camera information and
the connection status. When you click on a camera, a live view will show up on the right side for you to
identify the cameras on the list. If you want to remove a camera from the list, click the trash can icon to
delete it.

Instruction

Search button
Specify Address button

Irnpiort From File button

Edit Connection Settings
-» Import into List -»  Edit Recording Settings -2 Insert button

Edit Wideo Settings

—h

-
# Marme Address Port  Model  MAC Status [ Search... ]
@ 1 20% Zoom..,  192,168.6.143 a0 sDas.. 00-02-01-21-30-FB  OK [ = ]
® = Mega-Pie.. 192,168.6.101 80 FES173 00-02-D1-8173-03 OK Snecldoiessm
'ﬁ 3 Mega-Pixe... 192.168.6.219 g0 P332 00-02-D1-19-20-02 Ok [ T v e ]
i |
i ~
Camera Mame:  Mega-Pixel MNetwork Camera
Connection Settings | Recarding Settings I
Lzer Mame: Password:
Configuration Protocal;  |[HTTP - Configuration Port: 80 E
Streamning Protocol: TCP - Channel: E
Initial Yiewing Strearm: 1 E
Recording Storage
Add the cameras to the recording
storage:
Apply to Al

none
DefaultGroun (3256 CH)
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g. At the bottom of the window, there is a field for you to alter the camera settings including Connection
Settings and Recording Settings. You can apply the new settings to each camera on the list, or
click Apply to All to apply the same configurations to all the cameras. For more information about
Connection Settings and Recording Settings, please refer to Insert Device on page 96 for detailed
information.

h. Specify host: If you want to add a camera to the list, click Specify

Address to directly add a wanted camera. Click Add after filling in | , ... 102.168.5.131
the correct information. The camera will be added to the list of the | ~
Batch Insert Camera window. Configuration Protocol: 3

i. By default, all inserted devices will be applied to the default CofiguiEiien Zait a0
recording group. Deselect the Add checkbox if you do not want to
assign the selected devices to the default recording group. User Narme:

j. Click Insert when all the settings are done. Cameras will be added. Password:

~
w

Add ] [ Close

=9
When you modify the camera settings, and when the connection information (User Name, Password, Configuration
Protocol, Configuration Port, and Streaming Protocol) does not match the current network environment, the camera

will be disconnected and the status of the camera will become “Camera cannot be found” as shown below.

&4 Batch Insert Ca Ui X

Instruction
Search button Edit Connection Settings

Specify Address button  -=  Impott into List - Edit Recording Settings ->  Insert button

Irmport From File button Edit Video Settings
|
# Marne Address Part Modsl  MAC Statls ’ Search... ]
f& 1 Mega-Pixe.,. 192.168.5.132 443 FDS161 00-02-D1-F0-/.  Camera cannot be found. ’ Specify Address ]

(I Mega-Pixe.,. 192.168.5.131 443 FDE133 00-02-D1-0B-, .  Camera cannot be found. |
& 3 Mega-Pixe... 192.168.5.119 443 IPE132  00-02-D1-32-,.  Camera cannot be found, [

m

Import From File. .. ]

vl

w

%

Camera Mame:

Connection Settings | Recarding Settings

Uzer MName: Password:
Configuration Protocol:  [HTTP - Configuration Port: 80 =
Streaming Protocol: TCP - Channel: 1 :

Initial viewing Stream: |1
Recording Storage

Add the cameras to the recording
storage:

spply to & | | [DefaultGroup (3/256 CH) -

[ Insert ]’ Close ]
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You can enter a User name and Password and use the Apply to All button to apply this combination
to all selected cameras. This way, you do not need to change the user name and password for every
individual cameras.
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Camera Configuration

The Camera Configuration function group provides immediate access to the video streaming
and other settings without the need to open a web console. The function group is accessed by
selecting a camera on the device tree, and right-click to select Camera Management > Camera
Configuration. If you have new VIVOTEK cameras and the VAST server can not recognize
their features, see page 84 for how to update camera information using the Device Pack update.

= Wy TK_Station1(127.0.0.1) ‘

= F=r camera
IS Ko
...... (I—'p Me
Refresh
PEe EM e c ot
______ E Recordir amera >ettings
P Layout Camera Management J Insert Camera...

Output Streaming URL Update Camera...

Send to Talk Panel

i = Camera Configuration..

Delete Cameras...

= FOV (Field of View)

The FOV configuration is available for 5 megapixel cameras (such as IP8372 and IP8172P),
which allows you to crop a portion of the image captured by the sensor. The FOV setting ap-
plies in the scenario where you do not need all of the video a camera can capture. For example,
when shooting a parking lot where the upper half of the image is the sky. Cropping a field of
view can help save bandwidth and reduce the requirements for storage space.

Mo e ==

. W;i“ ] . Wik | o | emots Foous | NI Settings | Panorame PTZ
VYT Station2(127.0. | pey =
M repa-Poel Metwe) m T m:ada ) !
B Mega-Preel Metwr] ) ANEOF Full M0 (M&¥ 30}
“Mull"m!h:lm: Vst (aear L =
B s bt tect(1a Codier, by ,5:1.":- -
B Mage-Puel Hetw ) X
From s 75‘:"_?5? x| i
P T rafes :15 fﬂS 'I'I
Video qualty; | Coredank bit rate =| |6 Myr -|
" | Copy sattings toc e | dose
= VVideo mode .
For cameras having resource limitations such as hav- o | [ ckee |

ing a lower frame rate when supporting dual streams, or
lower frame rate when using the Rotation mode, its vid-
e0 mode is automatically displayed in the Video window.



= \ideo

This tabbed window privides access to the selection of the live view stream, its compression co-
dec, frame size, max. frame rate, and video quality. Note that the Constant Bit Rate methodol-
ogy can be used to ensure that the size of video stream does not exceed a preferred threshold,
regardless of the complexity or the changes of pixels in the image. You should use a maximum
of 1080P as frame size and 6Mbps as constant bit rate for video streams managed by this
system. .

%4 Camera Configuration e
Camera List Video | Audio | Remote Focus | NTP Settings || PAmramic PTZ
= — 3 | 1
g WK _5tation1(127.0.0. 1) || yideo stream: = =
3P Mega-Fiel Network -
(&M Mega-Pixel Network | COOEC type: svc -|
... [ Miega-Poeed Network r
g ) Frame size: 1056x 1056 ,]
- (M Mega-Fiocel Netwark
-G Mega-Pinel Network Maximum frame rate: [15 fos ,]
Video quality: Constantbitrate = | [4Mbps |
-l U E Copy settings to: | ': Save I l Close ]

If your camera supports the Smart Stream function, the related options will be available with the
Video quality. Note that only the Auto mode option will be available.

Auto: When set to Auto, only the moving objects and the areas around them will be displayed
with the Foreground quality. The rest of the screen will be displayed with the Background (lower)

uality. > -
T e R —

Camera List

Video | audio | Remote Focus | NTP Settings | Panaramic PTZ

= E YWY TK_Station1{127.0,
& Mega-Pixel Metur

EM Mega-Piel MNetwr | Codec type: H.264

EM Mega-Pixel Metw:

[N Mega-Pixel Metwy | FTame size: 19201080

videno stream: Streamn 1

Maxirmum frame rate: 30 fps

Yideo quality: Smart stream (auto r|Z|

Constant bit rate

Fixed qualit

Smiart stream (auto mode)
Background quality: | Mediurm

Maximurn bit rate: 40Mbps

Copy settings to:
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= Audio

If audio feed is preferred, configure the audio codec type, sampling bit rate, and operating mode
in here.

=

Camera List Videa | Audio ww Panararic PTZ |
E,._..- WTK_Station1{127.0.0.1) | [@]Enable audio
Audio codec type: Ib}
Made: l.E J
im0 ] coysettogstor [ v [ swe | [ cese |

User's Manual - 121




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

= Remote Focus

For cameras supporting the remote focus feature, such as the FD8362E that comes with a motorized
lens, this window provides finetune buttons and full-range scan fucntion to help reach the best image fo-
cus.

T far

e j-p;msam_luenmamm bl

E""! 0‘ nl&.smmnmu(mn-u.nk Sixce! N & mera BRI 12206 PM
i Gt F 9
S EEE Mega P Network L
- BB Mega Pocel Netwark

- [EN Mega 2 Network
8D MegaPuel Network

5 \\ '\

roas (=] O

B P —| ' copysettngstor | [ e [ ks

m NTP Settings

If cameras’ real time clocks are set to be synchronized with a time server, enter the NTP server’s ad-
dress or domain name and specify an Updating interval. If you select the “Synchronize camera time with
system automatically” checkbox during the initial setup, the NTP server IP will be the VAST server’s IP.

Always remember to Save your configuration before leaving this window. You can also use the “Copy
settings to” button below to duplicate your current settings to adjacent cameras.
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» Panoramic PTZ

Please refer to Appendix B Panoramic PTZ configuration on page 339 or the Panoramic PTZ
Installation Guide for more information.

Camera List

| video | Audio | Remote Focus | MTP Sattings | Panoramic PTZ

Enable panoramic PTZ
i (DM Metwork Carneral

= Y iega-Pixel MNetu

[CEnable auto tracking

E

Copy settings to; El I Save I I Close ]
L.-:— - —
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View Live Videos

The server will automatically add a newly-inserted device to the video cell for live viewing.
You also can double-click the target device or drag-and-drop the target device from the
hierarchical management tree to the video cell.

= WY T _Station1({127.0.0.1)
= BSr camera

"R 1 FD216

Bm recording Storage

E Layout

1_FD8161

Dual / Multiple Streams

I3 Live View ﬁ Matrix Wigw

201040803 AM 11:25:23

For dual-stream devices, you can right-click on the focused cell to select stream 1 or stream 2. For
multiple-stream devices, you can select from stream 1 ~ stream 4.

= WVTK_Station1(127.0.0.1)

= By Camera

"R 1 FDE161(192,168.5,132)

P recording Starage

B Lavout

Fisheye Display Modes

03 Live View ﬁ Matrix Wiew

1_FD8161

2010/08/03 AM 11:25:23
—— o i

Pemann

Singgle Yiew

Full Scsman

Emahle PP

e Hobal Viev

Ermitile Tnmer Bty
Strmyre L (1290720
Stream 2 (1280720}
Seraar 1 (176144)
g 4 (1901080

Cthers (]
Widhed Enhancgrret 0

By default, a circular view is displayed when a fisheye camera is successfully connected. To
display Regional, Panoramic, or the combination of different views, right-click on a fisheye
camera's live view to display the associated commands. The display modes available are: 10
(Original), 1P (Panoramic), 1R (Regional), 2P (2 Panoramic), 103R (1 Original & 3 Regional),
4R (Quad Regional), 108R (1 Original & 8 Regional), and 4R Pro (4 Proactive) modes.

0 Live Vi

Mega-Pixel Network Camera

Linglhe View
Full Sereen

Ermbile rdant Regley:

Steam 1 (TGETES)
Etream & (T68=THS)
Streamn 3 (15091536
Send to Talk: Panal
St GO

Lo T H

Video Enkancement
Videno Displey Mode

Hdnr,.'f (rspdery Mode

i T "t""‘l'

vy

"ff' iE *‘3




Fisheye Display Modes: below are conceptual drawings for different display modes.

10 (Single Original) Display mode: 1R (Single Regional) Display mode:
An Original oval view covers the A Regional view crops a portion of the hemisphere
hemisphere taken by the fisheye lens. as a region of interest. You can zoom in or out or
move the view area elsewhere from on the regional
10 View (Original View) e
— - 1R View (Single Regional View)

180° Hemispheric

Zoom in/out
&
all-direction
navigation control

A Regional view is dewarped, by correcting images
from the distorted oval view to a rectangular and
visually proportional image.

1P (Single Panoramic) Display mode:

With image correction algorithms in firmware, the hemispheric image is transformed into a
rectilinear stripe in the 1P display mode. Viewers can use the PTZ panel or simply use mouse
control to quickly move through the 360° panoramic view.

Note that the 1P view is apt for an overview, the Zoom in/out function does not apply in this
mode.

1P (Panoramic) Mode Screen Control
X e Viaw

Mega-Hixel Mebwork Camena




2P (2 Panoramic) Display mode:

Two dewarped rectangular views are placed one on top of another each showing 180 degree of
panoramic view. The 2P view looks like the upper view shows the front of hemisphere, and the
lower view the rear half of the hemisphere.

2P (Panoramic) Mode Screen Control

N L Vikw

‘- "LI 4‘&3—‘ i

" Swipe to scroll hofjlhzont_ally %Hﬁ}

3T s

_Ir'- '-JHHHI hﬁ

103R (One Original & 3 Regional) Display mode:

Fisheye cameras also support the display of multiple regional views taken from within the same
hemisphere, and they can be displayed with or without an Original view in its view cell.

3R View (Regional View)

Zoom in/out
&
all-direction
navigation control

* Only two regional views are shown for simplicity reason



PTZ Mouse Control

The "Mount type" setting also determines the display modes available to your display modes.
Please refer to fisheye camera's User Manual for more information.

A highly versatile mouse control is implemented with fisheye cameras. The same control takes
effect on a browser management session, on the LiveClient utility, and even on a video playback
screen. See the drawing below for how it works.

You can click and hold down the left mouse button to quickly swipe through the field of view,
change the view angle, or use the mouse wheel to zoom in/out on a region of interest. However,
the PTZ mouse control is only available in the "R" (Regional) mode. In the Panoramic mode,
you can only scroll horizontally across the 180° or 360° panoramic view.

103R (Original & Regional) Mode Screen Control

3 Live View

Mega-Fixel Mebyork Camera

> Interactive

ZoomIn  ZoomOut regional FOV indicators

<z _

— Current screen selection

@ Pan or tilt

Click to bring into
center of view ﬁ —>Click and hold down
— " @ the button

ge

The various display modes require the support of D3D technologies by your display card on the
LiveClient or Playback station. Most off-the-shelf display cards today support this feature.

The onscreen mouse control is very agile. Therefore, use the PTZ panel for more delicate
moves in a field of view. Pan and Patrol moves are also supported if you have configured
preset PTZ positions in the camera's firmware. Note that the Pan move takes place in the
Panoramic and Regional views, while the Patrol function through preset positions applies only in
the Regional views.



Below are the conceptual drawings for other display modes. The available display modes can
different with different mount types:

Regular: 10, 1P, 1R, 103R, 4R.

Wall mount: 1P2R, 1P3R.

For more information, you can refer to fisheye camera's user documents.

4R (Quad Regional) Display mode: 4RPro (4 Regional Proactive) Display mode:

0 e 0 1w

Regional View #2 Regional View #1 ( Regional View #2 Regional View #1

)

Regional View #3 Regional View #4 g Regional View #3 g Regional View #4

108R (One Original & 8 Regional) Display mode:

20110901 05:41:35%

Mega-Pixel Network Camera

Regional View #3 Regional View #2 Regional View #1

Regional View #4 Original View Regional View #8

Regional View #5 Regional View #6 Regional View #7




Refresh

Right-click the device, then click Refresh, the camera information will be refreshed from the server.

B vyrie_stationL({127.0.0.1)
BEmy camera
i@ 20 Zoor Panmn Punt Craent

P voya P Dielete
@M MegaPin. (| Refresh

B recondng s, Camera Settings
E Larpowt Cameva Managermenl L3

Cutpust Strearming LIRL

Send bo Talk Fanel

Streaming Server

Right-click the station or the device and click Output Streaming URL. A .txt file with streaming URL will
pop up. Then you can use this URL to link to the live streaming through QuickTime Player.

Camess Man ) v .
B | e | — WWTK_Station1(127.0.0.1)
Stabicn Maragemant ;
5 = By Camera
i Logiesl Tepe View Mansgemant : : ||
. 10 B Mansgeoment ' e @ 20x Zoom Mega-f
] [ i Delete
By User Management o --G@D Mega-Pixel Natwg
L Assetiston Menegemet L e M Mega-Pivel Metwo e
= 1 Alarn P rnagyemmers + ______ E Recording Storage l Camera Settings
d  Virtusl Matsa Mansgemen '
e i C Il t ]
i e : B Layout amera Managemen
Gaarch VivaCam Dwitches ! Output Streaming URL
Batyew Satiings 3 i Send to Talk Panel
Find - —

Chitput Sireaming LRI

et Publc [P

Output Camera List

This command produces a text file containing cameras' brand name, IP address, and HTTP port
information. The camera list file can later be used for Batch Insert function, Import from File.

Get Public IP

If your access to Internet is via PPPOE, this function will display the public IP provided by your service
provider. If your access to Internet is via a router, please consult your network administrator or consult
your ISP for a valid public IP.

L

- P Camera Camera Management 4
E .. TR Me Station Management...
— h Recordin Logical Tree View Management...
E 3 h De’ 1/O Box Management »
e B User Management...
o [ Layout Association Management...
Alarm Management...
Virtual Matrix Management »
Failover Management »

Search VivoCam Switches.
Station Settings 3

Find...

Output Streaming URL
Output Camera List
Get PublicIP
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Camera Settings

Left-click to select a camera, Right-click, and then click Camera Settings to open a brower's session

to the camera.

2 Bl wyTk_Station1(127.0.0,1)

o BSy Camera
w 20 FOOpstnns Mienl Peed 0
O Mega-Fi Delete

P Recording Sto Camera Settings
Lo [ Layaut Camera Management 3

| Output Streaming URL
Send to Talk Panel

You must have an IE browser rev. 7.0
or above for opening a management
session.
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Remove Live Video from the Video Monitoring Window

There are two ways to remove a live video from the video cell:
Method 1. Right-click the video cell and select Remove.

= Wy TK_Station1(127.0.0,1)
= B‘ Camera
I“"B1 FDE161(192,168.5.132)
Pm recording Storage

B Lavout

I3 Live View ﬁ Matrix Wiewy

1_FD8161 2010/08/03 AM 11:25:23

T

-

Rernoy

Crl+Y
Ctrl+F

Ctrl+1
Ctrl+H

Single

Full Ser

Enable PiP

Hide Global View

EnableInstant Replay

Stream 1 (19201080
Stream 2 (1280x720)
Stream 3 (176x144%

Method 2. Drag-and-drop the live view from the video cell to the hierarchical management tree window.

= WY T _Station1(127.0.0.1)
= BE camera
@ 1 _FDB151(192,168.5.132)
Pm recording Storage

B Lavout

g¢

08 Live View | [ Matrix View

1_FD8161

2010{08/03 AM 11:25:23

If you want to remove all live videos from the video cells, please click E\ on the menu bar.

0|z & 0| « @S| 4= H

B e[




How to Change the VAST LiveClient Layout

Changing the Layout of the Live Video Monitoring Window

VIVOTEK VAST LiveClient supports up to 32-CH simultaneous video viewing on a single
monitor and allows you to change the layout of the live video monitoring window based on the
number of inserted devices.

Switch Video Channels

To move a video channel to another empty video cell, drag-and-drop the view to the target video cell.

To switch two different channels, drag-and-drop one view to the other, then the two different channels
will be switched to the opposite.
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Configure Layout Mode

Click the Layout button [ on the quick access bar. Select a desired layout mode, and the layout
window will be changed accordingly. Below we illustrate 15 types of layout modes and the corresponding
page numbers:

ofa][fofa] s [@) =B

Layout mode Description No. of Video page
1x1
2V
- 1P+2
3v
2x2
4V
2V+3
1+5
— 1P+6
3x3
— 1P+8
1+12
4x4
5x5
1+ 31

20 More than 1 video page;

P-PTZ modes — — rotation function is enabled

Only 1 video page;
— rotation function is disabled

BEEREEELEEEEBE0

= 2 NN O W 0o A~ N 0O

Configure Layout Mode

Click the Layout button [E] on the quick access bar. Select a desired layout mode, and the layout
window will be changed accordingly. Below we illustrate 11 types of layout modes and the corresponding
page numbers:
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The 1P+2, 1P+6, and 1P+8 layouts apply exclusively to the Panoramic PTZ configurations. Please refer
to page 325, Appendix B Panoramic PTZ Configuration, for details.

Normally, a Panoramic PTZ layout will consist of 1 fisheye Original view, 1 speed dome field of view, and
1 fisheye Panoramic view as shown below. Note that the interactive click-on-image control only takes
place on the Original and the Panoramic views.

e e e

Fisheye .

A panoramic vie
Fatid Plaacs  Soaie s T e s Doz gt
A Tocww MG Sownd AW AWM T Mg Slah wt
2w Sy JOEE Eed.. ANBOR AR sl Earing Whing [
0 Jivirw RN Sl S e ' e Bzt Tsh s Pt
Al Tocws. WG Sewesd AN A IS < Warring Sl S
o S0 MEEG RREd..  JULRMIII BOATATE sl Eacring FLAL - ==
20 Dars YOS Soeind. i) b o8 5 5 g b <k Astrdng Sun s g =
Bl Vit sruk T MY WA <D o g Sk -
g REE A AUSRORN A N e FaTing M o

Some layout modes (1x1, 2V, 3V, 2x2, 4V, 2V+3, 1+5, 3x3, 1+12, 4x4) will spread all video channels
into several pages. Some cameras support the video Rotation function for scenarios such as a tall, long
corridor or the inside of a vehicle. The Rotation configuration is made through a web console with such
cameras.

% viverzk _
i ad T B G M Home Client settings Qs-Lu-[Vicid-/l Language
Media >Image

General setings | Image setlings | Exposure | Privacy mask

Video Settings

Image Video fitle
Video 7] Show timestamp and video fitle in video and snapshots
Audio Position of imestamp and videa fitle on image | Top [
Timestamp and video fitle font-size: Small [x]
Color: ' BW @ Color
Power line fraguency: 150 Hz @ 60 Hz
e Video origntation | Flip [7] Mirror
Event [VjiRotate | g [=] Degrees

Applications

Save
Recording

Local storage




For example, under the 3x3 layout mode, you can switch among the pages by clicking and on
the quick access bar. To arrange the content of each page, manually drag-and-drop cameras from the
hierarchical management tree to the video cells on each page.

Page 1 Page 2 Page 3
FEEE TS ——

- Bokaa 2
B

'::"-.U_! it

i ——
e T s .

19120
DB
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Rotating Video Pages

elelwolal- @ FkETs

For layout modes that contain more than one page, the LiveClient provides the rotating function for
displaying all video pages in turn.

= To enable this function, click [ on the Quick Access Bar, which will become Stop Rotating, and
the video pages will start to rotate so that the user does not have to click || to move to the next page.

m To disable this function, click |&# Stop Rotating, which will become [EI on the Quick Access Bar.

You can also click Layout > Start to Rotate/Stop Rotating to enable/disable this function.

Layout | Help::l
| Btart Rotetion Ctl+0 |

Edit *

The default rotating time interval is 6 seconds. If you want to edit rotation settings, please refer to
Rotation Settings on page 241.

Edit Layout

Please follow the steps below to save a layout:
a. Arrange a layout mode and drag devices to their desired video cells.
b. Click Layout > Edit > Save to > New on the menu bar. A Layout Name dialog box will pop up.

| Layr{]ut Help ¥ Save Layout [zl

atart Eotation Ctl4O H [ Layout Mame:
e

| | e

Wew .. |Iaw:uut 1 |

—

[ (04 ] [ Cancel I

c. Enter a name for the the layout, then click OK to enable the setting.



d. Back to the monitoring window, the new layout will be displayed under the hierarchical management
tree as shown below. You can save up to 10 layouts.

e. To change to another layout, double-click the layout options on the hierarchical management tree, or
click Layout > Choose on the menu bar to select a desired layout.

Layout Help :I

E - Start Rotating Cirl+0
< [ Recording Storage J i _)I !H
E /O Box Save To 3 L el
_ b Layout Delete [
e B Officel Choose ' Officel '
l Multi-Layout 3 Office2 ‘

E Dffice2 ,

Office3

"R Office3
Bl Offices

= |f you want to edit an existing layout, arrange a layout mode and drag devices to the desired video
cells, then click Layout > Edit > Save to > New to save as a new layout or an existing layout to
replace with the new one.

Officed

Layout Help ;I

Start Rotating Ctrl+0 h| =
Save To » Mew...
Delete 4 Officel
Choose L Office2
Multi-Layout i Office3

’“ _ Officed

® |f you want to delete an existing layout, right-click the layout item on the hierarchical management
tree or click Layout > Edit > Delete on the menu bar to delete it.

= B yms_station(127.0.0.1)

+ M camers

‘ Layout Help :I

4 P Recording Storage Start Rotating Ctrl+0O E
- [ 10 Box Save To 4 J g E‘E
= E Layout Delete 4 Officel [
@ Officel Choaose 3 Office2
@ Office2 Multi-Layout » Office3
e I -
- E W

VMS_Sta Delete
- G MD9541(192.168.4.157)

o[

F.-

ge

Whenever you close the LiveClient or Playback programs and changes in screen layout have been
made, you will be prompted to save your current configuration.

R Contirn —- 3

i 1 : Layout has been changed. Are you sure you want to save the channels in the layout?




Scheduled Layout Rotation

In a configuration consisting of a large number of cameras, you can configure different layouts containing
view cells of different characteristics, e.g., a V view for a vertical, corridor scene, or a P view for
panoramic glimpse of the scene. With these layouts, you can configure an automated layout rotation.
Each layout will be displayed in turn, for a configurable dwell time.

10 sec 6 sec 6 sec

IT
L T T T

I | N |

8 sec

l
o

A time frame can be configured for each layout rotation. For example, one rotation may take place during
the office hours, while another will take place during the off-office hours. Configuring a time frame for the
layout rotation is optional. If not preferred, you can select the "Always" time frame template.

To configure a Scheduled Layout Rotation,

1. The precondition is that you should have multiple layouts created for your application needs.
2. Click on Layout > Multi-layout > Settings.

Configuration | Layout | Help /I

Start Rotating Cirl+0
0| &) @ |
o Save To k

Delete (-

(-]

TSI

.0.0.1)

i

Choose 3

1-EV(192.168.4.161) Multi-Layout 4 Settings... J




3. Click on the Add ® button to create a new scheduled layout rotation. Enter a name for the layout

bk

kst

Time Frame List

Lanyrast List

Avable Gyinld

‘o el S Lot =

+

1

Hamey  Dewvell Time  Diweson

i}

Larce

rotation. Avoid using these non-alphanumeric characters: (<>&"). -.

Click on the Edit # button to change the
name of the configuration. Click on the

Delete & button to remove an existing
configuration.

The max. number of multi-layout
configurations is 128. Up to 256 individual
layouts can pair with a time frame.

Note that you can not edit a multi-layout
configuration while it is performing a rotation.

4. Click on the Add button on the Time Frame pane to create a time frame. You can manually enter the

Start and End time, or drag the time frame for the span of time you prefer. When done, click on the
Add button to create the time frame.

You can use the Load Template button to select a pre-configured template, such as the Officehour,
OffOfficehourinWorkday, Weekend, or Workday template. Make adjustments to the span of time. You
can save your current time frame as a tempate for later use.

If necessary, select the days within a week, or the effective range for the time frame.

&g bk
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Click Save to complete the time frame
configuration.
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5. Select the layouts that will be included in the Layout Rotation.
When done, click on the Dwell Time and Division field to edit their appearance and behavior on the

live view.
Tine Frame Ruie
tirairame Dy Sattng
Torma frame for Layout RoLStGonE Whaithly Setting {Day-baad)
P —— L
[ pd || eac || Odeoe | [ w ]
fopiatia ysuts: Added tyouty:
© Dffkel i i e
O Office] ; At
II: Office? Offced 5 1n1 @
i ofess 5 :-v
‘1paa IIJ
ke
fra. v}
ay
P
-._......_.—.:1;!4 .
o 1
[ seece al e
= &
141
EE— | Cncel, |
1431
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If necessary, use the Delte button to remove a layout. Use the move @ buttons to change
the display sequence of configured layouts.

6. You can start a Scheduled Rotation in many ways. Once configured, a Layout Rotation icon will appear
on the device list. You can double-click on it to start the rotation.

=-- BE¢ Recording Storage

P DefaultGroup
- [0 1O Box
= B Leyout

Layout-rotation
Officel X 2

Office2
Office3
Officed

R

(=1

You can start a Rotation from Layout > Multi-Layout > Layout-rotation.

| Layout Help )
Stop Rotating Ctrl+O

Save To
Delete
Choaose
Multi-Layout

v v v

Settings...

| Layout-rotation
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A rotation automatically starts with pre-configured layouts if you configure the option in Configuration
> Client Settings > General Settings.

System Sl lings
Tl gutomarraly kg 1 s kgong i 0 abeuing walem
I ustomaccaly dapiey m ful screen s g
14wt add newty-nseted camena & vateo caf
I Rt TSR oo on dpmefe ot 441 T
[Tlgennae whitaton trasmeg v ety
Alarm Settings
1 Erairie bvi aiarm notfication
¥ Erabie alert sounds)
¥ Gradale [-0ap proe winidmr
£ Papan

[ retation sertings

¥ Erabie roeation st g _
Fatitn the page ey 10 R mesnd(s) (1869
Display Settings -

Samum e of e celi (04 =)

e soam s s
[ Erable de-iartaca fincion
I Gradis Iratent Regty on vdeo oM

Dt raptey it [ 3 acemat =
Low g buer e 0 ) palesnali) (0 10000}

[

To stop a rotation, click on the Stop button on the tool bar. This button turns red when a rotation is
taking place.

You can also double-click on an existing layout to stop the rotation.
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Maximize/Minimize the Live Video Monitoring Window

® Single View: to maxmize a video cell to the entire live video window

Double-click the video cell, or right-click the video cell and select Single View. The focused video will
occupy the entire playback window as shown below.

|_rDoi|

Full Sorpen
Enabla PP

Tromtde bmsdmet Forgalag
Straam 1 (1380720
Streamn J [TI0TI0
Stream T [(176x144)
Sereem 4 (13001080
Earecl 1t Tale Pavedl
Set 00

Cithars

‘Vidso Urharaosmant
Widen Dwgliry Mode

ST PP Adpast Bar

1 _FORTEL ZOTIFIEANE AM 1744230

E

Ealilaleitant Replny

e | {1400T20
Stream 1 (1280T30
Erndarn 2 1TiL44)
Stremm 4 (13001087
S 1o Tals Pargd

Ge DO
Dthrn

‘Wghpn I rhargarmant
Vickpn Dipley Mode "
L}
\

ST PP Adpast Bar

/ . 4 o

5 /e« ; ;ﬁ‘ /
To restore to the original layout, double-click the video cell or right-click the video cell and uncheck
Single View.




® Full Screen: Maximize the live video monitoring window to the entire screen

Click Full Screen @ on the quick access bar or right-click the video cell and select Full Screen. In
addition, you can also click View > Full Screen on the menu bar to maximize the live video monitoring
window.

To restore to the original layout, you can right-click a video cell and uncheck Full Screen or click the
Esc button on the keyboard to exit full screen mode.
Wiew ﬂinlqulllm Layoud _H

¥ PicPenel
W Twn Way Audin Pensl
Insbent Playback Panel

wf Al Winelow

Full Srees Col4F
Minimaze

o Mlalrog Vi |

= Minimize: If you click View > Minimize on the menu bar, LiveClient will minimize to the Windows tool
bar.

View Live Video on Dual Monitors

VAST also supports live video viewing on dual monitors, allowing you to manage a maximum of
64 channels concurrently on two screens. Moreover, the layout of the video monitoring window
on different monitors can be set up individually.

Please follow the steps below to set up dual-screen mode:

a. Set up dual monitors for your local computer.
b. Launch VAST LiveClient on monitor 1.

c. Click System > Second View on monitor 1, then the live video monitoring window will be displayed in
monitor 2 as shown below.

Monitor 1 Monitor 2

=

(System | Edit | View | Configuration | L:-'@t 2

: S o | ®f,

©‘nahle Click On [mage
Canguage r
Becond View 1.1} [« |8
E-Map
Launch Playback I
d. There are two ways to view live videos. One is to drag-and-drop the target device from the
hierarchical management tree window to the video cells. The other is to click any video cell on monitor

1 or monitor 2, then double-click the target device; the live video will be displayed in monitor 1 or 2 in
accordance with your selection.

e. If you click Switch Screen @ on the quick access bar, the live monitoring window on monitor 1 and
monitor 2 will swap.

Logout
Exit




Simultaneously Viewing up to 128 Channels

If you select 1+31 layout on dual screens, you can view a maximum of 128 channels live video
simultaneously. In this case, each layout contains 32 channels on 1 video page.

Monitor 1 - 32 channel Monitor 2 - 32 channel

Using different layouts on each monitor

You can also select different layout for two monitors, simply click the Layout button on the quick
access bar. Below is an example of the 2x2 layout with 8 video pages on monitor 1 and the 4x4 layout
with 2 video pages on monitor 2. You can click _ and _ to switch among the video pages.

Monitor 1 - page 1 Monitor 2 - page 1

Click C

Monitor 1 - page 8
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View Live Video with Multiple Monitors

If you have multiple screens in your monitoring center, you can switch the VAST LiveClient
Window among these screens.

® |f you have two monitors, click Switch Screen @ on the menu bar; the LiveClient window on monitor
1 will switch to monitor 2.

Monitor 1 Monitor 2

= |f you have two monitors, a drop-down list will be displayed when you click Switch Screen @ on the
menu bar. The number of items on this list depends on the number of your screens. Select a desired
screen on the drop-down list and the LiveClient Window will switch to the specified screen.

&
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How to Manage Stations

The VAST Server allows you to construct a hierarchical management system by adding more
sub-stations to the root station. Under each sub-station, it can also insert sub-stations and
network cameras.

Relay Settings

Before adding a sub-station, please follow the instruction below to enable the sub-station's
Relay Settings first.

a. Login to the sub-station.

b. Select the station from the hierarchical management tree.

c. Click Configuration > Station Settings > Relay Settings on the menu bar (or right-click the station
on the hierarchical management tree and select Station Settings > Relay Settings).

- B
&
E
A Logical Tree Wiew Mansgement
10 Box Management ]
Lo Managemant.
Busocinten Managrmsat |
Wirtusl Bdstric Mansgement. ] ls'h'F_
Fafiover Management ] i.:;-:
Search ViveCam Switcher. .
Station Settings ¥ Gameral Sottangy
Clert Settings k. Festwark Settings
Wides Erhang rsent b fiazording Starage Settings
Pecording Schedule Setings
Sehedubed Backup Setbmgs
{ Servnr t
| ([ Rty Sattings

d. The Relay Settings window will pop up. Check Allow Relay Connection and enter a Password.
Then click OK to enable the settings.

¥ Relay Settings |z|

Relay Authentication

Confirm Password: I:I

[ Ok ] [ Cancel J
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Insert Sub-stations

Please follow the steps below to add sub-stations:
a. Select a target station from the hierarchical management tree.

b. Click Configuration > Station Management on the menu bar (or right-click the target station, then
select Station Management).

c. The Station Management window will pop up. The hierarchical management tree managed by the
target station will be displayed on the left panel.

[ System  Edil | View Configuration | Layout Help : E m Camess Mansgement b
2 oo i P |
= o E@ Camena Managermerd g § Station Management
1(.'} Ii@:i G | Seation Management 1 Lagncal Trad Vet WSRagarment
. CERTCHT TTEE VI TR ey & L0 Box Management ¥
E EK::HM“R 10 Bex Management ¥ o R User M ansgamant
@ -._ '.@‘" il User Management... [ Asgaciation Management
BN MegaP Association Mansgement [~ B Alarrm Manasgerment
o e Mega Alairn Managemen | . Virtual Matri: Managemant
4 B Rexoering Sh wirtual Matrix Banagement v Fallst Managamnt
B Caveut Failover banagement X Senrch ViveCam Switches,
B 1/0 e Search VivoCam Switches
g Station Settingt ¥
Al
. = Shntion Setlinegs v |
Find

et Cettingd

DOutpin Streameng URL |
Wideo Enhancement

Dutput Cameds List

___ S
@ %4 Station Management for VWTE Sm' 1 ' m @
. s

Station Tree for ¥Y¥TK_Stationl

Addrass:

Pazsword:

Communication Part: 3454 =

List Substation Hierarchy | | Insert | | Search...

Hierarchical management tree

Delete Update Close

d. Before inserting the sub-station, you can click List Sub-station Hierarchy button to know if there is
any sub-station under it.

e. Enter the sub-station's IP address and Password (defined in Relay Settings, not login password).

The default communication port is 3454.

m |f the sub-station is on the LAN, you can click the Search Station button to detect all ST7501 and
VAST on the LAN. A Station List window will pop up and show a list of detected cameras on
the LAN. On the top of Camera List window, you can select "List the stations which are not
inserted" or "List all stations". The items listed below will then change accordingly. You can click
Name, IP Address, Model, Http port to sort the items. Then select a device from the list to insert
to the station.



f. When all settings are done, click Insert to add the sub-station to the target station. The sub-station will
be displayed under the left station tree.

g. To insert additional sub-stations to the target station, repeat the above steps.

h. When completed, click Close to exit the Station Management window.

¥ Station Management for Y¥ TE_Stationl .

Station Tree for ¥¥TK_Stationl adldrese: 172.16.4.93

= YWTK Station1(172,16.7,62)

Password:
Communication Port: 3454 &
@] | List Sub-Station Hierarchy ) [ Insert I Search... } @

Hierarchical management tree :ﬁi’

VUTK_Station2(172. 16.4.23)

e 1010
il |

|J %d Search Stations l EB-J ﬁ
@ .

@ List the stations which are niot inserted
) List all stations Refresh

Station List

Marme Address Model HTTP Port
WY TE _Stationl 192,168.6.224 WAST 3454
RO1_MEIL_S5235 192,.168.6.207 WAST 12345
WY TE_Stationl 192,168.6,135 WAST 2454

I WY TE_Stationl 192.168.6,1332 WAST 2454

i. Back to the main window, you will find the newly-inserted stations displayed under the hierarchical
management tree.
= WWTK_Station1(172.16.7.82)

w B Camera
#- [ Recording Group

P Layou
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=
B You can add VAST or free standard ST7501 as the sub-stations. The number of sub-stations can be

added to the server depends on your key dongle. The VAST server will automatically detect the USB
dongle installed on your host PC. Following is an illustration for two-level hierarchical architecture:

VAST Client H——@

VAST- Central Control Room

A site B site M D site
‘ C site
5T7a01 ST7A01 WAST WAST

L lj Ilj L

assasss assassas assasss assasss
L L L i L i L P i L L L i i e L L L i
- - - - - -
VIVOTEE IP Camera VIVOTEE IP Camera VIVOTEE IP Camera VIVOTEE IP Camera

B Please note that the following cyclic relay is not allowed.

Server A Server C

@%@

Add ser\‘/er'x Add server C
as substation as substation

Server B
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Delete Sub-stations

There are two ways to delete a sub-station:

Method 1. Select the sub-station on the hierarchical management tree, then right-click to delete.
= VWTK_Station1{127.0.0.1)

+ E Camera
7 [ Recording Group
M Layout

+ WAWTE Station2{173.16.4.23)
Camera Management 4
Station Management. ..
Tser Management. .
A mociation Mansgement. .
Event Management...

Yirtual Mateos Management *
Station Sethngs 4
Find ...

Cutput Streaming TRL

Get Poblic IP

Delets |

Method 2. Delete the sub-station via the Station Management window:

a. Click the station on the hierarchical management tree, then click Configuration > Station Manage-
ment on the menu bar (or right-click the station, then select Station Management).

b. The Station Management window will pop up. The hierarchical management tree managed by the
station will be displayed in the left Station List window.

c. Select a station from the list you want to delete. Its related information will automatically be displayed
in the corresponding blanks in the Station Management window.

d. Click Delete to delete it.
e. To delete additional devices, repeat step c. and d.

f. When completed, click Close to exit the camera management window and return to the main window.
The deleted device will disappear from the hierarchical management tree.

% Station Management for ¥¥ TE_Stationl @

Station Tree for ¥Y¥YTK_Stationl

Address: 172.16.4.23
= WWTE Station1{172.1A.7.821
© VWTK Station2(172.16.4.23) Password:
Comrmunication Port: 3454 #
[ List Sub-Station Hierarchy ] [ Insert ] [ Search...

Hierarchical management tree

WWTK_Station2(172.16.4.23)
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Update Stations

Please follow the steps below to update a station via Station Management window:
a. Right-click the target device on the hierarchical management tree and click Station Management.

b. The Station Management window will pop up. The hierarchical management tree managed by the
station will be displayed in the Station List window on the left.

c. Select a station from the list you want to delete. Its related information will automatically be displayed
in the corresponding blanks in the Station Management window.

d. When all settings are completed, click Update to enable the settings.
= WWTK_Station1{127.0,0.1)
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How to Manage User Accounts

VAST allows users to apply multiple user accounts to a station with five levels of user roles:
Administrator > Power User > User > Operator > Guest. Each role has different permissions
listed as shown below. Moreover, Administrators have the highest privileges, while Power Users
can only add/edit users as Power Users, Users, Operators, and Guests.

The Default User Roles and Permissions of User Accounts

Functions \ User Roles Administrator Power User User Operator Guest Description
. Add sub-station under the
Station Management v Vv existing station
User Management V4 V4 Manage user accounts
Insert and configure the
Camera Management % % .
camera settings
Association Access and modify the
Management v 4 association settings
AR Gl Access Alarm management
Management v v 9
Modify Alarm .
Management V4 V4 Modify Alarm management
General Station Modify general station
Settings v v settings
Station Network . :
Settings v V2 Modify network settings
Access Recording
Storage/ Access the recording group
Recording Schedule v v and recording schedule
Settings
N CaRecediue Configure the recording
ST roup and recordin
Recording Schedule v v group 9
. schedule
Settings
Enable the recording
Hlagualiiecels v 4 function manually
Scheduled Backup ,
Settings v V2 Configure backup schedule
Access Server Settings v V4 Access server settings
Modify Server Settings 4 v Modify server settings
License Management Allow user to manage
9 v v station licenses
Allow user to manage
RelaylManagement v v station relaying settings
Configure the client
Client Settings % % settings: snapshot, AV,
etc.
Allow user to edit profile for
Video Enhancement Y Y video enhancement and

Settings

assign profile to camera in
LiveClient




Privileges \ User Roles Administrator

Modify Directories
Delete Station

Delete Camera

PTZ Control

Device Control

Talk Control

Access Camera
Configuration

Modify E-map
Event Search

Log Viewer

Backup
Record/Export Media

Virtual Matrix
Management

Virtual Matrix Control

Playback Authority

v

v

Power User

vV

v

User

vV

Operator Guest

Description

Add, remove and rename
directories

Delete sub-station from a
(parent) station

Delete camera from the
station

PTZ control for PTZ
cameras and speed domes
in LiveClient

Control the digital output or
white light/IR illuminators of
the cameras

Two way audio function for
the cameras

Access the camera settings

Allow user to modify the
E-map

Use built-in search engine
to search specific events

Use built-in search engine
to search the log

Back up database manually

Record live stream or
export playback stream to
local files

Allow user to manage
virtual matrix

Allow user to control virtual
matrix

Allow user to access
Playback



Manage a User Account

Add a New User Account - Basic Account

a. Select the station from the hierarchical management tree.

b. Click Configuration > User Management on the menu bar (or right-click the station, then select
User Management).
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c. The User Management window will pop up. The user accounts under the station will be displayed
under the left User List tree. Up to 1,021 users can be created (not including the default Admin and two
internal communication accounts).

d. Enter the User Name, Password, and specify the User Role of this user.
e. Click Add to add the user account to the station. It will be displayed under the User List.

User List Account Management i
Eﬁ VVTEK_Stationl
- BSy Administrator Althentication: |Elasic ACCOUnt
[ ]
- 4 admin
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Station Managem...
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Manualy Record
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Add a New User Account - Windows AD Account

In an established, enterprise network environment, the support for Windows AD (Active Directory)
infrastructure enables ease of integration using the credentials of existing users. Using the same AD
authentication methodologies, you can configure the clients or users in an established network to access
the VAST server configuration.

Note the following with Windows AD support:

1. The ST7501 software does not support Windows AD accounts. However, if you log in to a VAST server
which supports Windows AD accounts, the AD account will work for an ST7501 sub-station managed
by VAST.

2. If you install VAST server on a Windows XP machine with Postqre SQL server, the login using a
Windows AD account will not work.

. The VAST server must reside in a domain managed by the AD server.

. This function does not support the environment that spans across multiple AD domains.
. A user account hosted by an AD server cannot be modified in VAST.

. A User Group and its members configured in AD cannot be managed in VAST.

. You cannot add an account having the same name as one you used to log in VAST.

. There are 3 types of account for VAST: VIVOTEK account, AD single user, AD group.

0 N O O~ W
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a. To configure a Windows AD user as a VAST user, enter the User Management window. Select

Windows AD Account, and click on the Search button.

User fRols: | Admeistratee = =

Eicapprrae |aoie

OGS DG B Do Tl Ll (e

b. A Select User or Group window will prompt.

Click on the Object type button. Select
Group or User.

Slecs the types of ebincta you want o find.
Obetypes:

[ 4, B st i s vy pencipals

sl

o B, Upers

c. You can also click on the Location button to specify a search range on a location on the AD
hierarchical tree, e.g., a department in an organization.

Select the location you want to search.

Location:

=] Entire Directory
B2 vivotek tw

-2 Builtin

{E Computers

G727 Domain Controllers

-] ForeignSecurityPrincipals

2] LosthndFound

{E Managed Service Lccounts

-5 Meeting Room PC
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d. Enter a name for user or group that is known to the AD. Click on the Check Name button. The search

results will be listed.

rl
Select User or Group ] X
Select this object type:
| User, Group, or Builtin security principal | Ohbiect Types
From this location:
| ericthegreat 123.com |
Enter the object name to select (zamples):
admin & =t
Multiple Names Found -
More than one object matches the following object name: “"admin”. Select an
object from this list or, to reenter the name, click Cancel.
Matching names:

Mame Logon Mame {pr...  E-Mail Address Description In Folder

8) Administrator Administrator Buitt-n account f...  ercthegreat123....

EEAdminishators Administrators ercthegreat123....

e. Click to select a user, and then click OK to confirm your selection.

f. Users thus added will be listed on the left in the User List. These users or groups will be listed with

o T

their domain name listed in front of them and indicated by different icons s .o -

g. Select a User Role for the AD user as Administrator, Power user, user, operator, or guest.

h. Select user's privileges in terms of the Permission, Accessible Cameras, and Accessible

Substations from the tabbed windows below.

i. Click the Add button to complete the process.

The next time you log in, you can select Windows
AD Account, enter User Name and Password to

access the VAST software.

Note that you should specify the domain name in
front of the user name; "domain name\user name."

o

(m)

&g VAST LiveClient

]

¥Log in local station

Addrass:; 127,001

Authentication: | Windows AD Account -
Iser Mame: wivotek, twEric,Lu

Password: TITTTYY

Part: 3454 =

Proxy Settings |

[ Log in ]| Cancel ||Hide <=
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Permission of the User Account

Administrator is granted with all access privileges, while other user roles' permission is limited. If
you want to modify the permission, please login as the Administrator to configure the settings.

f. Select a User account from the User List tree.

g. If you want to set the limit of the permission
of the user, click Permission tab to check or
uncheck the items.

| Funcoes Descrtor ,‘H:
F Uiser Mani =
h. If you want to limit the devices accessible I B At :
by the user, click Accessible Cameras tab to l: Access Eve
select the desired devices. B senersistat
Il SEation Hatw
| B
P MamalRecord
Rl Tr— L
etz | wrte | (itdan]

i

| Permission | Becessible Cameras | Accessible Substations

)l camneras

| Carneras
1_FOE161
2_IPg1a1

You can select either a basic user can access a device tree or a logical tree.
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i. If you want to configure the access limit of the sub-station accessible by the user, click Accessible
Substations tab to select the desired devices.

é&

If you want to remove access permission mentioned above from the account, the user will not able to
operate some functions listed in the following warning dialog.

Unchecked sub-stations or cameras will have the following permissionds) removed from the account:
"Camera Management",

"Delete Catmera",
"Maodify Recording Group/Recording Schedule Settings",
i "Scheduled Backup Settings",
"Modify E-Map”,
"Miodify Event Managerment"

| ok | [ Cancel

j. When completed, click Update to enable the new settings.
u]

Permission | Accessible Caleras | Accessible Substations

O all substations () Selected substations

Substations
W wWTK_Station?

£ ¥
[K [ select 4l

Delete Lpdate
| Delete [ pdate

C—n

Delete the User Account

k. Click Delete, a delete user dialog will pop up. Click OK to delete the user account.

;_f 1 2 Are you sure you want to delete this user?

| s | [ Cancel l

ga

If the Administrator modifies or deletes the User Account, that modified user might be kicked off from the station.



Expiration

Click Expiration to configure the extension of time allowed for a user's access. For example, an
administrator may want some users to have access to the LiveClient during a specific period of time,
while they are forbidden to access when they are not on the duty.

Y R —
Lrr e

ArTTHINE ST
B veed_stnen
P mactvad el v Rt nega W BiSiae

b Entpac'hy
- Usar tag

Famagd

. 20

Cigey Bdr®

Acormbie Deiie: # Devke o Logaalan
Fumremos | Arvenia Cermras | Atesbin ety Doitor
T fvaame At

SiF) TereUls | | LEen i et

ren

— V{(} 0 =
Lowi Frdcenin 1

| M Frwmeme. neretiy Satieng {Deroemd}

Wkl Bckting Doy tommd ) e

3 HETETSL 04 NG

B RIS M

£

i
| e | o

Note that if a new user has the Administrator previlege, no Expiration setting will apply to him.
The Expiration setting applies to Power User, User, Operator, or Guest.

1. To start the configuration, enter a user name, password, and then select a User Role.
2. Click to enter the Expiration tab window.

3. You can either Load a Template or click Add to manually configure an Expiration setting. You may
also configure a Log-in Limitation by configuring the extension of time a user can access for each
day or each login.

4. If creating a new template, enter a name for the template.

. Drag your cursor across the timeline, or manually enter the Start and End time. Click the Add

button if you manually enter the time span. You can add multiple time spans to the timeline. The
time spans will display on screen as red bars.

To delete a time span, click to select a time span and click the Delete button.

When done with a manual template configuration, you can click the Save button to save the template
for later use.

Export: Click to export users' privilege, access list, as a CSV file. The information include Functions

Permission, Accessible Cameras, and Accessible Substations. The Logical Tree access information is
currently not included.



How to Set up Association Management

VAST LiveClient supports association management which allows the user to configure relative
event trigger notifications of connected network devices. (E.g., DI/DO status on the hierarchical
management tree, motion detection windows appear in the video cell, the event list in the event
window)

Association Management
Please follow the steps below to configure assocation settings:

a. Select the station from the hierarchical management tree.
b. Click Configuration > Association Management on the menu bar (or right-click the station and

select Association Management). o I (R — - :
= Camera Management b
[ Systam  Edn | View || Canfigurmtion | [Laysut | Halp Station Management... |
T K] Fﬂ LAMETE g emem L | : Logical Tree View Management...
[ {:}. II_E_‘I E@ VULICH b e T | E@ + ______ i /O Box Management 3
o Legial Tree View Maragemerd
E WK Station1{ 12 B M omirt . y- [ User Management...
@ v i = . Association Management...
Litar bisnaarent
¥~ pagar .. ‘ - B 1y L
T Mo & 3 e, - -
BN Maoa P L Virtual Matrix Management (|
-i— B Becording S Virtual Mainix Maregemren: Failover Management 3
B Loy Fakorat Massbeg i ’ Search VivoCam Switches...
P 0B Search VinCam Switchas
& ADAML SR - . | Station Settings 3
Clegrt Sedtings v Find...
Vides Enhancernent ¥ | Output Streaming URL

R T IR Ik

c. The Association Management window will prompt. Select or deselect the items and click Save
to enable the settings. The items you've selected will also be displayed under the hierarchical
management tree.

For example:

N Association Management B3

- Wy TK_Station1(127.0.0.1)

Check item to enable/disable the Digital Input or Digital Output. = h amera
B s sston(127.0.0.0) 5 B 1 pr7131(192,168.3.247)
IJ DI-Entrance
T FE91912(192.168.4.171) & DO-1
N M 3.102.168.4.124(192.168.4.124)
o K@ SD9161-H(192.168.4.164) = @ 2_1Pa161(172.16.200.40)
= g NDO541(192.168.4.157) D OI-1
........ ¥ DL1
........ W N1z a Do-1
------ ¥ _DE3 4 Input == - K& 3_FDE161(192,168.5,105)
........ ¥ Di4 — P ]
________ —— AR g o
........ ¥ D& | “ Do-1
"""" ¥ D17 +- [ Recording Group
........ ¥ DLs
........ ¥ Do [ ok || cancel + - [ Layout
........ ¥ Do-2
........ ¥ Do-3
........ ¥ Do4
i / ﬂ Digital input on / off
w /@ Digital output on / off

| Rename [ oK ]| Close |

d. If you want to rename the DI device, select the DI item and click the Rename button. It will be very
convenient for you to recognize the target DI device.



=)
m 7o manually enable DI/DO settings, please right-click the video cell and select Set DO to enable (Trigger) or
disable (Normal) the digital output of the linked device.
1 IP3161 2010401127 AM 03:31:28
Bemove
Single View CtlsV

Full Screen Cul+F
Enahble PiP Ctil+1

1_IP8161 2010401127 AM 03:31:28
Bemove
Single View Cl+¥

Full Screen Cul+F
Enahle PiP Ctil+1

Stream 1
Steeaim 2
Stream 3
Steeaim 4
Send to Talk Panel

Stream 1
Steeaim 2
Stream 3
Steeaim 4
Send to Talk Panel

Others Others

¥ideo Enhancement Video Enhancement

m Before you configure the DI/DO Settings for VAST, please enable DI/DO settings on your network device and set
up the camera correctly on the configuration page. You can right-click the device and click Camera Settings to

open the configuration page. g VWTK_Station1(127.0.0.1)

Delete
...... En Mega-Pi Refresh
- E Recording Sto Camera Settings
- E Layout Camera Management 3

Qutput Streaming URL
Send to Talk Panel

* viversk

W, W | ST

Home Client settings QL[N Language
Applications > DI and DO

System Digital input

Media Normal status: @ High () Low

Network Current status: High

Security

Digital output
P1Z Normal status: (@ Open () Grounded

Current status: Open
Event

Applications I: Save

Motion detection

DI and DO
Tampering detection
Audio detection

Package management
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How to Set up Alarm Management

VAST LiveClient supports Alarm management which allows the server to display and respond to

particular situations (events).

Alarm Management

Please follow the steps below to configure Alarm management:
a. Select the station from the hierarchical management tree.

b. Click Configuration > Alarm Management on the menu bar (or right-click the station
Alarm Management).

J, |
I O Megap  \ A M :
o [ Mecodeg sy Vetusl Matix Management
BB vt Fadaver Management
=— P 10 Bax Seaech VivoLam Switches.
T |
ol anaMd :
‘ st Gathinget

L3

-
Camera Management

Station Management...

Logical Tree View Management...
I/O Box Management

User Management...

Association Management...

: ‘ Alarm Management... ’
=R irtual Wiatrix Mianagement

Failover Management

Search VivaCam Switches...

Station Settings

3

and select

c. The Alarm Management window will prompt. Click New to con'figuFel a new event. Enter a name and
description for the new alarm. When you finish the general settings, click Next to set up trigger source
settings. The Alarm name you specify here will be displayed on the Alarm panel in the Live view.

0 amn

mere Miterestad evants. When one of them b tiogersd,

ALt Schedua
Tum D03 (A0 Alwars
Mation 1 on Mo, Start B eecond L. Alwiays

| - Brgrehws | I.Dﬁ'?-?z*._
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(|| General | .

Trigger .. Action ..

[¥1Enahle this alarm
[V]Enable live natification

Marne:

Description: e

-

Trigger Period:l 5 {secy 0 FU— 30

Detect next event after 5 s

Schedule

ww  Detal

l Back et
©

[ Finish

][ Cancel ]




d. Click Add to select the trigger source by Device or Trigger Type.

el RS D

| Gy »» TNQDAF 33  ACHOR . Gohedde oo Détal

& Add Fuent = &
il Dwerl By S Dol Tigger Typs
| Cabegory: | Carmerk Events -
]
Acki
Bk Cancal
|

Note that the Motion detection windows are separately
configured using web consoles with each individual
cameras. Open a web console with the camera to configure

Motion detection windows.

The Storage Status includes: Storage connection status
and storage capacity status on NVR systems.

Each individual motion detection window can be used as a
triggering condition. The Line Crossing and Field Detection
packages running on cameras also apply as triggers.

=B ol — BTk Stationi1(127.0.0.1)

[+ [ M Mega-Pixel Network Carnera(192.168.4.121)

-7 [ Wireless camera(192.168.6.143)

=7 &M Mega-Pixel Network Camera(192,168.6.127)
L[ i Mationel

MMotion-2

Motion-3

OI-1

Tampering

([ &P Mega-Pixel Network Camera(192,168.6,101)

ﬂ:&i Event

add Event by: () Device @ Trigger Type

Cateqgary: [Camera Events - ]

‘MDtiDﬂ- 1 - '

Motiorn-2
Motior-3
Motior-4
Motion-5
DI-1
DI-2
DI-3
DI-4
DI-5
DI-6
DI-7
DI-2
Do-1
Do-2
Do-3

Do-4
Do-5
DO-6

Type:

Do-7
Do-8
Yideo Loss/Restore

FIR

Tampering

Temperature

IR

I - Moving Obiject

IV - Loitering Detection
IV - Camera Tampering
P-PTZ
L g
Field Detection

If you connect your DI/DO devices via an 1/0O module (/O box), please refer to page 358, Appendix E

Support for Digital /O Modbus TCP Modules for details.
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=
There is a new event trigger type, P-PTZ. The P-PTZ refers to the occurrence of Auto Tracking action in
a Panoramic PTZ configuration.

T vy —— Auto Tracking is configured on the fisheye camera in a Panoramic PTZ
= configuration.

H

If you manually configure a detection area for the Auto Tracking function,
the P-PTZ event will not be triggered.

weRon A
Brhion
o8-L
=13
=5
tha
(=53
23
-7
=L
a
L1t
0O-F
[
[
[
et

R

e. The Device List window will prompt. Select one or more devices and set the Notification Type.

Depending on the trigger source, the Notification Type will be different. Then click OK to close the
window. ; S

% Device Lind-Connes turn Tiatas

x

i Trgger st

Seloct the tggor(s) fom the fleing k2. Selact the trigger(x) from the folowing ist.

= g 1(127.00.1) e B
F& m

-7 I Mnga-Pranl Motwitrke Camirad 192,166 6, 2781)
R
| 1
7 g Tamgedng
[ B 2t i Moga 5o Spned Come Metwirk: Camanl 192,
7GR M Pt Mgt Carmen o 192, 1686, 127 )
g Molion
w0l
o DO
e ]
F b PETT
" @& 20x Zoom 1080 Spasd Dome Netwer: Camers| 153165,
e W iag-Prund Mistwork Camera{152 166,228
g o] 0 JomeliniD) - 5 moea01(292 168.6.129)
Mohfication Type

Otormectod  @lost 2 ill : A

f. The trigger source(s) will be listed on the window as shown below. If you want to add more Trigger
sources, click Add and repeat steps d. to e. Then click Next to assign action(s) to the trigger source(s).

g. Click Add to open the Action Settings window.

B

B

| General

=  Irigger ..  Action

w5 Schedule

[ Detail | General ww  Trigger ..  Action .. Schedule

ww  Detal

@ Add » Rernove

'I Back ][ Mext ][ Finish ][ Cancel ]
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Note that if your camera is using Sony's SR-WM series cards, SD card status events can be used as a
trigger.

The event messages look like the following:

Normally Functioning The SD card is inserted and there is enough lifespan remaining.
Replacement Recommended |Has reached xx% of the SD card's lifespan.
Has Reached its Lifetime All the spare blocks have been consumed. The card is read-only.
Card Not Inserted No SD card is inserted.
Failed to Get Status Unexpected error has occurred.
] Wi Alarm M anagemen
:E-l-.“ Trigaer lat 5 | 1
Select the triggens) from the folowing s,
rB
F'-\Ii FESITLEV(152, 1689161 )
I wah Mooon-d
[T & Hotign-2
T & Mobon-3
T il Moton-4
[ & Motons
I w D1
C wb 001
[ & Terpaing

F igh Soait S0 Card
I wl Audic Betection
i [CaE MrRIe2{182, 168,407 )
7. 3192 1884 1 M 090 180 4,124
I w SORTEIHLS2. 1654144
i W FoRan -FHTW193.160.4.124]
I . WMS_Statmn] 192, 168 4. 158])
[ i NOSSA1(192.168.4.15T)

Haw [ Ramava Datad =5 Clesa

The related event messages will prompt on the event list. On seeing the Smart SD events, you
should replace your SD card.

Enstant Plwback fera T Deorpiion, Sopoe. W EBent Trpe T Yaue Tt T Bate T

L) Lk FERXRL-EN St 50 Cand Trggar 20170907 161943 Vi

L5 A 3 FES391EV Sevart 5D Card Trgpes 20170907 D& 1ckS Vit

L) Al 3 FE91-EY St 50 Cand Trgper 20170507 1€:08A3 Vi

L¥] ASrred FESI9L-EN Swan 0 Cnd T 20170507 180658 L]
A1 FOGHEELEHTY Reooidrg Statin St 201709407 180708 liarw

The Tampering, Audio Detection, and Shock Detection are also available as a trigger source
with cameras that support these features. Shock Detection is available for cameras that come
with an acceleration sensor. = —

Seect the tnggen(s) hom the folosmng k.

T ol Ao Detecdion
[ Sk Datastion

[ e




There are several types of Action Settings.
m Email: The sever will send a notification via e-mail when a trigger is activated.

h. To enable this function, please set up the SMTP server first. Click SMTP Setting to open the window
and refer to page 216 for detailed information.

i. Enter the related informtaion. You can modify the mail content in the blank. If you want to modify the
content, click Insert Macro to select the parameter. When completed, click OK on the bottom to

enable the setting. B3 Action - -
Note that you can insert a snapshot

@ Ernail h
taken by the time of alarm occurence g P ——
of the recorded video. The snapshot [ ™™ GEMIECetlingss
will be sent along with the notification To: [ Test |
Email. The snapshot comes from
camer's stream 1.

e

At $iEventTime), event type
[$(Trigger Type)] occurred o

Content:  $({DeviceMName) Insert Macro

Start to record on

AT LV Y AR VY S0 | SRV, F

m Start to record on: The sever will start to record video from selected camera(s) when an event is
triggered.
j. Click Add Camera to select the target camera(s).
k. The selected camera(s) will be listed on the left window below. When completed, click OK on the

bottom to enable the setting. o i
— H Splert the cafinads) B the Bllowing Bt
‘ Ernail ﬂ
k @) Start to record on
add Camera @ Mags-Pel Metwark Camers
o [F F RE CrRRETIERS e e i) ER)
J] B mga-Fingd Motweiek CEny
Move to preset location
Set DO
G5M short message
k 0% Cancol

® Move to preset location: The target camera(s) will move the shooting area to the preset location(s)
when an event is triggered.
I. To enable this function, please configure some preset locations on the camera configuration page
first.
m. Click Add Location to select preset location(s).
n. The selected preset location(s) will be listed on the left window below. When completed, click OK on
the bottom to enable the setting.

g Atz [

@ Move to preset location m Selact the preset incation(s) from the foloeing kst,

m | dd Location | | WTK_Btation1(127,0.0.1)

— e ADAMSEH 193, 166.6.136)
| Remove | N M. D Mlabwarel: Cameral 165,254,164, 215)

F lown kit
Set DO n

G50 shart meszage
HTTP

F  comer
¥ gt
F  upper nght
[ R
= TR TREN
"
M et

- PO TIOR3 1550 254 03 90

-Pooad Metwork: Came gl 192, 1686 718

L Laxid



m Set DO: Select this option to turn on external digital output device(s) when an event is triggered. For
more information about how to set DI/DO settings on the target camera, please refer to page160.
o. Click Add DO to select DO device(s) and select a DO status (Normal or Trigger).
p. The selected DO device(s) will be listed on the left window below. When completed, click OK to

enable the setting.

SUFT tO FEcodd on

| Ml B fraat Incationy @
l & Sot Do

E@ T Lun Cal | (g P Riirtwork Cirmera) o | (FYTTT )

R

‘| EEM SRE L eSS0

Select the Tirgger Period from the slide bar below.
The range is 0 to 30 seconds. The DO trigger
signal will return to normal after after this period of
time.

Note that the Trigger Period setting does not apply
to the camera DI/DO managed by substations.

Sednct the D) from the foltewing ket

- Notification T '
W TE_Stationd (127,001 i
T ADAM-EDR 192, 168.6, 136) e

B MepaPivel Mabwork: Camera(leg) | % Trigger

0) g S
& TR T ok Camara( 169

O Mo Pod Bietwork Camoral 162

Rolificalion Type
Morminl
& Trigger

Trgpges Peniod: 0 ([s8C) O 30

0 | Cancel

[

m GSM Short Message: The sever will send a short message to a GSM cell phone when an event is

triggered.

g. Please enter the Phone Number and open GSM Settings window to set related information if
necessary. When completed, click OK to enable the setting.

Ernail

Start to record on
Move to preset location
Set DO

@ 35M short mmessage

Phiorne Murnber: E5M Settings “ Test

HTTP

Client Motification

[ Ok ll Cancel |

;li' l.}i-.'-".r.'ﬁ'. f H-ﬁl-ﬁ."l - COM E’bﬁ!;ﬂup et
G5 Sattings
50 PIN Mumber: [

COM Port Mumber! (COML. =

Dol g o] 115200 L

Diata bits: L] -

Pty B -

SAop bits: 1 -

Pl contiok: Hone -
(i Camoid

Please enter the country code if you use overseas call.



m HTTP: This function allows user to send a CGl command to the linked network camera, such as pan/
tilt/zoom function or enable DO devices.

r. You can click Insert Macro to select the parameter. Please enter authentification information
if necessary. For example: http://192.168.3.66/cgi-bin/admin/setparam.cgi?system_
hostname=$(EventTime) $(CameraName)

If you want to use special characters such as $-_.+!*(),#%+$,@:;/?=&, please refer to the

following table to transfer the Code (Hex).

For example: http://192.168.3.66/cgi-bin/admin/setparam.cgi?system_hostname=123&456
--> http://192.168.3.66/cgi-bin/admin/setparam.cgi?system_hostname=123%26456

@HTTRP
Use authentication; [
User Marme: ||
Password:
Character Code (Hex) Character Code (Hex)
! 21 5 2C
# 23 - 2D
$ 24 . 2E
% 25 / 2F
& 26 : 3A
! 27 g 3B
( 28 = 3D
) 29 ? 3F
* 2A @ 40
+ 2B _ 5F
= 7E

= Client Notification: On the occurence of an event, a pop-up window will display to show what is
triggering the current event. Select the window size, and select the display duration of the notification
window. If not selected, the notification window is manually closed.

ﬁ_mm. =5 Include the event triggering camera: You can select to

display the screens of other cameras (e.g., cameras
h that are closely adjacent) when the notification
prompts.

) Ernail
I ) Start to record on
() Move to preset location
(0 5et DO
() G5M short message R p ared O R '_,!M!-I'ril A wi s
©HTTP '

@ Client MNotification

MNaotify me with Popup Window, Size:

[[]Close it automnatically after |5 - seconds

[¥]1nclude the event-triggering camera

Add Carnera

Remove

Ok ] l Cancel ]




s. The action(s) will be listed in the window as shown below.
Then click Next to set up schedule(s) to the action(s).

For more information about Schedule Settings, please refer to Recording Schedule Settings on page
192. You can assign more than one time frame to one action.

(oo R ==

e R ==

General ..  Trigger .. Action .. Schedue .. Detal

to Trigger

to Trigger

[ fifulo] ] [ Remave ]

Back | Ment I Firish

General -~  Trigger .. Acton .. Schedule .. Deta

Load Template ] ’ Save as Template

Time Frame

sdd || Edit || Dekte | [ w | pown |

’ Back ][ Mext ] Firish

Time Frame Mame:  Blways

Repeat Frequency: ’Weekl\,r Setting (Day-based)

weekly Setting {Day-based)

l Load Ternplate l [ Save as Template ] [ Save ]

Set time segments in a 24-hour day. Multiple segrments are allowed.

Start Time: 00 = 00 =

-

End Time: 00 & 00 =

[ Add ] [ Delete ]

Repeat on: [VISunday  [VIMonday [V Tuesday  [Viwednesday [V Thursday  [VIFriday V] Saturday

Range

Start: 2003/12f 8 - En:

2035 1 1«

@ Mever Stap

Repeat every 1 = ‘Weekis)




t. When you finish schedule settings, click Next to review the detailed information of the new event

settings. [ Newatar ez

General .. Trigger .. Acton .. Schedule .. Detai

’ Load Termplate ] ’ Save as Template
Time Frame Rule
Alweays Weekly Setting (Day-based)
add || Edit || Deete | | U | pown |

Back ' MNesxt " Firiish

u. Following is the detailed information of the new event setting. You can click Back to modify the event
setting or click Finish to close the window.

e R ==

General ..  Trigger .. Action ., Schedue .., Detai

Bescription:

Triggers:
* Motion-1 on Mega-Pixel Metwork Carmera, Trigger Period © 5 (sec
* Motion-2 on Mega-Pixel Metwork Carnera, Trigger Petiod @ 5 (sec
* Motion-3 on Mega-Pixel Metwork Camera, Trigger Period @ 5 (sec
* Tampering on Mega-Pixel Metwork Carnera, Trigger Period @ 5 (21| =

| »

Actions:
* Turn DO-1 (ADAM-6052) to Trigger
* Turn DO-2 (ADAM-6052) to Trigger
Schedule:
* Dhways

4 | 1 | 3

v. Following is an example of an enabled event. You can click New to set up more events or click Close
to exit the window. .

An alarm is associated to one or more interested events, When one of them is triggered,
the systern would raise an alarm,

Alarm List

Enable  MName Triggers Actions Schedule
a ADAMG,,,  DI-1 (Trigger) ... Tumn DO-3 (AD... Always
a IP2155...  Motion-1 on Me... Start torecord ... Always

alarm-2 Motion-1 on Me..,  Send dlient noti...

0 Alarm3 Motion-1 on Me,,.  Tumn DO-1 (A0, Always

Click to remove the event

’ ey ]([ Edit ]ﬁ Remave ]’H Detail>>]

ﬁé Click to disable or modify the selected event

If your target station has sub-station(s), the trigger sources can be selected from the device(s) under
the sub-station(s); while the actions can only be performed on the device(s) under the target station.



Alarm Notification Windows

With multiple alarms simultaneously triggered, the notification windows will appear consecutively at the
four corners of the screen. With more than 4 alarms, the latter notifications will appear on top of the old
ones at a slightly shifted position.

Alar Alarm notification

1 Alarm notification 2

Alarm notification Alarm notification

3 4

Fisheye Motion Windows

When fisheye cameras are configured with Motion Detection windows and their motion events are
triggered in the notification windows, they display in a more comprehensive dewarped, regional view.

If the Alarm triggering condition is configured as DI (digital inputs) or other inputs, you can configure the
Alarm Action as displaying Client Notification as well. You can select the "Include the event-triggering
camera," to display the pre-configured motion windows. The fisheye cameras' motion windows display in
the dewarped mode.

“d Action (23]

Select the camera(s) from the following list.

=l E

i [ [N 1B9381-HT(192.168.6.170)
-7 &P FEB182(192.168.6.200)
I_ i Default
-~ i Motion-1
- g Motion-2
-] 4 Motion-3
-7 4 Motion-4
w7] gl Motion-5
:------I_\.g.'-“ FEB8191(192.168.6.177)
I_ @ FD9381-EHTV(192.168.6.109)
—------|7® FE9181-H(192.168.6.105)
L[V &g Motion-3
- igh Motion-4
W i Motion-5
- (M IPB166(192.168.6.160)

|- oK | | Cancel
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Export All Logs

In the Playback utility, you can select the Log Viewer tab window, display the past events, and export all
event logs to a CSV file.
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How to Manage the Virtual Matrix

Virtual Matrix is a very useful tool for multiple monitor display and management. Based on the
whole surveillance system architecture, it efficiently helps user construct a real-time live video
wall in the control center. Under a large-scale hierarchical system, through VAST LiveClient
you can only simultaneously monitor up to 128-CH on dual monitors; while Virtual Matrix offers
fully extension for numerous channels and screens, thus making VAST a very powerful central
management system. Moreover, you can change the layout to 2x2 or 3x3 on each monitor
to enlarge the video size, then display the video pages on saperate monitor for close-up
monitoring. '

VAST-64-CH on dual monitors

Video Wall of Virtual Matrix

The architecture of VAST Matrix

As shown below, the surveillance system architecture is composed of VAST LiveClient, VAST Server with
two sub-stations, and VAST Matrix separately on individual hosts. Before constructing the Virtual Matrix,
please install and run VAST Matrix Program on Matrix Recipient connected with the video wall. Through
the Virtual Matrix connection, you can use LiveClient to log in the root server to remotely manage and
display all the live view onto the video wall by easily drag-and-drop. PTZ control is also available as on
the LiveClient.

il -'l ‘g Ii VAST Server VAST Matrix . e S
LiveClient WIS O (Root Station) 1 Recipient 1 —— '.HIHE: L — A )

. VAST Matrix
VIVOTEK IP Camera .| Recipient 2

Video Wall

VAST/ST7501 Server
(Sub-station)

VIVOTEK IP Camera

VIVOTEK IP Camera



Installing VAST Matrix Program

Please follow the steps below to install VAST Matrix Program:

a. Run VASTMatrix_setup.exe on another host (Matrix Recipient).
wizard. ™

W YAST Matrix Satup

VASTMatriw_setop

Installer Language

@ Please select a language.

|English

Cancel |

[ o

=J"&

Welcome to the WAST Matrix Setup
‘Wizard

Tha woiriar vl il yeus g e iwvikallabion of WAST
Maltrix

Tt b5 Peoommenciad that you chose ol atfer apokcakions
before starting Setup. This wil make & possible bo updaste
reskrvant system Fles without having bo reboot vour
COMpULe

Chok Meoet bo continie

Cancsl

e ||

b. Carefully read to accept the End-User License Agreement for use. Click | Agree to the next step.

c. Choose the installing path as the destination folder, the required space and available space of the hard
disk will be shown below for reference. Click Next to the next step.

Then click Next to start installation

& VAST Matrix Setup (=] 2 Bl | 8 vasT Matrix Setup =<
— License Agreement £ Choose Install Location
?_L-) Please review the license terms before installing WAST Matrix. ri‘) Choose the folder in which to install YAST Matrix,
k.- .
Press Page Down to see the rest of the agreement. Setup will install VAST Matrix in the following Folder. Toinstall in a different Folder, click
Browse and select anokher Folder. Click Mext ko continue,
A~
End-User License Agreement
PLEASE READ CAREFULLY: This End-User License Agreement ("EULA" iz a
legal agreement between VIVOTEK Inc. ("VIVOTEE") as lcensor, and you, as
licensee, for the VIVOTEK software that accompanies thiz EULA, which - d
includes the video management software VAST Matrix V1 and other applicable SEstrotomholden
software (the “Software™. YOU AGREE TO BE BOUND BY THE TERMS OF C1\Pragram Files\WIVOTEK IncivAST Matrix] Browse. ..
THIZ EULA BY INSTALLING, COFYING, OR OTHERWISE USING THE
SOFTWARE OR CTICKTNG THE RITTTON RMARKFED “T AGRFE” OR “VES™
IF wou accept the terms of the agreement, click I Agree ko continue. You must accept the Space required: 21,7MEB
agreement ko inskall WAST Matrix, Space available: 69.4G8
l < Back [ 1 Agree J l Cancel ] l < Back [ Mext = ] l Cancel ]
d. Fill in the connection information with Port, Account & Password for VAST Server to connect to the

Matrix Recipient. BE WAST Matrix Setup = @ |3
' & Connection Information
'i-) Please enter your connection information,

Part: 3455

HTTPS Port: 39444

Account: root

Password:

Confirm Password:

< Back Install | | Cancel




e. Click Finish to close the installation wizard, and you might want to run VAST Matrix immediately after
installation by selecting the option Run VAST Matrix.

i VAST Matrix Setap = =5

Completing the VAST Matrix Setup
Wizard

WAST Matrix has been installed on your computer,

Click Finish to close this wizard,

Launching VAST Matrix

Please follow the steps below to install VAST Matrix Program:

a. Click the desktop icon to start VAST Matrix. When it's begun running, there will be a VAST Matrix tray
icon on the toolbar for the user to configure easily.

VAST Matrix

b. The VAST Matrix live view window with multiple types of layout will be displayed. The following shows
32-channels layout.

c. Right-click on the live view window, a function menu will pop up. You may also open the menu by
right-click on the tray icon.

Configuration...
View Sethings. ..
Language 4

Display Client Information
Ahont
Fwit




Configuration
m Connection: Enter the account, password and port information for the VAST Recipient.

= Monitor: It shows the monitor(s) connected to your host. You can select the monitor(s) you wish to
display as the video wall.

m Others

Auto launch at windows startup: Select this option if you want VAST Matrix to launch when windows
starts up in case to avoid the computer reboots by itself and accidentally shuts down VAST Matrix.

Display key frame only: Select this option to display live video with the key frame only in order to save
the bandwidth. It also lowers down the CPU loading and memory usage.

Enable de-interlace: Select this option if your linked device does not support de-interlace function. For
example: VS7100.

Bt CDn:iCJurétiEE &J‘ B Conzigur&tigr o | f = Con:igurstigf i) |
Connection | Manitar | Others Connection | Monitor | Others Connection | Monitar | Others
Fort: 2455 z Use only the checked monitors: Auto launch at windows startup
| HTTeS Port 444 Il | [ P moritor 1
Account: root
Password: ssesnane

l [ OK ] | Carcel |‘

Confirmn Password:  eeesssss ‘
l [ oK ]| Cancel |

View Settings
Please refer to page 238 for detailed illustration.

About
This dialog that shows the version of VAST Matrix and the simple statement of the version copyright.
BE About VAST Matrix h - i
- VAST Matrix 1.12,1.3
All rights reserved, Copyright @ 2009-2016 WIVOTEK IMC,
bkt f ey vivotek. com
WINVOTEER ivienwer
Please click QR code to purchase.
. Product Information

Exit

Click to close the VAST Matrix.

£ Available on the

[ ¢ App Store
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VAST Matrix Management

Once the VAST Matrix Program is setup completely, the next step is to connect the VAST Server with
VAST Matrix Recipient(s). Use LiveClient to log in VAST Server, then click Configuration > Virtual
Matrix Management to configure Matrix Management and Matrix View Settings.

i Help )

Matrix Management Settings

Please follow the steps to set up VAST Matrix Recipient(s):

a. Click Configuration > Virtual Matrix Management > Matrix Management to open the Matrix
Management window.

b. Manually enter the Matrix Recipient Info as previous settings, or you click the search button E to
search for the Matrix Recipient(s) on the LAN.

The Managed by menu allows you to let a LiveClient instance manage the Matrix configuration. In
normal uses, the configuration is managed by the VAST server. @

VAST—’i Matrix
Server

VAST

LiveClient

c. When the information of the target recipient is filled in, you can use the detect button E to confirm if
the filled information is correct.

d. Click Add, then the recipient will be displayed on the Matrix Recipients list window.

et the st recipionts which are rat nsirtnd
Hame Address Port  Type :

. L R
([ Mamweerver 19L16B.6.043  #40a  Sener @Lﬂimw o ) |
Mistri Recipiont List
3455

00-18-F3E272.1F 121804178 WMiFS02
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ﬁi

When entering a server address, please avoid entering the XML-related characters: <, >, &, ', and ".

e. Click Edit display settings to set up the viewing interface for the monitors (video wall) connected to
the Matrix Recipient host.

Ratation Interval Time: &@ seConds(3~999) The Matrix View display is capable of executing rotation. The
PlErak e nteiace default interval time is set at 10 seconds.
[ Display key frame anly

f. If you want to set up more Martrix Recipients, repeat the above steps.

g. If you want to modify the Recipient Info, select it from the list to change settings, then click Update to
enable the new settings.

h. When all settings are done, click Close to exit the Matrix Management page.

&
Due to the limitations imposed by the Windows UAC (User Account Control), you need to right-click on
the Matrix icon to display and "run as administrator," after you close and re-start the Matrix utility.
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Manage VAST Matrix through VAST LiveClient

Once the setup is complete in Virtual Matrix Management, you may go back to the main page of
LiveClient, the connection between VAST Server and VAST Matrix will be working successfully. Then
you can choose Matrix Recipient and the monitor from the drop-down list for the operation control. Some
buttons on the quick access bar will be disabled when you switch from the Live View Panel to Matrix
View Panel.

® Change the layout

As the following picture shows, you can click @ to change the layout and set new layout group on the
Matrix View Panel using the methods same on the use of the LiveClient. The layout on the monitor (video
wall) will also change synchronizely once you change the layout on Matrix View Panel.

System | Edi View | Conhguration | Layowl | Help -}

— i | =
(123 ) (3 0 o ) 2 o) R
| — - - — ‘
B vy _statonl{1o2.150.4.009) 8 Lve View | [ Mot Vi
= [ Camera
v R Cuitrions NetHK Spoud Dorme (152 1884 || Mt Recpsent: | Recpwnt L »| & voree |
w W Network Carneral 192, 168.4.208) . P
& W Mega-Posl hatwork Cameral192, 160,49, 122
= - [ Recordng Storage
B Lovet




m Connection status

If the VAST Server is not able to connect to the Matrix Recipient, the status icon ,‘will become ﬁg
and show the reason of disconnecting when you slide the mouse to the connection status icon. The
"Connection Lost" string will be displayed on the Matrix View window as shown below.

O i | ) e

Wt | E

Connection Lost!

m Rotation

VAST Matrix is capable of executing rotation by clicking @ You can even select another layout group
on the Matrix View window without stopping the rotation. If you want to adjust the rotation interval time,
please refer to Edit display settings on page 177 for adjusting.

m PTZ
VAST Matrix currently does not support PTZ control.
Eemaove
m Matrix View Menu
Right-click on the window to open the menu. ® Stream |
Remove: Remove the channel from VAST Matrix. Stream
Stream 1 ~ 4: Switch the camera stream between 1 ~ 4. gﬁxi

® Remove All Connections
It's capable of removing all connections from VAST Matrix once by clicking on @ button.

Matrix View Settings

Click Configuration > Virtual Matrix Management > Matrix View Settings to open the window.

m Media Source

You can choose the path of media source from camera directly or the CMS server to display on Matrix
View.



m Display Settings

% Matrix View Settings @
Media Source

@ From camera
Using multicast
i2) From server
From substation
Display Settings
1 Full frame rate
@ Key frame only

[ oK ][ Cancel ]

To configure Multicast video streaming for Matrix,

Using Multicast configuration help preserve cameras' system resources while streaming video to a
Matrix machine. Before applying the Multicast settings, the related network settings should be properly
configured on the individual network cameras.

1. Open the web console with the individual network cameras.
2. Enter the Configuration > Network > Streaming protocols window.
3. Change the Multicast settings for Stream 1 on each camera.

Note that it is very important to configure a unique Multiple Group address for each camera.
Otherwise, images on the view cells will be overlapped, rendering the Matrix view useless. You can
also configure the unique Multicast video port into a unique number.

HTTR ihwm B! IF sionaving MTIF wrsimmy 0757 B
At e base | T o
s Copn g B g § e sdn e v Ly Tma e wik
A cpg e Bor phgar 1 Eenl ity o s il b e 3 . mn
RICRSE LT g a1 w2 o s forme by ima et E
AL PSR o 4 bt doc o e L i e
e L AT gt =y
s e et 2508 T e =
TP Gt R i HE O sy o,
RTP gt S SRS o B g By ey N
TG Do RO RS FET Y Ty
TP [ 0 i L RFP gtk itn
PETER 5t i i ATQE gt gt
L TS T ST e — —
F) AN S ]
Tl e B T4 1381 508 [P Tepp— Fr Tl QL
VAL el sl A . MR i el
VA el B2 e 51 A 1 ) o
e 42 Wealbons s v i
Wi LT sy port Wadioast S5 Futadal pirl
Uit gt pciec o e B e
W RS A Waican RTCH wasc por
et 110 o250 WAjoam TTL [5-50
Vi wpl g S aoman] v Ik e G B bt 2
i moicms R P il
il i 2AALD s B R DiE
IR B R 4
LR e o [FET T e
LI S e e i R A .
A P e Rt it e AT ratcta port
LA Bt s = e e g L]

Note that if you change the adress, the same address for stream #2, #3, and #4 will change
accordingly.
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The 239.0.0.0/8 address range is assigned by RFC 2365 for private use within an organization.
From the RFC, packets destined to administratively scoped IPv4 multicast addresses do not cross
administratively defined organizational boundaries, and administratively scoped IPv4 multicast
addresses are locally assigned and do not have to be globally unique.

When finished with configuration, you can use the Wireshark utility to test the presence of multicast
packets.

If you select the Always Multicast checkbox on the configuration page, multicast traffic will always be
detected whether or not the Matrix settings have been synchronized or started between server and the
Matrix machine.

[ Frame 1: 1398 bytes on wire (10384 bits), 1298 byles captured (106384 blts) on Interface B
+ Ethmrnet II, Sre: Vivotek 3e:1d:97 (B0:82:d1:3e:10:97), Dut: IPvdscant 81169 (61:00:5e:00:01:69)
 Internat Protocel Version 4, Sec: 192,168.6,217, Dst: 239.128,1.185

* Usar Dutageas Protocel, Sre Port: 5576 (5576, Dst Porz: 5576 (5576}

© Data {1256 bytes)

Ny
L
g

(= e || Toclets TI607 - Trgplageed : TR (1OODE) ° Lol e DO ATT || Foeti. Chee

You can choose the display frame rate in the Matrix view as full frame rate or key frame only.
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Search VIVOCam Switches

Use the serach managed switch function to locate and open a web console with the managed
switches. Double-click on the entry found to open a web console.

System | Edit | View | Configuration | Layout | Help_

. [N 189338
- [l Recording St
- [ Layout
o [ TS0 Bioi

Camera Management 4
Station Management...

Logical Tree View Management...

I/O Box Management 3
User Management...

Association Management...

Alarm Management...

Virtual Matrix Management 3
Failover Management »
Search VivoCam Switches...

Station Settings r
Client Settings 3
Video Enhancement »

wivoCam Switch List

ML

0000150 AD DR

AWGEV.2R4A3M &0
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How to Configure the Station General Settings

Select the target station from the hierarchical management tree, then click Configuration
> Station Settings > General Settings on the menu bar (or right-click the station on the
hierarchical management tree and select Station Settings > General Settings). The Station

General Settings window will pop up.

df LeChers

[ Systemn | Edit Help |
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View | Comfiguiation Layout
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Alwm Blaragement.

irtusi Matris Manageman
Faikrvrs WManagement

Ceareh Vivolam Swnches 5
Saticn Sommingi
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Withess Enhancement w |
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B b s
B oot

Statian Managament

Lageal Tree View Management
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Chdput Camena Lt

Zar Punho P
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— =T SR - B
Ganaral Settingt
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Pecarding Schedue Settings
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Server Settings

In this section, you can modify the Station Name.

Log Settings
In this section, you can set up Log Settings for the station.

The VAST server allows user to search for the recorded
log through VAST Playback. For more information,
please refer to How to Search Logs on page 314.

m Log level: Select High (only record high-level logs),
Normal (record high-level and normal-level logs), Low
(record all logs). For detailed information about log
levels, please refer to page 315.

m Reserve Time: Enter the time interval that you want
to reserve the log record. The maximum value is 365
days.

¥ Station General Sething

)

Server Setting

Station Marne:

Loqg Settings

Log Lewvel: Morrnal w
Reserve Time: 60 + day(s)
oK ] ’ Cancel ]




How to Configure Station Network Settings

Select the target station from the hierarchical management tree, then click Configuration
> Station Settings > Network Settings on the menu bar (or right-click the station on the
hierarchical management tree and select Station Settings > Network Settings). The Network
Settings window will pop up.

EEE . i e ENED
| T -
B asn
@ mo
Rt
& =mar
e
& Sy
B macwoing
B oelact
@ rix ———————
,.,..._.._if, " ¥ Network Settings
= L . " Part Settings
k: o iy Server port: 3454 =
el RTSP port: 554 3
- ; UPRP Settings
= T [Enable UPAP port: forwarding
- - SR ”_ [CJEnable UPAP presentation
T - ' Proy Sattings
POI’t Settlngs [CIEnable Proxy
m Server port: The default server port is set to 3454. If you change | ., ...
the server port, please enter the new value while logging the
LiveClient next time. Part:
m RTSP port: The RTSP (Real-Time Streaming Protocol) controls the | s Name:
delivery of streaming media. By default, the port number is set to | piowoa:
4543.
U PnP Settl ngs Web Access Settings
. . ]
m Enable UPnP port forwarding: For client to access the VAST Server e Enable Web pecess
from the Internet, select this option to allow the server to open ports o |
on the router automatically so the video streams can be sent out [ coe ]

from a LAN. To utilize of this feature, make sure that your router
supports UPnP™ and it is activated.

m Enable UPnP presentation: If you select this option, shortcuts to
VAST Server will be listed in My Network Places.

Proxy Settings

In this section, you can enable, modify, or cancel Proxy Settings for VAST Server if your network
devices are set up under a proxy.

Web Access Settings

User can access VAST LiveClient and Playback via Internet web browser
(http://IP address:3454). For local host --> http.//127.0.0.1:3454. See page 154 for

Windows AD account information.




How to Edit Recording Groups

By default, all devices are assigned to the default recording group. You can manually remove
a device from the default recording group. However, only those devices which belong to a
recording group can produce recorded media files.

Another purpose of setting recording group is that you can divide all the managed devices into
several recording groups, and for each recording group, you can assign several hard-disks (with
recording paths) to store media data. The live media data will be stored in the first assigned
hard-disk initially, and when the available space of the first hard disk reaches the preset
reserved space limit, the media data will be stored in the second disk and so on. If the available
space of the last disk reaches the reserved space limit, the recorded files in the first disk will be
overwritten with the new media data. This procedure is called "Cyclic Recording".

Recording Storage Settings

Please follow the steps below to set up recording groups for a station:
a. Select the target station from the hierarchical management tree.

b. Click Configuration > Station Settings > Recording Storage Settings on the menu bar (or right-
click the station on the hierarchical management tree and select Station Settings > Recording
Storage Settings). You can also right-click DefaultGroup under the station and click Recording
Storage Settings since all devices are assigned to the Default Recording Group by default.
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c. The Recording Storage Settings window will pop up.

Seheduled Esclup tettings



Default Storage Group Settings

The following example shows the default storage group settings. You can click Rename to modify the
group name or click |%| Delete to remove the default settings.

%4 Recording Storage Settings for VMS_Station

Storage Group: | DefaultGroup EI

Paths in Storage Group

@j Recovery Storage Path
C:\Record

@ 7] [

(]

Storage Information

Total: 916.15 GBytes
Reserved: 91.00 GBytes
Free: 70573 GBytes

d. The default recording path is D:\Recording. The total space and free space of the disk is shown on

the right for reference.

e. Add Local Path: Click to add another recording path on your local computer. A Select Path dialog
will pop up as shown below. When all settings are complete, click OK to enable the settings, or click
Cancel to discard the settings. The default reserved space is 10% of the disk volume.

f. Add Network Path: Click to add a networked storage for recorded data. Please refer to page 215
for detailed information about how to add a new network storage server. Then double-click the Path to
assign a specific folder as a new recording path.

| &4 Select Local Path

|

€]

- $RECYCLE.BIN
-irnibrowser
-2011-11-07

- AITEMP

- CAMERZ,

- Computex_2-13
- Digi-Cam

- Direct)

- Diowenloads

- driver

-Eric

- Eric_desktop

4 1

...
.+...+...+...+...+...+...+...+...+...+...+...+.H

-

m

Add... || Delete ||Rename...

Path:  Ei

Type: @ Storage Path Recovery Path
Storage Infformation
Total: 483,29

Reserved: 48

GBytes
| GBytes

Free:

folder under D:\

Click those buttons to modify the file

131.66 GBytes

Cancel

gg

Note that the reserved space is the comparatively
small amount of storage space saved for data
transaction during recording cycles. The reserved
space is not the storage space configured for

video recording.

f Select Network Storage Server @

Jtage Server List:

Address

102,168,5,122

Account
ritali

Damain
192, 158.5.122

[ Ok ” Cose ]

Path:

Space
Total:

Reserved:

11192, 168.5, 122\MAS

¥ Select Hetwork Path @

= 11192.168.5.122
¥

90,45 GBytes Free: 781 GBytes

2 S Ghytes




g. To modify the settings of a path, select the path from the list, then click E| Change settings to modify.

h. To delete a path, select the path from the list and click @| Delete path. A warning dialog box will pop
up as shown below.

Fheareprn Tes ki webinm may ey oy s reoeery aed scbsbed bacup B oagply e

e T

i. By default, all devices are assigned to the Default Recording Group in the window on the right. You
can select device(s) from the list and click <- to delete device(s) (or right-click the device under
DefaultGroup tree to delete it). Note that a Delete Camera dialog box will pop up. Click Yes to delete
the device along with the recorded data; click No to delete the device but retain the recorded data;

click Cancel to cancel the delete action. Please note that only those designated devices can record
videos.

j. Click -> to add devices to the DefaultGroup.

k

Delete recorded data older than |7 : day(s)

Cameras in Storage Group

Available Cameras: Added Cameras (6/256):

G N Add IB2381-HT
= ame ress FD836B-EHTV
L4 IB2381-HT 192.168.6.170 FEB182
& FD836B-EHTV 192.168.6.233 Eggﬁi BTy
L FEB182 192.168.6.209 FE9181-H
W FES191 192.168.60.177
W FD9381-EHTV 192.168.6.109
L4 FE9181-H 192.168.6.105
) ]
[| |
[ Restore ] [ Ay l [ Close ]
— F= Recording Storage r A -
5 = BS DefaultGroup | c_"'""'" |] (=]
ﬂ @ 159321 _HTD = r i S AR YOU EUME YOU VA o delets this camera from the reconding @roup along with the recorded data?
elete £ 3
Manually Begin Recording Tk o Fcal

[ 3] FEB191

| —

k. Delete recorded data older than the duration: If you only want to retain recorded data for a duration,
check this item and enter a number of day(s). In addition, since VAST Server will do "cyclic recording"

automatically, the oldest file will be overwritten by the latest one when the maximum capacity is
reached.

I. When completed, click Apply to confirm and save your settings. If you want to cancel all of your
editing, click Restore to return to the previous settings or click close to discard the settings.
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Add New Recording Group(s)

If you want to add a new recording group, click Add to give a name to the new recording group,
which will be displayed on the drop-down list.

The following is an example of recording group list.

r Z | |.'

]

ST EN R el 1 (il Recording Group |®| | y‘ |@|

Paths in Storage Group Mame: |RecordingGroup1

) 5 (%) (%] 1) ox ] [Lonal ]

Recovery Storage Path

D:\recording Total: 916.15 GBytes

Reserved: 91.00 GBytes
Free: 44934 GDBytes

Delete recorded data older than El day(s)

Cameras in Storage Group

Available Cameras: Added Cameras (6/256):
1B9381-HT
Group Mame Address = BEHTV
L 4 1B9381-HT 192.168.6.170 FEB182
"4 FDB36B-EHTV 192.168.6.233 FE8191
FDO3B1-EHTV
L4 FER182 192.168.6.209 FEO181-H
L4 FEB191 192.168.6.177
L 4 FD9381-EHTV 192.168.6.109
L 4 FE9181-H 192.168.6.105

Please refer to the following limits when you set up recording group(s):
B The maximum number of devices in a recording group is 64-CH. Please refer to the system requirements of the
software.

® One recording group can be assigned with several recording paths and perform cylic recording; while one
recording path should only be assigned to one recording group.
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Multiple Stream Recording

Since software revision 1.12, a camera's stream can be recorded to different storage paths, e.g., the
server's internal storage and a Network Attached Storage. If hardware should fail (such as H.D.D. failure)
on the VAST server, video can still be retrieved from other storage devices. This feature provides fault-
tolerant redundancy for stream recording.

Functional Requirements:

1. Each camera can be configured into multiple Recording Storage Groups, and has individual
configurations in each storage group.

2. Separate recording schedules can be configured for each camera in different storage groups.
3. Schedule Backup Settings:

As shown below, when configuring a Schedule Backup, each camera in different storage groups will
be listed as individula entries. You can select to back up only one of the recording streams.

s Schecled Backup Settngs (=
#| Eruhle schedule badcup
Select Backup Source
Al Cameray W Sslected camens

I o e [B9351 HT (Recordng Grows 1]

FOUIEL-EHTY 151688100 OefauRGr

FERLIE1-H 162.1668.6.105 DufaukGr =

PELEG 1FLIGEEIGE0  Defauks

IRGIGE-HT 192.168.6.170 Recordng .
Backup Schedub

0: %
> g ]
Backup trne = 12 - : 00 g

Select Backup Target

Pt EX\recondng Arceia
Manimum fokier sba; | Unimied -

Delete ol backup dats f soace & roulficent

Other Oplions
Back up avecia only  Pra-swent Ume: secondls) (2~ 20)

Post-event bime: | secondls) (2~ 200

(k] [ conce

4. By default, every camera is recruited into the Default Storage Group. You can select a camera from
the device tree, right-click to select Camera Management > Update camera.

= VMS_Station(127.0.0.1)
S h Camera

(EM 1B9381-HT(192.168.6.170)
= FEB182(19: Delete
@& FEB191(19: Refresh
@ FD9381-EH] Camera Settings
@& FES181-H(1
EM 1P8166(192
S h Recording Storag Output Streaming URL
+ ...... B DefaultGrou Send to Talk Panel

i B Recording Group 1 - Camera Configuration..
- B Layout
b M 1/0 Box / %

You can configure different video streams for different storage groups.

03 Live View | £ Matrix View

Camera Management 3 Insert Camera...

Update Camera...

Delete Cameras...
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In here, you can configure the recording parameters for different storage groups. Note that you should
only enable Seamless Recording or Active Adaptive Stream in one of the storage group. Applying
these two functions on multiple streams can over-stress the camera.

& IWFW:I TR
| EAHT{152 1606170 Camen lomes | ISR0EL-WT
| D FERYAZ{IRI.16R.6309) T

| P FENSI{190 18R 1TT)

- FORRIENTVILLIGRAL  poguiiame: | BEELAT

|G FEUINLN(150.160.6.108)
N PALELUL 1605 160)

5. When performing Instant Replay or Instant Playback, the system will poll the first available storage
group only. If video is not available in the first storage group, playback will fail.

Note that Multiple Stream Recording is not supported when access is made via a web console. From
a web console, playback displays the stream that last joined the recording storage group.

When the stream recording takes place on any of the camera's streams, the red indicator will light on
on the camera's view cell.
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How to Edit Recording Schedules

After editing recording storage settings, you can begin to edit recording schedules for the
devices in a recording group. By default, all devices are assigned to the default recording
schedule (Please refer to the default time frame settings on page 196). Therefore, once you
insert a device to the station, the VAST Server will begin to record live video according to the
default recording schedule. You can also manually remove a device from the default recording
schedule. Please note that you cannot assign recording schedules to those devices which
have been deleted from a recording group.

The following is an illustration of a set of recording schedules, which are composed of several
time frames. Each time frame has its own time segments, period of time, repeat interval, and
recording mode. You can create different recording schedules with simple or complex time
frames based on your needs.

Devices in Recording Group

[ o— —o Time Frame a

g ‘ o— —o Time Frame b

— Recording Schedule 1 —

.
o— L— Time Frame n
.

o
o
a ° Time Frame y

Recording Schedule N

(< 1
o

—o Time Frame z

In addition, you can arrange the priority of each time frame according to its importance. The
recording schedule with the highest priority will be applied first. This capability is very useful
because you can specify a new time frame with the highest priority temporarily without modifying
the other time frames.

Features of the recording schedules:

m Each device can be assigned to only one recording schedule.

m Each recording schedule may contain many time frames.

m Each time frame has its own repeat frequency and recording mode.

To save time editing recording schedules and time-frames, we also provide a useful template
function to save your time on schedules/time-frames settings. That is, you can save a specified
schedule and download it as a template for future use or upload a well-arranged schedule
template designed by others.

Please note that after you save the recording settings in the server, the recording schedule will
begin automatically according to your settings.



Edit Schedule List

Please follow the steps below to set up the recording schedules:
a. Select the target station from the hierarchical management tree.

b. Click Configuration > Station Settings > Recording Schedule Settings on the menu bar (or right-
click the station and select Station Settings > Recording Schedule Settings).

c. The Recording Schedule Settings window will pop up. Bydefault all cameras under the station are
assigned to Default Schedule, Default Time Frame, and Default Camera List.

Add Schedules

d. To add a new recording schedule, click Add to enter a name in the Schedule Name dialog box for the
new schedule. Click OK to confirm the settings or Cancel to discard the settings. The new recording
schedule will be displayed on the schedule drop-down list.

Rename Schedules

e. To rename an existing schedule, select the schedule from the schedule drop-down list and click
Rename. A Schedule Name dialog will pop up for you to fill in a name for the new schedule. Click OK
to confirm the settings or Cancel to discard the settings. The new recording schedule will be displayed
on the schedule drop-down list.

Delete Schedules

f. To delete an existing schedule, select the schedule from the schedule drop-down list and click Delete.
A Remove Schedule dialog box will pop up. Click OK to confirm or Cancel to discard the settings.

C

Schedule List: | Default Schedule[ ]| Add REname | Delete ‘ Load Template || Save as Terplate |

( %4 Recording Schedule Settings for V1§ d sonl @ " f r @J &J ‘

¥ Input Schedule Name @

@ Contirm X
:[F e_' 1 2 Are you sure you want to delete the schedule GateCamera?

oK | [ Cancel ]

l Schedule Mame

€

‘ [ oK l [ Cancel




Load/Save Schedule Templates

g. If you have a schedule template with time frame settings, you can upload it to simplify the editing of
the schedule. Click Load Template, and a Load File dialog box will pop up. Select the template file

and click Open to load.

h. If you want to save a schedule as a template for future use, select the schedule from the schedule
drop-down list and click Save as Template. A Save File dialog box will pop up for you to save the

template file.

%4 Recording Schedule Settings for VVWTK_Stationl

- @

hy

Schedule List: | Default Schedule IEH 2dd

][ Rename ][ Delete [Load Template ] Save as Template

g Load file

o

PIX)

Look, jr: | .D My Documents j |‘j€ v
=1 d My Music
hﬁ .ﬂ My Pictures
My Fecent
Documents
=
Desktop
My Documents
=
-
My Computer
y
by Netwark, File name: | j Open
Places
Files of type: | TimeT able template(* tc) j Cancel

ry

Save in: | (£} My Dacuments j £ FE-
- 1 dMy Music
\_»ﬁ (2} ry Pictures
Iy Recent
Documents
=
Desktop
ty Documents
-
‘__1..
ty Computer
y
by Netwark File harne: | j Save
Flaces
Save az lype: |TimeTahIe template(”.tc] j Cancel




Edit Camera List

Please follow the steps below to assign a device to a recording schedule:
a. Select a recording schedule on the schedule drop-down list.

b. By default, all devices under the station are assigned to the Default Schedule.
c. Click << to remove devices from the Default Schedule. Click >> to add devices to the Default

Schedule.

d. Click Apply to confirm or Close to discard the settings.

‘ &4 Recording Schedule Settings for VWTK_Stationl

=3

S

I
@ Schedule List: | Default Schedule |:| add || Remame || Delete || Load Template || Save as Template
Time Frame List
Recording Settings
Time Frame Rule _ E—
Recording Mode: | Event -
Always wieekly Setting (Day-based) —_—
Triggers
IMotion V| PIR V| Tarmnpering
JIP-PTZ  [V|Line Crossing || Field Detection
Digital Input
Traditional Recording
Trigger State Mormal State
add ” Edit ” Delete | Up BT @ Recording from DI activated to O normal
Recarding from DI normal to 0T activated
Camera List E@
Marne Address Group Schedule Mn_aga-Pier Metwrork Camera
Wireless camera
Mega-Pixel Me... 192.168.4.121  DefaultGroup Yes Mega-Pixel Metwark Camera
Wireless camera 192,168.6,143  DefaultGroup Yies @ Mega-Pikel Netwark Camera
Mega-Pixel Ne.. 192.168.6.127 DefatGroup  Yes Mega-Pixel Metwark Camera
Mega-Pixel Me... 192.168.6.217  DefaultGroupn Yes
Mega-Pixel MNe.., 192,168.6,101  DefaultGroup Yes
4 11 (2
@j | Apply ||

Close |

gg

If you add a Network Device that does not belong to any Recording Group, a warning dialog will pop up as shown
below. For more information about how to set up Recording Group(s), please refer to Recording Group Settings on

page 186.
Camera List
MNarme Address Group
1_PZ7131  192,168.3.247 | DefaultGroup

2_IPai6al  172.16.200.40

Scheduled

fes
Mo

1_PZ7131

@ The carmera is not in recording group.

Apply

][ Close




Edit Time Frame List

Default Time Frame: Weekly (Day-based), Mon.~Sun., 24-hour, continuous recording

p T —
&4 Recording Schedule Settings for VWTK_Stationl I LEJ @

Schedule List; | Default Schedule E [ Add ” Renarme ” Delete ][ Load Template ” Save as Template ]

Time Frame List

Recording Settings

Time Frame Rule _
Recording Mode:

Blweays wieekly Setting (Day-based)
Triggers

Motion PIR Tampering
P-PTZ Line Crossing Field Detection

Digital Input
() Traditional Recording

Trigger State MHormal State

[ add " it [ Delete ] Upn Dt @ Recording from O activated to O normal

Click Edit to open the Default Time Frame settings page as shown below.

Time Frame Iﬁ

Tirme Frame Mame:  Always

[ Load Template ] [ Save as Template ] [ Save ]

| Repeat Frequency: [Weekly Setting (Day-based) -

Weekly Setting (Day-based)

Set time segments it a 24-hour day, Multiple segments are allowed,

Start Time: 00 = 00 =

End Time: 23 + 55 = [ 2dd ] [ Delete ]

Repeat on: [[]Sunday  [CIMonday  [C]Tuesday  [|wednesday [ Thursday  [ClFriday  [T]Saturday

Range
Start: ENPES 710 - End: (' 2013/ 710 =

@ Mever Stop

Repeat every 1 |5 Week(s)




Add New Time Frames

Please follow the steps below to add new time frames to a schedule:

a. Select a recording schedule from the drop-down list.
b. Click Add to open the Time Frame Settings window.

‘ &4 Recording Schedule Settings for VWTK_Stationl | = | LiE-J
[
@ | Schedule List: | Default Schedule E | &dd || Rename || Delete || Load Template || Save as Template
Time Frame List
Recording Settings
Tirme Frame Rule ) —_——
- Recording Made: |Event -
Blweays wWieakly Setting (Day-based) —_——
Triggers
YIMotion  [VIPIR I Tampering
JIP-PTZ  [YLine Crossing |/ Field Detection
Digital Input
b Traditional Recarding
Trigger State Mormal State
| add | Edit ” Delete | Up Down @ Recording from DI activated to DI normal

c. Enter a name for the new time frame.

d. If you have a time-frame template, you can upload it to simplify the editing of the schedule. Click Load
Template and the Load File dialog box will pop up. Select the template file to load.

e. To edit the new time frame, select a Repeat Frequency from the drop-down list and edit the time
segments, applicable days, applicable period of time, and repeat time interval. For the detailed settings
of each repeat frequency, please refer to The Concept of Repeat Frequency on page 200.

f. When completed, click Save to enable the settings.

g. If you want to save this time frame as a template for future use, click Save as Template. A Save file
dialog will pop up for you to save the template.

EE . e 0

@ |Time Frame Mame | Time Frame 2 [ Load Template ] { Save as Template J [ Save J

Repeat Frequency | weekly Setting (Petiods in a week) v
Weekly Setting (Periods in a week)

Set time seagments in a week, Multiple segments are allowed.

Sun Mon Tue [ Wed Thu Fri Sat
e

01 2 3 4 5 6 7 68 9 1011 12 13 14 15 16 17 1§ 19 20 21 22 23

Start Time | Tuesday ~| (00| [00|%

End Time |Thursday | (00| 5 |00 2 [ aod | [ Delate ]

Range:
Start | 2010f 1/27 End O |2010f 1/27 +

(&) Mewer Stop

Repeat every |1 | 5 weskis)




h. If you want to add additional time frames to the schedule, repeat the steps above.
i. Close the window when you finish the time frame settings.

j. Back to the Recording Schedule Settings window, the new time frame will be displayed on the Time
Frame List.

k. If you want to edit an existing time frame, select if from the Time Frame List and click Edit to set up.
. If you want to delete an existing time frame, select if from the Time Frame List and click Delete.

m. If you want to change the priority of a time frame, select it from the Time Frame List and click Up or
Down to shift its position. The time frame on the top of the list has the highest priority.

&4 Recording Schedule Settings for VWTK_Stationl | L | I&I
Schedule List: | Default Schadule EH Add || Rename || Delete || Load Template || Save as Template
Time Frame List [m
Recording Settings
Time Frame Rule ) ———————————
- Recording Mode: |E\rent -
g | Always Weekly Setting (Day-hased) — @
IFiggers
JIMation  [V]PIR 7| Tampering

JIPPTZ  [Y]Line Crossing (VI Field Detection

Digital Input E@

IK [I m Traditional Recording

Trigger State Mormal State

@ Recording from DI activated to DI normal

Add Ediit | Delete | Recording from DI normal to DI activated

Camera List

Marne Address Group Schedule Maga-Pixel Network Camera
Wireless camera

Mega-Fixel Me.,. 192.168.4.121 DefaultGroup Yes Mega-Pixel Metwork Carmera

Vireless camera  192.168.6.143  DefaultGroup Yies Mega-Pixel Netwark Camera

Mega-Pixel Ne... 192.168.6.127 DefaultGroup  Yes Mega-Pixel Network Camera

Mega-Pixel Me,,, 192.168.6.217  DefaultGroup Yies
Mega-Pixel Me,.. 192,168.6.101  DefaultGroup s

o L] 2 q

| Apply || Close

n. Select one of the following Recording Modes for the time frame:
= None: No recording action.

m Continuous: 24-hours continuous recording. If you want to enable Activity Adaptive Streaming,
please refer to page 189 for detailed illutration.

m Event: The server will start to record only when an event is triggered. The recording time length
depends on the settings in Recording Storage Settings. The default time length is 20 seconds (10s
pre-event time plus 10s post-event time). Please refer to page 188 for more information. For more
information about event catagories, please refer to page 308 for detailed information.

0. Select Trigger Source(s): Motion Detection, Line Crossing, Field Detection, PIR, Tampering Detection,
and P-PTZ (Auto Tracking).

p. Digital Input: See next page for more information.



The Digital Input signal triggers can be configured as follows:

1. Traditional Recording: can be triggered when the DI enters the Trigger State or the Normal
State. If thus configured, the recording task will end when the post-event recording time is

reached.
2. The recording starts when Dl is triggered, and will end when the DI signal returns to Normal.

3. The recording starts when DI is Normal, and will end when the DI signal returns to Triggered.

4. The DI-triggered recordings also include the appended lengths of pre- and post-event recordings
(default is 10 seconds). Therefore, the length of DI-triggered recording is as follows:

DI triggered DI returns to Normal state

Pre-recording Post-recording

An example for the configuration can be: the recording starts when a door is opened (DI triggered),
and the recording stops when the door is closed (DI returns to normal).

=
When connected, a camera's Digital input signal is automatically detected as pulled-high or pulled-low.

Users should then designate the current state as Normal or Trigger. The configuration page is found in
Configuration > Application > Digital Input on a web console.

Applications > Digital input

Digital input
Mormal status: @ High Low
Current status: High

Save

g. Click Apply to confirm the settings. Then close the window when you finish the recording schedule
settings.
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The following diagrams show the frame rate variation of two recording modes:
1. Continuous recording + Activity adaptive recording (helps save bandwidth and storage)

A #lllp &

Bandwidth

N

2. Event recording

N T
> Time

| frame ---> Full frame rate ---> |frame

y #005 %

Bandwidth

< T
> Time

No recording data ---> Full frame rate ---> No recording data

The Concept of Repeat Frequency

VAST offers the following types of repeat frequency. The definition of each type is listed in the

following table:

Repeat Frequency

Daily Setting

Weekly Setting (Day-based)
(Default Time Frame)

Weekly Setting (Periods in a week)

Monthly Setting (Day-based)

Yearly Setting (Day-based)

Discription

m Specify arbitrary time segments within a day,
m Repeat the segments every N days in the specified period of time.

m Specify arbitrary time segments within a day,
m Apply only on selected days of a week,
m Repeat the segments every N weeks during the specified period of time.

m Specify arbitrary time segments within a week,
m Repeat the segments every N weeks during the specified period of time.

m Specify arbitrary time segments within a day,
® Apply only on selected days of a month,
m Repeat the segments every N months during the specified period of time.

m Specify arbitrary time segments within a day,
® Apply only on selected days of a year,
m Repeat the segments every N years during the specified period of time.




Repeat Frequency: Daily Setting

To set up daily repeat frequency, please configure the following items: Daily time segments, applicable
period of time, and repeat time interval.

Time Frame Marne [ Load Ternplate ] [ Sawve as Template ] [ Save l

Repeat Frequancy | [EEREEE |

Daily Setting
Set time segments in a 24-hour day, Multiple segments are allowed, Daily time segments
0 1 2 3 4 5 6 7 8 91011 12 13 14 15 16 17 18 19 20 21 22 23 *You can drag the daily

Daily timeline control bar timeline bar for more

Stat Tme 00| 2 |00 & than one time segment

per day.

End Time 00 3 003 add | | Delete |

Range:

Start 2010/ /27 v End O (2010 127 v —— Applicable period of
(& MNewer Stop time

Repeat every |1 | 5 Day(s) Repeat time interval

Set up daily time segments

You can specify several time segments within a day. The numbers 0~23 on the hourly timeline control
bar (the purple rectangles) represent the 24 hours in a day.

There are two ways to define time segments: one is to use the computer mouse to manipulate the
timeline control bars; the other is to fill in the precise start and end time values in the corresponding
fields.

Add time segments: Choose either step 1 or step 2 to set up
1. Use the mouse to drag the timeline bars:
a. Left-click the daily timeline control bar (the purple rectangles) and drag the mouse.

b. The corresponding time segment will also appear in the Start Time and End Time fields. Click Add,
then the red timeline bars representing new time segments will appear as shown below. You can
drag multiple time segments within a day.

In the following illustration, the yellow arrows show the dragging direction of the mouse. You can
drag from left to right or the opposite.

[
o1 2 3 4 &5 6 F 8 9 10 11 32 13 14 15 16 17 18 19 20 21 22 23

L

Start Time |08 | & |00

End Time 19| % |00 add | | Delete

4




2. Fill in the precise Start Time and End Time:
a. Directly enter the value in the Start Time and End Time fields, then click Add.
b. The corresponding red timeline bar will automatically appear as shown below.

e ™

Start Time 2 :
End Time . e,

Delete time segments: Choose either step 1 or step 2 to set up

1. Use the mouse to erase the timeline bar: Right-click on an existing red timeline bar and drag the

mouse. A green timeline bar representing the deleted part of the time segment will erase the red bar as
shown below.

In the following illustration, the green arrows show the dragging direction of the mouse. You can drag it
from left to right or the opposite.

-------w-----

Start Time ; - %
End Time ¥, 3

Start Tirme E; 3
EndTme |14 3 00| 3 | add | | Dekte |

2. Use the delete button to remove the entire timeline bar:

a. Click an existing red timeline bar or left-click the daily timeline control bar (the purple rectangles)
and drag the mouse.

b. The corresponding time segment will appear in the Start Time and End Time fields.
c. Click Delete, and the selected timeline bar will disappear.

tart Time E; 2
End Tirme: E; E Add
--------“------------

Start Time £ :
End Time F, E; add | | Delete |

| Acd |[ Delete ]




Set up applicable period of time

For repeat frequencies, you can set up the applicable date and period of time for the time frame.

a. Specify the start date and time in the Start field. A calendar date selector will appear when you click
on the drop-down list of date. Click € or ¥ to select the month, then pick a desired day in the
calendar.

b. Specify the end date and time in the End field if you have an end time for applying this time frame. If
you do not have a terminating time for this time frame, select Never Stop.

| Range: b
@ Start | 1j26/2010 W End () | 1jzefz010  w

January, 2010 ever Shop
Sun Mon Tue ‘WethJhu B 5ak

Repeak 1 \
i 4 5 & 7 el \
1o 11 12 15 14 15 1

17 18 19 20 21 22 23 \Click to select a year

24 o5 [ER 27 28 29 30 , )

2 Click to select a month from the drop-down list
[ITeday: 1/26/2010 ———— Click here to move the focus to the current date

Set up repeat time interval

The repeat time intervals is "every N day(s)" as shown below. Repeat every 1 day means the time frame
would apply for every day within the period of time.

Repeat every |1 | 2 Daw{sjl




Repeat Frequency: Weekly Setting (Day-based)

To set up Weekly (Day-based) repeat frequency, please configure the following items: Daily time
segments, applicable days within a week, applicable period of time, and repeat time interval.

Time Frame ﬁl

Time Frame Marme ’ Load Ternplate l [ Save as Template ] [ Save ]

Repeat Frequency | |({EE AR MiE R =)
Weekly Setting (Day-based)

Set time searments in a 24-hour day, Multiple segrments are allowed,

#0000 21 31 [ [0 [0 [ 8 1190 [ [ 120 131 [l (1S 61 171 (181 18] (201 211221 128] | | Daily Time segments

Start Tirme (00 | 5 (00 2 than one time segment
r T er day.
End Time |00 5 003 [ &dd ] [ Delete l P y

| Applicable days

Repeat on [JSunday [CImMonday [lTuesday [wednesday [ Thursday [Clrriday [ Saturday — PP
within a week

Range:

Stat 2010/ 1/28 ~| End O |2010f 1/28 v -+—1 Applicable period of
&) MNever Stop time

Repeat every |1 |3 Week(s) Repeat time interval

Set up daily time segments

Please refer to page 201 for detailed instructions.

Set up applicable days within a week

For repeat frequency--"Weekly (day based)", you can apply the time segments only on selected days of
the week.

Repeat on [JSunday [IMonday [Tuesday [Iwednesday [Thursday [Friday [ Saturday

Set up applicable period of time

Please refer to page 203 for detailed instructions.

Set up repeat time interval

The repeat time intervals is "every N week(s)" as shown below. Repeat every 1 week means the time
frame would apply for every week within the period of time.

Repeat every 1 5 waek(s)



Repeat Frequency: Weekly Setting (Periods in a week)

To set up Weekly (Periods in a week) repeat frequency, please configure the following items: Time

segments within a week, applicable period of time, and repeat time interval.

Time Frame §|

Tirne Frame Mame ’ Load Template ] ’ Save as Template ] [ Save

]

=Ta=E s e =Tl B Ekly SEtting (Periods in & week) J&d

Weekly Setting (Periods in a week)

Set time segrnents in a week. Multinle segments are allowed.

Daily timeline control bar (24hr)

~ FY

Start Time | Sunday S 1 s T
End Time | Sunday w| |oo|3 (005 [ add ] ’ Delete ]
Range:

Start |2010/ 1f28 End O |2010f 1/28 ~

&) Mever Stop

Weekly timeline control bar | Bl

| Time segments within
a week
*You can drag more
than one time segment
per week.

— Applicable period of
time

Repeat every |1 | o Week(s)

Repeat time interval

Set up time segments within a week

You can specify several time segments within a week. The weekly timeline contol bar represents the
7 days of a week, and the daily timeline contol bar represents the 24 hours in a day. The daily timeline
control bar is only valid when one of the days on the weekly timeline control bar has been selected.

There are two ways to set up time segments: one is to use the computer mouse to draw the timeline
control bars; the other is to fill in the precise start and end time value in the corresponding fields.

Add time segments: Choose either step 1 or step 2 to set up
1. Use the mouse to drag the timeline bars:

a. Click on a day on the weekly timeline control bar. The selected bar will turn green.

b. Left-click the daily timeline control bar and drag the mouse.

c. The corresponding time segment will also appear in the Start Time and End Time fields. Click Add,
then the red timeline bars representing new time segments will appear as shown below. You can

drag multiple time segments within a day and a week.

In the following illustration, the yellow arrows show the dragging direction of the mouse. You can

drag from left to right or the opposite.

-@4—_____
— 9

o2 is e s e NE o120 210 22 23

Start Time | Monday | 08|53 |00|3% ©

4

oa

4 ¥

End Time | Monday | |19

Add

Dielete
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2. Fill in a precise Start Time and End Time:
a. Directly select a day and enter the value in the Start Time and End Time fields, then click Add.
b. The corresponding red timeline bars will automatically appear as shown below.
The following is an example of an extended time segment from Mon. 8:00 to Fri. 19:00.

e Start Time Monday v 082 00| %
End Time B

A I [ Delete J

Delete time segments: Please refer to page 202 for detailed instructions.

Set up applicable period of time

Please refer to page 203 for detailed instructions.

Set up repeat time interval

Please refer to page 204 for detailed instructions.
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Repeat Frequency: Monthly Setting (Day-based)

To set up Monthly (Day-based) repeat frequency, please configure the following items: Daily time
segments, applicable date(s) of a month/ day(s) of a week, applicable period of time, and repeat time

interval.

Time Frame gl

Time Frame Marme [ Load Template ] ’ Sawve as Template l [ Save ]

e S DN M on Ry Setting (Day-based )
Monthly Setting (Day-based)

Set time segments in a 24-hour day. Multiple segments are allowed.

W 24 5 5 1 7 0 0 921 0 5 6 ol Sz | |

Timeline control bar (24hr) *You can drag more

Start Tme |00 [{] {00 |f5 than one time segment
End Time (00 3 00| % | add || Deete | per day.
Repeat on |Date {of a month) v Applicable date(s) of
January w2010 2 Repeat on the following dateds) of a month; a month/ day(s) of a
Sun Mon Tue Wed Thu Fri Sat week
1 =z
3 4 =] =} 7 g = Deleta
1o 11 12 13 14 15 16
17 18 19 20 21 22 =23
24 25 26 27 H§ 29 0
a1
Range:
Start 2010/ 128 v | End O |2010f 128 v ——1— Applicable period of
&) Mewer Stop time
Repeat every |1 |5 Monthis) Repeat time interval

Set up daily time segments

Please refer to page 201 for detailed instructions.

Set up applicable date(s) of a month/ day(s) of a week

For repeat frequency--"monthly (day-based)", you can apply the time segments only on selected days of
a month. There are two types of repeat frequencies: Date(s) of a month and Day(s) of a week.



Repeat by date(s) of a month:

Select date(s) from the calendar, and it will be displayed on the right blank as shown below.
The following example refers to the 1%'~5" day of a month.

Repeat on | Date (of a month) A

January w2010 2 Repeat on the following date(s) of a month:

Sun Mon Tue Wed Thu Fri Sat |01
i o 0z

3456?8982

m 11 12 13 14 15 16
17 18 19 20 21 22 23
24 25 26 27 28 29 30
31

Repeat by day(s) of a week:

Select day(s) from the calendar, and it will be displayed on the right blank as shown below.
The following example refers to the 1* ~ 5" Friday of a month.

Repeat on | Day (of a week) b

s

January: W | 2010 ~ PRepeat on the following day(s) of a month:

Sun Mon Tue Wed Thu Fri Sat | 1st Friday
i 2 2nd Friday

ard Friday
3 4 5 5 7 8 09
4th Friday
0011 12 13 14 15 16 g i
17 18 19 20 21 22 23
24 25 25 27 2B an
ch

Set up applicable period of time

Please refer to page 203 for detailed instructions.

Set up repeat time interval

The repeat time intervals is "every N month(s)" as shown below. Repeat every 1 month means the time
frame would apply for every month within the period of time.

Repeat every |1 | 5 Monthis)
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Repeat Frequency: Yearly Setting (Day-based)

To set up Yearly (Day-based) repeat frequency, please configure the following items: Daily time
segments, applicable date(s) of a year/ day(s) of a week, applicable period of time, and repeat time

interval.
Tame Frame |z|
Time Frame Name | | [Load Template ] [Save as Template ] [ Save ]
Repeat Frequency | SR me = =R S aE ==l ) le‘

Yearly Setting {Day-based)

Set time segments in a 24-hour dax. Multiele segments are allowed,

(707 [T 720 1730 A ST (76 1 [he e [ [ 20 (93] 1 [1S) 6] A (e 19 [200 (210 )220 1231
Timeline control bar (24hr)

Daily time segments
*You can drag more

Start; Time L;, ‘3_, than one time segment
End Time :_ : [ Add ] [ Delete J per day
Repeat on  Date (of ayear) v | Applicable date(s)
_3 Repeat on the folowing dateis) of a year: of a yearl day(s) of a
(S e Tus Wed Thy i 6t week
102
2 4 5 & 7 8 0

10 11 12 13 14 15 16
17 18 19 20 21 22 =3
24 25 26 27 5 29 =0
31

Range;

Start Erd O Applicable period of
&1 Mewer Stop time

| Repeat every |1 3 Year(s) — Repeat time interval

Set up daily time segments

Please refer to page 201 for detailed instructions.

Set up applicable date(s) of a year/ day(s) of a week

For repeat frequency--"yearly (day-based)", you can apply the time segments only on selected days of a
year. There are two types of repeat frequencies: Date(s) of a year and Day(s) of a week.
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Repeat by date(s) of a year:

Select date(s) from the calendar, and it will be displayed on the right blank as shown below.
The following example refers to the 1°'~5" day of a year.

Repeat on  |Date (of a year) A

January w2010 2 Repeat on the following date(s) of a year:

Sun Mon Tue Wed Thu Fri Sat |01/01
i =z 01Oz

01/03
AR A R
o 11 12 13 14 15 16 0105
17 18 19 20 21 22 23
24 25 26 27 28 29 30
21

Repeat by day(s) of a week:

Select day(s) from the calendar, and it will be displayed on the right blank as shown below.
The following example refers to the January 1% ~ 5" Friday of a year.

Repeat on |Day (of a week) "

January W | 2010 2 Repeat on the following day(s) of a year:

Sun Mon Tue Wed Thu Fri Sat | January 1st Friday
i 2 January 2nd Friday

Janary 3rd Fricay

3 4 3 G 7 a8 =

0 011 12 13 14 15 16 Janary gtk Fricay
17 18 19 20 21 22 =3 January Sth Friday

24 25 25 27 2B an

31

Set up applicable period of time

Please refer to page 203 for detailed instructions.

Set up repeat time interval

The repeat time intervals is "every N year(s)" as shown below. Repeat every 1 year means the time
frame would apply for every year within the period of time.

Repeat every |1 | 2 Year(s)



How to Manually Begin /Stop Recording

By default, all devices are assigned to the default recording storage and default recording
schedule. Therefore, once you insert a device onto the station, the VAST Server will begin
to record live video according to the default recording schedule. Please refer to How to Edit
Recording Schedules on page 192.

However, if you have changed the default schedule, you can manually click Manually Begin
Recording to enable a device without setting up a recording schedule. Please follow the
instructions below to manually begin recording.

Select the device from the hierarchical management tree under Default Group, then click Edit
> Manually Begin Recording on the menu bar (or right-click the device and select Manually
Begin Recording). The string on the menu bar will turn into Manually Stop Recording as
shown below and the VAST Server will start to record video from the target camera. Please
note that its priority will be higher than the recording schedule, so it will continue unless you
click Manually Stop Recording. After you click Manually Stop Recording, the device will then
follow the preset recording schedule.

(System Edit | View | Configuration | Layo (System Edit | View | Configuration | Layol

Manually Begin Eecording

@@ Snapshot Crl+d { @@ Snapshot Ol a@

Mannally Stop Recording

Print r Erint v
5 B vy Recod o EXE = B3 v Recond to EXE
- LT TR TE TRy - —_ '—“—'*‘—"—'\.‘-“—"—‘—"—’"—’"—‘—"—’J
= h Recording Storage = h Recording Group

= [ DefaultGroup = [ DefaultGoup
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How to Edit Scheduled Backup Settings

VAST LiveClient supports scheduled backup which allows the user to back up the recorded data

to another disk.

Please follow the steps below to enable scheduled backup settings:
a. Select the target station from the hierarchical management tree.

b. Click Configuration > Station Settings > Scheduled Backup Settings on the menu bar (or right-
click the station and select Station Settings > Scheduled Backup Settings).

c. The Scheduled backup settings window displays.

Select Backup Source

d. Select the Enable scheduled backup checkbox.

e. Select the data source you want to backup. If you check Selected cameras, you can click >> or << to
choose the data source that you want to backup.

Schedule Backup Status : Standby

Enable schedule backup

Select Backup Source

@ Al cameras () Selected cameras

Marne Address

FEQ391-EV 192.168.4.161
FE9191-v2 192.168.4.171
3_192.168.4.... 192.168.4.134
SD9161-H 192.168.4.164
FDO381-EHTV 192.168.4.124

Group

DefaultGroup
DefaultGroup
DefaultGroup
DefaultGroup
DefaultGroup

Backup
Yes
Yes
Yes
Yes
Yes
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Setup Backup Schedule

f. Click the Edit button to enter the configuration screen. Please note that the backup time interval must
not be shorter than 1 hour. For example, 23:40 and 00:15 are not allowed to exist simultaneously.

In the following example, the server will backup the recorded data at 12:00 PM and 23:00 PM everyday
once you save the settings.

Backup Schedule
Time Frame Rule
f Off duty Weekly Setting (Periods in a week)

Edit

ge

The following diagram shows the backup schedule and backup data:

1st backup 2nd backup 3rd backup 4nd backup

/ data Y data Y data \/ data
| | | |

server ) ) 5 1

start 12:00 23:00 12:00 23:00 ¢ & 0 0 0o
2010/01/24  2010/01/24 2010/01/25  2010/01/25

Select Backup Target

g. Click Browse... to select a path (local path or network storage) to store the backup data. Please
note that the disk for backup data should be different from the original recording path, or a warning
message will pop up as shown below. For more information about how to set up recording path, please
refer to page 187. [E

A Scheduled Backup Path cannot be assigned to the same disk as Recording Path.

h. Select Delete old backups if space is insufficient if you want to do cylic backup due to the limited
size of the hard disk.

i. Select the backup speed. The speed range start from 0 to 100MB/s. "0" stands for no limitation. If
bandwidth or system resource is of the concern, you can tune down the backup speed.

I UULY VWEERY JELLIY (FEIUUD I d WEER)

Edit

g Select Backup Target
Path:

Delete old backup data if space is insufficient

Browse

Backup Throughput
0 30 100

Max Throughput: MB (0 for unlimited)

—0
|

| oK | | cancel |

The backup destination folder should look like this "2016-07-06_164500 > DISC_001." A scheduled
backup error log will be available for users to examine the backup history.

Since the scheduled backup is a file-based process, if the backup involves an unfinished video file
(currently being recorded), the backup process will skip the file.



How to Configure Station Server Settings

VAST LiveClient supports Server Settings including DDNS Settings, Network Storage Settings,
and SMTP Settings.

Select the station from the hierarchical management tree and click Configuration > Station
Settings > Server Settings to open the page (or right-click the station and select Station
Settings > Server Settings).

Configuration | Layout | Help

Camers Mensgement ’
Station Management. . l | H

User Management. . wa E l |+ l+ qu
Asmociation Management. ..

e Wi ﬁ Matrix View

General Sethngs

Event Management. ..
Wirtual Matrix Management ¥

Station Sethings

Client Settings 4 Wetwork Settings

Becording Storage Jettings
Recording Schedule Settings
Scheduled Backup Settings

DDNE Settings
Wetwork Storage Settings
SMTF Bettings

= E W T, Station1({127.0,0.1} I Live View ﬁ Matrix Wiew
Camera Management 4
Btation Management...
Uaer Management. ..
Azmciation Management...
Ewent Management...
Virtual Matriw Management *

Btation Settings General Settings

Find Hetwork Settings

o . Recording Storage Settings
Crtput Streaming TRL . .
(et Fubli [P Eecording Schedule Sethings

B uled Backup Settings
i Sett DDN3 Settings
Wetwork Storage Settings

SMTP Settings

DDNS Settings

Since the public IP of VAST Server may be a dynamic IP address, DDNS service will give it a
fixed domain name.

Select a DDNS provider from the provider drop-down list. VIVOTEK offers 2bthere.net (Safe100.
net), a free dynamic domain name service, to VIVOTEK customers. Please refer to the user's
manual of VIVOTEK's network camera for detailed DDNS settings.

@ DDNS Settings x]

DOMS: Dynarnic domain narme service
[[JEnatle DOMS

Provider: | Dyndias, orgiDynammic)
Host name: | |

Save




Network Storage Server Settings

The VAST Server allows user to set up network storage path(s) for recorded files. Please follow

the steps below to add a new network storage path.
a. Click Add to open the Network Host Window.

b. Fill in the related information for the network host. Then click OK to save the new settings.

¥ Network Storage Server Settings §|

Storage Server List:
Address Dormair Account
L“édd [ Edit... ][ Remave

Address:

Domain Mame:

ser Mame:

Password:

CaunoadOhsen K
|

Host L

guest

ok ko

(04 ] [ Cancel

c. If you want to add more network host(s), please repeat step a. b.

X]

¥ Wetwork Storage Server Setlings

Starage Server List:
Address Domain Account
192.168.5,122  VIVOTEE ritali
[ add |[ Edit... ][ Rermove
(o= |




SMTP Settings

VAST Server allows user to set up SMTP Server to send mail alert when event triggers. For
more information about how to set up event management, please refer to page 162.

Please follow the steps below to configure the SMTP Server:

a. Click Add to open the SMTP Settings page.
b. Enter the related information of your mail server. If your SMTP server requires a secure connection

(SSL), check Use SSL.

c. Click OK to enable the settings.
d. Then the new information will appear on the SMTP Settings window as shown below.

¥ SMTP Settings

Address Authentication S5l

X

£
\

Close

¥ SMTP Settings

Address Authentication
@] Ms. vivotelk, b YiEs
add ] | Edit Rermiowve

S5L
¢ [m]

@ Edit SMTP Settings X
Server E@
Address: M=, vivotek, tw
Part; 23 s
Liagir

Lise authentication ;

Liser narme: ritali
Password: bk o
Use S5L: |

@ If you have more than
| _one SMTP server, you
can click to arrange the

@ priority.

Close




How to Use the Talk Panel

VAST LiveClient supports the two way audio function which allows the user to communicate with
people around the network camera. Please enable the two way audio function on the camera
side.

The following is an illustration of the two way audio function:

Audio transmitted from network camera

g om
By ™

Network Camera with internal
or external microphone

>~

Audio transmitted from operators

Add a Camera to the Talk Panel

W There are several ways to add a Network Camera to the Talk Panel:

Drag-and-drop a camera from the video cell or from the hierarchical management tree to the talk panel
as shown below. You can also right-click the target camera or the video cell, then click Send to Talk
Panel on the popup menu.

= B v sasizron g s [ v shenstizvany =i YWTK_ Station1(127.0.0.1}
. ﬂx;m = B Camera
« E . iy o
o e P EMELIL R 16 0 Al = W 2 Toufliire.asmn s0) & S 1_P77131(192.1658.3.247]
& B Pecorden Gres # M oo e EN Delete
B Lo B Lot E Recor Refresh
B Layou Carmera Settings
Camera Management 3
Otput Streaming URL
Send to TalkPanel
Open Recording Folder
BTZ | Twn ¥iay B30 | Inetant B Brz | Twn W T
Tala Pamed Talk Pamed
Zingle View
Full Soreen
Erslal P2
¥ | Erabletbant Replay
& Sersany ] (19201080
Skrearn J (LoEDT 0
—_— Shrenm 3 (1 Tl A4)
| Tal Py Seea i, Cheae 6 L "'!_*L‘:?L"'.-'.E!‘.‘.’ Stream 4 (19201080
- e
o 10 Sound Fie © 1)
CrProgram FlasAiotek ine vl EIJ [ —T) @E e .
ks : i_!!!_l!_l_llllllll | Wides Enhancement ¥
Witeo Display Maode v

W FRE feljuit o
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B An icon with the camera name will be displayed in the Talk Panel.
PTZ | Two Way Audio | Instant Playback

2
PZ7131

Click to play sound from the camera
Remove all cameras
from the Talk Panel

Click to talk . .
(I I Y

Select sound from the
file list

Click to play the selected
sound on the client side

C:\Program FilesWivotek Inc'S1 rl. .!

é; Click to adjust volume

m Please note that you cannot Talk and Play Sound at the same time.
® When you are talking or playing sound, you cannot add other cameras to the Talk Panel. If you want to add more

cameras to the Talk Panel, please Stop Talking and Stop Playing first.

PTZ | Two Way Audio | Instant Playback PTZ | Twio Way Audio | Instant Playback

1_PZ7131

1_PZ7131

Click to stop playing

C:'\Program FilesWivotek Inc\/ r- “

C:\Program FilesWivotek IncWi r- “

(CTTTTTTTTTTTT I—
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Remove a Camera from the Talk Panel

B Remove a camera

Drag a camera from the Talk Panel and drop to the hierarchical management tree window as shown

below. The camera icon will disappear.

= PE Camera

; w 20x Zoom Mega-Pixel Speed D
@& Mega-Pixel Metwork Cameral 1
EM Mega-Pixel Metwork Cameral 1t
i Mega-Pixel Metwork Carneral 19
=5 - Recording Storage
E| ------ P DefaultGroup
v 20 Zoom Mega-Pixel Spe
Mega-Pixel Metwork Carm
@M Mega-Pixel Network Carmi
v Mega-Pixel Metwork Carm
- [ Layout

B Remove all cameras

Click @ , all cameras in the Talk Panel will be removed.
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How to Configure E-map Settings

VAST LiveClient supports intuitive E-map function which allows users to upload E-maps for
overall devices management.

Click System > E-map to open E-map Settings Page:

( System | Edit | \ 5
Lock

Enable Click Omn Image
Leangvage

Second View

Lawnch Playback

Logout
Exit

Upload an E-map

Click @ to search for E-map(s) to upload.

Upload New Maps
Loak jr: |@maps v| Q T mE-
O e
My Recent i
Documents @ Map4.jpg
@
Desktop
My Documents
My Computer
" File name: |"Map3.ipg" "Mapl.jpg" "Map2 PHG" Vl [ Open ]
My Metwork | Files of tupe: |AII image filez vl [ Cancel ]

The uploaded E-maps will be listed under the E-map list tree.

gg

If the uploading procedure fails, please compress the image size of your map (equal or smaller than 2MB) and try
again.




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

User Interface of E-map Settings Page (View Mode)

B Double-click an E-map on the tree, it will be displayed on the E-map window as shown
below. There are two operation modes of E-map settings page: "View Mode" and "Edit Mode".
The following is the "View Mode" illustration.

%

- S— — _ -

A. Menu bar B. Quick access bar C. E-map list tree D. E-map window E. Status panel

m Right-click the E-map, then you can Edit, Rename, or Delete the E-map.
= WY TK_Station1(127.0.0.1)
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m Right-click an E-map on the tree and click Edit or click _. on the Quick Access Bar, it will
switch to edit mode.

= WY Tk _Station1(127.0.0.1)
= E’ E-Map
[ [
] (B
m Rename

Delete

Quick Access Bar

K re ) =] ) ]

Icon Function Description
@ Zoom in Zoom in the E-map
@ Zoom out Zoom out the E-map
@ Default size Adjust the E-map to default size
ﬂ| Upload Upload E-map to the login station
@i View Mode Click to switch to view mode
.4 Full Screen Extend the E-map settings page to full screen
E\ Save Save E-map settings

Status Panel

User Name

Station Name (IP Address)

Login Time (yyyy-mm-dd hh:mm:ss)
Current Time (yyyy-mm-dd hh:mm:ss)

CLurrent Time
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User Interface of E-map Settings Page (Edit Mode)
A F G

L

A. Menu bar B. Quick access bar C. E-map list tree D. Device tree
E. Map preview F. E-map window G. Status panel

m Right-click the E-map, you can Edit, Rename, or Delete the E-map.

Rename

Delete
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Device Management

Please follow the steps below to edit an uploaded E-map.

a. Double-click the E-map you want to edit, it will be displayed on the E-map window.

b. Use Quick Access Bar to adjust the size of the E-map. In edit mode, you can also use your mouse to
drag the position of the E-map and zoom in or zoom out the E-map.

c. Drag-and-drop the connected devices to the E-map according to your deployment.

“Gaadigur) E@
R s[5
B T Stetont LE7 OLC-L
B Fra Uu
-
s 3 TR = "u_-‘
(o] -
x Lim =
w0 am==2
a L Y -
o TR N
§ B FGRITIAGAE G -
+ AT Sea
~ Sea

d. Right-click the device icon on E-map, you can rotate the direction or delete the device. The device
can be rotated in 8 derections as shown below.

FQELAIDE

e. You can also drag the DI/DO device under the connected device onto the E-map. If you want to
change the status of the DO device, double click the DO icon on E-map.

For more information about DI/DO settings, please refer to i / ﬂ Digital input on / off
Association Management on page 160.
W’ / & Digital output on / off

f. Click @ on the Quick Access Bar to save the new settings.

gg

The red frame twinkling around the device means there is event trigger(s) going on.
Meanwhile, a live view dialog will pop up beside the model.




Live View Dialog Settings

Click Configuration > E-map Settings to open the E-map Settings dialog, then you can
choose to Open Live View Dialog or to Send to Single View when you double-click the device
deployed on the E-map.

Open Live View Dialog

Select Open Live View Dialog: When you double-click the device icon on the E-map or when an event
triggers, a live view dialog will pop up beside it. It is the default setting in E-map Settings window.

¥ E-Map Settings

Double Click Carmera on E-Map _F'Zl?131
( Configuration j & Hpen Live view Dialog

20091117 AWM 10:21:26

E-Map Settings.. ) 5end to Single View

a

[ )4 ] [ Cancel

Send to Single View

Select Send to Single View: When you double-click the device icon on the E-map, it will open a single
view on the VAST LiveClient.

¥ E-Map Settings §|
Double Click Carmera an E-Map
( Configuration j () 0pen Live View Dialog

E-Map Settings. . @ Eend to_Sindle View!

[ [9]4 ] [ Cancel ]

If you have set up dual monitor, it will be automatically sent a single view to the second monitor.
Monitor 1 Monitor 2

1_PZ7131




gg

The live view dialog also supports click on image, PTZ, and e-PTZ as long as the linked device supports and
enables those functions. To enable those function on E-map, please check the item "Enable click on image" on the

menu bar of LiveClient as shown below. Then an icon @ will appear in the live view dialog for you to control the
cameras.

(System | Edit | View | C

Lock Cic4L 1 _PZ£7131
Enable Click On [mage < 1 PZT131
Language g =

E-Map
Launch Plavback

Logoug
Exit

E-map Link

After completing device deployment on your E-map, you can link an E-map to another E-map.
Please follow the steps below to configure E-map link:
a. Select a map you want to edit and enter Edit Mode.

= VW TK_Station1{127.0,0.1)
= B E-Map
B an1 |
[ (Eaw
m Eename
Delete

b. Drag-and-drop another E-map onto current E-map. A blue frame will appear as shown below.
For example: Link Map1 to Map2 by dargging Map2 onto Map1

B v smeonairon.)

{hive o ANBNRY. Toinan
e

Maclin
« Tafung
A m"“- - iorwen P AT
v Lbochia SRy Dl AN
& 80k  1Mand wFarphang i
anyu
D 40 milas oDHaangi

c. Use % to move the position of the blue frame.
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rotate the direction

resize change the shape

move the position

e. Click on the Quick Access Bar to save the new settings.

f. If you want to set additional map links, please repeat steps a. ~ e.
For example: Link Map2 to Map3 by dargging Map3 onto Map2

g. Click on the Quick Access Bar to save the new settings.
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h. Test the web links. Click |Z4| on the Quick Access Bar to switch to view mode.

Double-click the blue frame on Map1, it will automatically switch to map2. Then double-click the blue
frame on Map2, it will automatically switch to map3.

Map 1

( Contgueation )

Pl tEEE

K
=
\

e R ="

= : 38 |

ey oyeenivent] |

R e |

i 3 R =1 * Map 3
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Since VAST revision 1.13, you can also click and drag cameras or NVR's DI/DO devices to an E-map.
See page 108 for how to enable NVR DI/DO options.

(Combasicn |

casanes
$ETE

See page 242 for how to enable popup video windows on E-Map. y
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How to Configure Client Settings

In Client Settings, you can configure Snapshot Settings, Recording Settings, View Settings,
General Settings, Joystick Settings, Proxy Settings, and PiP Settings.

Camera Management

Station Management...
Logical Tree View Management..
I/O Box Management

User Management...

Association Management...
Alarm Management...

Virtual Matrix Management
Failover Management

Search VivaCam Switches...

Station Settings
Client settings

Video Enhancement

Snapshot Settings

Please follow the steps below to configure snapshot settings:

a. Click Configuration > Client Settings > Snapshot Settings on the menu bar to open the Snapshot
Settings window.

b. By default, camera name and current time will be printed on the snapshots taken.

c. Select a picture format for snapshots (BMP or JPEG). If you select JPEG format, you can adjust the
recompression quality (from 1 to 100). Note that a higher value would generate higher picture quality

but
d. Fill

lower compression rate.
in a filename prefix for the snapshots.

3

E‘l > E‘@

[ri:( View

Snapshot Settings

» Recording Settings
View Settings
General Settings
Joystick Settings
Proxy Settings

PiP Settings

e. The default storage path for snapshots is C:\Users\Public\Documents\VIVOTEKInc\VAST\Client\
LiveClient. If you want to change the storage path, click Browse - | to select another folder.

-

% Snapshot Settings

Generate a file name autormatically. (YYYYMMDD_HHMMSS)

| Overlay camera name and time on snapshot.

BMP files (*.bmp) ~

o

Format:

Recompression Quality:

©

C:\ProgramData\VIVOTEK Inc\VAST\Client | ...

Prefix:

Save to:

| 0K | | Cancel |

=

f

ﬁe

The recompression quality is only enabled
in MPEG-4 streaming. If your stream source
is MJPEG, the system will directly save the
JPEG image without recompression.

f. If you check Generate a file name automatically, VAST will directly save snapshots with the following
filename format to the storage folder.

p
l l

File name prefix Date and time

Snapshot_20100125_173015_01.jpg

(YYYYMMDD_hhmmniss)

Serial number of snapshots

~
!

Picture format

v




If you uncheck Generate a file name automatically, the Save file dialog box will pop up when you
take a snapshot. The file name prefix will automatically be displayed in the Save File dialog box.

Take a Snapshot

Please follow the steps below to take a snapshot of the live video stream:

Save file RIK
Save ir: | () Snapshat j £k B
©
My Recent
Documents
THH
Desklop
My Documents
-
5
My Computer
y
by Network. File name: | Srapshat_| j Save |
Flaces
Saveastype:  |JPEG files [*.ipg) -] Cereel

a. Select the video cell of which you want to take a snapshot.

b. Click Snapshot @ on the quick access bar, or right-click the video cell and select Others >
Snapshot from the popup menu. You also can click Edit > Snapshot to take a snapshot.

(o[8[« J&IE | pea B[« [ [

(127.0.0.1)

DB161(192,168.5.111)
| Storage

08 Live View | [ Matrix View

1_FD&161 2010/09/02 PM 04:47:2

Engle'view

Full Screen Cori+F

! Englle bR Chral
¥ -

¥ | Trable Ingans Rapley

& Steam ] (1FI0U0ATE
Lardain 2 (EIAOTIN
Stresm 3 (1 oAy
Stream 4 (19001080
Gomudl 82 Tk, Fansl
v (]
Others

Cirles
Vides Frha ‘ o e
Vices Cispl }
T R A e f ’
r L,
( Mute e =

Edit | View | Configuratior

Snapshot Chl+E
Print 3
Fecord to EXE

c. The snapshots will be found in the preset storage folder on your local computer.



Recording Settings

The VAST Server allows you to record the live video in EXE, 3GP, or AVI format to your storage
folder.

Record video as an EXE file. The EXE is not only a media file but also a built-in media player. When
user execute the EXE, the media file will be played automatically. There is no need to install any other
program. For more information about how to use the EXE player, please refer to page 236.

Please follow the steps below to configure EXE record settings:

a. Click Configuration > Client Settings > Recording Settings on the menu bar to open the Recording
Settings window.
b. Select EXE as the Record Type.

c. The default storage path is C:\Users\Public\Documents\VIVOTEK Inc\VAST\Client\LiveClient\Record.
If you want to change the storage path, click Browse _-- | to select another folder.

d. Select the Length of each file-- Maximum Size (11~2000MB) or Maximum Time Interval (1~150
min).
a4 Recording Settings ol lEJ L]ﬁ

[@ @ EXE| Record video in EXE forrnat, includes a built-in media
player along with the media file, Executing the file
Record Type: (0 3GP  yaaits in automatic playback, elminating the need to
AT install a separate playback program.

@ Save to;  C\ProgrambDatalDocurments\WIVOTEK InchWAST W ClientLiveClis ||
.||

d

Length of Each File
@) Maxirnurn Size Maxirnurn Tirne Interval

11 1500 2000
- (MB)

U

e. Click OK to enable the settings.

Record video as a 3GP file. 3GP file is a standard MP4 format compatible with players such as VLC
player. Choose this type if you has already installed one of these players.

Please follow the steps below to configure 3GP record settings:

a. Click Configuration > Client Settings > Recording Settings on the menu bar to open the Recording
Settings window.
b. Select 3GP as the Record Type.

c. The default storage path is C:\Users\Public\Documents\VIVOTEK Inc\VAST\Client\LiveClient\Record.
If you want to change the storage path, click Browse _-- |to select another folder.

d. Select the Length of each file-- Maximum Size (1~2000MB) or Maximum Time Interval (1~150 min).



e R =

EXE Record wideo as a 3GP file, a standard MP4 format
compatible with players such as YLC, QuickTime, ar
Record Type:| © 3GP | paalone, Choaose this format if vou have already installed
Ay One of these players,

(G  savets: CiProgramDatalDocuments\WIVOTEK InclyasTiCientilivecle | ... |

(d] | Length of Each File
@ Maximum Size Maxirnurn Tirme Interval
1 1800 2000
— ME
0 (ME)
3GP Settings
@ Record with only standard codec
[ Ok ] | Cancel |

e. If you check "Record with only standard codec", the video from old models (VIVOTEK 6000-series
products) using H.263 codec will not be recorded.

f. Click OK to enable the settings.

Type 3: Record to AVI

Record video as an AVI file, which uses the popular codecs pre-installed in the Windows OS. Please
note that the speed may be slower due to the need of decoding the video/audio and re-encoding both
into a compatible codec.

Please follow the steps below to configure AVI record settings:

a. Click Configuration > Client Settings > Recording Settings on the menu bar to open the Recording
Settings window.

b. Select AVI as the Record Type.

c. The default storage path is C:\Users\Public\Documents\VIVOTEK Inc\VAST\Client\LiveClient\Record.
If you want to change the storage path, click Browse -- | to select another folder.

d. Select the Length of each file-- Maximum Size (1~2000MB) or Maximum Time Interval (1~150 min).

exg  Record video as an AVI file, which uses the popular
codecs pre-installed in the Windows 0S. Please note
Record Type: 3GP  that the speed may be slower due to the need to i 3

decode the video/audio and re-encode into a
@ AV compatible codar.
Save to:  ChAProgramDatalDocumentsi W IVOTER IncWAST ClientiLiveclie | ... . .
@ |—| Due to the AVI file has a limitation on

I . o |
@] Length of Each File the maximum file size of 2G bytes, if
& Maximum Size Maximur Time Interval the setting “time length” generates data
1 1500 000 larger than 2G bytes, several files will
0 (ME) be created.
AVI Settings
@ &1 Frame Rate: 15 - (1 ~30)
r]’f | ¥ideo Compression Setting | ' Audio Compression Setting | @

(84 ] | Cancel




e. Select the frame rate/ per second.

f. To modify the video compression settings, click Video Compression Setting to open the AVI Video
Compression Setting window. Select the desired video compression algorithm, compression
quality, key frame intervals, and data rate in the corresponding fields.

Video Compression Setting g|

) 2
Compressor: K. g

Cancel

- - If you do not choose to compress the video, the
C Qualiy, 100 , s
— » @l generated AVI will be very large in file size.

<
About...

Cinepak Codec by Radius

Kep Frame Every |15 frames
Data Rate 300 | KB/sec

® To modify the settings of the compression algorithm: Click Configure, then a dialog box will pop
up for you to modify the settings. The dialog box will be different according to the compressor you

Se|eCt. Cimepak for Windows T2 El
radus

Wegon 1.10.0.11
Coppughl & 19921995 Rlachus bnc. . A Hights Rleterved

() Coengeed 1o Color

[

{2 Coengweszs in Black L Whin

¥
T

m To read the information of a compression algorithm (its version for instance): Click About, and a
dialog box will pop up showing the related information. The dialog box will be different according to
the compressor you select.

Cimepak for Windpws T2

radus

Cinespas A Codec
Wergiom 1.70.011
Copprghl o 1900 1995 Flackus e, A Flaghts Flesrrved

g. To modify the audio compression settings, click Audio Compression Setting to open the AVI
Audio Compression Setting window. Select the desired audio quality, format, and attributes in the
corresponding fields. X

Audio Compression Setting

RE=S

[untitied] v

Farmat: PCH v
Attributes: 44100 kHz, 16 Bit, Sterec 172 kbizec

Ok, Cancel




Record an EXE/3GP/AVI File

Please follow the steps below to record an EXE/3GP/AVI file of a live video stream:

a. Select a video cell or a device from the heirarchical management tree which you want to record to
media file.

b. Click Record to EXE/3GP/AVI E| on the quick access bar, or right-click the video cell and click

Record to EXE/3GP/AVI. You can also click Edit > Record to EXE/3GP/AVI on the menu bar. (The Ul
string will change according to your Recording Settings.)

B0 (= I ) == e R Y )

n1(127.0.0.1) 10 Live View | 2§ Matrix View Edit | View | Configuratior
1
_FDE161(192.168.5.111)
ing Storage

1_FD8161 201009702 PM 04:47:2
. ek

. Snapshot Cl+d

Print 4

Record to EXE

Aemon

irghe Wi
Full frpon

Inakles P&

[nskle hars Nepley

Strwsm 1 (LR0I080
Straam 2 (10T
Seoparri 3 {1 TH144}
Serewn 4 (102 01080y
Sl 10 Tadk Posl
S D0
Crebegrs

Srmpshil Colas

Videa Erhantersent Record b EXE
Videa Diiglay Mode et -

c. For recording a high-resolution video (1600 x 1200) in AVI type, a dialog box will pop up as shown
below to remind you that the CPU loading will increase. Click OK to continue the process.

Cormer trg hagh niscdution vided S8 may Lgndicantly forpase Te OFU acng,
leading ' possibilty of sreaming deconrechion o reduced Syvieen porformancg

d. The icon E| will then change to Recording EXE/3GP/AVI E' and a red text string (EXE/3GP/AVI)
will appear at the bottom right of the video cell. Note that only one video channel can be recorded at a

e BLEEEEE R

K Live View | P Matris Vi ée'
B SEG 1_FD#161 2010/09/02 PM D4:56:31
o 1AR.3.50) i \ 1 .

21683102

If you save your video via a LiveClient installed
on another computer, the videos will be placed in
where you installed the LiveClient utility: e.g., C:ll
VASTIClient|LiveClientlRecord. On Windows XP:
C:|Documents and Settings|All Users\Documents|
VIVOTEK IncI\VASTIClient\LiveClientIRecord

e. When you want to terminate the AVI Recording, click the icon E| on the Quick Access Bar. The export
process will then terminate and the button will change from | = | to LﬂB The recorded media files will be
found in the preset storage folder on your local computer as shown below.

Below is the file name format for AVI files:

J, \L ""71-; IediaPlayer £ pplication 230 KR

IGFP
Date and time Video format
(YYYYMMDD_hhmmss)

T T T e v
R

it :




Built-in Media Player--EXE

Below is the icon of footages saved as EXE files. Double-click on it, the recorded video will be played
automatically as shown below. You may also open the built-in Media Player in the default location:
C:\Program Files\VIVOTEK Inc\VAST\Client\LiveClient. On Windows XP: C:\Documents and Settings\All
Users\Documents\VIVOTEK Inc\VAST\Client\LiveClient\Record.

20091118 112743 exe
Video Title MediaPlayer & pplication
[ Hfi=dia Playe T = |

File] Edit Wiew

2013-04-01 | U Timeline Slider 2013-04-01

0g:49:13 08:49:45

Status Panel

ll——l‘ li ’7 @ @ 2[?&39D;l‘501 Playing

| Total length of the histogram
Control Buttons
The playing rate can be 1/8, 1/4, 1/2, 1X, 2X,
4X.

Current time of the video clip

Icon Function Description
E Pause Pause playback of the focused video clip
E| Play Start playback of the focused video clip

E| Next Frame Go to the next video frame of the focused video clip

Slow Down  Slow down the playback rate

@ Speed Up  Speed up the playback rate




The function menu of the built-in media player are displayed as shown below:

Bdit View Edit N
Crpen 3GF File .. Snapshot (BMP) Full Screen
save az BHE .. snapshot JPED)
Bave az 3GF File .. Comvert to AY]
Print
Exit

® The built-in player is able to playback 3GP and EXE files.

® The built-in player is able to save 3GP files as EXE files.

® The built-in player is able to save EXE files as 3GP files.

® The built-in player is able to convert EXE and 3GP files into AVI files.
® The built-in player also supports snapshot and print functions.

=Y
Below are special notices related to video recording with the fisheye cameras:

m For recorded videos from the fisheye cameras, only the built-in Media Player can playback the
Regional or Panoramic views. If you access the recorded videos using other playback software, you
will end up seeing the circular-shape Original view.

m \When recording videos from fisheye cameras, Regional and Panoramic views can only be preserved in
the EXE and 3GP format. If you save the dewarped views, i.e., Regional and Panoramic, as AVls, only
the circular Original view will be preserved.

= Currently the video playback on the Emap window displays the Original view only.
m To display a Regional or Panoramic view, right-click on the Media Player window.

Qe —— T gl

File Edit View W

2011}07¢27 09:27:11

2Ull-ur-27
09:27:15

2UL1-UF-27F -
09:27:09
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View Settings

This section allows you to set the display mode of a video cell, including Display Location,
Date and time Format, Video Display Mode, and Font Settings. When you change the
settings, the sample window will change accordingly for you to preview the settings.

S View Settings @
Display Location

Dty vea 1: | RS- |

Camera Name 2016/6{24 T % 06:07:23

Display Area 2: | Server Date & Time El

This is a sample screen.
Display Area 3: | Video Title El

Display Area 4: | No Display El

Date and Time Format Font Settings

@ Samne as Local Computer Font: ’System ,]

() Specify Color: E
Date Format: | YYYY/MM/DD Size:

Time Format: | Default Time Format

Video Display Mode

@ Hide borders ) Keep top/down borders ) Keep the aspect ratio
Show motion windows when triggered

Display the connecting message when video is lost

[7] The screen goes blank when video is lost

VCA
[¥] Show VCA rules
VCA extra information:
’ 0K ] [ Cancel
Display Location . ;
pay Display Area 1 Display Area 2
Display Location
Camera Name “UThIBIZA = UbUSZS
Dispay Avea 1: [ERERI S~ L
Display Area 2:  Server Date & Time E
This is a sample screen.
Display Area 3: | Video Title E
Display Area 4: | No Display E

Yideo Title

. . ) Display Area 3 _ Display Area 4
As the illustration shows, there are 4 display areas for you to input information about the live video. Each

drop-down list includes many options for you to select: No display, Camera Name, Video Title, Camera
Date & Time, Camera DateTime, Server Date & Time, Codec & Resolution, Address, and Network
throughput & FPS.



Date and Time Format
Date and Time Format
@ Same as Local Computer
Specify
Date Format: | YYY"/MM/DD
Time Format: | Default Time Format

m Same as local computer: Select this option and then the date and time format will synchronize with the
local computer.

m Specify: Select a desired format for the date and time from the drop-down list.
Date format: Select YYYY/MM/DD or MM/DD/YY.

Time format: Select the default time format (synchronize with the local computer), 12h AM/PM, or 24h.

Video Display Mode

Video Display Mode
@ Hide borders Keep top/down borders Keep the aspect ratio

¥| Show motion windows when triggered

Camera Name 201040129 PM 02:12:11
m Keep the aspect ratio: In the default settings, the size of
the video window will change according to the layout of This is a sample screen.

the live view window you choose. However, the frame
size may be distorted.

m Keep top/down borders: the camera name, video title, _ _
and time will be displayed on the black borders instead LRI

of displaying floating text on the screen.

m Keep the aspect ratio: If you select Keep the aspect ratio, the video window will be adjusted to the
same frame size as the preview window. This function is disabled as default.

®m Show motion window when triggered: If you select this option, the red frame of the motion detection
window will appear in the video window when motion is triggered. This function is enabled as default.

m Display the connecting message when video is lost:indow will appear in the video window when motion
is triggered. This function is enabled as default.

m Show VCA rules: VCA rules refer to the Line Crossing and Field Detection lines drawn on individual

video screens. These VCA functions are configured on the web consoles with cameras, not on the
VAST LiveClient.

The Display options can also be accessed by a right-click on the view cell.

For detailed information about how to set up the layout of the live view window, please refer to How to
Change Video Viewing Mode on page 132.
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Font Settings
This function allows you to change the font on the video cell.
m Font: Automatically lists all fonts installed on your operating system. Select the desired type.

m Color: Select a desired font color (white, red, green, blue).
m Size: Select a desired font size (8, 10, 12, 14).

Femmve
~Eingle View = P

Font Settings Full Screen Cutek
o Enablebtant Repley
Font: [Sgrsbem vl & Stmsn |
Stresm
Color: Streand
‘ B “Send ta Talk Pand
en0
Sige: |10 - Cibis

Viddew Enhargernert
Widea Digplay Meds
Fisheys Diphay Mode
VL RS Ackus Bar

wo L bm e
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General Settings

This section allows you to configure the System Settings and Rotation Settings.

w s S i

System Settings

Autormatically log in after logging in to operating system
Autornatically display in full screen after login I
I auto add newly-inserted camera to video cell

J|Retrieve RTSP stream on specified port; 554

Connect substation streaming via relay

V| Keep detecting camera DI/DO status

System Settings

Sort carnera by name

m Auto login after logging in to operating system: If you check this option, VAST LiveClient will
automatically login after you login to Windows without filling in the user name and password. This
function is disabled as default.

m Automatically display in full screen after login: If you check this option, the video cells will be displayed
in full screen without showing the menu bar or the control panels.

m Auto add newly-inserted camera to video cell: If you check this option, VAST LiveClient will
automatically add the newly-inserted device to a video cell. This function is enabled as default.

m Retrieve RTSP streaming on specific port: The default port for RTSP streaming is 4543. If you want to
change this port, please check this item and fill in a desired port number.

m Setup substation streaming via relay: This option is not checked by default. As the following diagram
shows, VAST Client might directly connect to the streaming under VAST Server 3-2 without requesting
the connection via VAST Server 1 and Server 2-1. If you want to get streaming through relaying,
please check this option.

VAST _! - > VAST
Server 1

| manages 2 sub-stations

VAST VAST
Server 2-1 > Server 2-2

'l' ST7501 VAST - ST7501 - ST7501
Server 3-1 3 Server 3-2 l .Server 3-3 l .Server 3-4

VIVOTEK IP Camera VIVOTEK IP Camera VIVOTEK IP Camera

VIVOTEK IP Camera

g;

um [f the VAST Server 3-2 is set up behind a firewall, the VAST Client will not be able to access the VAST Server 3-2
directly. You have fto get the connetion by relaying.



m Keep detecting camera DI/DO status: The default for this option is enabled. This option enables the
VAST server to monitor the DI/DO status from the configured cameras. You may also disable this
option.

m Sort camera by name: The positions of cameras on the device tree will be sorted by their camera
names. —

“ad Gearaesl Sattings i
Systom Seltings
Agtneraticaly og n 3w Dpging In b0 Doentng mebeT
Aetommatcaly Savay i ful soeen after ogn

Aalhn 38 newl-nseted amen o vdes ol

Hetation Settings
Enabie ratation ater logn

Deply Settingy
Mo nomer of v ool (i =
Enabis 3ot Strasm ;| Cualty fire
racacs Ranckicn
¥ Enabis Instant Reglxy oo viged Cel
Detsit rephy length |30 semonds =

Local mreaming boer time: 0 milleaCond .

Alarm Settings

= Enable live alarm notification: Select this option to activate real-time event notification. For example:
the event notification of DI/O status on the hierarchical management tree, the event list in the event
window, motion detection windows in video window, or the event notification on E-map settings page,
etc. This function is enabled as default.

= Enable alert sound(s): If you enable this option, you will hear alert sound on the client side when the
event is triggered.

m Enable E-Map popup window: When enabled, a popup window appears on an E-map displaying the
current video when a camera-related event occurs.

Note the following with the E-Map popup window:

» The camera that triggers an alarm must be placed on the E-map to have its live video displayed in
the popup window.

*  When an event occurs, and the related camera is configured into multiple E-maps, the popup
window appears on the first available E-map.

*  When many popup windows appear, many map views will consecutively appear until all popup
windows properly display.

» This feature supports popup windows for cameras under VAST substations or NVR.

* Popup windows only appear when the E-Map is opened; however, the windows will still appear on
a live view.

» If a DI/DO trigger is not associated with a specific camera, no popup video window will appear
when triggered.

» Fisheye dewarp is also available on the E-map popup windows.
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* Please also configure the Client Notification options in the Alarm Management window.

B! 'ﬁﬁ”' - ... :

An 3l & assocated to one or more inberestad events. Whan one of them & mggened,
ke FyStem would raiss an akem,

= Alarm window mode: Select Fixed or Popup mode for the event window. For more information about
event window, please refer to page 90.

Rotation Settings

m Enable rotation after login: If you check this option, the video cells will start to rotate after you login to
the VAST LiveClient. The default setting of this function is disabled.

m Rotate the page every ] second(s): Fill in a desired interval time for video page rotation. The
maximum value is 99 seconds. The default value is set at 6 seconds.

For detailed information about how to set up the layout of the monitoring window and rotation functions,
please refer to How to Change Video Viewing Mode on page 132.
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Display Settings
Maximum number of view cells |64 v|
/| Enable auto stream slze:|QuaI'rt~,r first v|

Enable de-interface function

/| Enable Instant Replay on video cell

Default replay length: |30 seconds v|

Local streaming buffer time: 0 * milisecond(s) (0 ~ 10000)

® Maximum number of view cells: This determines the number of view cell on window, and also takes
effect with the number of layout pages. For example, if there are 320 channels using the 1+31 layout,
there will be 10 layout pages in the LiveClient window. The configuration changes take effect after the
LiveClient is re-started.

m Enable auto stream size: The Auto Stream Size feature dynamically adjusts the stream sizes of video
feeds from network cameras in order to reduce CPU load and bandwidth consumption.

It is often the case that in surveillance deployments the physical dimensions of monitors, the
effectiveness of visual stimulus, and the operators' regions of interest can all be very limited.
Streaming large-size videos at all times will be a waste of bandwidth and system computing power.
CIF and VGA size videos are usually sufficient for the operators watching surveillance screens.

When enabled, your LiveClient station automatically requests smaller-size streams as video feeds (any
from streams #1 ~ #4) from the network cameras. For example, the frame size of video stream #4 will
be reduced to 320x240 (CIF). Depending on the actual size of view cells on the LiveClient monitoring
screen, the VAST server automatically requests different video streams.

When the size of view cells is manually expanded, a VAST server requests a different stream. This is
called Stream Jump. Shown below are the details of the corresponding stream jumps.

View cell size Stream jump to...
4:3 resolutions
<= 320x240 stream #4 (CIF)
> 320x240 or 640x480 stream #1
16:9 resolutions
<= 384x216 stream #4 (CIF)
> 384x216 or 640x360 stream #1
1:1 (fisheye cameras)
<= 384x384 stream #4 (CIF)
> 384x384 or 640x640 stream #1

Facts about Auto Stream Size:
* The Auto Stream Size takes effect when,
1. The size of view cell is changed.
2. Inserting a new camera, or when the "Auto add newly-inserted camera" feature is applied.
3. Double-click or click-and-drag cameras into view cells.
4. When Auto Stream Size feature is enabled (the configuration on this window).
5. Through the layout change.

» The LiveClient utility automatically adjusts stream selection according to the size of view cells, no
user's configuration is required.



* The frame size of stream #1 is user-configurable. The VAST server only resizes stream #4.

« |If a user disables the Auto Stream Size function later, the frame size of stream #4 will not be
restored to the previous configuration. Stream jump takes place on the display of all connected
cameras once the function is enabled.

» The Auto Stream Size function does not apply to the Matrix view.

+ If users configured a region of interest before the Auto Stream Size function is applied, e.g., via
the ePTZ control, the view cell might display a different live view.

* Below is the general rule for stream selection:

stream # configured into VGA stream # configured into CIF
4 streams cameras Stream 2 Stream 4
3 streams cameras Stream 2 Stream 3
2 streams cameras none Stream 2

* When a smaller stream is selected, the video quality is set to fixed quality as Good.
* The Maximum frame rate is not configured.

+ The VAST server automatically selects a video resolution of a specific aspect ratio that best fits
the current view cell, and places the video into the view cell.

Limitations:
* For older, single-stream cameras, the Auto Stream Size feature does not take effect.

*  When the Auto Stream Size feature is enabled, the NR and ND series NVR configured under the
VAST server will be considered as substations. The stream configuration of cameras managed by
these NVR substations will not be changed. Only the video codec, bit rate, and frame rate of the
video feeds directed through these NVR substations will be changed into a more economic setting.

+ For the NR8401 NVR, the Auto Stream Size function may not fully apply. For cameras managed
by the NR8401, the following will apply:
Large view cell: default viewing stream.
Medium view cell: stream #2.
Small view cell: the last stream.

« a user disables the Auto Stream Size function later, the frame size of stream #4 will not be
restored to the previous configuration.

®m Enable de-interlace function: Select this option if your connected device does not support de-interlace
function. For example: VS7100.

m Enable Instant Replay on video cell: Here you can change the duration of a playback that happened
immediately before a user utilizes the instant playback function.

m | ocal streaming buffer time: Video frames can be temporarily stored on the cache memory of the
VAST server for a short, configurable period of time before they are displayed on the Liveview. If the
networking condition is less than ideal, this can help delivering a smooth video stream. Note that this
feature is not available on a Matrix view and the web console.



Joystick Settings

This section explains how to remote control connected network devices with a USB joystick. It's
easy to install and configure via the USB interface.

Enable Joystick

Connect to the USB plug of the joystick to a USB port on your computer. Supported by the plug-in in the
main page (Microsoft’'s DirectX), once the plug-in in the main page is loaded, it will automatically detect if
there is any joystick on the computer. The joystick should work properly without installing any other driver
or software.

Then you can begin to configure the joystick settings of connected devices. Please follow the instruction
below to enable joystick settings.

a. Select the target device from the hierarchical management tree.

b. Click Configuration > Client Settings > Joystick Settings on the menu bar to open the Joystick
Settings window. If your joystick is working properly, it will be displayed on the drop-down list.

c. Select the joystick you want to configure. Check Enable Joystick, then click Configure Buttons to
open Buttons configuration window.

(System | Edit | W [b) | | Configuration || Layout | Help:l

Camera Management 9
olelaloh v ISR
— Uzer Management .. =
A zsociation Management. ..
‘;;K —oratentiz Event Management... e Views | [ Matrix View
- C _ .
arnera Virtual Matrix Management * GRTR] 2010/09/03 PM 01:21:42
&l & 1roa | 03 |
- 1 Recording Ste_~ition ettings v

Clisnt Settings Snapshot Settings
B Layout - Recording Settings
View Settngs
Creneral Settings
Jowstick Settings
Proxor Settings
PiP Bettings

+

Yideo Enhancenent r

Joystick Settings Assigned Actions
71 Enable JDYStiCk Blors Buttone - Aty AChors |
@ Hayme - Buttan - Record to EXE
Rewerse direction of zoorm contral Zoom In Buttor? - Zoom In
. Zoam Out Buttond - Foom Cut
Selected joystick:| |CH PRODUCTS [P DESKTOR CONTR! | - Forus e _;‘;’*““’
. ol Bullors - Shig
- Pan Button? - Patrol
| Calibrate | | Configure Buttons | | Configure Keypad | Stop BUthOrE - Home
Patend Butbord - Full Stneen
b Pratat Buttanii - Srapchat Safo harming
| Page U D.ll.l.-'_vnil - Prcwll
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Reverse direction of zoom control

Due to different designs in joystick zoom wheel, you can select this checkbox to reverse the zoom in/out
directions.

Buttons Configuration

In Button Configuration window, the left column shows the actions you can assign, and the right column
shows the functional buttons and assigned actions. The number of buttons may differ from different
joysticks.
Please follow the steps below to configure your joystick buttons:
a. Choosing one of the actions and click Assign will pop up a dialog. Then you can assign this action to
a button by pressing the joystick button or select it from the drop-down list.
For example: Assign Home (move to home position) to Button 1.

Assigned Actions
Actions | |Eluttc|r'|s Assigned Actions |
Home ”
£00m 1n
Zoorm Out
FoCus
Iriz
Pan Press the joystick button to assign to "Horme" or
Stop select the button from the list below.
Patrol
Preset
Page Lp Buttonl
Page Down BLttonz
Recard to A\l BLtton
Snapshot Auto Maming Buttong
= ButtonS
Buttong
= Button?
Button3 (84 ] [ Cancel
|__|Buttong
Buttonlo K | | Cancel
Buttonll
Buttonl2




b. Click OK to confirm the configuration.

9 x|

Assigned Actions

Actions @ "Home" g|

Horme

Zoom In

Zoom Out)  Press the joystick button to assign to "Home" or
+- Focus select the button from the list below,

4 Iris
Pan IButtonl
Stop
Patrol

= Presat Click "COk" to assign "" to buttonl

Preset]
Presetd
Preset3

ErESEFf )4 ] ’ Cancel ]

Assigh Clear Selected

[ ok ] [ Cancel

c. The Assigned Action will appear beside Button 1 in the right column as shown in the following diagram.
Note that a button can only be assigned with an action. If you want to modify the settings, select the
action on the list and click Clear Selected.

¥ Butions Configuration g'

Azsigned Actions
Actions Buttons Assigned Actions

Home ~
Zoom In
Zoorm Out
+-Focus
+- Iris
Pan
Stop
Patrol
1 Preset
Page Up
Page Down
Record to AWI
Snapshot Auto Narming

ussign { [Clgar Selected

[0]4 ] [ Cancel
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d. If you want to assign additional actions, repeat step a.~c. When all settings are complete, click OK
to save the settings or click Cancel to discard the settings. You may also assign buttons to jump around
matrix screens.

Assighed Actions

|Actiun5 |Elutt|:|n5 - Assigned Actions

- Stop Alert Buttonl - Record to EXE
- audio Mute ButtonZ - Zoom In
Button2 - Zoom Out

- Rotate

- Record to EXE Buttond - Single view

. Buttons - Pan

Enapshut Auto Naming Buttoné - Stop

- Print Button? - Patrol

- Lock Buttong - Home

- Full Screen Button® - Full Screen

- Gingle View ButtonlD - Snapshot Auto Maming
: ; Buttonll - Presetl

- Previous Matrix

- Mext Matrix Buttonl2 - PresetZ

- Prewious Monitor
- Mext Monitar

Azsign ] [ Clear Selected ]

[ Cancel

e. Click OK to save the settings or click Cancel to discard the settings.

¥ Joystick Settings |z|

Jovystick Settings
i

Selected Joystick! | cH PRODUCTS IP DESKTOR COM v |

[ Calibrate J [Cunﬁgure Euttons]

QK [ Cancel ]
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m /f you want fo assign Preset actions to your joystick, the preset locations should be set up in advance.

m /f your joystick is not working properly, it may need to be calibrated. Click Calibrate to open the Game Controllers
window located in the MS Windows control panel and follow the instructions for trouble shooting. For more

information, please refer to the MS Windows help files for details.
¥ Joystick Settings |X|

Joystick Settings

Selected joystick! | (H PRODUCTS IP DESKTOP COF |

l Calibrate ' Configure Buttons

[ oK ] [ Cancel J

m The joystick will appear in the Game Controllers list in the Windows Control Panel on your computer. If you want
fo check out your device, go to the following page.: Open Start > Control Panel > Game Controllers.

Game Controllers

These settings help you configure the game controllers installed on
w your cormputer.

Installed qame controllers

Cantroller | Status |

CH PRODUCTS IP DESKTOP COMNTROLLER

[ Add... ] [ Remove J [ Properties J

[ Advanced... J[ Troubleshoat. . J
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Configure keypad

For joysticks that come with a keypad, you can use the combination of a number assigned to a camera
and the Enter key on keypad to quickly move to the camera’s current view. The current view will be
displayed in a single view. To configure the number representative of each camera, double-click to open
a configuration window. The number used for quick switch must be mapped to an existing channel.

Also note the following:

1. The keypad key representative can be a 4-digit numeric combination.

2. If a number key is pressed without pressing the Enter key within 3 seconds, the command is cancelled.
3. You should have at least ONE EMPTY view cell.

4. A Rotation operation will be halted when using the keypad quick switch function.

5. This quick switch function does not take effect on the cameras managed by VAST substations.

ad Joystick Keypad Mappiné ‘ ﬁ
A Set Key Mumber x_iJ-
Carmera Mame Key Mumber
Enter numberic characters starting from "0" to
FEB191-shepherd test 1 "@999" or select the number from the list to map to
Mega-Pixel Metwork Carnera 2 Mega-Pixel Network Camera.
IB3338-H 3 1
sDe161 4 M

oK | | Cancel MJ




Joystick Settings - Using VIVOTEK's AJ-001 & AJ-002

The AJ-001 and AJ-002 joysticks come with some defaults working with a VAST server.

* Channel quick switch: Enter 1 to 4 numbers and press “Enter” on the keypad to bring the channel
into a full view. For example, enter 0010 and press Enter, CH 10 camera view will prompt on screen.
Note that the number keys and Enter must be pressed within 3 seconds.

» Currently, this function does not apply to cameras managed by sub-stations.

Following are the conditions for making the connection:

1. The joystick can either be powered by a DC 12V adaptor or via the USB. If powered by USB, plug the
USB cable twice to the USB port to enable USB power.

2. Connect the included USB cable between the USB ports on the joystick and a VAST server.

VAST

4]

S ¥ enn *‘!1 ] 12vDC

KEYPAD DEFINITION
Below is the keypad numbering sequence:

(1) (2) (8) ‘C:)‘ =
(«) (5D (8) B e B @ - S
SR I = e =
) (P (=1 L)L) ) &) &) (A ()
9 10 11

12 13 14 21 22237 8 1 2
15 16 17 24 25 26 27 28 3 4
18 19 20 5 6




Since VAST rev. 1.13, the following keypad functions will be available as the defaults for the joystick.

1 |Pan 9 |# 17 |#9 25 |Pause

2 |Patrol 10 |#2 18 |Cancel/Clear/Esc |26 |Play

3 |[Stop 11 [#3 19 |#0 27 |Speed Up

4 [Home 12 |#4 20 |Enter 28 |Speed Down
5 |Zoomin 13 |#5 21 |Full Screen

6 |Zoom out 14 |#6 22 |Manual recording

7 [Snapshot 15 [#7 23 |[Change Layout

8 |Preset 16 |#8 24 |Rewind

Use the combination of "Preset Move Combo" (button 8) + number keys + Enter.
For example button 8 + 1 + 0 + Enter -> Preset #10.

1d Pressing the layout button changes the current view cell layout. Press to change the layout
2y from top to bottom as shown on the left.
1P+2
3V
2x2
4y
a3 You can see the default definitions for the keypad in the Joystick configuration windows.
1P+6 Joystick Settings
33 Enable Joystick
[“] Reverse direction of zoom control
1P+8 .
Selected joystick: IBD Joystick Keyboard 'J
1+12
[ Calibrate J [ Configure Buttons l [ Configure Keypad I
dad
x5 oK J I Cancel I
1+31
EKE \a!-ut!qunﬁ_guram' b st

Assigned Actions

Actons

= oot

Home

Zoom Dut
- Focus
4 Irs
Pan
Stop
Patrol
i3 Presel

| ZToom In

Page Up
Fage Down
Page Homa
Page End
Stop At
Rotate
Record to EXE
Prenvious Matri
et Matroc
Prinious Monios
Hext Monktor
i Keypad
Escape
Preset Move Combo
+ Ingtant Replay
+1- Playback
#1- Common

Buttons - Assgned Actions

Buttonl - Pan
- Patrol
3 - Stop
- Home
- Zoom In

& - Zoom Out
- Snapshot Auto Naming
- Preset Move Combo
- Keypad Hurmber 1
) - Kaypad Hurmber 2

i1l - Keypad Number 3
thonl2 - Kaypad Number 4
- Kaypad Nurmber 5
- Kaypad Number 6
- Kaypad Humber 7
- Keypad Nurnber
- Kaypad Number
- Escape
- Kaypad Numbar
- Kaypad Entar
- Full Screan
- Record to EXE
- Change Layout

Rawind

- Pause
- Play
- Speed Up
- Slow Down

e e
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If you should need to change the mapping table, use the Keypad Mapping function.

Camera Name Key Number
30x Zoom Mega-Pixel Speed ...
Network hi Camera

Mega-Man Network Camera
Mega-Man Hetwork Camera
Mega-Man Hetwork Camera
Mega-Man Hetwork Camera
Mega-Piel Network Camera
Maga-Piell Natwork Camera
Mega-Man Hetwork Camera
Mega-Man Hetwork Camera
Mega-Man Network Camera

DB s O WA B W R e

B
-0

| Enter numberic characters starting from 0" to
"9998" or select the number from the list to map to
Mega-Man Network Camera.

3

[

(- RN AT Y

b=k

The below message shows a mapping table ID conflict.

T

Enter numberic characters starting from 0" to
"0999" or select the number from the list to map to
Mega-Man Network Camera.

E |

The number i already in use by Mega-Man
Network Camera.
Press the OK button to replce it or press
Cancel to cancel.

[ ok || concel |

.
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Below is the normal server status information.

. Statio
01-19 17:21:19
Current Time: 2015-01-19 17:21:26

Ky Mimber: 1

Falch

Camera: [P7161




PTZ/ E-PTZ Function
In addition to using the PTZ control panel, you may also control the rotation handle of the joystick to
remote control a PTZ/ E-PTZ network camera with ease.

Pan/Tilt: Move the rotation handle of the joystick; you can pan the camera to the desire position. There
will be blue line displaying the moving direction in the center of the video image as the diagram 1 below.

Zoom in/Zoom out: Shift the rotation handle clockwise to zoom in the camera on an image or go
counterclockwise to zoom out the camera on an image. There will be a circle and four vectors in the
center of the video image as the diagram 2, 3 below.

FD8161

FD8161 2010/09/03 PM 03:56:17 |l FD8161 2010/09/03 PM 03:56:17
r= ; [=

Wideno

Wideno Wideno

Pan/Tilt Zoom in Zoom out
(Move the rotating handle back and forth) (Turn the rotating handle clockwise) (Turn the rotating handle counter-clockwise)
Proxy Settings

In this section, you can enable, modify, or cancel Proxy Settings for client if your VAST Server
is under a proxy. If you change the proxy settings, please fill in the new value next time you login
the LiveClient next time.

4 Proxy Settings =5 N VAST LiveClient 53
Log in local station
Enable Proxy
Address: 192.168.6.117 -
Address:
Authentication: |Basic Account -
Port: an :
User Mame: admin
B [T, Password: .
Password: Port: 3443 =] [@luse ssL
(04 ] | Cancel | | Proxy Settings

= | Log in || Cancel ||Hide<:<:




How to Use PiP (Picture-in-Picture)

PiP (Picture-in-Picture) is an intuitive function for user to simultaneously view a Global View and
ROI (Region of Interest) for live monitoring. The digital zoom in function can only focus on the
interested area and represent the details of megapixel video. Moreover, the multi-touch mode is
a very user-friendly interface for digital zoom in.

Enable PiP

Right-click the video cell and select Enable PiP. If you want to disable PiP, click the option again to
uncheck it. After you enable the PiP function, a movable global view window and a ROI frame will be
displayed as shown below.

Mega-Pixel Network Camera . 2010/6/29 PM 09:24:24

Ctr+I
Hude Global Yiew Ll

Stream 1

Btream 2

Stream 3

Btream 4

Fend to Talk Panel
Het DO

Orthers

Global View ¥ideo Enhancement

Region of Interest
(ROI)

Global View

The global view is the original view with the size scaled down to 160x120. It is movable and you can drag
it anywhere in the live view window. If you want to hide the global view, right-click the video cell and
select Hide Global View from the menu. An icon “*_ will appear on top of the live view window.

1_FD8161

pLo)

Remove
eingle View
Full Screen

v Enable I'iP Ctrl+]
Hide Global View Ctl+H

& Stream 1
Atream 2
Atreagm 3
Btresgm 4
Zend to Talk Panel
Zet DO »
Others *

Video Enhancement L4



ROI (Region of Interest)

The ROI frame is capable of being resized and dragged in any direction upon the global view window as
e-PTZ function.

Digital Zoom In

Through digital zoom in, the live view window will be filled with the zoomed in ROI image. The maximum
magnification of the ROI frame is 16x zooming. The zoomed in area will change as the ROI frame is
dragged and resized. You can also easily zoom in and zoom out the ROI frame by rolling the mouse back
and force.

Edit | View | Configuration

Snapshot & Print Zoomed In Image Spapshot ol
You can snapshot and print the zoomed in image. Erint '
Eecord to EXE

Snapshot Zoomed Tmage
Frint £oomed Image

PiP Settings
The PiP Settings is for you to adjust the initial position of the global view window.

Click Configuration > Client Settings > PiP Settings to open the window. On top of it, you may choose
the horizontal position with left / middle / right side of the live view window, or you can customize the
percentage of space distance from the border of the live view window as an option. It is also fully applied
for vertical position with top / middle / bottom side of the live view window. When it's done, you may click
on Apply to existing windows to enable the settings.

= -

Configuration || Layout | Help | ‘s PiP Settings x
Coamers Management Initial Position for Global Wiess Window

3
Station Management. .. ||"‘H E H‘ l Horizomtal:

ser Management...

S zmnciation Management. .. % aweay fram left border
I8 Live Yiew
Event Management... it ,
: : A ertcal Bottom aligned |
Wirtnal Mateix Management ¥
Station Settings b ) .. % away from top border
; : P .
i ;ﬂﬂpfft SZ ) [ Apply to existing windows ]
Video Enhancement k _'_Em mg RIURE
View Sethings
Feneral Pettings [ OK ] [ Cancel l
Jowstick Settings
Broxor Bettings
Pif Settings

g;

m [f the position of ROl and global view will be saved and applied for the next open. It will be removed when the live
view cell is removed.
® The PiP function is also applied in VAST Playback.



Multi-touch Mode

VAST also supports advanced multi-touch mode for PiP. You can easily zoom in or zoom out the image
by touching the multi-touch monitor with two fingers.




How to Configure Video Enhancement

The LiveClient allows you to enable post-image enhancement and defog for video live view.

Basic Image Adjustment

This function allows you to configure basic image adjustment including Brightness, Contrast,

Saturation, and Hue.

Please follow the steps below to set a profile for post-image adjustment settings:

a. Select the target video cell.

b. Click Configuration > Video Enhancement > Basic Image Adjustment > Settings on the menu
bar to open the Profile Settings window. (Or you can right-click the video cell and select Video
Enhancement > Basic Image Adjustment > Settings from the popup menu.)

9

Configuration || Layout | Helpj

<>

| Camera Management 3
i 7
[ Swtion Management . “‘“ EE”J
Wzer Management... -
A smnciation Management. . f -
Event Management... e Wiew ﬁ Matrix Wiew

Virtual Matcix Managentent ¥ [RTRI

Station Sethngs
Client Settings

Video Enhancement

1_FD8161
Remove
Single View
Full Bereen Ctl+F
Enable PP

Stream 1
Stream 2
Stream 3
Stream 4
Hend to Talk Panel
et D0

Orthers

Video Enhencement

aettings .

Dizble &1 Cameraz
Enable Al Cameras

4 O . . },""‘-
I _’(«Qﬁ
i r "
R /

c. Adjust the values of Brightness, Contrast, Satura-
tion, and Hue. You can preview the image from the
window on the right. A “VE (Video Enhancement)”
text string will appear at the bottom right of the
preview window.

d. When completed, click Save as Profile and enter
a name for the new profile.

e. The new profile will be displayed on the drop-down
list. This profile can be applied to all video cells.

f. If you decide to apply the selected profile to the
target video cell immediately, click the OK button.
Otherwise, click Cancel to close the window.



¥ Basic Image Adjustment - for 1_FD8161

Current Profile:; Ir'u:h:u:ur [+ €]
Profie Settings
@ Brightness:  -128 J 128 |27 -
Contrast: 0 —{J 128 ;.
Saturatian: o —{J 128 1
Hue: 180 J 10 o |2
Ccﬂl [ Save as Profie... ] [ Update Profie ] [ Delete Profile ]

:m

] [ Cancel l

| o

g. Back to the main page, a “VE” text string will also appear at the bottom right of the video cell and the
new profile will also appear and be selected on the popup menu as shown below.

_Cunfiguratiun | Layout | Helpj

Camera Management 3 _
i o a

Station Management... |I“||E‘ H‘_.|| Hq:l‘

User Management... X

Aszsneiation Management. .. .

Event Management... e Vigw ﬁ Matrix Wigw

Firtual Matrix Management v ERFS| 2010{09/03 PM 04:16:10
Btation Settings
Client Settings

¥ideo Enhancemen

Dizable AN Cameras
Enable L11 Cameras——
Dizabled

Oiiginal
v Indoor

Remove

Single View
Full Bcreen
Enable PiP

Stream 1
Streaim 2
Streaim F
Streanm 4
Send 1o Talk Panel

profile

cell

Click to create a new profile, edit
or delete a customized profile

Click to disable VE on all linked
devices

Click to enable VE on all linked
devices

Click to enable/disable VE on the
target video cell

Click to create a new profile, edit or delete a

L
— Click to enable/disable VE on the target video



Defog

This function allows you to configure post-image defog.

Apply a Preset Defog Profile
Please follow the steps below to set post-image defog settings:
a. Select the target video cell.

b. Click Configuration > Video Enhancement > Defog or right-click the video cell and select Video
Enhancement > Defog.

c. There are some preset profiles for you to apply to the target video cell. You can select one from the list
accoding to the environment.

E@ [ Configuration | Layout | Help)

l_aimera Management L4 _
i =
= BRI
Taer Management... x
Asociation Management. .. :
Event Management. . Ve Wiews | ﬁ Matri Wienr

Virtal Matri: Managemfat ¥ BRI

Slation Betbings L4
Client Bettings L4

1 L
- ¥ L i
asic Image Adjustment * LA 0 o
Settings
Dizable L1 Cameras
Enable 411 Cameras

Yideo Enhancernent
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Fog

Rainy
Snowey
FirefSmoke

1_FD&161
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Single View
Full Screen Cul+F i
Enable FiF

Stream 1
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Btream 3
Stream 4
Bend to Talk Panel




d. The string of the selected profile will be selected as shown below. A “VE” text string will also appear at
the bottom right of the video cell.

Configuration | Layout | Help_:l

Camera Management 4
Station Management. |“ |E | I - ||+ | %
User Management. . x —_
Association M t. : . :
Eii?:{ 5 :zf:mn ve View | O Matrix view]| | —————— Click to create a new profile, edit or
SHEIL EANAZEMEL... delete a customized profile
Wirtual Matrix Management + EREY 2010/09/03 PM 05:35:08

- —
Station Settings L. “.
Client Settings L

¥ideo Enhancemen

Click to disable VE on all linked devices
Disable Al Cameras

Enzble ALl Camersz—— Click to enable VE on all linked devices
Dizabled Click to enable/disable VE on the target

video cell

1_FD8161

-

Eemove

Single View Cl+¥
b Full Bereen Chl+F
Enable BiF Cirl+]

® Stream 1
Strean 2
Stream 3
Strean 4
Send to Talk Panel # ™
Set DO i p——

Video Enhancenment

| Click to create a new profile,
edit or delete a profile

———1— Click to enable/disable VE
, on the target video cell

Create a New Defog Profile
e. Click Settings on the popup menu to open the Profile Settings window.



¥ Defog Settings - for 1_FD&161

Current. Profile; | eEEyykEE]

g Fog
Profile Settings Rainy

[y

'[F Block Size: (RS- 5 ¢

Morrnal ‘

1_FD8161

4

Strength: 1 J 5 |3 %
Threshold: 1] J 255|120 | &
@ | Gave as Profile... ] l Upndate Profile l [Qelete Profile l [ ok ] l Canicel ]

f. Adjust the values of Block Size, Strength, and Threshold. You can preview the image from the right

window. A “VE (Video Enhancement)” text string will also appear at the bottom right of the preview
window.

Block Size: Brush diameter from thick to thin (Value 1~5)
Strength: Brush stroke from soft to strong (Value 1~5)
Threshold: Brush pixel from loose to dense (Value 0~225)
g. When completed, click Save as Profile and enter a name for the new profile.
h. The new profile will be displayed on the drop-down list. This profile can be applied to all video cells.

i. If you decide to apply the selected profile to the target video cell immediately, click the OK button. Oth-
erwise, click Cancel to close the window.



How to Search for a Device on the Hierarchical Management Tree

This function allows you to conveniently search for an inserted device, which is useful when
many devices have been inserted.

Please follow the steps below to find a device on the camera list:
a. Click the station on the hierarchical management tree.
b. Click Edit > Find on the menu bar (or right-click the station and click Find).

S E@ Edit | View | Configuratior o g'! Camars bianagement it ¥ Find E
h St = Lar, T
I | | Find what: |IPS161 @
ol E': Snapshot Ctots I & . )
——  Puint 4 Baw User Biaragerrare String Options Search in =
. - y 2 e T - Find Mext
~= » Record to EXE g ! by [ Match case () Station only
L Slarn Marsgrhent
=B Find W Wirtual Mare Marasarmans ! [[]Makch entire word () Camera only
Filirms Marigeion b4 (%) Camera and Station
b Search Vivotam fuitches Direction
mpn Feth % () search up
Find.
rir- A= (%) Search down
earting UL
v Lint
et

c. The Find window will pop up for you to set you"r search criteria.

® Find what: Enter a string in the blank. The string can be the full or partial name of the device you want
to search for.

= String Options: Match case represents that the search results should be identical to the string in
lower-case or upper-case letters, the string can be part of a word. Match whole word means that
the search results should be identical to the string for every character, and that the string should be a
complete word or phrase. If you select both options, the search results should conform to all criteria

listed above.
m Direction: Select search up or search down. I W TK_Station1(127.0.0.1)
m Search in: Select search in station or camera. = E& Camera

w3 1 pr7131(192.168.3.247)
+ - @M 2_IP3161(172.16,200.40)
+ & 2_FDE161(192.168.5.105)

F=r recording Group
Search down . P DefautGroup Search up

+ - [ Layout

d. Click Find Next, the seaching result will be marked as shown below.

WWTK_Station1(127.0.0.1) @ Find X

= ES Camera
w- W pr7131(102 168,3,247) | Find what: |IPE16L
[EM 2_1PB161(172.16.200.40 . ) .
Search results > ( ) TR coarchin @ﬂ .
- & 3 FDB161(192.168.5.105)
= B Recording Group [Match case ) Station anly
= [ DefaultGroup [(IMatch entire ward () Camera only
+ E Layout (%) Camera and Station
Direction
() Search up
(%) Search down

e. If there is nothing found in the camera list, a message will pop up as shown below:

@ Thair sqwcitiond bt weirs raod ford el ered.

[ = ]




How to Print a Video Image

There are two ways to print out an image of live video:

1. Select a video cell, then click Print @ on the quick access bar, or right-click the video cell and select
Print from the popup menu. A Print window will pop up for you to choose the printer.

o] &][ < J®|5) al[EH/E[ ][> A

(127.0.0.1)

08 Live View ﬁ Matrix View
1_FD8161 2010409102 PM 04:47:2
. el

)8161(192.168.5.111)
Storage

Hamiore s

fingle view
Full Soremn
Inakla &
Enstln hatart foplay

Serewn 1 {102 01080
Strearm 2 {LIB0T20
Straen § (1 T84}
Stras 4 (LESO080

2. You can also click Edit > Print to print out an image from a video.
m Focus Cell: Print out an image of the target video.
m All Cells: Print out an image with all video cells in the monitoring window.

Edit || View | Configuration | Layout | F

Snapshot Ctrlss i\ | &= ﬁ
Recond to EXE Al Cells
r
1_FD8

How to Lock LiveClient for Security Concerns

If you are away from your computer, for security reasons, we suggest you lock the program.

When LiveClient is locked, the user must fill in the correct password to unlock and access the

program again.

® To lock LiveClient, click Unlock @ on the quick access bar or click System > Lock on the system
menu. The Unlock @ icon will then turn into Lock @

® To unlock LiveClient, fill in the correct password in the popup window.

Lock Cl+L The application is lacked. Please enter the password far STAdmin.
Enable Click On [mage
Language 4

mamuoe|

E-Map oK ] [ Cancel

Lavnch Plavback

Logout
Exit



How to Log out from the VAST Server

To logout from the current server, click Logout |z on the quick access bar or click System >
Logout on the menu bar. A confirmation window will pop up. Click OK to confirm or Cancel to
return to the VAST LiveClient window.

[Syﬁtem | Edit | View |

Lock Ctl+L i 1 2 This will terminate the current connection. Are you sure you want 10 continue?
Enable Click On Image

Lemngmage r ok ]| cancel

E-Map
Lawnch Plavback

Logont
Exit

How to Exit VAST LiveClient

To exit VAST LiveClient, click Exit |©/ on the quick access bar or click System > Exit on the
menu bar. A confirmation window will pop up. Click OK to confirm or Cancel to return to the
VAST LiveClient window. When you exit the program, your user account will be automatically
logged out from the current server.

(System | Edit | View | !

Lock Ci+L ,-r . ': Are you sUre you swant to exit the prograrm?
Enable Click On Image

Language r | ok | [ Cancel

E-Map
Lawnch Plavback

Logout
Exit



How to Configure a Logical Tree

A Logical Tree view is available since rev. 1.10 for both LiveClient and Playback. The Logical
Tree view allows you to re-define the logical relationships between the real-world deployment
and the physical devices (cameras). For example, according to your deployments, you can
designate several cameras to be listed under a logical sub-directory named as "Building A," and
the other cameras into "Building B." In this way, you can re-arrange your cameras and devices
on a tree view that is geographically accurate.

In addition to this, the logical folders can also be used to create privilege groups for users with
different access rights. This enables an administrator to easily and flexibly align user privileges
with his camera deployments.

T VAST CMS Server
‘ | (Root station) é&

Admin: all areas
c Q- >

(Logical folders)

i
|

(Power users:
work area #1)

i
|

(Power users:
main building regions)

i
|

(Users:
Front door and drive lanes)

|
bo[ofefefofefe[ole[o




To configure a Logical Tree, either right-click on the Device list root entry (VVTK_Station1), or
visit the top menus through Configuration > Logical Tree View management.

e . W' TK_Stationl || M Live Viey
E Layoud Logical Tree View Management. .

Refresh

Connect All

Find...

You will then enter the Logical Tree View management window. Left click on the root directory,
and then right-click to display the Add command.

[+ == | s o SERTE
e e e
gt +
"
=

LTIt

Byornuny

aa

A Logical tree can also display and include the cameras from VAST substations. To enable
connection with substations, make sure the Relay Settings is enabled both on the VAST Root
and substations.

a4 LiveClient

(System | Edit | View | Configuration | Layout | Helpj

S Camera Management L
@‘ @Imﬂ || Station Management...
o ] Logical Tree View Management...
= B WK Station1(19, 10 Box Management 5
B camera ] User Management...
h Recordling St Association Management...
“oo [ Defaulty
B Layout Alarm Management...
: M 1/ Box Virtual Matrix Management 4
i WWTK_Statial Failover Management 4
+ B cCamera Search VivoCam Switches... General Settings
+ B Record Station Settings 3 Metwork Settings
........ B 10 o g Recording Storage Settings
Output Streaming URL Recording Schedule Settings
Output Camera List Scheduled Backup Settings
Get PublicIP Server Settings '
O mEEEEmgETT | bt
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Relay Authentication

Passyword: -

Confirm Passward: 4]

Lo ] [ Cancel ]

To create a logical folder, enter a name for the sub-directory. The name can be a geographical
indicator or whatever name your prefer; such as Building A, Site 1, etc. Add a short description.

(& Add New Folder
Name: |
Description:

ook || cancel |

. Z — A

You can also create logical folders under sub-directories, e.g., a "Corridor" under "Building A."
Do this by selecting a sub-directory with a left-click and then right-click on it.

Logical Tree

3 ...... rEsiel
e @ spatst
......... r M
| Add
Edit

Note that the root directory can not be edit.
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You may also left-click to select a sub-directory, and use the Add, Edit, and Delete buttons to
create, edit, or remove sub-directories. Use the arrow buttons to change the positions of sub-
directories or devices on the logical tree.

When done, click the OK button at the low right corner of the window.
Configuration changes will be preserved.
You should then insert cameras to a preferred directory:

1. Open the device tree to select camera. Left-click to select the checkboxes in
front of cameras.

2. Select the checkbox of a preferred sub-directory. Make sure the checkbox is
selected and the directory is highlighted.

EIRNRE]

3. Click the Move button in the middle of the screen.
Cameras will be listed under the target sub-directories.

[Py 1 s
-". D L Lol Trise
| | r ._ VWTE Statond | 100, 1868 205) - ¥ e
S r'- WWTH_Saation1{ 192 168 40.34] ﬁﬂ‘m
P rEaa A 192 168,40 124) TP Carreina w01
" * R gk Carraana LER 16040 21 Tl Carmad
) q ™R Vicko Sare
@ rFEBIRLY
& segsdmal ratwor Carng
F P Correra 1-F00L00

[© B Carrera 2 - CCR3TO0
T 0 Camaea 300500
™ e Camera 4-PUL51
@ Correes 70018
r BB semwon 2
T B o o

£ ©

Update Add

|

Use the Sort and Find functions on the Device List on the left panel if it is hard to locate a
device.




When done with the configuration, click the OK button, and select from the top menus View
> Logical Tree View. The Logical Tree View will become the standard display for your VAST
configuration.

LiveClient

(System Edit | View | Configuration Layout Help ;I

0[] & e [

PTZ Panel

- B wTk st Y . |
_ h Site v Two Way Audio Pangl

_________ & Instant Playback Panel

""""" @ v Alarm Window

41 [ Full Screen Ctrl+F
i &2l Minirmize

........ E Layout v Ilatri= Wiew




When done with the creation of logical folders, you can move to the User Management
window. You can then define users' access rights using the logical folders you created. For
example, you may let a user access a specific logical folder while forbidding him from the

others.

1. When you assign Accessible Devices for a user, select the Logical tree button on the
lower right.

2. Select the "Selected logical tree nodes" button. You can then select or deselect logical
folders to confine the accessible devices for a user.

Note that an administrator has access to all devices, and hence the selection is not
available for an administrator.

g Utbr hiampgarmant far VUTE EeRtiEn]
Usuer List ACoomL Managemenl
B v _station1

ESr admintstrator mughentication: | Rasic ACooung -

-
bk, Doy 1

g e s blara Testl
ok b el g
-~ S ,
B ¥ vtk twrifrank chang pam— .
vtk ikt warey
£ omn Corifimn Pagiweond:  +

B ponwier Liser

Liser Fois: Pararer LUnar

-
:h . - o

AOCesRbM Drvica! Dereln Bred B LOSCH rdd

Permiztion | Acresshis Logeal Tes
A Epod el @ Sl s rhie

B B vvre_staton

I Bl nubsration 1
- T Camira SVTEAN
i [T Camera 6
o [ i Video Sever
s ey
2 7 @ MegaPuel Metwork Camera
& T Camera 1-FERLRD
s e Camard 2. CCEEN
i [ W Camera 3-VCEE0L
7 N Camera 4398151
o M@ Canmma 7R0013S

F By nubavanon 2
< G Camora 1 FERLED
i R Cavera 7F0O1%6
o I ) Viden Sever

= E st users

3. Click the Add button on the lower right.

Update Add

|




4. The User account information will prompt. Click OK to proceed.

- &4 Confirm Iﬁl

Unchecked substations or cameras will have the following permission(s) removed from the account:
"Camera Management”,
"Delete Camera”,

/\ "Wodify Recording Storage/Recarding Schedule Settings”,

"Scheduled Backup Settings",
"Modify E-Map",

"Modify alarm Management",
"Yiew Device Tree"

[ 0K l | Cancel |

5. You can repeat the above steps to create more user accounts using the limited access
configuration via the use of logical folders.

&

* The Refresh, Camera Settings, Output Streaming URL, Send to Talk Panel commands are
available for cameras listed in the Logical Tree View.

+ The DI/DO, Recording Storage, and I/O Box are not available on a Logical Tree View.

* The root directory (default VVTK_Station1) can not edited or removed.

« A camera can be added to different sub-directories; however, it can not be added twice into
the same sub-directory.

* A camera managed by a sub-station can be added into the Logical Tree.
« The Logical Tree View can not be edited through a web console with the VAST server.

+ Cameras added to the VAST configuration will not be automatically added to the Logical Tree
View.

» By default, only the administrator and power user are authorized to configure the Logical
Tree View.



VAST Playback Configuration

Activating VAST Playback and Logging in to a Server

VAST Playback allows you to search and playback recorded media data from VAST Server.

Once you insert a device into the hierarchical management tree of VAST LiveClient, it will
automatically be displayed on the hierarchical management tree of VAST Playback. You can
then begin to use VAST Playback to view recorded or backup video clips.

After installing the VAST Playback program, please follow the steps below to activate VAST

Playback:

1. Run the VAST Playback program. If you have already run VAST LiveClient, you can also click System
> Launch Playback to activate VAST Playback.

2. A Login window will pop up. Fill in the information as shown below:

m |f you want to login to a remote VAST Server, enter the IP address, user name, password and
communication port of the server. Click Log in to login the target server or Cancel to exit the
system.

m |[f you want to login to your local host which is running VAST Server, check the Login local
station checkbox, and the local IP Address will be displayed automatically. Enter the User Name,
Password, and Communication Port of the local server to log in. Click Login to log in to the target
server or Cancel to exit the system.

’ & VAST Playback |E| lﬂ?—_J\ ( NS_ Playback |E| et |
Log in local station V| Logn local station
Address: 192,168.6.125 - 127.0.0.1
Authentication: |pasic sAccount = Authentication: |gasic Account =
User Marne: adrmin User Marne: adrnin
Passwaord: . Password: .
| Login | | Cancel | [ More == l [ Log in ] | Cancel | | More >

3. The VAST Playback main window will be displayed.

g;

m /f your network environment need to set up proxy, click More >> to extend the login window, then click Proxy
Setting to open the dialog. Then enter related information to link fo your proxy server.

& VAST Playback [-é_&-J %) Proxy Settings | tm | [ﬁj
Log in local station 7 Enable Prowy

Address: -

Address:
Authentication: | pasic account -

Port: a0
User Mame:

User Mame:
Password:

Password:
Port: 3434

oK Cancel

‘ | Proy Settings | } warking Cffine. .. | l |

‘[ Log in ] | Cancel | [ Hide << ]

m Available functions of the VAST Playback program will be enabled according to the role of your login account. For
more details about the privileges of the user account, please refer to How to Manage User Accounts on page
151.



VAST Playback User Interface

A. Menu bar B. Quick access bar C. Query panel (Browsing / Time search / Bookmark search /
Event search / Alarm search / Log viewer) D. Status panel E. Recorded video playback window
F. Playback control panel

G. Video clips list

Menu Bar

[System | Edit | View | Configuration | Layout | Help)

Menu Item Drop-down Options
System Lock / Language / Launch LiveClient / Logout / Exit
Edit Snapshot / Print / Snapshot zoomed image / Print zoomed image / Find

Logical Tree View / Device Tree View / Backup Status /Exporting Status /
View Browsing / Time Search / Event Search / Bookmark search / Alarm search /
Log Viewer / Full Screen / Minimize / Query Panel / Video Clips List

Client Settings (Snapshot Settings / Export Settings / View Settings / Proxy

outiasation Settings / General Settings / PiP Settings)

Layout Change Layout
Help About

Status Panel
User Name

Station Name (IP Address)

Login Time (yyyy-mm-dd hh:mm:ss)
Current Time (yyyy-mm-dd hh:mm:ss)
CPU and memory usage in percentage




Quick Access Bar

0] 6|0 &) 3Ebeal|EFET| ] 0 )

Function
Exit
Logout
Lock
Volume
Snapshot
Print

SVC Level
Remove All Connection
Layout

Full Screen

Switch Screen

RlEFERERRIEIRIRIEHE

Synchronous Playback

Description
Exit the system
Logout from the current station

Click to Lock the system for security concerns (@ Unclock the system)

Adjust the audio volume of the target video (@ Mute)
Capture the picture of the target video

Print out the picture of the target video

Exert SVC control of video playback frame rate

Remove all live videos from the live video monitoring window
Change the layout of video monitoring window

Maximize the live video monitoring window

Switch to another screen

Click to enable synchronous playback for multiple channels

53

Some buttons will be disabled if the selected device does not support those functions.

Recorded Video Playback Window

The "VIVOTEK" logo indicates that no camera has been assigned to the video cell.

The red frame ( |:| ) represents the focused cell.

Video Cell




Language Selection

VAST current supports user interfaces in multiple languages; and language options are availabe
in: English, Deutsch, Espafiol, i, Frangais, Italiano, HAGE, Portugués, Pycckun. fii{AH 32,
and % %87 <  User Defined If you want to select another language for the interface, please click
System > Language on the menu bar to select a desired language. Please note that if you want
to change the language option, a message will remind you to restart the system.

P =

<

' s.y:.!.l.-m Eda Wi EunTlg_u
Lk |

T
Latmtch Livel et Deutsch

+  Enghsh

Eunt Esmpaitol

T B s ...|\VASTIClient|\Playbackl\languagelzz_UD (language string)

B Locave Frongnis ...|\VASTI|Client\Playbacklimage (images)

If you want fo use "User Defined" language, please prepare images and
language strings, and upload the files to the following folders:

Partugués
Procania

i Lok

b o
User Defned

Query Panel-- Browsing Page

Browsing |[Time Search | Event Search | Bookmark Search | Log' *["
1
= Managed Stations

W Tk _Station1(127.0,0.1)

Root Station Name (IP address)

= S Cameras
= @M 1_Pz7151
2H05-11-24 —| Dates with recorded
20031125 1 T video clips
Devices listed - &N 2_Pe161
under the root 2005-11-24
station 2008-11-25
= @M 3_FDE151
2005-11-24
2005-11-25
: Paul-kun(172.16.4.38)
= BB cameras —————— Sub-station Name (IP address)
= @M 1_IP7138
2009-11-22
2009-11-23
- @M 2_IP7171
Devices listed 2009-11-22
under the sub- 2009-11-23
station = @M 3_Pz7151
2009-11-23

T & B owen(172.16.4.23)

@ Local DB

Local Database

You can hide this panel in order to maximize the single playback view from the View menu.
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Icon Description

Station list including server and local database

! A station (a computer that has installed VAST Server)
=

A station (a computer that has installed ST7501 Server)

The camera that exists on the hierarchical management tree of LiveClient.

En
The camera that has been removed from the hierarchical management tree of
&M LiveClient (off-line). However, its recorded video (if any) is still accessible from
the server.

Dates with recorded video clips.

Local database for backup data. For more information about how to upload
backup data to the list, please refer to page 301.

See page 268 for how to configure a Logical Tree View.
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Query Panel--Time Search Page

Select station(s)/ device(s) that
you want to search for recorded
files

= . "u'"'u"TK _Station1{127.0.0.1)
E v (Cameras

E I:l F‘aul Kuul{l?E 16.4.38)
[T Camneras
w7 Owen(172.16.4.23)

GMT+08:00 Beijing, Chonaging, Hong FE

Er R e
o

— Specify search period of time

aoosjijzs v Joasons | 2

Click to start to search, the
results will be shown on the
video clips list

You can hide this panel in order to maximize the single playback view from the View menu.

ﬁ;

The Time Zone setting is automatically synchronized with that on your client computer.
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Query Panel--Event Search Page

=~ Wy TK_Station1{127.0.0.1)

Select station(s)/ device(s) that

=~ Carneras
: 20x Zoom Mega-Pixel Speed Dome Metwork C
Mega-Pixel Metwork Carmera

Mega-Pixel Metwork Carmmera
Mega-Pixel Metwork Carmera

Motion - Window 2
Motion - Window 3
Motion - Window 4
Motion - Window S

I - Maoving Object

IwA - Loitering Detection

00 e, g, s
il

you want to search for recorded
files

Select an Event Category

Click to add search criteria

Click to remove search criteria

— Specify search period of time

Click to start to search, the
results will be shown on the

video clips list
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Query Panel--Bookmark Search Page

Select station(s) that you want
to search for bookmarks

=T WTK_Station1({127.0.0.1)
=" Cameras

=[] Mega-Fixel Network Camera

-7 Mega-Pixel Network Camera

~[ Mega-Pixed Network Camera

<[] Mega-Fixel Mebwork Camera

-7 Mega-Pixel Network Camera

Select a name to serach for

Select a time zone

::j :é-."; " =

o yoiz_ v 14652% ||

__|End Time: __ Specify search period of time

o/ -

Click to start to search, the
results will be listed on the
video clips list
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Query Panel--Alarm Search Page

| Edit | View | Gonhigurali L
WeSpiz2an) L. Select station(s) that you want
3 Am to search for bookmarks
4 Aam
Click to configure the search conditions
SMT+08:00 B, Chonggng, Hoag Kong, Kual Lu Select a time zone
NG B 1 v OESEIT
Specify search period of time
2006 7 8 = MEEID S
- M Click to export a log files for
the occurrences of alarms

Click to start to search, the
results will be listed on the
video clips list
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Query Panel--Log Viewer Page

&l Local Logs

EMT-+08:00 Esijing, Changaging, Hong k i

aoosfrsjes v oesos |
ol

eoosjusjzs | osous ] -
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Select station(s) that you want
to search for recorded logs

Select a Log Category

Select a User Account

Select a Result Type
Select a Log Type

Select a Log Level

__ Specify search period of time

Click to start to search, the
results will be listed on the
video clips list




Video Clips List Window

If you select an option “date”, the video clips will be displayed in the video clips list window. An
option “date” may contain more than one video clip.

[ Pr——
B o ez oo
By covene
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You can hide this panel in order to maximize the single playback view from the View menu.



Playback Control Panel

When you double-click a video clip to play, the playback control panel will be enabled for you to

use. Playback Histogram

(Displays the period of time of the
video clip being played back)

Playback Timeline Slider

AMAHH-TT OB+
[F =T

AN

| I | |
Playback Status Panel  Playback Control Buttons
Function Description

Manually add a bookmark to pinpoint and extract a 20-second video clip

Add Bookmark o .
from an existing recording

Histogram Zoom In  Zoom in on the displayed period of time of the histogram

Histogram Zoom Out Zoom out of the displayed period of time of the histogram

If you want to export part of the recorded video clip, click to set marker |

MEILEIA on the histogram, which will be the start time of the exported media

Marker Il If you want to export part of the recorded video clip, click to set marker I
on the histogram, which will be the end time of the exported media

Export Media Click to export the selected section of video clip

Last Time Interval Go to the previous video clip on the video clips list

RICIE EE RMEEE B B BE b 8

S

-
+

Pause Pause playback the selected video clip

Play Start to playback the selected video clip

Rewind Reversely plays back the current video

Next Frame Go to the next video frame of the selected video clip

Previous Frame
Next Time Interval
Repeat Mode
Slow Down

Speed Up

Displays the previous frame

Go to the next video clip on the video clips list
Playback the selected video clip repeatly
Slow down the playback rate

Speed up the playback rate

Current time of the video clip

16:17:51

Total length of the histogram

223 NMOUrs o3 Mins o3 Secs

The playback status
(Stop/Playing)

The playing rate can be 1/8, 1/4, 1/2, 1X, 2X, 4X, 8X, 16X, 32X, and 64X.



Rewind

The Rewind function enables users to reversely playback from a specific point in time on a video
playback window. Once the occurrence of an event is ensured, this function can facilitate the
process of finding the evidences that appeared before the occurrence.

The Rewind function also applies to the Synchronous Playback mode. The following also apply:
1. The maximum playback speed is 64x. (I-frame only when speed is higher than 16x)

2. When you pull the time slider during the Rewind playback, short interruptions may occur.
3. When switching from the playback mode to the Rewind playback, the playback speed remains
the same. The same applies when switching from Rewind to the playback mode.

Limitations:

1. Short delays may occur when switching from playback to rewind, due to limitations by the
hard disk access speed and network speed.

2. When doing the forward playback, the previous frame function is not available. When doing
the rewind playback, the next frame function is not available.

3. The Rewind playback on multiple streams requires system performance resources.
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How to Playback Recorded Video
Select a Recorded Video Clip

Please follow the steps below to select a video clip:
1. On the Bowsing page, click the plus sign (+) to expand the hierarchical management tree.

2. Right-click a station, device, or option “date” on the hierarchical management tree and click Refresh
to display the recorded video clips.

=) a Maraqed statci-s

PLAUL U, DY, L)

E| (EM Mega-Pixel Network Camera

o MR 201207-30

= (@M Mega-Pixel Network Camera

- R w0730

- R zorn

= DM Mega-Pixel Network Camera
o (B 2012-07-31

- B tocaos

If a camera is configured with Multiple Stream recording, all its recording group configurations will be
listed on the device tree.
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3. There are two ways to view the video clips of a date.
= View all video clips of a date:
a. Select an option “date” from the hierarchical management tree.

b. Double-click the option “date” or right-click the option “date” and click play, and it will start to
play in an available video cell. (You can also directly drag-and-drop the option “date” to a desired
video cell in the recorded video playback window. The video clip will start to play.)

..... B npa4n1(192.166.4.135)

T
- .' Cameras
gg Ew Mega-Pivel Network Camera

i [N Mega-Pixel Network Camera
E} -n Mega-Pixel Network Camera

PR e Ren su: J01207-20]
O @M Megabive  Backup BB 201240731
= T i - [EF 20120801
IE.‘ ‘muﬂmmcuwa Bon -Magu-Pi:dNa!hrmk

[ 2120730 - [B 201207-30
B e -8 ;“:I“? 3 B -l Mega-Pixel Network Camera
Mega-Pixi Metwerk Camera H
: R 2012-07-30
- [EH 2975 H E
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= View only one of the video clips of a date:

a. Click on a “date” on the hierarchical management tree. The corresponding video clips will be listed
in the video clip list window.

b. Select a video clip from the video clip list window.

c. Double-click the video clip, then it will start to play in an available video cell. (You can also directly
drag-and-drop the video clip to a desired video cell in the recorded video playback window. The
video clip will start to play.)

T i e,
ey
. g ot vt [y B 45T N AT B R e v o

b LU LS 8 R it rafn e B L

4. Then you can make use of the playback control panel to playback the selected video clip. Please refer
to Playback Control Panel on page 286.



Remove Recorded Video Clips from Video Cells

There are two ways to remove a recorded video clip from the video cell:
1. Right-click the video cell and select Remove.

Browsing | Time Search | Event Search | Bookmark Search | Log Viewer |

Mega Pixel Network Camera 2012/07/31PM

S el MNDB401(192,168.4.135)
- B cameras
i [ Mega-Pixel Netwerk Camera
- [ Miega-Pixel Netwark Camera
m
- [EH 201207-31
; FE 20120801
|i_ @ Mega-Pixel Netrork Camera
i ER 20120730
|— - ([ Mega-Pixel Network Camera

2. Drag-and drop the live view from the video ceII to the hierarchical management tree window.

Browsing | Time Search |Evtnt$nalch | Bookmark search | Log viewer |

E| ------ ND8401(192 168.4.135)
— By cameras

(- (M Maga-Pixel Network Camera

(- [N Mega-Pixel Metwork Camera

o m
- [ 201207-311

; FR 20120801

|: &N Mega-Pixel Network Camera

i ER 20120730

|‘ - (EE Mega-Pixel Metwork Camera

ﬁe

If you want to remove all live videos from the video cells, please click @ on the menu bar.

B ER D EEE D EE R

Timeline Slider Bar and Histogram

The red part of the histogram shows the period of time of a video clip. The timeline slider bar will move
forward as the video is on playback. You can manually move forward/backward the Timeline Slider Bar
to the desired position as shown below.

ime of the histogram End time of the histogram

The current time of the video clip will be displayed on the status panel. It will change according to the
current position of the timeline slider bar.



Zoom in / out of the Histogram
Histogram zoom out

oL ] xifp-oa-z2
DEO000 IG0T00

20040422 | 2040432 |
= e
o =

* EIEIEE B = = S B YT

Histogram zoomed in Total time length

As the second picture shows, by clicking Histogram Zoom In, the total time of the histogram will shorten
to half of the original period of time, while the red part of the histogram that shows the period of time of
the video clip will extend to twice the original time span.

In addition to clicking @ and @‘ to zoom in/ out of the histogram, you can use the mouse directly to
drag the histogram to zoom in part of the focused video clip.

For example:

a. Drag a section of the histogram. You can drag it to either direction.
Misonz 1 1 040422
abash c '.:Tnnsz

| =)
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b. The section will be extended as shown below.
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For more functions of the playback control buttons, please refer to page 286 for detailed description.



Synchronous Playback

VIVOTEK VAST Playback supports synchronous playback, which allows you to review up to
16-channel video clips simultaneously during the specific time point.
Please follow the steps below to enable synchronous playback:

a. Drag-and-drop the option “date”s to the video cells.
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b. Drag the Timeline Slider Bar to the specific time point.

c. Click the synchronous playback button 'L'l_ on the quick access bar. The selected channel will start to
sychronously playback as shown below.

i:ln_,m Lom | View . Gosligorwion. | Laysul  Hsis |

2012/07/31 11:02:03PM




d. You can move forward/backward the Timeline Slider Bar to another time point, and all of the time
stamps on the video cells will change accordingly.

e. If you want to stop synchronous playback, click the non-synchronous playback button G again.

g;

The following illustration shows that during the specific time, there is no recorded video on the camera.
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The audio function will be enabled if the device is equipped with an internal or external

microphone. Please follow the steps below to adjust the volume or turn on/off the audio of the
focused video:

m To turn off the audio (Mute Mode)

a. Click Audio On [% on the quick access bar and check Mute. Or you can right-click on the video
cell to open the popup menu, then click Others > Mute. The mute option in the popup menu will then
be selected.

b. If you want to turn off the audio of all live video, select Apply all.
c. The Audio icon will then change from [%] to [#<].
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= To adjust the audio volume |
|
a. Click Audio On [#}| on the quick access bar. R
b. Drag-and-drop the slider bar. Slide to a higher position for louder volume. @ ‘

[ Mute

® To turn on the audio

a. Click Mute [# on the quick access bar and uncheck Mute. Or you can right-click on the video cell

to open the popup menu, then click Others > Mute. The mute option in the popup menu will then be
unchecked.

b. If you want to turn on the audio of all live video, select Apply all.
c. The Audio icon will then change from [# to [4:].
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How to Change the Playback Layout

Changing the Layout of the Recorded Video Playback Window

VIVOTEK VAST Playback supports up to 16-CH simultaneous recorded video playback on a
single monitor and allows you to change the layout of the recorded live video playback window
based on the number of inserted devices.

Switch Video Channels

Drag-and-drop a video channel to another empty video window.

To switch two channels, drag-and-drop one view to the other, then the two channels will switch
positions. — e

Configure Layout Mode

Click the Layout button on the quick access bar or click Layout > Change Layout on the menu bar.
Select a desired layout mode and the layout window will change accordingly. Below we illustrate 6 types
of layout modes:
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Maximize/Minimize the Recorded Video Playback Window

= Single View: to maxmize a video cell to the entire video playback window

Double-click the video cell, or right-click the video cell and selec Single View. The focused video will
occupy the entire Playback window as shown below.

Single View
Full Sereen
Enahble FiF

Cithers

Video Enhancement

1_FD8161

Enabls PiP

Orthers

Video Enhancement

To restore to the original layout, double-click the video cell or right-click the video cell and uncheck
Single View.



» Full Screen: to maxmize the video playback window to the entire screen

Click Full Screen on the quick access bar or right-click the video cell and select Full Screen.
In addition, you can also click View > Full Screen on the menu bar to maximize the recorded video
playback window. o

r..-?n_ﬂlpm E.dl_._\'-m- Configuataion | Layoul H.l.lp__

=P, Logical Tres Vs L L
Ol G} ¢ orvermver JE [=E

T Sairc® | Gwpat r 1

I owd pEGrown)
Alwrn 5 h s
oo Y Tk ErGraca)

¥ Video Chp Lt

To restore to the original layout, right-click the video cell and uncheck Full Screen. You also can press
the Esc button on the keyboard to leave the full screen mode.

= Minimize: If you click View > Minimize on the menu bar, the Playback window will minimize
to the Windows tool bar.

View Recorded Video with Multiple Monitors

If you have multiple screens in your control center, you can switch the VAST Playback Window
among these screens.

m |f you have two monitors, click Switch Screen @ on the menu bar, the Playback window of monitor 1
will switch to monitgn@nitor 1 Monitor 2

m |[f you have three or more monitors, a drop-down list will be displayed when you click Switch Screen
@ on the menu bar. The number of options on this list depends on the number of your screens. Select
a desired screen from the drop-down list and the Playback Window will then switch to the specified

screen.
2

Monitor 1
Monitor 2
Monitor 3




How to Backup Recorded Video

In addition to the Schedule Backup function of VAST LiveClient introduced on page 61, the
VAST Playback also features to backup recorded video clips from the local database. Please
open the Browsing page and follow the steps below to backup recorded video:

a. Select the target files.
® To backup all recorded video of a selected device: Right-click the device and click Backup.
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® To backup all recorded video of the day: Right-click the option “date” and click Backup (or select the
date and click the Backup button below).
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®m To backup part of the recorded video of the day: Select the date and choose the video clip(s)
from video clip window. Then right-click the selected option(s) and click Backup. Note: Use the
combination of the Shift key and left mouse click to select multiple video clips.
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b. A Backup Settings window will pop up. Spetify the time span and select a storage path, then click
Backup. The system will start to backup and popup a window showing the backup status.

Bac St Lo
Backup Settings =] @ ==l
\ ga-Posl M bwork Camers
Start Time: 2015-01-15 O0E00:00 = 20130116 23:99:55
1162013 - 00:00:00 : Badhap Mepafue i Caamer a s comgiie e
End Time: — o

1/16/2013 +  23:59:59

4

Save to:

E:\Recording|2013-01-1513 E

| Badwp |[ Cancel

If you close the status window, you can also open it again by clicking View > Backup Status.

(Systeml Edit | View | Configuration | Layout | Helpj.

W ‘Eatkup Status '

I_d-)]'i] , Exporting Status

Time Search

Browsing Tumzs-u-;' ¥ Event Search

—— ]
”'5 Managed v Bookmark Search
: '—'|---- wi ¥ Log Viewer

I Full Screen Ctrl+F

d. When the backup is complete, you will see an information dialog. The recorded data will be restored in
the specific folder.



How to View Backup Files

The VAST Playback also allows users to playback backup files, including Schedule Backup by
VAST LiveClient and Recorded Data Backup by VAST Playback.

Please follow the steps below to view backup files:

a. Right-click Local DB and click Add.
b. A Load Backup File window will pop up as shown below. Select the *.dif file to upload.

[ Systers | Eda | View | Cosfeuraton, | Lapsnt | Heip |

ole=ls falhalBiE ol
ol [l #balBiC]uf
B | P S | Forwril Ly | B S e | L vt
I e veatirn
B v swsesiizrinn
B e
W e P ot L

Mz

M momar

Ml o

M e P bartcarks Carrars

[ S T -
e bar b

S Ll W

| e
a Laca Dk
Ul Pk

" a bave Bk

b Beapt

4 UigeFid oo Ciomans T P00 1T |
A Wb B i € e 2 50015 P

Wl Ve v,

[y

HE
T
AERCYER L

tadw Camee [re et Fans frm g

i Mg P s Ty 3017 G700 050 EREEEE 2t o0 W by 40 L e

c. The following is an example of uploaded file, and you can double-click it or drag-and-drop it to a
video cell to playback.
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=Y
If you want to playback the backup files from the local database, you can also click Working Offline in the Login
Window without the account information. The VAST Playback will launch as shown below.

e
&) VAST Playback ‘

[¥] Log in local station

Address: 1127.0.0.1 -]
Authentication: [Bﬂc F— v]
User Name: 1
Password:

i B
Port: 3454 5 [[use ssL

! | Broxy Settings || working Offine... | |

| logn | [ GConcel | [THde<< |

e —

No user account information required

ik

| - p— - . [— e
g — e me [T - b
s Bt G VLT A A T T - 4 T i T
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Model-specific Functions (FE Series Fisheye)

The VAST Playback program offers model-specific functions through a right-click menu. For
example, if you playback a video clip made from an FE8171V fisheye camera, a right-click on
the playback screen will bring up the Display mode options. You can even exert mouse control
while playing a recorded video. You can zoom in, zoom out, and change the view angle as if you
are investigating a 3D scenario kept in a recorded point in time.

Note that ePTZ functions via the mouse control only takes place in a Regional view, e.g., the 1R
or 103R mode.

The Display mode options and mouse control methodologies are identical to those described on page
125 and the following pages. |
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Video Enhancement
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To configure the SVC-related feature:
1. Right-click on the playback window of an SVC-enabled camera. Select SVC fps adjust bar.

Femove

v Single View Ctrl+W
Full Screen Ctrl+F (i)

Others 3

Fisheye Settings *

SVC fps adjust bar

2. A slide bar will appear above the view cell. Click and drag the slide bar. A numeric indicator will display
the current selection. See below for the frame rates represented by the numeric indicator.
to page 103 for the introduction of this feature.|Changing the SVC vaule takes immediate effect on the
number of frames per second shown with the video being played.

Indicator Frame rate per second (fps)
Maximum 30

7 26

6 22

5 18

4 12

3 8

2 4

1 1
Minimum 1/4




How to Search for a Video Clip in a Specific Period of time

Please follow the steps below to use Time Search function:
a. Open the Time Search page.
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b. Select the target station(s)/device(s) that you want to search for video clips.

c. Specify the time span. You can choose to set up the start time only, the end time only, or both the
start time and end time. The search results will only include the video clips within the time span. If you
uncheck both the start time and end time, the search results will include all video clips recorded by the
selected device(s).

v Skart Time:

You can manually enter a specific time.

Sun Mon Tue s
25 29 30 1
5 6 7 8
1z 13 14 15 186 17

1o Eflzs 22 23 24 .
26 27 25 29 a0 a1 . Click to select a year

2 3 4 5 & 7 B Click to select a month from the drop-down list
[ IToday: 10/20,2008 — Click here to move the focus to the current date

d. Click Search to start time search.
e. View the retrieved video clips.

Search

o |
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How to Add a Bookmark

Bookmark is a convenient tagging function that allow your to pinpoint and extract a 20-second video
clip from out of a video recording. When you see somehting of your interest while browsing through a
recorded video

1. Click on the E Bookmark button,

2. Enter a name for the bookmark, such as "thief spotted."

3. You may enter a short description in the Description field. You may also search for the bookmarks you
created later on.

A bookmark comprises a video clip starting from 10 seconds of before and ends at 10 seconds after the
point in time you selected.

2! \3‘! il |'ilr

| o ) o

Index  Camera Start End Time Zone Description
1 Mega-Pixel Network Camera  2012-08-01 13:17:59.253 2012-0B-01 23:59:59.999 +03:00 10 hours 42 mins

Please refer to page 282 for how to search for bookmarks.
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How to Search for Events

The VAST Playback program offers users an intuitive event search engine for retrieving video
clips from the database of recorded videos based on different search criteria such as motion,
IVA, or DI events.

Please follow the steps below to search for recorded events:
a. Open the Event Search page.
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@] © repeat mode

b. Select the target station(s)/device(s) that you want to search for events.

c. Specify the Event Category. For detailed information, please refer to Select Event Category on the
following page.

d. Specify the time span for event search. You can choose to set up the start time only, the end time
only, or both the start time and end time. The search results will only include the events within the time
span. If you uncheck both the start time and end time, the search results will include all events from
the selected device(s). Please refer to step c. on the previous page for detailed information.

e. Start event search. Please refer to page 311 for detailed information.

f. View the retrieved video clips. Double-click on it or drag-and-drop it to the video cell. It will playback
in repeat mode.

Note: The length of each video clip will depend on your settings of pre-event time & post-event time for
the recording storage. The default setting is 20 seconds. For more infromation, please refer to page
188 for detailed information.



Select Event Category

The following introduces the event search categories: All Events, All Motion Events, All
IVA events, All DI Events, Named DI Events, PIR, Tampering, Tamperature, Video Loss/

Restore, IR Trigger/Normal, and P-PTZ. You can also add or remove customized events from
the list.

Event Category- All Events

If you select the All Events category, all of the events including motion detection, digital input, and
intelligent video analysis, PIR, tamper detection, and tamperature alarm will be listed in the search
results. You can click Add or Remove to change the search criteria options.

Search Categories: | All Events A4

Mation - Window 1 I ~
Mation - Window 2 | a)l 1vA Events

Motion - Window 3 | all DI Events

TvA - Mowing ObieciNamed DI Events

I'V& - Loitering Detection

I'VA - Camera Tarnpering

Iva - Others hs

[ Add ] l Remove l

Event Category- All Motion Events

If you select the All Motion Events category, all detected motion events will be included in the search.
You can click Add or Remove to change the search criteria options.

Search Categories:

Motion - Window 1 2 = [
Mation - Window 2 YO TYPac | OO0 S |
Motion - Window 3

Al Motion Events

Sewweh Crilvria

Wirelow1 Wirnkwa Wirdkrwd Wik wWirdkows

[ ok ][ comel
’ Add l ’ Remove ]

The parameters of the motion detection windows, such as motion percentage and the time of occurrence
are also recorded in the database of the server. If you wish to change the parameters of the motion

detection windows such as the position, size, detection sensibility, and motion percentage, please link to
the camera's Configuration page to modify the values.

Enable motion detection
Video(TCP-AV)

YWincow MNarme
1

Sensitivity




Event Category- All IVA events

If you select the All IVA events category, all detected IVA events will be included in the search. Cameras
with embedded intelligent video content analysis are capable of detecting IVA events such as moving
objects, loitering, and tamper detection.

The embedded video content analysis, superior to the conventional motion detection function, is capable
of distinguishing between creature’s motions, static backgrounds or natural movements such as swaying
trees, waves or sunsets to prevent false alarms from environmental noises.

With camera tamper detection, it can detect incidents such as camera redirection, blocking or defocusing
of cameras, or even spray-paint. Additionally, a suspicious object in the pre-defined detection region will
trigger alarms once the dwell time of the object is longer than the given time.

You can click Add or Remove to change the search criteria items.

Search Categories: | ENERN ==

IWA - Maoving Object §
Iva, - Loitering Detection Evant Typa: | AlIVA Bvants
WA - Camera Tampering
Iva - Others Sparch Criterla
Mowirsg Otgoct Loftieing Tarparning Crthrs
[ aod | [ Remove ] L_ox || tancel

If you want to change the parameters of IVA, such as the detection region, loitering duration, etc, please
link to the camera's Configuration page to modify the values.
Trigger name: TNggerl

] Enabla thee trigger
Dedeclion bypse

:'_l:.! Moving cbpect delecbion

O Lomenng detecton - duraton: 10 Seconds [1-90)

T Camara tampanng detaction

Dhele=clion region

To deaw a rectangle reguon, chick on the rectangle button and deag
on the widea area.

S To draw a polygon regon, deck on the polygon bulton and chek
ggveral powits on the wleo ared,

;if'.i Clogs |
Event Category- All DI Events

If you select All DI Events category, all triggered DI signals will be included in the search. The DI events
signify that there is a Digital-Input signal detected by the camera; its corresponding information such
as DI-Trigger or DI-Normal signal and the time of occurrence are also transmitted and recorded in the
database of the server.

You can click Add or Remove to change ... categaries:
the search criteria options.

Al DI Events

Custonired Craeia o
e il B

DI - Trigger Ewenit Typa: Al D Evenits = |

DI - Morrnal
Srarch Criteria
Tricper Horrmial
[ Add ] [ Remove ] = fexs

For more information about DI/DO settings on the connected devices, please refer to page 160 for
detailed illustration.
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Event Category- Named DI Events

This category allows you to select only Named DI Events--the DI device which you have renamed in
the LiveClient. Please refer to Association Management on page 160 for more information about how to

rename DI device.
Click OK and fill in the name you want to search on the left window.

MNamed DI Events

Search Criteria
Trigger Normal

Remaove W [ﬂ—]

The new search criteria will be displayed in the search categories column as shown below.
You can click Add or Remove to change the search criteria options.

Marned DI Events E

|Entrance (DI - Trigger)
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Start Event Search

After you specify all of the search criteria mentioned above, check/uncheck Display in new result list
and click Search to begin event search.

= |f Display in new result list is unchecked, all search results will be displayed on the original event list

window as shown below.
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Only one page

m In the above picture, The Type field in the search result page shows the event category, and the
Description field displays the motion percentage of the detection window. Please refer to page 308
for more information about Motion Events.

m |f you select Display in new result list and click Search, the search results will be displayed on a
new page as shown below. This allows you to place the search results of each search category on an
individual page. You can set up to 5 pages in the event list window.

Search Categaries: | &l Events v

DI - Trigger

OI - Morrnal

FIR

Tarnpering
Temperature - Trigger
Temperature - Mormal

13

(54}

2023-2340
m0:00:Co

= e
I ) <[ (] o] (Ll

0000-00-0C
(C0J00

Add ] [ Remove

Time Zone: |GMT+DEI:DD Beijing, Chongging, Ho v|

Start Time:

- Index = Camera Time Tirme Zone Type Diescription S
2009/11/30 v | (092643 [ { 1 3 FDA16L 2009-11-30 094454 +02:00 FIR Trigger =
W= T 2 3_FDE161 2009-11-30 09:44:54 +08:00 PIR Tr?gger
: 3 3_FDE161 2009-11-30 09:44:55 +08:00 PIR Trigger
| | | [ 4 3_FDE161 2009-11-30 09:44:55 +08:00 PIR Trigger
5 3_FDE161 2009-11-30 094456 +08:00 PIR Trigger
4] 3_FDE161 2009-11-30 094456 +08:00 PIR Trigger v
! D|s?lay in Mew Result List Search | I Page 2 ” Page1 |
i

Chlecked

ﬁ;

The P-PTZ event type refers to those triggered by the Auto Tracking actions.

You can set up to 5 pages.
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Backup the Event Videos

Please follow the steps below to backup the evnet videos on the results list:
a. Select the video clips you want to backup. You can select more than one video clip.
b. Right-click the selected video clips and click Backup.

Index  Camera | Time | Time Zore | Description

10
Tr‘iEIIIIE!r'
Trigger
Trigger

+08:00 PIR Trigger ~

I Page 2 I[ Page 1

Show Millizeconds

c. A Backup Settings window will pop up. For more information about how to set up the Backup
Settings, please refer to page 299. For more information about how to view backup files, please refer

to page 301 for detailed illustration.
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How to Search for a Bookmark

Please follow the steps below to use Bookmark Search function:

a. Click on the tabbed menu to open the Bookmark Search page.
b. Select the cameras which have video clips you have placed bookmarks on.
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c. Enter the name of bookmark.

d. Specify a range of time during which the video streams were recorded and its points in time were
bookmarked.

Click search. You can then click on a bookmark to display the short video clip extracted from
within the recorded video.

To remove an existing bookmark, left-click to select an entry, and then right-click to display the
Delete button. Bookmarks will be indicated as "Invalid" if the videos where the bookmarks were
appended were erased, e.g., when the original recording was erased by cyclic recording.
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How to Search Logs

The VAST Playback program offers a convenient log engine for searching all local logs based
on different search criteria such as log category, log type, and log level. The search results will
be displayed in the log viewer window along with the detailed log history.

Please follow the steps below to search logs:

a. Open the Log Viewer page.

b. Select the target station where you want to search logs.

c. Specify the Log Category. For detailed information, please refer to Select Log Category on page 315.
d

. Specify the User Account. If you have added other user accounts to the station, you can select one to
search its login history. For detailed information about user account, please refer to How to Manage
User Accounts on page 151.

e. Specify the Search Result. Select All to display all search results; select Success to display successful
log activities only; select Fail to display failed log activities only.

f. Specify the Log Type. For detailed information, please refer to Select Log Type on page 315.
g. Specify the Log Level. For detailed information, please refer to Select Log Level on page 315.

h. Specify the search time span. You can check the start time only, the end time only, or both the start
time and end time. The search will only include the events within the time span. If you uncheck both
the start time and end time, the search will include all events saved by the server. Please refer to page
305 for detailed information.

i. Start the log search and the results will be displayed on the log list window.
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Select Log Category/Log Type/Log Level

The following table shows the breakdown of log category, level, and type. The search results will
be different according to your selections.

Log Categories Log Levels Log Types

Login / Logout
Insert User
Update User Name
Update User Password
Update User Privilege
Delete User
Insert Station
Update Station Information
Update Station Name
Delete Station
Insert Camera
Update Camera Information
Delete Camera
Set Recording Group
Insert Recording Schedule / Update Recording Schedule / Delete Recording
Schedule
Insert Event Management / Update Event Management / Delete Event
Management
Insert Recording Group / Update Recording Group / Delete Recording Group
Insert Recording Path / Update Recording Path / Delete Recording Path
Insert Camera to the Recording Group
Normal Update Camera information in the Recording Group
Delete Camera from the Recording Group
Move Recording Path
Operation Log Move Camera to another Recording Group
Insert Layout / Update Layout / Delete Layout
Set Digital Output
Update Scheduled Backup
Update Server Port
Set Proxy Server
Set UPNP
Set DDNS Server
Create Directory / Rename Directory / Delete Directory
Insert SMTP Server / Update SMTP Server / Delete SMTP Server
Insert Network Storage Device / Update Network Storage Device / Delete Network
Storage Device
Set GSM Modem
Set DI/DO Rename
Set Relay Settings
Update License Information
Update Web Access Information
Insert Matrix Recipient / Insert Matrix Recipient Information / Delete Matrix
Recipient

Manually Begin Recording

g Manually Stop Recording

Camera PTZ, Iris, Focus, Pan, Patrol Control
Low Click on Image
Select Preset Location

Server Start / Server Stop
Trial Expired

System Log High Key Dongle Lost
Virtual Memory Low
Network Lost / Storage lost



Log Categories

Event Log

Time

2009-12-09 09:50:54
2009-12-09 09:50:54
2009-12-09 09:50:55
2009-12-09 09:50:55
2009-12-09 09:50:55
2009-12-09 09:50:56
2009-12-09 09:50:56
2009-12-09 095142
2009-12-09 09:51:44
10 2009-12-09 09:51.47
11 2009-12-09 09:51:48
12 2009-12-09 09:51:50
13 2009-12-09 09:51:51
14 2009-12-09 09:51:51
15 2009-12-09 09:51:52

Index

i N ) (S W L oy

Log Levels

High

Time Zone
+08:00
+02:00
+08:00
+08:00
+02:00
+08:00
+08:00
+08:00
+02:00
+08:00
+08:00
+02:00
+08:00
+08:00
+08:00

Log Types

Camera Disconnected from the Server / Camera Connected to the Server
Parent Station Connection Lost / Parent Station Connection Restore

Sub-station Disconnected / Sub-station Connected
Camera Recording Start / Camera Recording Stop

Start Scheduled Backup / Stop Scheduled Backup
Event Trigger

Log Category

Cateqary
Systemn Log
System Log
System Log
Systemn Log
System Log
Event Log
Event Log
Systemn Log
System Log
System Log
Systemn Log
System Log
Event Log
Event Log
Event Log

Clzar All Results ] [ Trace Login Activities ] [ Export All Logs ]

Clic

Result
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success

Log Level
Log Type
Level  Type
High Seryer Stop
High Server Stop
High Server Stop
High Server Stop
High Server Stop
High Camera Disconnecte...
High Camnera Disconnecte...
High Cetyer Start
High Server Start
High Server Start
High Server Start
High Server Start
High Carnera Connected t...
High Camera Connected t..,
High Camera Recording Stop - Success

Lser
Loecal
Local
Local
Local
Local
Local
Local
Loecal
Local
Local
Local
Local
Local
Local
Local

Target

Description

Service Mame=YAST Backup ...
Service Mame=YA5T Event S...

Service Mame=%AST Query 5...

Service Mame=4A5T Recordi...

Service Mame=YAST Configur...

Target Camera Mame=1_PZ7...
Target Camera Mame=2_IP3...
Service Mame=4AST Recordi...

Service Mame=%AST Query S...

Service Mame=%A5T Event 5...
Service Mame=YAST Backup ...

Service Mame=YAST Configur...

Target Camera Mame=2_IP3...
Target Camera Name=1_PZ7...
Target Camera Mame=3_FD&...

b’

[ Local Logs || Login History || Login Activities

Click to export all search results from the list

to remove all search results from the list

Select Login History from the log category field and click the Search button below, the search results,

including all login logs, will be displayed on the Login History page.
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Search Login Activities

This function allows you to search the operations the user performed during the login period of time. You
can search for login activities on the Local Logs or Login History page.

m Search Login Activities on the Local Logs page:
a. Click on the Local Logs page.

b. Select a login/logout option from the list.

c. Click Trace Login Activities (or you can right-click the selected login/logout option on the list, then
click Trace Login Activities).

Iradox T T Form: Cabigey Ll Toypme Rl Lkapr Tt Duecrigalion o
1 20100118 10; 5500 #0800 Systemn Log Hgh  Server Start Success Locd Sanmice Name=VAST Recordng ...

2 20100118 10:56:05 «[2:00 Syt Log High Brvir Starl wr=VAST Cuamy Sir...

3 20100118 10:56:16 «[2:00 Syt Log High wir Slarl =YAST Bickup Sar...

4 «[2:00 Syt Log vir Slrl

5 +05:00 Syibiem Lo St 1 1

fi werabion Log L BT Ackrin (LTl ) U Accownd =5STA,

7 2010-01-18 131122 +02:00 Operation Log LOGK|  Clenr AD Remlis = STAdmin Loca (Playback) Liser Account=5TAd., .

a 2010-01-18 16:14:24 +02:00 Ewent Log Cameé  toen Log= Acthvities Lo Target Camera Mames=1_IPA330

9 2010-01-18 16:14:25 +02:00 Cperation Log [reer e @ STadmin Lo Menw Camera Name=1_IPD300, ...

10 2010-01-18 16:14:25 +02:00 Ewent Log Camé  Fhew Miernmds Lo Target Camera Mames=1_IPA3030

11 2010-01-18 16:14:27 +02:00 Ewent Log LA mocmmny suan— sudBEE Lo Target Camera Mames=1_1PE33, ..

1z 2010-01-18 19:55:22 <0800 Operation Log  Womnal — Logout Success STAdmin Locd (Playback ) Lser Account=5TaAd...

12 2010-01-18 195541 +0E00 Oparation Log  Nomal  Update Layout Success ST Adrmen Locd Tangat LMS Name=Defaut Mag,...

14 2010-01-18 195541 +0E00 Oparation Log  Romal - Logout Success ST Adrmen Locd (LiveChant ) Usar ACCOURT=5TA,..

15 2010-01-18 195912 #0800 Oparation Log  Nomal  Login Success ST Adrmen Locd (LiveChant ) Usar ACCOURT=5TA,...

1 2010-01-18 200724 L-AL Opsration Log  Momal  Logout Succass STAdmin Lo (LivarClont) Usar ACCOUNt=5TA,..

1r OO0 1% LR A (I Systesn Log High Serwer Start SICORES | SoLaer Mamn=WAST (hatry Sor... %

[ Gear A1 Rests | || Trace Logn Acthwties || [ Export A1 Logs | @ [ Local Logs [Logn History || Login actities

d. The search results of the login activities will be displayed on the Login Activities page as shown below.

Index | Time Time Zone Cateqgory Level | Type Result User Target Description

1 2010-01-18 11:26:30 +05:00 Operation Log  Mormal  Login Success STadrmin Local (LiveClient) User Account=STA...
2 2010-01-18 16:14:25 +08:00 Operation Log  Mormal  Insert Camera Success STAdmin Local Mews Camera Mame=1_IP8320, ...
3 2010-01-18 19:58:41 +05:00 Operation Log  Mormal  Update Layout Success STadrmin Local Target LMS Marne=Default Map,...
4 2010-01-18 19:58:41 +05:00 Operation Log ~ Mormal  Logout Success STadrmin Local (LiveClient) User Account=STA...

Clear &l Results Export Al Lags Local Logs ” Login History || Login Activities

m Search Login Activities on the Login History page:
a. Click on the Login History page.
b. Select a login/logout option from the list.

c. Click Trace Login Activities (or you can right-click the selected login/logout item on the list and
click Trace Login Activities).

Index = User Login Time |1® i Ras It Logout Time Logout Result Time Zone Description
STAdmin 2010-02-01 09:41:38 2010-02-01 11:48:52 SLCCEsS +08:00 Playback
2 STAdmin 2010-02-01 11:05:53 SUCCE|  Clear All Results h16:21 Success +08:00 LiveClient
3 STAdmin 2010-02-01 11:48:55 Succe 77 : . = Success +05:00 Playback
T L Activitie:
4 STadmin  2010-02-02 09:31:04 Lcre| e B TR @ +03:00 LiveClient

Show Millisconds

&l

Local Logs | Login History | Login Activities

Clear Al Results ] Trace Login Activities Export All Logs
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d. The search results of the login activities will be displayed on the Login Activities page as shown below.

Index | Time | Time Zone | Category | Level | Type | Result | User | Target | Description |
1 2010-02-01 11:05:53 +05:00 Operation Log ~ Mormal  Login SuCcess STAdMmin Local (LiveClient) User Account=STA...
2 2010-02-01 20:16:21 +02:00 Operation Log  Mormal  Logout Success STadrmin Local (LiveClient) User Account=STA...

Clear &l Results | Trace Login Activities | Export Al Logs Local Logs || Login History || Login Actities

=
When you select All in the Log Level field, the search results will include all log levels. If you select Low in the
Log Level field and select Including above level as shown in the picture on the left below, the search results

will include all levels of logs. But if you select Normal in the Log Level field and select Including above level as
shown in the picture on the right below, the search results will only include Normal-level and High-level logs.

All ﬂ Lo ﬂ
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How to Configure Client Settings

On Client Settings, you can configure Snapshot Settings, Export Settings, View Settings, Proxy
Settings, and General Settings. It allows you to save snapshots and media files on the local
computer.

Configuration | Layout | Help /I

Client Settings Snapshot Bethings

Ewxport Sethings
¥ideo Enhancement * _@D E.
—— L1 Setings
- Pronor Bettings
it Search | Log Wienwer General Settings
27.0.0.1) FiF Settings

Snapshot Settings

When you play a recorded video, VAST Playback also allows you to take snapshots. For
detailed information about Snapshot Settings, please refer to page 230.

Export Settings

When you playback a recorded video, the VAST server allows you to export part of the recorded
video in EXE, 3GP, or AVI format to your local computer. Before exporting a media file, please
set up Export Settings first. For detailed information about how to set up EXE, 3GP, and AVI
Export Settings, please refer to Record Settings on page 232.

The default exporting path is: C:\ProgramData\VIVOTEK Inc\VAST\Client\PlayBack\Export

Limitations

1. The size of exported footage depends on the file size limitation. When the limitation is
reached, files will be concluded regardless of the length of your selection.

2. The Export button will not be available when there is another exporting task.

3. If the time settings on camera and VAST server are inconsistent, the export task will generate
files of unexpected length.

4. The minimum export length is 1 minute. The maximum is 150 minutes. However, due to the
embedded limitation, the approximate max. file size is 3.7GB.



Export an EXE/3GP/AVI File

Please follow the steps below to convert part of an EXE/3GP/AVI file of recorded video:
a. Playback a video clip from which you want to export a media file.

b. Set a period of time. Move the timeline slider bar to the desired start time and click Marker | @ Move
the timeline slider bar to the desired end time and click Marker I @

ge

Currently exporting video files from the NVR series is not supported.

D
iR

e

RN = Y B ] LR O
—— e — @

c. Click Export EXE/3GP/AVI @ the server will start to export the data and popup a window showing
the exporting status. If you close the status window, you can also open it again by clicking View >

Exporting Status.

d. When the export is complete, you will see an information dialog. The exported data will be restored in
the preset storage folder on your local computer (C:\ProgramData\Documents\VIVOTEK Inc\VAST\

Client\PlayBack\Export).

@ Mags P Hotwerk Cattaind
| 20130116 105005 ~ 201301 16105210

| Espaaeting mscka for Mags el Matwork Camers o 120116 1R to 20030115 105
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View Settings

This section allows you to set up the display mode of video cell. For detailed information about
View Settings, please refer to page 238.

Proxy Settings

Please refer to page 256 for detailed illustration.

General Settings

System Settings
Please refer to page 241 for detailed information.

Display Settings
m Enable de-interlace function: Select this option if your connected device does not support de-interlace

function. F le: VS7100.
netion. For example

System Settings

[fetrieve RTSP stream.on.snecified nort;

[JConnect substation streaming via relay

Display Settings

[JEnable de-interlace function

[ Ok ] [ Cancel

How to Configure Video Enhancement

The Playback also allows you to enable post-image enhancement and defog for video viewing.
Please refer to page 260 for detailed information.

How to Search for a Device on the Hierarchical Management Tree
The Playback also allows you to conveniently search for an inserted device. Please refer to
page 265 for detailed information.

How to Print a Video Image

The Playback also allows you print out an image of live video. Please refer to page 266 for
detailed information.



How to Lock VAST Playback for Security Concerns

If you happen to be away from your computer, for security reasons, we suggest you lock the
program. When VAST Playback is locked, the user must enter the correct password to unlock
and access the program again.

m To lock Playback, click Unlock @ on the quick access bar or click System > Lock on the system
menu. The Unlock @ icon will then turn into Lock @

® To unlock Playback, click @ and enter the correct password in the popup window.

% Playback
oot e . i

(Sy&tem Edit = View | Configurati

The application is locked, Please enter the passwaord for adrmin,

Lock Chrl+L

. |
Launch LiveClient
Launch System Manager

0K l | Cancel

Logout
Exit

How to Log out from the VAST Server

To log out from the current server, click the station and click Logout |z on the quick access
bar or click System > Logout on the menu bar. You can also right-click the station and click
Logout. A confirmation window will pop up. Click OK to confirm or Cancel to return to the VAST
Playback window.

Lack Chsl

Browising |T|me Search | Ewent Search I Bookmark Search | Log '\ﬂewer| i Candrm et

Lasamcs LiveClierm
Luvansh Syotem Mansger = @ Managed Stations ﬂl_ y Th well lirrminely the curen] orredsn, Ane you e yo wand b contre?
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£ =T B Carneras Logout | Cancal

= [ Me Refresh
- Find...

—— B 20120802
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How to Exit VAST Playback

To exit VAST Playback, click Exit [©| on the quick access bar or click System > Exit on the
menu bar. A confirmation window will pop up. Click OK to confirm or Cancel to return to the
VAST Playback window. When you exit the program, your user account will be automatically
logged out from the current server.

% Playback % Confirm ==)

[ System | Edit = View | Configurati f '*_‘, Are you sure you want to exit the program?
Lock ChaleL '

Cancel ]

J Launch LiveClient 2 )
Launch System Manager

Logout
Exit




Import and Export Utility

VAST supports import and export utility for user to keep record of all server settings. You can
use the export file to copy the configuration on another host.

Export Utility

Please follow the steps below to export the server settings:
a. Under Microsoft Windows, choose "Start > All Programs > VIVOTEK Inc > VAST > Tools > Import-
export Utility." =
G Tools 3 I I Import-Export Utility

b. The Import/Export Utility window will pop up. Click Export and select a target folder. The system will
start to export a .bin file.

| B IpertBasen Liiny ! w Import/Export Diility
et

Exporl emiieal wibing

. Il  5Startservice... ackup. bin
| [ |

& Tmport previows sethings

| Crgy it 13-11 12:44:00

Import Utility

Please follow the steps below to import the server settings:

a. Under Microsoft Windows, choose "Start > All Programs > VIVOTEK Inc > VAST > Tools > Import-
export Utility."

b. The Import/Export Utility window will pop up. Click Import and select the export file. The system will
start to import the file.
You should then select the Restore or Copy settings options.

Restore: If this is selected, the VAST server GUID will also be restored. This option applies when
you need to restore as crashed server.

Copy Settings: This applies you use the exported profile to duplicate your configuration to mul-
tiple computers. A new server GUID will be generated.



! The svsterm will still recycle the video files in the original paths when the new sttings with new paths is imported.

i Tmport will drop all current settings in the station.
L Would you like to continue?

oK | [ Cancel
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VAST Service Control Tool

VAST service control tool is a tool for server control and for user to be aware of the VAST Server status.
It starts up as Windows OS startup.

Under Microsoft Windows, choose "Start > All Programs > VIVOTEK Inc > VAST > Tools >

VMServiceControl."
Il, VIVOTEK Inc
j Installation Wizard 2

J vAST
&4 LiveClient
& Playback
&7 Uninstall
. Toals

Import-Export Utili
&} VMSSeniceCantrol -

You may also find it in the system tray icon of the tool bar, which indicates that the service is running:

It shows a disconnection icon when the service is stopped: m

A menu for the service control tool will pop up when you right-click on the icon:

Open VAST Senice Control  ——}———{ KA VAST Senvies Contral = ]| =) ol
Start Service Service Status

Stop Service Wersion: 1.12.1.4

Restart Service Status: Running

Exit | start | | Stop | | Restart |

Here you can manually start, stop and restart the service.
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Appendix A Failover Server Configuration

VAST servers can be configured into two groups: Active and Redundant. The Active group
performs daily recording and monitoring tasks, while the Redundant group acts as the standby
servers. In the event of server failures, the Redundant group becomes active, and takes over
the recording task.

The Redundant server group configuration consists of the following:

1. One VAST server designated as the CMS (Central Management server) VAST central

management server.
2. At least one VAST server in the Active group.

3. At least one VAST server in the Redundant group.

4. Gb/s network or higher-speed connection among the servers. All Active and Redundant
groups can reside in different subnets, provided that static IPs are configured for these
servers.

IMPORTANT:

For a Redundant server configuration, you must first enlist VAST servers in the Sites
configuration page before configuring the Redundant server groups. See the Sites
configuration page.

CMS VAST

External storage /

NAS
N N N

0 | N E:-lll
O O N

Network Cameras

Redundant Group

Active Group

Active VAST servers Redundant VAST servers

Node 1 Node 1

Node 2

Node 3




Below are the definitions of server roles:

1. CMS VAST server: The main access portal for the configuration.

1-1.  |CMS server is where the Failover configuration takes place.

1-2. |CMS continuously polls to check the hearbeats to monitor the statuses of all Active
and Redundant servers.

1-3. |CMS regularly backs up the configurations on Active servers.

1-4. |CMS assigns redundant server(s) to the takeover of a failed Active server.

1-5. |In a Redundant server configuration, the CMS is supposed to be up and running at
all time. If the CMS server fails, the server failover and failback operation will not
take place. It is therefore preferrable to install the CMS server at a high up-time
environment, such as on a VMWare configuration.

2. Active servers: Active VAST servers are the work horses that perform recording and
monitoring tasks.

3. Redundant servers: The Redundant servers are actually active-standbys. They participate
to continue video recording in the event of active server failures. It is recommended for the
Redundant server to have an equivalent or higher processing power than the Active servers.
The same applies for the storage volume and write performance.

Note that you cannot configure a Redundant server by opening a local console.




The conditions during the failover are illustrated below:

Multiple Active and Redundant groups can be created.

Network Cameras

CMS VAST

External storage /

(- - -T--- - --=-=-TT-"qr--"-~"-"--"-=-==-=-- r - - - -T - - T-T-= == -~ - r---—=—T"="=-"=—==-==
| Active Group Redundant Group \I | Active Group Redundant Group
I |
1 Active VAST servers Redundant VAST servers : | Active VAST servers Redundant VAST servers
I I I
1 Node 1 Node 1 1 1 Node 1 Node 1
| ! |
1 1 1
| ! |
1 1 1
| ! |
! 1 !
: Node 2 Node 2 ! : Node 2
|
| ! |
I | I
| | I
I | I
| | I
I | I
| Node 3 | |
I I I
1 1 1
I
| Server Group 1 : : Server Group 2
| ! |
\ J \

Each Redundant server can serve as the backup for ONE Active server. Depending on

the number of the Active and Redundant servers, if the number of failed servers exceeds
the number of Redundant servers, the failover will be abandoned. For example, if 2 Active
servers failed, and there is only 1 Redundant server available, the second Active server that
failed will be abandoned.

N e e e e e =
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In the event of a server failover, a VAST server in the Redundant group takes over the recording
task. Note that depending on the network environment, the takeover can take up to 5 minutes.

=3 Recording

Active Group Redundant Group

Active VAST servers Redundant VAST servers

Node 1

Node 1

Node 2

Node 3
Server Group

Node 2
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Once the server in the Active group is restored to normal operation, and a CMS server requests
for the recordings and data occurred during the time the active server failed, the requests will
be fulfilled by a shared volume on the redundant server. Due to the concerns with network
bandwidth and processing power, the restored active server does not synchronize its recording
pool with that on the redundant server.

=9 Recording
~@— Playback & Search

jm——— ===t -t ----=-=-=-=-=-=--
| Active Group Redundant Group :
|

|
| Active VAST servers Redundant VAST servers |
: |
| Node 1 I
: I
! |
1 L 1
| Recovered! < |
! 1
: |
: |
| Node 2 Node 2 |
: |
: |
' |
' 1
' 1
! |
|
| | Node3 !

|
: |
: |
| Server Group I

|
' |
|

The recovery path should be available in the network neighborhood, with a name that looks like
the following: ActiveServer1 _91AAF3D06B6C47 \RecGroup1.

If an Active server has 3 recording groups, then each Redundant server will have 3 recording
paths accordingly.



In terms of network failure, the VAST2 configuration supports Seamless Recording. For cameras
equipped with an SD card, video is recorded to the SD cards in the event of network failure. Of
course, the camera must be powered by a secondary power source, such as a DC 12V input. In
cases such as the only PoE switch or POE mid-span fails, power is lost.

CMS VAST

Recording

External storage /

Network Cameras

| |

Active Group Redundant Group

Active VAST servers Redundant VAST servers

Node 1 Node 1

Node 2 Node 2

Node 3

™™ T O

Server Group 1

—_—— e e e e e e e e — — — — — — — — — — — — — —

|
> |l <<
__ __ | __
|
1
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
\



Once the network connection is restored, the VAST2 servers resume the recording task and also
retreive video segments from the SD cards. The video segments recorded during the network
failure will be stitched up with those occurred before and after the network failure. The retrieval
speed varies depending on the available network bandwidth and CPU resources.

CMS VAST

= Recording
=== Retrieval

External storage /

NAS

Network Cameras
a7 = a7

S SO N (a - Y u Y|

IL.I!I mOE 7

Ty

Node 3

Server Group 1

W
-] Y - — A ————
. | — Active Group Redundant Group ‘I
|
| Active VAST servers Redundant VAST servers :
| I
| Node 1 Node 1 |
| I
| I
| I
| I
| I
| I
: Node 2 Node 2 |
|
| I
| I
| I
| I
| I
| I
| I
| I
| I
| I
| I
\
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To enable Seamless recording, find the associated option in Configuration > Camera
Management > Camera Update, and select the Seamless recording checkboxes. Camera

models that support the Seamless recording option will have it listed.

- Camera List

o [l vws_stron(127.0.0.1)
— D FE9Z91-EV(192.168.4.161)
B 3_192.168.4.124[192.168.4.124)
W c0oi61-H{102 168 4.164)

Camera Name:  FE9191-v2 4

Address: 192.168.4.171
Modelllame: | FEiaie |

HAC Address: | 0002013AD1EF |

STorage Groun:
Barsdc Seltings
Recording Streame 1

oA

Pregvent Trre: 10

o

Paost-pwent Time: 10

Activity Adaptive Stream
Ciactve

(&1

| Connecton Settigs | Recordng Settigs |

seconde 3-15)
sarconds]10-60)

[Tl Enable seariess recarding

[_toone | [iiommn]
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Failover Configuration Process

Before Failover configuration, you need to add other servers to your Failover configuration.
« If you are adding a Redundant server, enter the "Redundant Server Management" screen.

* When adding a Redundant server, you can provide a Windows account 802.1x domain user
name and password. A Redundant server requires this because a full access to the recorded
data is required during the failover and failback process.

To configure Redundant servers,

1. Install VAST server on a server chosen as the active standby.

2. On the server chosen as the VAST CMS server, open Configuration > Failover
Management > Redundant Server Management.

%d LiveClient

(System Edit | View | Configuration | Layout | Help :I

Camera Management r
(I)‘ Eﬂ‘ GI I Station Management... I J . é‘ qu J
Logical Tree View Management...

= B vMs_station(127.0 0 Box Management v tri:-: View

+ M camers

User Management...

201719y7 _F4-10:46:35

+ E ;ecnrdmg SY Association Management... T "
Alarm Management... iy
M Layout -3 .
Virtual Matrix Management 3 o A
Failover Management 3 Redundant Server Management...

Search VivoCam Switches... Redundancy Group Settings...

Station Settings 4
Client Settings L

Note that it is a must for the Redundant server to be installed differently by selecting a
"Redundant server" checkbox during the installation process.

Standard Server

Free wersion: 32 channels (WIVOTEK only)

Trial wersion: 256 channels (60 days)

@ Redundant Server

Cancel % Back | [ Nexk =
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3. Enter the IP address and Windows AD credentials for access to the Redundant server. Click

the Add button when done, and click the Done button to leave this page.

Addris:
Fort, 5 Elwessi
Windows Account (optional)

Ingut Windows acoount information to #ooess recrdings

Dorain Hama:  Host

User Mama:  guest

| Deets_| s ]| vodste || cose,

An Active server must have a CMS password configured for the hierarchical configuration.

Note that on the Active servers, you should configure them as the subordinates to your CMS
VAST server. On a web console with these servers, open the Site management page, and select
"Allow CMS connection." Create a common password for the CMS hierarchy.

Allow CMS connection

Relay Authentication

Passweard: | Corroeee

Caonfirmn Password: | I —

Lok ][ cancel |
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Two agents will be running on the Active and Redundant servers, "stunnel" and
"VMSWebServer." Make sure they are not blocked out by your firewall. These agents can be
found in the default folders below:

C:\Program Files (x86)\VIVOTEK Inc\sTunnel\stunnel.exe
C:\Program Files (x86)\VIVOTEK Inc\VAST\Server\VMSWebServer.exe
P el L - o =

1'rmw-wum~mm.uﬂw w & [ ST
T lie Vo= Tesk

Aicw apps 10 ommuncie Ewougt Whndows Foewall
T b, kg, v e Mo kog pvd rons, chor Change eitisge.

R e T i 8 ] 4 P st | S
| e g el Pasiaer
|| W Freae Suwe =
L o et 18 favaans. B
T B g Tt e Prpien R R
RAILE Sty S8 008 Bz B B
RESAILD fesmarmng ELA LEF Escaption B
[ 2 &
(=T o a
- =] =]
E 1 %] a5
nwb-m-i BB
BT B B
580 T ] I
R

L= 8 i Cwesd

4. Enter Configuration > Failover Management > Redundant Group Settings. Enter the

Group name, Description, and click on the Edit button .

Falregr gerver 2ol CME sengr
192.158.4.165; server 192.168.4.167;
redundant server 192.168.4.157

Marmbere:

B acove Server
— M Redundant Server

336 - User's Manual




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

5. Select the Active and Redundant servers and move them to the list of Selected servers. The
Active and Redundant servers you enlisted should all be listed below. Select the members of
the Redundant group, and click OK to complete.

'Qredimdng Gowp Senge =

Availabe Selected
g ._ B= Unused Servers g ._ B Members @
|:| P Active Server |:| B Active Server
E = i [ Redundant Server @

I VMS_Station

1) (&)

ok || cancel |

The default for the network disconnection timeout is 30 seconds. It is not recommended to
configure a very short timeout, e.g., 5 seconds, because if doing so, a temporary network
disorder can make servers consider the Active server(s) have failed.
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Using the failover function requires Failover license. On the CMS server, you can check the
number of channels in Help > Failover license. Below are the requirements for running a failover
configuration:
1. In a Redundant server group, the number of licensed channels = No. of Active server
channels x No. of Redundant server(s).
For example,
There are 3 Activer servers with 100, 125, and 165 channels.
There are 2 Redundant server.
The number of failover license channels are: 165 x 2 = 330.

arate Licanse Update Reouest | | Cose |

2. Error prompts will display if there are not sufficient failover channels when you create a
Redundant server group.

The following features exceed the number allowed by the license. Please contact our sales representatives to upgrade.
*Camera Number
*Failover Number
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Appendix B Panoramic PTZ (P-PTZ) Configuration

Enable Panoramic PTZ on VAST

The process of configuring two cameras (1 fisheye and 1 speed dome) into the Panoramic
PTZ configuration takes place on a PC using the calibration tool. The Auto Tracking feature is
configured using a web console with the fisheye camera. A Panoramic PTZ package should
comprise two cameras running specific firmware for this application and a software CD
containing all necessary utilities. For configuration details, please refer to the Panoramic PTZ
Installation Guide.

—
ﬂ gj} Calibration tool
‘\,—

360°
All round view

To exert Panoramic PTZ control on VAST:

1. Once these two cameras are configured into an interactive pair, insert these cameras into
your VAST configuration.

2. Select a preferred layout using the Layout @ button. The 1P+2, 1P+6, and 1P+8 layouts
are specifically designed for the Panoramic PTZ configuration.

3. Taking the 1P+2 layout as an example, once they are listed on the device list, click and drag
the fisheye camera to the upper left and the bottom view cells. Place the speed dome in the
upper right view cell.

Fisheye 10 Speed Dome

Fisheye 1P




4. Right-click on the fisheye's view cell to change its Display mode either into the 10 (Original)
or the 1P (Panoramic) mode. Note that the Panoramic PTZ control does not take effects on
the "R" (Regional) mode and the combinations of other display modes.

5. There are two different ways to quickly exert Panoramic PTZ control. The pan, tilt, and zoom
actions are made from the fisheye's 360° hemispheric overview:

5-1. Click on a spot on the fisheye's Original or Panoramic view where you detected a
condition of your interest. The speed dome will aim its lens at the corresponding position
to cover that field of view.

5-2. Click and drag a region of interest either on the Original or on the Panoramic view. The
speed dome will move to that region and zoom in to fill the same proportion of view into its
view cell.

* On the Original view, click-and-drag creates a circular region of interest.

* On the Panoramic view, a square region.
+ If you draw a small region, the speed dome will zoom in on the scene. The smaller the
region, the larger the zoom-in ratio. A large region makes the speed dome to zoom out.

Object %} QQ}

Click and drag

Click to move

Object
of your interest

Tz iy i
sl gk |ehand - 9 T

@E. Click and drag
= 7% e S

The speed dome camera automatically performs optical zoom in/out to best fit the selected
field of view until the maximum and minimum zoom ratio is reached.

- Tips: Object
1. When drawing a region of interest, click and drag from of your interest
the center of your interest over a diagonal line to the

bottom right. It is not like drawing a diagonal line from
corner to corner.

2. To swipe the Panoramic view left or right, press and
hold down the Ctrl. key and the left mouse button.

S
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g;

1. The fisheye and the speed dome are made into an interactive pair using the calibration tool. The VAST
software provides the control interface only. If the cameras have not been properly configured, the
Panoramic PTZ function will not take effect.

2. If the password of the speed dome camera has been changed, you will need to open a web console
with the fisheye camera to change the coordinate password.

3. You may need to reset the fisheye camera if the speed dome camera is powered on after you started
the VAST software.

4. The precision level of the interactive positions between the view cells of the fisheye and the speed
dome is determined by the mapping table. Make sure you have inserted a sufficient number of
reference points and make good association of these points using the calibration tool.

5. Currently the associated event trigger by Auto Tracking is not supported on VAST. The associated
event triggering is configured through a web console with the fisheye camera:

Applications > Panoramic PTZ

' General settings || ImporvExport files |

[¢] Enable Panoramic PTZ
[] Enable Auto tracking

Auxiliary camera information
1P address: 1172.16.90.172
HTTP port 80
Conireller camera account
User name:
Password:
Associate the auto tracking event with the auxiliary camera’s manual trigger [ |1 []2 [7]3

5-1. You should then create an event setting using the manual triggers as triggering sources.
5-2. When Auto Tracking takes place, the pre-configured event settings on the speed dome camera
can take associated actions, e.g., taking a snapshot, recording to SD, or triggering the DO pins.

6. The Panoramic PTZ function is currently not available on the Matrix or web console mode in VAST.

7. If the interactive camera pairs (Panoramic PTZ cameras) are managed under VAST substations, then
all of the VAST instances, such as the primary VAST server, the substations, and the client side must
be running the revision that supports P-PTZ.
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Panoramic PTZ - Event Trigger

The P-PTZ-related event types include: "triggered" and "returned to normal" when Auto Tracking
takes place. Below are the configurable options with the event configuration:

1. When configuring a recording schedule, the Auto Tracking actions can be selected as one of the event
triggers. The configuration is found in Configuration > Station Settings > Recording Schedule
Settings.

S Ravmrdieg T 4 L

Scheckle Lt; Dofadt Screchie (=] add | Meume | Cwbe | Lot Temolan | fave o Terrolae |

[
Trigpprs:

iTamoser
Dl It
¥ Triggee St (9 haorrmad Seate

[ rrrerms e |

I#mwﬁmm#m
f .
| Mgt Eivrain

|20 Znom 300D Sipasped Do Wetwork Carmard

FERd

]

2. When Auto Tracking is enabled, its actions are considered as one of the system event types.
In Configuration > Event Management, P-PTZ is configurable as a Trigger Type in Event
Management > New Event > Trigger. This event trigger can be associated with different actions,
such as Email, recording, moving to a preset location, GSM message, HTTP, Client notification, etc.

MNew Even

An et b 3 combinution of trigoens, actions, and schedule. You can add a niw event or i

et an exishing o, General ==  Trigger == Action == Schedule == Detail

Evailt List

©  Ewatt 002 (Trigow) . Sendclentnot. Abways iadd e —_—

Add Event by: ) Device @ Trigger Type
o Eventd  P-PTZ (Trigger)... Senddentnobl. Abways Categary: [Camera Everits v]

Type:  (Mation 7]

Motion
DI-1
DI-2 ]
———— D13 Remove
DI-4
DI-5

[ Mew || Edt || Remove | | Detdas | . [ Balit B

D-a

- Do-1
Do-2
DO-3
DO-4

Do-5

Tirme Zone Tvpe Do-6

Do-7

Do-8

Wideo Loss/Restore
PIR

Tampering

Termperature

IR

Iv'A - Maoving Object

Iva - Loitering Detection

IvA - Camera Tamﬁerini
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Auto Tracking can also function as a Device type in the Event Management configuration.

Select the trigger(s) from the following list,

Once triggered, the P-PTZ Trigger and

ERA BTk _Stationi(127.0.0.1)

S @M Maga-Pixel M
“oT i Motion
- & DIl

etwork Cameral192,168.6,228)

G- [ BB 20% Zoom Mega-Pivel Speed Dome Metwork Carneral192.
= G899 Mega-Pivel Metwark Cameral 192,168.6,127)

™
¥
V@
s

Motion
DI-1

Do-1
Tampering
P-PTZ

[ e MDB401(192.168.6.128)

4

1n | §

P-PTZ Normal events will create two
short videos for a length of 30 seconds.

Note that the P-PTZ event is not
triggered by Panoramic PTZ control on
the view cells, it is triggered by Auto
Tracking. Auto Tracking takes place
when a moving object enters the pre-
configured region of interest. Please
refer to the Panoramic PTZ Installation
Guide.

[ Ok ] [ Cancel ]

3. Events triggered by Auto Tracking are also recorded into system logs.

Instant Phayback

Source Time Tme Zong nm"nm1
w SF8172 2013-06-19 15:41:47.087  +08:00 'ﬁz Hormal
P7160 2013-06-19 03:41:43.821  +08:00 Moton - Wndow 1 13%
P7160 2013-06-19 03:41:40.488 +08:00 Motion - Window 1 5%
P7160 2013-06-19 03:41:37.156  +08:00 Movon - Window 1 129
w SFB172 2013-06-19 15:41:36.844  +08:00 PPTZ Trigger I

4. As the result, in Playback > Event Search panel, Auto Tracking (P-PTZ Trigger/Normal) is also a
search condition.

Search Categories: | Al Events -

Wideo - Loss
Video - Restore
IR - Mormal

IR - Trigger
P-PTZ - Trigger
P-PTZ - Mormal

Add ] ’ Remove

Tirme Zone:  GMT+02:00 Beijing, Chongging, Hong Kong, Kuala IZI

Start: Time:

2013F 7F 3+~ 135203 =
["1End Time:
2013F 7F 9 14:52:05

[ I Display in Mew Result List
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Enable or Disable the Panoramic PTZ Functions

You can manually enable or disable the Panoramic PTZ function in Configuration > Camera
Management > Camera Configuration:

El ...... . Camerta
...... 2|:| Delete
...... ' EE
Refresh
- EN e . cetti
------ P recordir mera ngs
o P Layout | Camera Management [ Insert Camera...
Output Streaming URL Lrzsieiamen
Delete Cameras...

Send to Talk Panel

i Camera Configuration...

1. Select the fisheye camera by a single click, and then open the panoramic PTZ panel from the tabbed
menu.

2. You can enable or disable the panoramic PTZ or the Auto Tracking functionality using the checkboxes.

3. Click the Save button, and the saving progress window will prompt.

Camera List

Video |A|_;h Imml MPSEHI"EF" Panmnrarnic PTF
& B Wi staton1(127.0.0.1] | ygeo stream:

Stream 1 =
[N Mega-Pixel Network] | | Codec type: [sve -|
i Mega-Pixe! Network .
Frame size:
[EN Miega-Pixe! Netiork wsowss 7
LGP Mega-Pixel Networkl | Maximum frame rate: IIH'DB ".]
Video quality: |mu|aﬂhitrate - | |4Mbps n

4. Click Close to end the configuration process.
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Appendix C  ONVIF Support

ONVIF is supported in an environment where the VAST server can detect and record video
streams from the cameras made by other manufacturers.

The following are supported.

1. ONVIF camera icons on the device tree. Bl [ElM

Brand name selection is also available on the configuration window.

B Megafoel Network Care

Model Mame: | PRI
MAC Addere | OOEDLIEIGE |

| Conneeton SNG: | Ancording Satbags |

P Camara Hama: | | Emen
@ oot e e meuasne [

st Mames
Sitrpaming Protocol: L

¥ autormaticaly sdd camera nbo tecordng strage | Deflmitinn

Patword:
Confguation Pot: BN =
Channet: =

[ ot | | ome |

2. Insert/update/delete camera from the device tree.

2-1. Detect ONVIF cameras.
2-2. Connection test.
2-3. camera password authentication.

2-4. Supports HTTP and HTTPS streaming protocol.

2-5. Supports multiple streaming.
3. Live view/recording/playback.
3-1. Audio G.711 support.

4. Mechanical PTZ support with the exception of Focus, Iris, Pan, Patrol, and preset location

operation.
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Limitations:

The following limitations apply to ONVIF cameras made by other manufacturers. Some features
may be implemented in later releases of software.

1. Users should ensure that your other brand cameras support ONVIF.
2. The connection statuses of the other brand cameras will not be displayed on the device tree.

3. For mechanical PTZ cameras, the Focus, Iris, Pan, Patrol, and preset locations functions will
not be supported. The associated buttons and control elements on the Ul screen will not be
disabled.

. Does not support the Batch Insert Camera function.
. Does not support Camera Configuration.
. Does not support Active Adaptive Stream (AAS) function.

N O O~

. Does not support Event related functions, including event recording, event management,
instant playback, event search, etc.

8. Does not support camera DI/DO.
9. Does not support Two Way Audio.
10. Does not support Auto Stream Size.

11. The ONVIF user authentication (account and password) may not comply with those
configured via a web console.

12. The number of multiple profiles can vary.

13. The number of accessible profile can vary. Some might have only one profile to be
connected.

14. Does not support Click on Image.



Appendix D VCA Report

The VCA Report utility is started from System menu > Launch VCA Report. The VCA Report
utility provides comprehensive graphs and line charts for quick access to the data collected
through VIVOTEK's People Counting modules, such as the SC8131 stereo camera. Statistical
results is refreshed by hour or minutes, and you can compare the results acquired through
different time periods or among different surveillance areas. These data help figuring the
customer flow in retails so that shop owners can optimize the arrangement of store layout, or
mange queues more efficiently.

I Time selector and function
panel

L)
'S
>

i

Chart panel

Add, Select, Edit

"3 ﬂ

E1

Area data oo e

ge

The configuration of detection methods in People Counting still occur on a web console with individual
cameras. It is not configurable through the VAST LiveClient.

Prerequisites:
The prerequisites for using the VCA Report are:

1. Cameras running the VCA utilities have been configured and added into the VAST
deployment. The instances of available VCA rules will be listed in the Area panel.

2. The life expectancy of VCA records is 5 years.
3. Currently the utility supports Windows XP, 7, and 8.

4. The latest revision v.1.12 supports Seamless Recording, in order to retrieve collected data
and recording during Ethernet disconnection. Provided that an SD card is installed on
the SC8131 camera, the VAST station gradually retrieves data from the SD card after the
connection is restored.



To begin using the VCA report:

Create Areas

1. Click on the Add button in the Area panel. Cameras running the VCA utilities will be
listed. Click to select cameras. Those running multiple detection rules will be displayed on
screen. Data collected for these rules is kept in camera's flash memory.

2. Click to select one or more cameras.
3. Enter a name for the area, and then click the Create button.
4. The Areas thus added will be listed on the Area panel on the left side of the screen.

If you have multiple detection rules on cameras, you can manually remove some of them from
the list by mouse-overing the rules. After you configured an area, you can still right-click on an
area to configure its parameters.

If only one camera is selected, its name
will apply as the Area name. If not, enter
a name for the area.




5. Click to select one or multiple areas. Those selected will be highlighted in a different color.

Select Date & Time

6. By default, the time displayed on the calendar is the current system time on the client

computer running the utility. Select from the Date selector on top.
7. Select a date or span of time from the calendar or use the and Time selector to select a
span of time.

> Single-click to select a date or click and drag to select multiple dates.

> You can select a month or a year using a single click. If you select a month, the timeline unit
will be days within the month. If you select a year, the timeline units will be the months in a
year.

> In the Month or Year panel, single click to select the entire month or an entire year. Double-
click to select sub-units, e.g., days within a month. If you double-click on a Month panel, you
will enter the Day panel.

+ May 06 - 22, 2014

B
Floor 1

Day Month Year
Floor 2

Floor 3 May, 2014




You can select a different month in the Month or Year panels. The Calendar panel
disappears if left unattended for 2 seconds.

On a Month panel, double-click to select a month, and the Day panel for that particular
month will display.

May, 2014

ER i |®|

Month Year

Select a month

gg

« When a date is selected, the Date and Time panel will not automatically close, and the
configuration changes will not take effect until it is closed. You can click on the outside of the
panel to leave the panel.

* You can select multiple days to form a span of time. Select one date with a single click and
select multiple dates by draging your cursor across the screen to a preferred end date.

» To select a year, click to open the Year panel. Single click to select a year. Multiple years can
be selected using the click and drag method.



8. Select the hours to be included in the statistical poll using multiple clicks on the chart.

Single-click to select an hour or click and drag to select multiple hours.

Jan 31 - Feh 03, 2015

=,

Note that you can only compare the counting results
from two spans of time if you select only one Area. If you
selected multiple Areas, you can not compare the results
from multiple time spans.

9. Click outside the Calendar panel. The statistical results will display. The default display is the
bar chart. Below is a sample screen showing the results polled from 3 areas. Up to 8 areas
can be selected in one view.

FlowPathoount! Gl ag ) 15 1190 .4 mins

I Couantingl J&0 15 1190 4 mins 1600
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Select different display modes using the Bar “ Line , or Pie n chart buttons.

Line chart.

Pie chart.

- 3aa "o Taan w30 1438

159€ = Tatn TN TO0 T
1R A 1o, ™mi 000 N

11940 min 2200 i ] =200 pa &

.

 Counting). 11265 mns.
* HowPathcount! 11265 mins:

Note that the timeline units can vary depending on the span of time you selected on the
Calendar panel. If a date was selected, hourly data will display in chart. If a year was selected,
monthly data will display in chart.
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Use the following functional buttons to change the display parameters

Show data on chart : Displays the collected numbers on chart.

Average : Displays the average number per time span unit (e.g., per hour). If the interval

is changed to 30 mins, the average number will be halved comparing to the number acquired
by every hour.

Report Interval : Configure the intervals for polling data from the camera. The default for
displaying results is by every hour. If you enter 30 minutes as the display interval, all data will

be listed on the basis of the 30 minutes time span. The configurable range is 1 to 1440 mins.

Counting1

FlowPathoount] ) ] 15887 £ mins

Use the Refresh button to poll the latest data from camera.

Use the time selector on the View Report from pane to select the start time of your statistics
view window. Data collected before that time will not be displayed.

A number is displayed when you mouse over an
area on the chart. Move your cursor to an area on
chart, and the number is displayed.
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=
If you selected only one area, you can use the Shift key to select multiple areas (or two spans of
time). You can select multiple dates in the Calendar panel.

Data on a time line will be generated. To close the window, use the close button on the second
date information. Equivalent spans of time can also be used for comparison. For example, you
can compare the data in a span of 4 days against another span of 4 days.

Note that the Compare function only applies when you select to display only one area on
screen.

— Tt Remaining peoples

{irPeaplel

L]
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B SaE
B T
5,203
A
'!"“ﬂ"‘ﬂl*’ﬂ'ﬂ-"'ﬂ“ﬂ""ﬂ"'ﬁ"ﬂ'"l*ﬂ'"ﬂ"ﬂ'Il"lf"! W"U"h*‘l"ﬁ*'b"r"ﬂ"'f"h"-il" FY*FrIT "
= ol o 5] ] oE ) ur s = ] mn 1 12 13 14 15 1k 7 B 14 ] L E

In a comparison result displayed in a line chart, mouse over to the peak value to display the
percentage of an increase or decrease rate.
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See below for the functions of buttons on screen.

No. of people who o. of people who No. of people who
entered the area left the area remain in the area

Show an average
number

m <Change the time interval

Click to display or Show data on chart
hide the results for an area

In addition to the charts, a summary of displayed data will be listed below showing the areas
involved, visits/Day or Month, Average visits / Hours / Days, Average duration of stay / person,
and the Peak hour.

Floor 3 490.870 122,718 1053 mins 12704
I Floor 2 959,482 239,870 105.9 mins 12/02
site 2 3873510 868,478 108.0 mins 12/01
h323 862
10. When done with displaying the results, you can use the Export button to produce an

image file to preserve the current results. Both a spreadsheet and a graphic chart will be
produced.

Export

Raw data (CSV file)

Save to

C:/ProgramData/Documents/VIVOT -

Open folder after export




11. Click the Reports Subscription button to configure the regular report sent to your Email
account or a specific location on the server itself. Select the report chart image in JPEG or
PNG, and CSV data files. Slide the email button to enable the Email notification.

Select the time to deliver your mail notification. Enter valid Email addresses as the sender
and receiver addresses and make sure the SMTP mail server configuration has been
properly configured on your VAST server. This VCA mail notification utilizes the mail service
on VAST for regular notification. You can then receive Email notification every day on your
Email account. You can enter up to 5 recipient addresses.

Reports

crare - [RCRN

Raw data (CSV file)

Sentat | 00 : 00 : 0O

Subscribe by email .

. SMTP Setup LIve Client > Conf

Subscribe by sending to server .

Locatio C:/Users/Public/Documents/VIVOTE .

Note that the notification contents is your current field of view, including a Bar, Line, and
Pie chart combined into one image file. The In/Out/Remaining results will be generated into
3 charts. Each Area will generate one CSV file, and each CSV data file will contain In/Out/
Remaining/Summary information.

Peak period (30m)

The generated file names will look like this: 20160226 _test02_Remain.jpg for charts and
20160226_Summary.csv for CSV files. The Email subject will be "VCA Daily Report -
2016/02/26."

Note that if you manually export a report, the default is sending the data collected until one
hour before the manual export. For example, if you generate the report at 14:07, the report
will only cover the data collected until 13:59. You may use the Refresh button to manually



immediate data inputs (those occurred between 14:00 and 14:07).

Below are the messages with the Email test function.

@ suresewp

. SMTP Setup

Failed to send email

sending to server

é@

If changes have been made to the VCA People Counting configuration through a web
console, Refresh the connection with a network camera from the Device Tree. You can left-
click to select a camera and right-click to display the Refresh command.

The object height information detected by cameras is displayed on screen. You can select to
display such information in centimeters or inches in Configuration > Client Settings > View
Settings.

4 View Settings @
Display Location

Camera Name 2016/6/14 £ 09:19:03

Display Area 1: | Camera Name

Display Area 2: | Server Date & Time
This is a sample screen.
Display Area 3: | Video Title

1 ] B [E]

Display Area 4: | No Display

Date and Time Format Font Settings

@ Same as Local Computer Font: [S\,fgtem v]

© Spedify Color: E|
Date Format: | YYYY/MM/DD Sge: |10 -

Time Format; | Default Time Format

Video Display Mode

@ Hide borders () Keep top/down borders () Keep the aspect ratio
Show motion windows when triggered

[] Display the connecting message when video is lost

[7] The screen goes blank when video is lost

VCA
Show WCA rules

VCA extra information:

none
cm
inch [ 0K ] l Cancel




Appendix E  Support for Digital I/O Modbus TCP
Modules

This revision, rev. 1.9, supports Advantech's I/O Modbus TCP Modules 6000 series. The VAST
server can receive digital inputs and trigger digital outputs via the I/O modules.

The Advantech 1/0 modules come with configuration utilities, such as the Adam/Apax.NET.
Connect the DI/DO wires to the module and the Ethernet wire from the module to the local
network.

Proceed with the following to configure the 1/0O module:
1. Use the Search function to locate the I/O module on the network.

Advantech Adam/ 1 3
File | Tools | Setup  Help

Search Device |

Add Devices to Group
Group Configuration fting ]

Terminal for Command Testing

Wetwork setting:
Print Screen Apply change

Monitor Strearn/Event Dats MAC address: |UU-DU—C9-FU-EF—3EI
Monitor Peer to Peer

Meaniter GCLIO Data Message IF address: |172.13.IUU.22
Monitor AP AKX

L ggroum Subnet address: [255.255.00
E@b Wireless Sensor Networks
< COMI Defanlt gateway: (1721601

2. It is recommended to configure a static IP for the 1/0 module.
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3. You may then test the DI/DO device connectivity using the software utility.

Me Tosk
OHEHY*Er o

= B Tecl

193 1686 139

Chasura] setting | Modbes |

The Fcl Sae Yaluw (FEV) of commexabon WOT
Each Do) will sl o o PV of the rocdole's WD s wronbled sl o ot tiggeend,
FEV checked - Logie High D, FEV meheched - Loge Low Tne.

M Commmucaboa WOT [ F2RGCL WDT

4. To configure the 1/0O modules in VAST, open the Configuration > I/O Box Management >
Insert 1/0 Box Device window.

System | Edit | View | Configuration | Layout | Help)

o By Camera
w Mega-Pi
- [N Mega-P
- [N Maga-p
- [ Recording St
o [ Layout
- [ 1jO Box

Camera Management

Station Managerment...

[/0 Box Management

-

Insert [0 Box Device. .

User Management...
Association Management...
Alarm Management...

Wirtual Matrix Management

Station Settings
Client Settings

Video Enhancerment

Update [/ Box Device...
Delete /O Box Devices...

5. Select the Module model name, enter IP address, User Name, Password and then click the

Insert button.

B wi sumni(z700.1)
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6. Click Close to close the window. The 1/0 module and its DI/DO entries should be listed on the
device tree under the 1/O box sub-directory. As shown below, once a Dl is triggered from the
I/O module, the associated DI icon will be lighted. Audible notification can also be heard from
the VAST server.

i+ BN Mega-Puel Network Camera(16( ~ _

. Ilacnrdrq Storage Meqa-Pixel Network'Camera
[ Layout
& B 10 Box

E-a " ADAM-6052(192.168.6.136) | |

@ oo

@ o2

— @ o3

5 o4

OIS

1ctsiié-i

¢
g

§EEEEES

7. You can also double-click on a DO icon to manually trigger the digital output. Double-click
again to cancel the trigger.

System | Edit | View | Configuration | Lay

l - &M Mega-Fixel Metwark Carmeral 16t =
- Recording Storage
- Layout
=} . 1j0 Box
‘:‘ ADAM-B052{192,168.6.136)
DI-1

DI-2

DI-3

DI-4

DI-5

DI-6

DI-7

DI-3 X2
Do-1

Dio-2

Do-3

OD-4

5
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8. You can also implement the digital inputs and outputs from the I/O module in your alarm
setting. For example, a DI can be wired to an intrusion detector; and when the DI is triggered,
an associated DO can be used to sound an alarm.

To configure the Alarm setting, enter the Configuration > Alarm management window.
Configure a new alarm. On the Trigger window, select the Trigger Category as External
Device Events.

11
| General ., Trigger .. Acton .. Schedue ., Detal

&4 Add Event

Add Event by: @ Device () Trigger Type

Cateqgory:
Camera Events
Camera Status
Substation Connection Status
Storage Status

Station Status

External Device Events

Remove

i [ Back ][ Mext ][ Firish ][ Cancel ]

9. The DIs and DOs on the I1/0O module will be listed. You can then select one or more Dls as the
triggers.

Select the trigger(s) from the following list,

........ “ DI-1
........ D 0 nl-2
........ 0 nl-3
........ 0 OI-4
........ D 0 0I5
........ D 0 DI-6
........ D 0 OI-7
........ D 0 nl-8
........ D “ Oo-1
........ D “ 0o-2
........ D “ 0o-3
........ D “ D04
........ D “ 005
........ D “ Dio-5
........ D 0 Do-7 i
........ D . Do-2 l
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10. On the Action panel, you can select to trigger DOs, for example, as the reacting actions

: Sk e DO} ot Prllowng 1.
B = I v stabona{1ar 01 (=] | MeticEin Type
Rt mmodon B apaonaRE LG 1y || 7 Hormal
£ Miwn o preset locabon oo i)l e Trigger
& 5t 00 [ o2 |

F i

F oo |

(=i - -] |

r ooe

r o7 =|

.
e
| S

Note that once a DO is triggered, you should manually disable the DO.

é;

If an 1/0 module is started later than the VAST server, you may not be able to access the 1/0 module.
You should then re-start the VAST service.

o
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Appendix F  Database Merge Function

The Database Merge function applies in the following scenario:
1. A VAST server A failed or was intentionally depleted. The precondition is that the disk drives

containing the recordings remain intact.

VAST Server A

@

Network Cameras

Recorded

videos

VAST server B

DB
b Recovery path

Recorded
videos (default path)

2. The VAST server B is used to continue video recording. The previous recordings on server A

can be retrieved by attaching the hard disk(s) to server B or manually copying to a storage
device on server B. You can then designate the location of these files as the "Recovery
path" from server B. An administrator can then use the VAST Playback to access the past
recordings.

Note that you can also configure a separate recycle policy for that Recovery path.

ge

It is IMPORTANT to move or copy the entire storage group folder, e.g., D:/recording/2016-
06-17/1-FE9181-H..., which is a root directory configured by VAST server as the recording
folder. The default recording folder contains file folder structure, video files, and database
metadata. If you copy the video files only, the database data will not be synchronized, and
you will not be able to access the recordings using the VAST Playback utility.

The video streams received from cameras will not be recorded on to the Recovery path
folder. It is designed to maintain previous recordings. The Recovery path folder becomes
static.
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- D:/Record

|
RN
D P PP P

2016-06-17 2016-06-18 2016-06-19 2016-06-20 2016-06-21 2016-06-22

2016-06-17 . . . . . . o

1-FE9181-H 2-FD9381 3-Outdoor  4-Outdor  5-1B9381  6-1IP8166
Speed Dome Speed Dome

L

L

« It is also a good habit to export and preserve your VAST system configuration to prevent
losses in the event of system failure. In case you want to migrate or upgrade your VAST
server, you can use the Import-Export utility to duplicate your VAST configuration to
another server. Copy the configuration file and import the configuration from another VAST

server.

| VIVOTEKInc
| Installation Wizard 2

J vAST
&g LiveClient
) Playback
&7 Uninstall
|l Toals
[ R4 Import-Export Utility
& VMSServiceContral -

Options
@ Export current settings
Configuration settings

() Import previons settings
Eestore [] Copy settings

B e R | ]
| Wext I Cancel
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When the file folder is ready for server B, designate the location of recovered files from
another VAST server, go to Configuration > Station Settings > Recording Storage Settings.

Select the recording folder that contains the recordings from the counterpart VAST server.
Select the Recovery Path check circle and click OK.

"4 Fieuoriing Herege Setirm for UG Btatien
Srorage DelaukGroup: el
Recovery  Storage Bath  Rabesnce
CREEaE-1

4

il Pabehiss_FW
) Mot 152.168 4. 10528 Zoom Soeed Dodme Network Cirers_
“shwed_Rta

-

Far

LS TR LR TS

L E]

ltumore. | [ tewr. | oose |

Click the Apply and Close button.

Steage Gy ovaeson 7] (@] (2] (98]

Path in Storage Group
8 [ () (3] e
Rocovery  Stomge Path Storage Information
C:\Recond-1 Toual: 186289  GBytes
T Rosoned 1600 GByles
Fres: M9332 Ghyles

I Delete recorded date oider then |7~ diyls)

Caneria n Stodege Group

Grgup faamg Addriss ﬁg;m

W FESIGLH 192.162.6.105 Cutdoor Netwerk Spaed Dome Camen
w FOUIEEHTY 192, 168.6.109 Critdoor Betwirk Speed Doame Camen
W Outdeor Nabwork Sop..,  192.168.6.060 FE166

o Outdoce Nabwnric Spa... 1921686160 s

o REER1IHT 1831686170 el

w7 L 19 168.6. 160

L 4 sCELI 192.16840.1.-
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If you are running the Playback utility, close and re-start the Playback utility. Open the device
tree, and you should be able to see previous recordings listed under each camera. This
indicates previous recordings can be accessed from the recovery path and the databases on
the two VAST instances have been synchronized.

{ Systemn._Edn_ View | Conhgumabon | Layoul | Halp |

REARDREETE D

o Murued Stitons
WSl LT 001
B corem
e PG (Defaitiroun )
M o0
R zoeaodaon
B xisodar
F 06020
B Soiho6-30
Bl oo
0 FOAGA1-EHTY (Defaiio
B aisorx
M8 soasoad
A us06-17
B aviéot-a0
MR 20080630
8 misoro
W Custins Patwork Spmses O
D Cwtioor Faetwionk Spased O
0w (B T [Dadaittntun)
O A (Owlaittneg)
e S0En3] (DefekGoup )
r= ETEE

M aois0e-30

B tocars
B Eiepor path



In addition to the use of Recovery path, if you need to access the recordings made by a
different VAST server, you can also manually copy the entire storage group folder, such as
D:/recording, to a hard drive or a network share, and then avail the recordings on the new
server.

Different from the use of Recovery Path (Database Merge), this scenario applies to two VAST

servers with different configurations.
VAST Server A

Network Cameras
Recorded

videos

VAST server B HDD Network share

r (Entire folder)

Recorded

videos

On the Playback window, right-click the Local DB icon to display the Add command. Select
the folder where the recordings reside. The recordings should be listed under each of the
cameras.

Browsing |Time Search IEvent Search | Bookmark £ [ "

aﬁ Managed Stations
[ E WMS_Station(127.0.0.1)
[=h Eﬂ Cameras
i (W FE9181-H (DefaultGroup)
EW FDI381-EHTY (DefaultGroy

g OUtSW “Et"“mt SDEESD Note that as the folder structure remains intact, you

Outdoor Metwiork Speed D . . .

. @ B9IBLHT (DsfultGroup) cgnlstllll manually remove some of the video files
@M Pa166 (DefaultGroup) within, if they are not of your interest.

Lo @M 5CH131 (DefaultGroup)

- |2 Local DB
S & EjRecord-1

H|
- (M FO9381-EHTY

- M Cutdoor Network Speed Dome
- M Outdoor Network Speed Dome
|
=)

i TN e OO pr O

- [N 1B9381-HT
- (@M 1PE166
[ 2016-06-17
oo [FH 2016-06-20
- (M SCA13L

|




The Export Storage is another backup function.

To export video recordings to a specific target folder, enter Configuration > Station Settings >
Recording Storage Settings. Click the Browse button to select a target folder.

Select the default storage group, click on the Export button L) . Select all cameras (default)
or manually select specific cameras from the list. If you want to select individual cameras, use
the arrow buttons to move cameras to the right column. Select the time span of the export
using the selectors below. The minimum span is one day. Click OK to proceed.

Note that the videos thus exported can not be indexed in the Playback utility's device list.
Each video clip should be watched individually.

Stersee Oeowy  DefautiGioeg =| o P [

Sturage Infrrmation "

51615  GByies

=11 [~ i)

e ey = -.

Depending on the length of time span and the number of selected cameras, the export
process may take several minutes or longer to complete.

% Information £3

G Exporting Success
| ook

ge

» If the members of the original VAST configuration (cameras) have been changed, the VAST
server will not be able to locate the original MAC addresses, and may not be able to retrieve
past recordings.

+ The Export Storage function only takes effect on the VAST server local console. It is not
available on a web console.



Appendix G Other Parameters

Disable background decode:

Administrators can choose to disable the background decode for other view cells when entering
a single view of a specific camera. This can help reduce the CPU load on a server short of
system resources.

This function can be evaluated in two aspects:

1. For a server with abundant system resources, there is less stress when disabling and
enabling background decode. When a user leaves a single view and enters a multi-cell
view, the background decode starts again, and a powerful server handles this process more
smoothly.

2. For a server with less resources, this feature can reduce CPU load. However, latency can
occur during the process when returning from a single view back to a multi-cell view.

This feature is enabled by editing the ClientSetting.ini file in C:\ProgramData\VIVOTEK Inc\
VAST\Client\LiveClient.

64 [F[GeneralSetting]

65 AutoFullScreen=0

66 AutolddCam=1

67 S5E=1

68 EnableRTSP=0

69 RTSPPort=4543
StreamingRelay=1

1 SubscribeCamera=0

2 SortCamera=0
LiwveEvent=1

74 Localilert=0
EventWindowType=0

76 RotateSec=10
AutoRotate=0
DeInterlace=0
SynchudioVideo=0
AutoStreamSize=1

B1 AutoStreamSizeMode=0
B2 InstantReplay=1

5 DefaultPlaybackLength=1
B4 BufferTime=0

85 GDICnly=0

B& GPUDecode=0

87 GPUDecodeMaxNumber=0
H MinPTSpeed=-1
MaxPTSpeed=-1
—DisablEEECkgroundDecode=ﬂ
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